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PREFÁCIO

O desenvolvimento de protótipos envolve avaliações estáticas, cinemáticas e 
dinâmicas de sistemas mecânicos, as quais são atividades comuns aos engenheiros 
e estudantes de engenharia.

Geralmente, ao projetar um sistema mecânico, o modelo virtual desenvolvi‑
do em um software de simulação qualquer, deve ser capaz de representar, o mais 
próximo possível, o funcionamento real desse sistema. Em seguida, a partir de 
simulações, o profissional ou estudante obterá resultados sobre esforços, tensões, 
deformações, além de informações referentes à cinemática e à dinâmica de fun‑
cionamento do sistema. Esse conjunto de resultados será crucial na tomada de 
decisão do projetista, no que tange à manutenção ou à modificação do projeto.

Nesse contexto, o presente Guia tem por objetivo apresentar, de forma sim‑
plificada e ilustrada, uma ferramenta computacional, que atende engenheiros e 
estudantes de engenharia em uma das três fases de desenvolvimento de um pro‑
duto, ou seja, o Computer Aided Engineering (CAE). O software MSC ADAMS 
(Advanced Dynamic Analysis of Mechanical Systems), da MSC, permite que se‑
jam realizadas simulações voltadas ao estudo da estática, da cinemática e da di‑
nâmica de sistemas multicorpos, de modo a permitir a otimização de projetos nos 
aspectos de desempenho, segurança e conforto, sem que vários modelos físicos 
precisem ser construídos e testados.
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6 MSC ADAMS: Guia Prático de Utilização

O MSC ADAMS é um sistema modular que permite usar plug‑ins confor‑
me necessidade dos usuários. Assim, nesta obra, serão tratados o ADAMS/Car, 
ADAMS/View e o ADAMS/PostProcessor, sendo que o ADAMS/View é o pré
‑processador padrão da MSC ADAMS. A sistemática de apresentação dos módu‑
los se baseia na construção de modelos reais, os quais contextualizam a apresen‑
tação da interface do software. Contudo, ao longo da metodologia de construção, 
quadros explicativos podem trazer: conceituação de variáveis tratadas, formu‑
lação que rege o fenômeno de funcionamento do mecanismo ou uma análise de 
resultado obtida no ADAMS/PostProcessor.

A apresentação do módulo ADAMS/Car baseia‑se na construção das suspen‑
sões MacPherson e Duplo A, seguida da forma de obtenção de gráficos que per‑
mitam a análise da geometria adotada, por exemplo, segundo a interface gráfica 
padrão gerada no ADAMS/PostProcessor. Quanto ao ADAMS/View a abordagem 
será feita a partir da apresentação de tutoriais de mecanismos típicos da engenha‑
ria: pêndulo simples, pêndulo físico, came e mecanismo de comando de válvula 
(valvetrain).

Os autores salientam que o conteúdo do livro foi desenvolvido na platafor‑
ma MD R3, utilizando‑se a interface clássica (Classic interface). Tal fato, no en‑
tanto, não configura um limitante para os usuários do ADAMS 2012, visto que é 
possível alterar o modo de visualização da interface e, assim, executar o conteúdo 
proposto na obra.

Os autores da obra acreditam que esta será de grande valia para engenheiros 
e estudantes de engenharia que queiram começar a trabalhar com essa ferramen‑
ta, no desenvolvimento de projetos.

As autoras
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INTRODUÇÃO

A proposta da presente obra é fornecer aos estudantes de Engenharia Auto‑
motiva, Engenharia Mecânica e áreas correlatas; um material didático em forma 
de tutoriais, baseado no estudo da cinemática e da dinâmica multicorpos de mo‑
delos virtuais aplicáveis à área da Engenharia. Neste sentido, a obra lança mão de 
uma ferramenta computacional aplicável especificamente em estudos dessa natu‑
reza denominada: MSC ADAMS®. Este software possui vários módulos (plug ins), 
contudo, para construção e análise dos protótipos virtuais propostos nesta obra 
será dada ênfase aos recursos oferecidos pelos módulos ADAMS/Car, ADAMS/
View e ADAMS/PostProcessor. Levando‑se em conta estes aspectos, justifica‑se o 
título escolhido: MSC ADAMS: Guia prático de utilização.

Cabe ressaltar que o conteúdo deste livro foi desenvolvido na plataforma 
MD‑R3, utilizando a interface clássica (Classic interface), o que permite a execu‑
ção dos exemplos aqui descritos nas demais versões do software, mesmo as mais 
atuais. Neste sentido, torna‑se necessária apenas, a alteração do modo de visua‑
lização da interface, o que é, no caso, aplicável ao usuário que utiliza o ADAMS 
2012.

O livro se divide em seis capítulos. O primeiro traz uma apresentação geral 
do software e, em seguida, dos três módulos a serem utilizados. O segundo e ter‑
ceiro capítulos trazem a aplicação do módulo ADAMS/View no estudo do MHS 
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8 MSC ADAMS: Guia Prático de Utilização

(Movimento Harmônico Simples), por meio do desenvolvimento e da análise de 
pêndulos simples e físico, bem como de mecanismos aplicados à área automotiva, 
como a came e o valvetrain, respectivamente.

O quarto e quinto capítulos são dedicados ao desenvolvimento e à análise 
de suspensões independentes, do tipo MacPherson e Duplo A. Nesse contexto, os 
recursos do módulo ADAMS/Car serão utilizados.

O sexto capítulo aborda aspectos referentes ao intercâmbio de informações 
entre duas das fases de desenvolvimento de um produto, ou seja, CAD (CATIA®) 
e CAE (MSC ADAMS®).

O leitor perceberá que, ao longo da obra, os autores inserem quadros deno‑
minados A notar, que trazem esclarecimentos teóricos ou mesmo técnicos a res‑
peito de um determinado assunto. Sendo assim, os autores consideram que este 
seja um diferencial deste texto, não o colocando como um simples manual de 
utilização de um software.
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MSC ADAMS:  
Aspectos Gerais

1.1.	 Sobre o MSC ADAMS

Historicamente, a tecnologia existente no ADAMS foi implementada há mais 
de 30 anos. Originalmente, o software era denominado ADAMS/Solver, que era 
um aplicativo que resolvia equações não lineares a partir de arquivos tipo texto 
“.txt” que eram submetidos ao, então, ADAMS/Solver.

Nos anos 1990, com a chegada do ADAMS/View, os usuários passaram a ser 
capazes de construir, simular e gerar resultados para análise de um produto em 
um ambiente relativamente simples. Hoje, o ADAMS se apresenta como um sis‑
tema modular com diferentes plug‑ins que se atendem às diferentes necessidades 
do usuário.

Seu contexto de utilização se justifica, uma vez que softwares CAD (Computer 
Aided Design) podem auxiliar apenas na avaliação de interferências entre peças, 
análise estática, avaliações de cinemática básica e de frequência de vibração. O 
MEF (Método dos Elementos Finitos) é eficiente para o estudo de vibrações lineares 
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12 MSC ADAMS: Guia Prático de Utilização

e transientes dinâmicos, mas não atende eficazmente a análises que envolvam gran‑
des rotações, movimentos não lineares não infinitesimais de sistemas mecânicos.

O ADAMS, como uma ferramenta CAE (Computer Aided Engineering), é 
um software de análise cinemática e de dinâmica multicorpos, muito utilizado 
no domínio da Engenharia. Seu objetivo é auxiliar seus usuários no estudo da 
cinemática e dinâmica de mecanismos complexos, assim como na determinação 
da distribuição de esforços, gerada mediante a ação de um determinado sistema 
de força e sob determinadas condições de funcionamento.

Assim como outros softwares, o ADAMS vem ao longo dos anos sofrendo 
atualizações de suas versões de modo a deixar a interface mais amigável e intera‑
tiva, bem como a adição de novos módulos (ou plug‑ins). O conteúdo deste livro 
foi desenvolvido na plataforma MD R3, utilizando a interface clássica (Classic 
interface), o que permite a execução dos exemplos aqui descritos nas demais ver‑
sões do software, mesmo as mais atuais. Neste sentido, torna‑se necessária ape‑
nas, a alteração do modo de visualização da interface. Por exemplo, para o usuá‑
rio que utiliza o ADAMS 2012, acesse o menu Settings → Interface Style → Classic.

A notar: As raízes da dinâmica de multicorpos data de antes da Mecânica Analítica 
que teve início com os Princípios de Newton, Euler aplicado a corpos rígidos e a 
Mecânica Analítica de Lagrange. Importantes contribuições à dinâmica multicorpos 
são identificadas nos trabalhos de D’Alembert, em seu Tratado da Dinâmica (Traité de 
Dynamique), Jourdain em sua analogia ao Princípio de Gauss, entre outros.
O estudo da dinâmica multicorpos ganhou força no século XX com as teorias do 
giroscópio e do mecanismo de Wittenbauer. No meio deste século, o estudo de aeronaves e 
da biomecânica impulsionou mais ainda a área. O fundamento da dinâmica multicorpos 
no ramo da Mecânica está em modelar o comportamento dinâmico de um sistema de 
corpos rígidos ou flexíveis interconectados, sendo que cada um dos corpos pode sofrer 
grandes translações e rotações. Neste sentido, o sistema mecânico original deve ser 
modelado utilizando elementos pertinentes à aproximação do sistema multicorpos, 
quais sejam: barras ou superfícies rígidas ou flexíveis, juntas, molas, amortecedores, 
além de considerar a gravidade e estabelecer a posição e/ou forças atuantes.

1.2.	 Considerações gerais sobre o módulo ADAMS/Car

O módulo ADAMS/Car destina‑se ao desenvolvimento de projetos na área 
automobilística, atendendo usuários que desejem construir protótipos virtuais de 
subsistemas veiculares. Entende‑se por subsistemas a suspensão dianteira e tra‑
seira, sistema de direção, sistema de freios, motor/transmissão e chassi. O veículo 
completo surgirá com a consideração de todos esses subsistemas juntos. É possí‑
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13Maria Alzira de Araújo Nunes e Rita de Cássia Silva

vel também, nesse módulo, simular individualmente a suspensão, assim como o 
veículo completo.

Assim, este tópico tem por objetivo apresentar ao leitor o ambiente do mó‑
dulo ADAMS/Car. Neste sentido, os itens que se seguem irão mostrar as atribui‑
ções/permissões de cada tipo de usuário; arquivos de configuração; a estrutura 
da base de dados no ADAMS, a hierarquia de dados, como acessar o Help do 
software, além de alguns conceitos básicos.

1.2.1.	 Tipos de usuário e arquivo de configuração

Para desenvolver protótipos no ADAMS/Car, é necessário, primeiramente, 
recorrer ao arquivo de configuração do módulo e estabelecer o tipo de usuá‑
rio, tendo em vista as operações que esse módulo irá desempenhar. O arquivo a 
que se refere é o .acar.cfg, que é criado automaticamente para cada usuário pelo 
ADAMS/Car; e os usuários podem operar em dois modos: como usuário padrão 
(Standard User) ou usuário expert (Expert User).

Figura 1.1 – Arquivo .acar.cfg

1 ‑! ************ ADAMS/Car Private Configuration File 
************
2 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
3 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
4 ‑ ! ‑ List of personal environment variables
5 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
6 ‑ ! Desired user mode (standard/expert)
7 ‑ ENVIRONMENT  MDI_ACAR_USERMODE    expert
8 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
9 ‑ ! ‑ List of personal database directories
10 ‑ !      Database name   Path of Database
11 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
12 ‑ DATABASE   private      $HOME/private.cdb
13 ‑ ! Example database entry:
14 ‑ !DATABASE   proto_2000    /usr/people/joao/prototype.cdb
15 ‑ DEFAULT_WRITE_DB  private
16 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
17 ‑ ! ‑ List of personal tables directories
18 ‑ !      Type class      Name of table       Extension
19 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
20 ‑ ! Example table entry:
21 ‑ !TABLE    example        example.tbl           exa
22‑ !!‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
23 ‑ ! ‑ List of personal default property files
24 ‑ !      Type class     Default property file
25 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
26 ‑ ! Example property file entry:
27 ‑ !PROPFILE   damper      <private>/dampers.tbl/myfile.dpr
28 ‑ !!‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
29 ‑ ! ‑ List of personal default testrigs
30 ‑ !      Assembly class    Name of testrig
31 ‑ !‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑‑!
32 ‑ ! Example testrig entry:
33 ‑ !TESTRIG   suspension     .__MY_TESTRIG
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14 MSC ADAMS: Guia Prático de Utilização

A Figura 1.1 ilustra o formato do arquivo .acar.cfg; a escolha do tipo de 
usuário se dá na linha 7 do arquivo e pode ser alterado usando‑se o editor padrão. 
O usuário expert é atribuído àqueles engenheiros que irão construir o protótipo 
virtual, pois dá acesso a todas as ferramentas de modelagem do ADAMS/Car. 
Normalmente, esse tipo de usuário tem acesso irrestrito a uma interface do pro‑
grama com mais recursos, distinta daquela do usuário padrão.

O usuário padrão, por sua vez, poderá operar apenas na interface padrão 
(Standard Interface) do ADAMS/Car, sendo atribuído a projetistas e engenhei‑
ros de teste. Eles podem usar a biblioteca do ADAMS/Car para trabalhar com 
subsistemas já criados pelo usuário expert e trabalhar com o veículo completo, 
sendo capazes de unir todos os subsistemas já projetados e acessar o ambiente de 
simulação padrão.

1.2.2.	 Estrutura da base de dados

Há três tipos de base de dados. A primeira é a Shared comum a todos os 
usuários e constituída por exemplos que são fornecidos pela MSC.Software. O 
diretório denomina‑se shared_car_database.cdb e o tipo de arquivo armazenado 
é template/.tbl. A segunda é a Private área de trabalho do usuário (workspace) 
criado pelo ADAMS/Car no diretório do usuário. Por último, a User criada para 
um usuário específico.

A Figura 1.1 ilustra nas linhas 12 a 14 a especificação de uma base de dados. 
No caso em questão, linha 12, trata‑se da Private seguida do endereço da base de 
dados a ser usada. As linhas 13 e 14 trazem um exemplo de como se pode proce‑
der no preenchimento, veja que, com a exclamação na frente da linha, esta ganha 
status de comentário.

Quanto à manipulação da base de dados, ressalta‑se que não há limitação 
quanto a seu número, recomenda‑se que cada projeto tenha a sua base de dados 
definida pelo usuário expert e ao salvar um determinado projeto este só poderá 
ser salvo em uma base de dados por vez.

1.2.3.	 Hierarquia de construção de um protótipo virtual

O ADAMS/Car possui três níveis de hierarquia na construção de um pro‑
tótipo virtual de um veículo, o que abrange subsistemas ou o veículo completo. 
O primeiro deles é o Template, que será desenvolvido, segundo item 1.2.2, por 
apenas um usuário expert. No Template, são definidas as topologias dos compo‑
nentes do veículo, ou seja, definições de partes (item 1.2.5.2), como se conectam 
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15Maria Alzira de Araújo Nunes e Rita de Cássia Silva

entre si, ou seja, graus de liberdade relativos entre as partes por meio da definição 
de juntas, inserção de buchas.

A notar: Define‑se grau de liberdade como sendo o número de movimentos rígidos 
possíveis e independentes que um corpo pode executar. Grau de liberdade relativo é 
o movimento que se estabelece de um corpo em relação ao outro em um sistema de 
corpos.

O ambiente de trabalho correspondente a esse usuário é chamado Template 
Builder. Se o MSC.ADAMS tiver várias licenças, o acesso à esta interface se dá 
automaticamente, a partir do momento que se define o papel de cada engenheiro/
técnico no processo de desenvolvimento do produto, bem como a base de dados 
a qual eles terão acesso, conforme os itens 1.2.1 e 1.2.2.

Cabe ressaltar que, uma vez definido como usuário expert, ao iniciar‑se o 
ADAMS/Car, esse mesmo usuário tem a possibilidade de trabalhar como usuário 
expert ou padrão, cabe a ele definir no início da seção, conforme será mostrado 
no Capítulo 2. Em resumo, o usuário expert tem direitos amplos podendo, inclu‑
sive, atuar como usuário padrão.

O segundo nível de hierarquia é o Subsystem. Em termos de construção de 
um protótipo virtual, este corresponde a um modelo mecânico gerado a partir de 
um Template. A partir do Subsystem, algumas soluções técnicas/premissas podem 
ser efetuadas sem que haja interferência de um usuário expert, por exemplo, a 
mudança de localização de Hardpoint ou a alteração das propriedades de uma 
mola ou mesmo do amortecedor, arquivo de propriedades de buchas.

De maneira geral, o Subsystem corresponde a uma etapa específica do Tem‑
plate, no qual o usuário pode definir novas posições para os Hardpoints, assim 
como propriedades, ou mesmo criar arquivos editáveis para definição de uma 
propriedade. O ambiente de trabalho correspondente a esse usuário é chamado 
Standard Interface. Os autores esclarecem que esse nível de hierarquia será deno‑
minado, ao longo do texto, como subsistema.

O terceiro nível de hierarquia é o Assembly, que corresponde a um conjunto 
de subsistemas interligados ou um subsistema e um equipamento de teste virtual 
simples denominado Test Rig. O equipamento virtual, no ADAMS/Car, é conside‑
rado um subsistema especial e representa a parte do modelo que impõe movimen‑
to ao subsistema suspensão, conforme será visto nos Capítulos 4 e 5. O Assembly 
também é desenvolvido no ambiente Standard Interface.
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O Test Rig consiste de um sistema de atuadores virtuais, conforme mostra‑
do na Figura 1.2, que impõe movimento ao sistema, sendo utilizado para testes 
preliminares no modelo completo, ou seja, todo o veículo, ou ainda, apenas o 
subsistema suspensão. Na Figura 1.2, o subsistema de direção encontra‑se unido 
ao subsistema de suspensão dianteira, o que permite análises correspondentes à 
geometria desta (Capítulo 4). Assim, o Assembly se define pela união/junção de 
dois ou mais subsistemas desenvolvidos no ADAMS/Car.

Figura 1.3 – Níveis de hierarquia do ADAMS/Car.

Figura 1.2 –� Ilustração do Test Rig no 
ADAMS/Car, juntamente com o 
subsistema suspensão e direção. 
Fonte: ADAMS/Car Tutorial
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As extensões de arquivo para cada nível de hierarquia são Template*.*tbl, 
Subsystem *.*sub e Assembly *.*asy. A Figura 1.2 consolida o exposto acima.

A notar: Cabe salientar que o mais importante na construção de um protótipo virtual 
é a construção do Template. Isto porque é no Template que se definirá como este se 
comunica com outros subsistemas e com o Test Rig (Figura 1.2), se for o caso. Em 
nível de um Template, definir a massa das partes que o compõe, inércia e o sistema 
de forças atuantes, é tarefa secundária, visto que um usuário padrão pode fazê‑lo em 
seu ambiente. Contudo, é de extrema importância definir a conectividade entre as 
partes (juntas) e como as informações serão transmitidas de um Template a outro, 
porque tal não pode ser feito por um usuário padrão.

1.2.4.	 Conectividade dos subsistemas no ADAMS/Car

No processo de desenvolvimento de um protótipo virtual no ADAMS/Car, 
passa‑se obrigatoriamente pela criação de Templates (item 1.2.5), em seguida, de 
Subsystems para, finalmente, chegar‑se ao Assembly. Desta forma, a construção 
do Assembly representa o objetivo final no processo, porém, para que este seja 
válido, devem‑se definir alguns parâmetros relativos à construção do Template e 
Subsystem.

A Figura 1.4 ilustra a tela de criação de um novo protótipo no ambiente 
Template Builder. A segunda aba da caixa de diálogo New Template solicita ao 
usuário a definição do Major Role, que, mediante um clique na seta à direita da 
referida aba, leva às seguintes opções: suspension, steering, antirollbar, Wheel, 
body, powertrain etc.

A partir desta tela, observa‑se que todo Template tem seu status definido 
como Major e que os elementos que podem obter tal status correspondem aos cin‑
co subsistemas que compõem um veículo, suspensão, direção, powertrain, freios 
e chassi, além da barra antirrolagem, rodas, mola de feixe etc. Cabe ressaltar que 
o Subsystem recebe o Major Role especificado na criação do Template, ou seja, o 
Subsystem de uma suspensão já tem características reconhecíveis pelo ADAMS/
Car nessa categoria.
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Por outro lado, todo Subsystem gerado será Minor Role, conforme ilustra 
a Figura 1.5. A caixa de diálogo mostrada indica que este pode ser do tipo front 
(frontal), rear (traseiro), trailer ou any. Note que é necessário especificar o Tem‑
plate de origem, o que reafirma o dito aqui. Isto evita que o mesmo Template, por 
exemplo, o da suspensão, seja usado na dianteira e na traseira do veículo.

Figura 1.4 – �Tela inicial de construção de 
um Template no ADAMS/Car.

Figura 1.5 – �Tela inicial de construção de um 
Subsystem no ADAMS/Car.

Uma vez selecionada a opção referente ao Minor Role, esta é armazenada em 
uma variável do tipo string. Essa informação será de grande importância na con‑
cepção do Assembly, pois ela estabelece como o Subsystem será identificado ao ser 
inserido na construção deste. Assim, se a opção any é selecionada na criação do 
Subsystem, este poderá conectar‑se em qualquer outro subsistema ativo por meio 
da identificação de Communicators (item 1.2.5.3). As opções rear e front são mais 
restritas, ou seja, Subsystems selecionados nessas opções só se unem a outros de 
mesma natureza, assim, rear ou front.

1.2.5.	 Construindo um Template

Conforme dito no item 1.2.4 a criação de um protótipo virtual passa, obri‑
gatoriamente, pela criação de um Template. Neste sentido, o presente tópico tem 
por objetivo apresentar sucintamente informações sobre a criação de Template 
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considerando o processo de parametrização; os componentes que podem formar 
o Template e a função destes no ADAMS/Car.

1.2.5.1.	 Parametrização no ADAMS/Car

A parametrização é um processo por meio do qual se estabelecem parâme‑
tros e/ou variáveis para a especificação completa de um modelo. No ADAMS/Car, 
esse recurso está disponível e se mostra bastante útil na construção de modelos 
virtuais. Isto porque se estabelece uma relação entre os entes que compõem o mo‑
delo, na qual, havendo qualquer alteração em seus componentes, esta se repercute 
a todos os componentes relacionados atualizando o modelo final. Para o proje‑
tista, isto representa economia de tempo e esforço na correção ou atualização de 
modelos.

A parametrização no ADAMS/Car pode ser observada, por exemplo, na 
construção de Hardpoint (item 1.2.5.1) ou Construction Frame (item 1.2.5.1.2 
e 1.2.5.1.3). De modo geral, no ADAMS/Car pode‑se parametrizar a posição e 
a orientação. No caso da parametrização da posição, as opções disponíveis são: 
Delta location from coordinate; Centered between coordinates, Located on line, 
Location input communicator, Located at flexible body node e Located along an 
axis. Já no caso da orientação o ADAMS/Car oferece dez opções, neste guia serão 
apresentadas apenas as principais.

Cabe ressaltar que essas opções estão disponíveis para a construção de um 
Construction Frame (cf) que será discutido em 1.2.5.1.1 e 1.2.5.1.2. A janela, à 
direita, mostrada na Figura 1.6, representa a tela geral de criação de um cf.

Repare que esta tela, Figura 1.6, pode ser dividida em três áreas. A primeira 
se refere à identificação do cf. A segunda se refere à parametrização da posição no 
ADAMS/Car, solicitando ao projetista o tipo de relação de dependência (Location 
Dependency). Obviamente, as abas que se seguem nesta área variam de acordo 
com o tipo selecionado. A terceira e última área traz a parametrização da orien‑
tação (Orientation Dependency). A seguir, nos itens 1.2.5.1.2 e 1.2.5.1.3, serão 
apresentadas algumas dessas opções.
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1.2.5.1.1.	Parametrização a partir de Hardpoints

Os Hardpoint, no ADAMS/Car, são entidades básicas que definem a posição 
dos elementos de construção de um protótipo virtual. Eles são parametrizáveis 
por suas coordenadas x, y e z. A Figura 1.7, a seguir, mostra a janela básica de 
construção de um Hardpoint.

Nesta figura, além da coordenada que dá a posição do elemento, escolhe‑se 
o tipo se de esquerda (left), direita (right) ou single (indiferente à posição direita/
esquerda). Nota‑se que, quando se escolhe uma das duas posições, automatica‑
mente o Hardpoint se cria em dualidade, ou seja, caso se selecione à esquerda 
espelha‑se à direita e vice‑versa.

Figura 1.6 – Informações de tela para construção de um Construction Frame (cf).
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Figura 1.7 – �Tela básica de criação 
de um Hardpoint.

1.2.5.1.2.	Parametrização da posição relacionada à construção de  
um Construction Frame

a)	 Delta Location from Coordinate

Nessa opção, a posição será definida com relação a uma referência pré
‑definida (Coordinate Reference), conforme ilustra a Figura 1.8. Na aba Location 
o preenchimento pode ser feito com um sistema de coordenadas que pode ser 
local ou global.

Figura 1.8 – �Ilustração da tela referente à criação de um Construction Frame com a 
opção Delta location from coordinate.

b)	 Centered between coordinates

Selecionando essa opção um cf será inserido ao longo de uma linha imaginá‑
ria que une duas coordenadas denominadas Coordinate Reference (#1 e #2), as 
quais serão definidas pelo projetista, conforme a Figura 1.9.
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c)	 Located along an axis

A janela de criação do cf possui a seguinte aba Location Dependency, que 
deverá ser preenchida com Located along an axis. Neste modelo de criação, a po‑
sição do novo cf ficará condicionada a outro cf dito de referência, o qual possui 
um sistema de referência local.

A definição do novo cf terá sua posição estabelecida a uma determinada dis‑
tância do eixo local selecionado pelo projetista.

Figura 1.9 – �Ilustração da tela referente à criação de um Construction Frame com a opção 
de parametrização de posição Centered between coordinates.

d)	 Located on a line

Nesta opção, o novo cf será posicionado sobre uma linha que será definida 
a partir de duas coordenadas fornecidas pelo projetista. Uma barra de rolagem 
permite que o projetista informe o quão próximo se quer que o novo cf se situe da 
primeira coordenada de referência (Coordinate Reference #1).

e)	 Location input communicator

O cf criado a partir dessa opção requer a definição de um Input Communi‑
cator (item 1.2.6). Recomenda‑se o uso dessa opção, quando se deseja parame‑
trizar um cf com relação a outro Template, ou seja, outro protótipo virtual. Cabe 
ressaltar que ao se montar o respectivo Assembly, os cf criados dessa forma se 
conectarão a Output Communicator de outro Template. Assim, a posição desse 
novo cf está condicionada à forma com que o Communicator foi criado.
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1.2.5.1.3.	Parametrização da orientação relacionada à construção de um cf

a)	 Delta orientation from coordinate

Nesta opção, o cf criado tem orientação condicionada a outro cf já existente. 
Assim, deve ser fornecida uma coordenada de orientação usando ângulos de Eu‑
ler. Tomando como referência o cf, a operação oferece uma rotação com relação 
aos eixos de referência local x, y, z de um cf.

A notar: Os ângulos de Euler foram propostos por Leonard Euler visando descrever 
a orientação de um corpo rígido em um espaço 3D. Para alterar a orientação de 
um dado corpo rígido, este deve ser submetido a uma sequência de três rotações 
descritas pelos ângulos de Euler. Isto equivale a submeter um corpo rígido a uma 
transformação do tipo rotação simultânea nas três direções, ou independente, ou 
seja, em etapas. Essas rotações ocorrem em relação a x, y ou z.

b)	 Parallel to axis

Esta modalidade de parametrização de orientação permite que um dos eixos 
do cf de referência seja selecionado para ficar paralelo a um dos eixos do novo cf 
definido pelo projetista.

c)	 Oriented in plane

Esta opção solicita três coordenadas ao projetista (Coordinate Reference #1, 
#2 e #3), além da definição de um plano zx ou yz. Se a opção selecionada for zx o 
novo cf terá seu eixo z (referencial local) situado ao longo de uma reta imaginária 
formada pela união das duas primeiras coordenadas; enquanto seu eixo x estará 
orientado de modo que o plano zx (referencial local) deste cf esteja contido no 
plano formado pelas três coordenadas, conforme a Figura 1.10.

Caso a opção selecionada seja o plano yz o eixo y do novo cf estará sobre a 
reta formada pelas duas primeiras coordenadas, contudo, dessa vez, o plano yz 
formado pelo referencial local do cf estará contido no plano formado pelas três 
coordenadas.

d)	 Oriented axis to point

Esta opção permite que o projetista oriente um de duas opções de eixos do 
cf construído, da seguinte forma: define‑se a coordenada para orientação, que no 
caso é um Hardpoint, e em seguida o eixo para orientação. No caso, pode ser o 
eixo z ou x do cf, conforme a Figura 1.11.
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Figura 1.10 – �Ilustração da tela referente à criação de um Construction Frame com a 
opção de parametrização de orientação Oriented in plane.

Figura 1.11 – �Ilustração da tela referente à criação de um Construction Frame com a 
opção de parametrização de orientação Orient axis to point.
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e)	 Orient to zpoint‑xpoint

Neste caso, o projetista tem a possibilidade de orientar o eixo z do novo cf 
na direção da primeira coordenada fornecida, enquanto o eixo x orienta‑se pela 
segunda coordenada.

A Figura 1.12 ilustra a tela dessa opção de parametrização de orientação e o 
resultado em uma janela auxiliar.

Figura 1.12 – �Ilustração da tela referente à criação de um Construction Frame com a 
opção de parametrização de orientação Orient to zpoint‑xpoint.

1.2.5.2.	 Construindo partes no ADAMS/Car

Ao começar a construção de um Template, o projetista deve decidir pelos 
elementos mais apropriados para a criação do protótipo virtual; isto inclui a geo‑
metria que irá representar uma parte, ou seja, sua topologia/forma.

As entidades disponíveis no ADAMS/Car são: Rigid Bodies, Geometry, At‑
tachments, Springs, Dampers, Communicators, Bumpstops e Reboundstops, além 
de, finalmente, os Suspension Parameter Array (parâmetros de uma suspensão). 
Os dois últimos serão oportunamente explicados no Capítulo 4.

1.2.5.2.1.	 Parts e Rigid bodies (corpos rígidos)

As partes ou Parts no ADAMS/Car são constituídas por General Part, Flexi‑
ble Bodies, Non Linear Beam, Mount e Switch.
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A notar: Os Mounts são definidos como partes sem massa que funcionam como uma 
espécie de pseudônimo para outras partes em Templates distintos. Seu uso se justifica 
como uma forma de substituir (clonar) uma parte real necessária para a criação de 
juntas (Joints), molas (Spring), contatos (Contacts) e outras. Normalmente, é fixado 
por default no solo (Ground).
Durante o processo de formação de um Assembly, os Mounts existentes em um dado 
Subsystem buscam seus correspondentes em outro Subsystem, que normalmente são 
os Output Communicator (item 1.2.5.3). Sua criação passa pela tela ilustrada a seguir. 

As informações demandadas são o nome do Mount (Mount name), a coordenada 
de referência (Coordenate Reference), onde esse nome será inserido e, informações 
denominadas from Minor Role que podem ser do tipo inherit, any, front, rear e trailer.
Esta última aba define a posição do Mount no assembly. Assim, se a opção any é 
selecionada na criação deste, no Assembly o ADAMS/Car poderá conectar este Mount 
em qualquer outro Subsystem ativo por meio da identificação de Communicator (item 
1.2.5.3). A opção inheret permite que o Mount herde o Minor Role do Subsystem ao 
qual ele está se unindo. As opções front e rear são indicadas quando se quer estabelecer 
papéis (roles) específicos para os mounts que estão sendo criados.

Um corpo rígido no ADAMS/Car não sofre deformações; possui proprie‑
dades de massa, inércia, posição inicial definida pelo projetista, orientação e é 
chamado General Part.

É criado por um usuário expert no ambiente Template Builder, assim, no 
menu principal, deve‑se selecionar a opção Build → Parts → General Part → New. 
Nessa operação, a tela que será exibida encontra‑se na Figura 1.13.

Repare que a tela pode ser dividida em quatro áreas. A primeira identifica o 
General Part e dá ao projetista a possibilidade de escolhê‑lo como left, right ou 
single. Os dois primeiros, quando escolhidos, geram entes simétricos, assim, uma 
vez que se cria um General Part à esquerda, automaticamente o da direita é criado 
e vice‑versa; já o terceiro cria uma General Part sem simetria, portanto único na 
coordenada especificada.

A segunda e a terceira áreas seguem o padrão explicado em 1.2.5.1.1 e 
1.2.5.1.2, respectivamente, só que ligado à construção de uma General Part. A 
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quarta área permite ao projetista definir massa, inércia, densidade do material e 
tipo do material.

1.2.5.2.2.	Geometry (geometria)

Uma geometria criada no ADAMS/Car permite a definição de comprimento, 
raio, largura e espessura tendo como função, apenas, realçar a visualização de 
uma parte. Na verdade, ela não é necessária para que se faça uma simulação, a 
parte sim é essencial nesse processo.

As geometrias disponíveis no ADAMS/Car são Arm, Link, Cylinder, Ellip‑
soid e Outline. O menu de acesso a essa opção é Build → Geometry → uma das 
opções desejadas. Lembrando que esse menu só é acessível no ambiente Template 
Builder.

Na construção de um Arm, Link e um Outline pede‑se o General Part asso‑
ciado, já para o Cylinder solicita‑se o General Part e o Construction Frame asso‑
ciados. Para o Ellipsoid, apenas uma coordenada de referência.

Figura 1.13 – �Tela de exibição 
referente à criação de 
uma general part.
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1.2.5.2.3.	Attachments – Joints and Bushings (juntas e buchas)

Estes elementos são aplicados ao modelo virtual a fim de estabelecer como 
uma parte reage/interage com relação à outra. O acesso se dá pelo menu principal 
do ambiente Template Builder, ou seja, Build → Attachments → Joint ou Bushing.

Ao criar uma junta, pedem‑se os pontos de fixação entre as partes que intera‑
girão; o tipo (Type), se a junta será criada à direita (right), à esquerda (left) ou de 
forma não simétrica (single); o tipo de junta (Joint Type); a aba Active, na qual se 
podem selecionar as opções always ou kinematic mode, além das áreas de posição 
e orientação similares ao indicado nos itens 1.2.5.1.2 e 1.2.5.1.3. 

A aba Joint Type permite a escolha da junta de acordo com a natureza da 
mobilidade que se quer proporcionar ao modelo virtual. Os tipos disponíveis no 

Figura 1.14 – Tela ilustrativa sobre a inserção de juntas.
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ADAMS/Car, levando em consideração o número e a natureza de graus de liber‑
dade (gl), são mostrados na Tabela 1.1.

A aba Active oferece duas opções de funcionamento. Quando se opta pela 
opção kinematic mode, a interferência da junta no modelo se restringe à análise 
cinemática; enquanto, a opção always terá efeito nas análises cinemática e dinâ‑
mica. 

A tela de inserção de uma bucha no ADAMS/Car está ilustrada na Figura 
1.15. As áreas de posição e orientação permanecem as mesmas mostradas na Fi‑
gura 1.14. Para sua inserção, pedem‑se os pontos de fixação entre as partes que 
interagirão; o tipo (Type), se a bucha for criada à direita (right), à esquerda (left) 
ou de forma não simétrica (single); a aba inactive onde se podem selecionar as 
opções never ou kinematic mode, além das abas que definem características de 
carregamento e geometria.

Figura 1.15 – Tela 
ilustrativa sobre a inserção 
de buchas.
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Na construção de um protótipo virtual, o projetista pode prever, entre duas 
partes selecionadas, juntas e buchas, no mesmo ponto de conexão. Assim, am‑
bas poderão funcionar, bastando selecionar, coerentemente, as opções disponíveis 
nos campos active para juntas e inactive para buchas. Em geral, a alternância de 
funcionamento depende de ativar‑se uma, enquanto a outra se encontra inativa. 
Assim, pode‑se simular cinematicamente e dinamicamente o mesmo modelo. En‑
tretanto, reforça‑se que a troca entre junta‑bucha em um mesmo modelo só ocor‑
re, se a junta e a bucha foram definidas: ativa e inativa, respectivamente, quando 
são inseridas no mesmo ponto do modelo.

Normalmente, as juntas são úteis na avaliação do comportamento cinemá‑
tico do modelo virtual, tornando‑se inativas nas análises dinâmicas na presença 
de buchas. A seguir são mostrados os efeitos das modelagens de buchas e juntas 
inseridas ou não em um mesmo local do modelo.

Junta Bucha Efeito

Active  → Kinematic 
model

Inactive  → Kinematic 
model

Uma junta e uma bucha confi‑
guradas desta forma entre duas 

partes indicam ao ADAMS/
Car, que durante a análise ci‑

nemática a bucha estará inativa 
e a junta ativada. Enquanto 
em uma análise dinâmica o 

ADAMS/Car deverá substituir a 
junta pela bucha.

Active → always

Esta configuração define que 
a junta criada estará sempre 

ativa nas análises cinemática e 
dinâmica.

Inactive  → never

Esta configuração define que 
a bucha criada estará sempre 
ativa nas análises cinemática e 

dinâmica.
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Tabela 1.1 – Opções de juntas disponíveis no ADAMS/Car

Tipo de junta Número de gl’s disponíveis Movimento entre as partes

Translational Um
Movimento de translação de uma parte em 

relação à outra. Os eixos das partes se 
mantêm paralelos.

Revolute Um Rotação de uma parte em relação à outra 
ao longo de um eixo comum

Cylindrical Dois Translação e rotação de uma parte em 
relação à outra

Spherical Três
Três rotações possíveis tendo secionados
pontos coincidentes em cada uma das 

partes

Planar Três
O plano x‑y de uma parte desliza em 

relação 
à outra nas três direções

Fixed Zero Sem movimento

Inline Quatro
Uma translação e três movimentos de 

rotação 
de uma parte em relação à outra

Inplane Cinco Duas translações e três rotações de uma
parte em relação à outra

Orientation Três

Bloqueia a posição de uma parte em 
relação 

à outra deixando os graus de liberdade, 
refrentes à translação, livres

Parallel_axes Quatro Permite as três translações e uma rotação 
de uma parte em relação à outra

Perpendicular Cinco Três translações e duas rotações

Convel Dois

Duas rotações de uma parte em relação à 
outra, tendo pontos coincidentes nas duas 
partes, e, ainda, mantendo constante a 

velocidade

Hooke Dois
Duas rotações de uma parte em relação à 
outra, tendo pontos coincidentes em partes 

distintas
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Figura 1.16 – Tela ilustrativa sobre a inserção de molas.

1.2.5.2.4.	Springs and Damper (molas e amortecedores)

A tela de criação de uma mola é a mostrada na Figura 1.16. Nela, pede‑se 
o nome a ser atribuído à mola; as partes I e J nas quais a mola irá agir/fixar; as 
coordenadas I e J que localizam pontos nas partes I e J. Esses pontos podem ser 
Hardpoint ou Construction Frame.

A aba Método de Instalação, Figura 1.16, discrimina três possibilidades Pre‑
load, Installed Length e Use Hardpoint. A primeira, que dá ao projetista a possibi‑
lidade de entrar o carregamento inicial a ser aplicado nas coordenadas dos pontos 
I e J, pode representar, por exemplo, o peso do veículo em cada uma das rodas. A 
segunda permite apenas que se considerem as coordenadas dos pontos I e J para 
o posicionamento da mola e, finalmente, a terceira possibilita a entrada do com‑
primento da mola, que é igual à distância entre as coordenadas dos pontos I e J.

Características geométricas da mola também podem ser definidas como o 
diâmetro da mola e o número de espiras (spring diameter e number of coils). Cabe 
ressaltar que a inserção de molas e amortecedores no ADAMS/Car equivale à de‑
finição de uma força. No ambiente Template Builder, escolha, no menu principal, 
Build → Force → Spring.

A aba Property File busca as propriedades da mola, segundo o que está dis‑
ponível na biblioteca ADAMS/Car. A Figura 1.17 ilustra um arquivo com dados 
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de uma mola. O primeiro bloco fornece informações sobre o tipo do “rótulo” 
considerado. O segundo bloco indica as unidades aplicáveis. O terceiro, o com‑
primento livre entre a 1ª e a última espira da mola, sem levar em conta as extre‑
midades da mola. No quarto bloco, constam os dados de deslocamento e força, 
da referida mola, ilustrados no gráfico ao lado.

Para a inserção de um amortecedor no ADAMS/Car a tela se assemelha a da 
mola, obviamente o Property File irá buscar, na biblioteca, informações relativas 
a esse elemento. No ambiente Template Builder, escolha no menu principal Build 
→ Force → Damper.

1.2.5.3.	 Communicators no ADAMS/Car

Essas variáveis são responsáveis pela troca de informações entre os dife‑
rentes subsistemas que compõem um Assembly, como também entre o Test Rig 

Figura 1.17 – Arquivo das características de mola no ADAMS/Car e seu gráfico.
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(item 1.2.3). Um Communicator pode receber um objeto; uma parte, no caso um 
Mount (item 1.2.5.2.1); uma variável; uma junta; coordenadas de posição ou até 
mesmo uma mola.

Ao construir um Assembly, normalmente, requerem‑se informações em duas 
vias. Neste sentido, os Communicators classificam‑se em Input e Output. O Com‑
municator Input solicita informações a outros subsistemas e ao Test Rig, por 
exemplo, enquanto o Communicator Output fornece informações para outros 
subsistemas e Test Rig.

As principais classes de Communicators são: Mount; Marker; Juntas; Bu‑
chas; ou seja, tudo o que é capaz de transferir informação. Um Communicator 
possui um Minor Role que abrange as seguintes opções front, rear, trailer, inherit 
e any; as funções são semelhantes ao mostrado em 1.2.5.2.1.

Para se criar um Communicator, o projetista deverá estar no ambiente Tem‑
plate Builder ir ao menu principal opção Build Communicator → Output ou 
Input. As telas de criação de um communicator são mostradas na Figura 1.18.

A aba Entity permite a escolha de diversos elementos que poderão receber este 
Communicator, a fim de viabilizar a construção do Assembly. Repare que na tela 
de criação de um Input communicator a aba Minor Role utiliza a preposição From, 
enquanto a de um Output ‘To’. Tais definições devem coincidir com o da entidade 
(Entity), que receberá o Communicator. A tela de um Output Communicator ainda 
requer os nomes de um Construction Frame e de uma Part.

Figura 1.18 – Telas de criação de communicators no ADAMS/Car

1.2.6.	 Nomenclatura de Elementos Construtivos segundo o ADAMS/Car

A convenção dos nomes dos elementos construtivos no ADAMS/Car segue 
uma nomenclatura própria. Normalmente, a convenção aparece por blocos de le‑
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tras separados por underline. No primeiro bloco, as duas primeiras letras de uma 
sequência de três se referem ao tipo de elemento e a última a posição com relação 
a um referencial, ou seja, r (right – direita); l (left – esquerda) e s (single – elemento 
sem simetria).

Ainda com relação ao primeiro bloco de letras, as duas primeiras identificam 
o tipo de elemento construído. Assim, no menu principal do ADAMS/Car na aba 
Build, exclusiva do usuário expert, encontram‑se os elementos que podem ser 
criados no ambiente. A Tabela 1.2, a seguir, ilustra alguns exemplos.

Tabela 1.2 – Exemplos de nomenclatura de elementos no ADAMS/Car

Nomenclatura ADAMS/Car Significado do primeiro bloco de letras

gel_arm General_Part_Left_ ….

hps_lcs_front Hard_Point_Single_ …

bkl_mount Bushing_Kinematic_Left_ …

nsr_main_spring Non‑linear_Spring_Right_ …

pvs_toe_angle ParameterVariable_Visible_Single_ …

1.2.7.	 Acessando o Help do ADAMS/Car

O acesso ao Help do ADAMS/Car é geral, cabendo ao usuário a seleção 
daquilo sobre o que se deseja informação. Há três formas de acessá‑lo pelo menu 
principal do módulo, e nesse caso, é indiferente se o usuário é padrão ou expert; 
pelo diretório em que o Help se encontra instalado, consultando‑se assim, os ar‑
quivos *.*.pdf disponíveis e, por último, pressionando a tecla F1, com o cursor 
sobre o que se tem dúvida.

Esta última forma de acesso ao Help é bastante útil, uma vez que, durante o 
processo de construção do protótipo, o usuário pode sanar dúvidas de preenchi‑
mento de abas, por exemplo, de maneira direta e eficaz.

Alguns links são disponibilizados em sites da própria MSC ADAMS, veja:
http://support.adams.com/kb
http://www.adams.com/mdi/news/dyndim/vol3_kbtour.htm
http://support.adams.com/support/ cnsltsrv.html
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http://support.adams.com/support/suppcent.html
http://support.adams.com/support/sla_agree.htm

1.2.8.	 Funcionalidades do ADAMS/Car

O ADAMS/Car permite o uso de algumas teclas facilitadoras, as quais são 
mostradas na Tabela 1.3 que se segue.

Tabela 1.3 – Descrição das teclas de função disponíveis no ADAMS/Car

Teclas Função da tecla

F1 Aciona o Help do software

F3 Abre uma janela de comando que pode ser editada

F4 Abre uma janela de coordenadas x,y,z que fornece infor‑
mações sobre qualquer ponto da tela

F8 Abre a janela do ADAMS/PostProcessor tanto para o 
usuário padrão quanto para o expert

F9 Permite alternância entre os ambientes Template Builder e 
Standard Interface – possível apenas para o usuário expert

Ctrl+Z Undo (desfaz um comando dado)

Ctrl+Shift+Z Redo (refaz um comando anulado)

Ctrl+X Delete (apaga um elemento selecionado)

Ctrl+D Deselect all (deseleciona algo selecionado para uma 
operação)

Esc Anula a realização de um comando

Algumas funcionalidades encontram‑se no próprio mouse, Figura 1.19. Por 
exemplo, ao apertar o botão direito do mouse sobre a tela do ADAMS/Car, desde 
que não seja sobre entidades do projeto que se está desenvolvendo, uma série de 
funções se tornam disponíveis, são elas: vistas do desenho (planas e isométricas); 
movimentação do desenho por translação ou rotação; visualização por Zoom, 
ajuste dinâmico do desenho em tela pelo fit; alteração da aparência de apresenta‑
ção do desenho por meio de Wireframe, Shaded e opção de omissão de partes do 
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desenho; geração ou não de grid e a opção de apresentar ou não a nomenclatura 
dos elementos construídos (Toogle Icon Visibility).

O usuário do ADAMS/Car pode acessar opções do tipo Pick, Browse, Guesses 
etc. ao pressionar o botão direito do mouse sobre campos a serem preenchidos nas 
caixas de diálogo do módulo. Essas opções fornecem ao usuário, às vezes, atalhos 
para construção do modelo. Oportunamente, essa funcionalidade será mostrada 
ao longo do desenvolvimento dos tutoriais.

1.3.	 Considerações gerais sobre o Módulo ADAMS/View

O módulo ADAMS/View destina‑se ao desenvolvimento, além de estudos 
estático, cinemático e dinâmico de modelos virtuais mecânicos, além de possibili‑
tar o refinamento destes, a partir de resultados de simulações do comportamento, 
obtidos por meio do ADAMS/Solver ou ADAMS/Postprocessor (item 1.4). A es‑
colha entre os dois ambientes depende do nível de processamento de dados que 
se deseja, assim, para análise e visualização mais avançadas é recomendado o 
ADAMS/Postprocessor.

Dessa forma, o presente tópico tem por objetivo apresentar ao leitor, de for‑
ma sucinta, o ambiente do módulo ADAMS/View. Para tanto, os itens que se se‑
guem irão apresentar o acesso e a interface do software; o processo de construção 
de Parts no ADAMS/View, a criação de corpos rígidos envolvendo geometrias de 

Figura 1.19 – �Funcionalidades do botão direito do mouse no ADAMS/Car. 
Fonte:c http://www.intersolucao.com.br/p/mouse‑wireless‑microsoft‑mobile‑1000
‑reto.html. Acesso: 22/04/2013
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construção e sólidos; a inserção de restrições; hierarquia na atribuição de nomes; 
como salvar modelos virtuais e as principais funcionalidades do ambiente.

1.3.1.	 O acesso a interface principal do ADAMS/View

A inicialização do módulo pode ser feita de duas maneiras. A primeira, pela 
área de trabalho (Desktop), onde um duplo clique com o botão esquerdo do mou‑
se sobre o ícone ativa o módulo. A segunda seria pelo menu Iniciar do Windows 
por meio do caminho “Todos os programas” → MSC.Software → MD Adams R3 
→ AView → .

Acionado o programa, a tela principal de abertura traz a área de trabalho, na 
qual se desenvolvem os modelos virtuais e, também, uma tela auxiliar, conforme 
ilustra a Figura 1.20.

Na primeira linha da tela se lê a seguinte questão How would you like to 
proceed? e, em seguida, dá ao usuário quatro alternativas: criar um novo modelo 
(Create a new model); abrir um modelo existente (Open an existing database); 
importar um arquivo (Import a file) ou sair do módulo (Exit).

A aba Start in dá ao usuário a possibilidade de especificar o diretório de 
trabalho. Assim todos os arquivos gerados na sessão serão armazenados neste 
local. Cabe ressaltar que ao escolher a opção “abrir um modelo existente”, esta 
aba servirá para especificar o diretório no qual o modelo será encontrado. A aba 
Model name requer o nome do modelo.

A aba Gravity permite ao usuário selecionar a forma como a aceleração da 
gravidade será considerada. A última aba permite a seleção do sistema de unidades 
que pode ser escolhido entre: MMKS (comprimento: mm, massa: kg, força: N), 
MKS (comprimento: m, massa: kg, força: N), CGS (comprimento: cm, massa: g, 
força: Dina) e IPS (comprimento: polegada, massa: slug, força: poundForce), além 
de outros sistemas de unidade disponíveis no software.

A interface final do ADAMS/View, após a configuração inicial mostrada na 
Figura 1.20, é a ilustrada na Figura 1.21.

No item 1.3.1.1, serão mostrados como a alterar os efeitos de cada uma das 
opções disponíveis para a aba Gravity, bem como a forma que o usuário deverá 
proceder para selecionar novas opções de unidade.

1.3.1.1.	  Alterando a opção Gravity e Units

Dentre as opções de alteração da aceleração da gravidade, três possibilidades 
se apresentam: Earth Normal, No Gravity e Other. A primeira seleciona a gravi‑
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Figura 1.20 – Tela de configuração inicial do ADAMS/View.

dade como sendo igual a 1G e direcionada para baixo. A segunda desativa a força 
gravitacional que atuará sobre o modelo.

A terceira, por sua vez, permite que o usuário escolha o valor de aceleração 
que deseja. Nesse momento, ao clicar OK na tela mostrada na Figura 1.20, uma 
tela auxiliar se abre, conforme Figura 1.22 e, o usuário poderá preenchê‑la com 
o valor desejado, além de escolher o eixo em que essa figura irá atuar. O sistema 
de coordenadas disponível se refere ao sistema de referência global, e o vetor que 

Figura 1.21 – �Tela principal de apresentação do ADAMS/View.
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representa a força gravitacional poderá estar no sentido positivo ou negativo de 
cada um dos eixos.

Outra maneira possível de se alterar esse valor é a partir do menu principal 
do ambiente de trabalho. Seleciona‑se a opção Settings → Gravity e a tela que apa‑
recerá será a mesma da Figura 1.22.

Para selecionar uma unidade de medida diferente das disponíveis na tela 
mostrada na Figura 1.20, o usuário deverá escolher, no menu principal, a opção 
Settings → Units, conforme aFigura 1.23.

Ao ativar a opção do sistema de medidas, que se encontra na parte inferior 
da janela mostrada na Figura 1.23, nos campos logo acima aparecem as unida‑
des padrão para cada uma das grandezas. Clicando sobre a seta lateral em cada 
campo, várias opções se apresentam para cada uma delas, então, cabe ao usuário 
selecionar o que deseja.

Figura 1.22 – �Tela de alteração da orientação e 
valor da aceleração da gravidade.

Figura 1.23 – �Tela de alteração da unidade 
a ser adotada no modelo.
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1.3.1.2.	 Menu Main Toolbox

No canto esquerdo da tela principal do ADAMS/View encontra‑se disponível 
o Main Toolbox, Figura 1.21. Nessa área, o usuário irá encontrar as principais 
opções de criação, edição, seleção e simulação que, normalmente, são utilizadas 
no módulo para o desenvolvimento de protótipos virtuais.

Essa área será dividida em quatro grupos, conforme mostra a Tabela 1.4, que 
apresentará, de forma sucinta, as opções disponíveis. Cabe ressaltar que, como no 
módulo ADAMS/Car, a tecla F1 permite ao usuário obter mais informações sobre 
funcionalidades do ambiente.

Alguns dos ícones deste menu trazem uma pequena seta na parte inferior à 
direita. Para ser acionada, o usuário deve clicar com o botão direito do mouse so‑
bre o ícone, o que dará acesso a novas opções. O usuário irá perceber que, ao pas‑
sar a seta do mouse sobre cada opção, aciona‑se uma identificação automática.

1.3.2.	 Construindo Parts no ADAMS/View

Nesse módulo, é possível identificar três tipos de partes (Parts): corpos rígi‑
dos (Rigid Bodies); corpos flexíveis (Flexible Bodies) e pontos de massa (Point 
Masses). Os corpos rígidos são partes que possuem massa e inércia, enquanto 
os corpos flexíveis, além de possuírem massa e inércia, podem se deformar sob a 
ação de um sistema de forças externo aplicado. Os pontos de massa são partes 
que possuem apenas massa. Este Guia abordará apenas, aspectos básicos de cria‑
ção de corpos rígidos.

A notar: Corpos rígidos, de acordo com a Mecânica, são constituídos por número 
infinito de partículas, ou pontos materiais, que não possuem movimento relativo uma 
em relação à outra, portanto não se deformam. Contudo, os corpos rígidos podem 
movimentar‑se uns em relação aos outros, o que permite o estudo da Cinemática 
dos Corpos Rígidos, na qual deslocamentos, velocidade e aceleração podem ser 
determinados.
Forças externas, assim como as internas, são reconhecidas como forças de interação. 
Forças de interação externas se estabelecem pelo contato físico direto entre corpos 
rígidos, normalmente forças de superfície são dadas em unidade de força por unidade 
de área.
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Tabela 1.4 – Descrição dos ícones do menu Main Toolbox

Subdivisão da tela Funções

1º Grupo

Este ícone, quando acionado, mostra ícones auxilia‑
res que permitem a inserção de geometrias sólidas 
(solid geometry); elementos de construção geométri‑
ca (construction geometry), ambos relacionadas à 
construção de corpos rígidos (item 1.3.2.1; elemen‑
tos booleanos (Booleans) e ferramentas de alteração 
de forma de corpos rígidos.

Este ícone possibilita o usuário escolher as juntas 
que serão responsáveis por garantir movimentos re‑
lativos entre partes, inclusive ground part. Este as‑
sunto será mais bem abordado no item 1.3.3.

Este ícone denomina‑se Interactive Simulation Con‑
trols e será abordado no item 1.3.4.

Ícone referente à opção Plotting que remete o usuá‑
rio ao ADAMS/PostProcessor MD ADAMS R3, mó‑
dulo que será tratado no item 1.4.

2º Grupo
Este grupo de ícones permite o controle de visualização da 
área de trabalho do módulo ADAMS/View. Na primeira 
linha, da esquerda para a direita, o primeiro ícone permite 
uma visualização ajustável a uma área ativa. O segundo, 
uma visualização dinâmica dentro de uma janela especifi‑
cada pelo usuário. O terceiro, um controle de visualização 
centralizado em um ponto especificado.
Na segunda linha, o primeiro ícone, da esquerda para a di‑
reita, dá ao usuário a possibilidade de realizar uma rotação 
dinâmica 3D, expandindo o menu; a outra opção permite 
apenas rotação no plano de visualização. 
O segundo ícone permite a translação dinâmica (mantendo 
ativo o botão esquerdo do mouse), enquanto o último ícone 
permite o zoom.
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Subdivisão da tela Funções

3º Grupo
A primeira linha deste grupo de ícones permite visualizar as 
vistas frontal/posterior; lateral direita/esquerda e superior/
inferior, respectivamente.
Na segunda linha, o primeiro ícone permite uma vista iso‑
métrica; o segundo estabelece que o plano a ser visualizado 
pelo usuário será coincidente com o plano ‘xy’ de um deter‑
minado objeto selecionado. O último ícone permite que o 
usuário escolha três pontos para formação de um plano de 
visualização.
Na última linha deste grupo, o primeiro ícone permite a es‑
colha da cor do fundo da tela. O segundo pode ser expan‑
dido apertando‑se o botão direito do mouse sobre a seta do 
ícone. Os ícones auxiliares permitem: a visualização ou não 
do sistema de coordenadas globais do ambiente; a abertura 
de uma janela auxiliar para leitura das coordenadas na tela 
percorridas pelo mouse e uma janela ativa para rotação da 
área de trabalho no plano de visualização. O terceiro ícone 
permite a partição da tela em subtelas de acordo com a 
escolha do usuário.

4º Grupo
Este grupo permite o acionamento do Grid (gradeamento da 
área de trabalho), Depth, Renderização (mostra a geometria 
sólida) e ativação/desativação de Icons.

Há uma peculiaridade no ADAMS/View que é a criação automática de uma 
parte, denominada ground part, no momento em que o usuário cria um modelo 
virtual. Essa parte não possui massa nem inércia e está sempre em repouso não 
havendo possibilidade de atribuir características cinemáticas a ela.
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A notar: O ground part define o referencial global ou sistema de coordenadas global 
da interface de trabalho, sendo que é a partir dele que os modelos virtuais são criados 
e são posicionados. O estudo cinemático de um modelo terá como referencial inercial 
o ground part por default. Normalmente, o que se faz é criar referenciais inerciais 
auxiliares, mas a atribuição de referencial inercial principal dada ao ground part não 
pode ser alterada pelo usuário.
Ao criar novas partes no ADAMS/View, há sempre um sistema de coordenadas local 
criado automaticamente, que permite definir seu posicionamento relativamente ao 
referencial global. Quando se trata de um corpo rígido, normalmente o referencial 
local se localizará no seu centro de gravidade e durante a avaliação da cinemática 
desse corpo rígido todas as características serão obtidas a partir desse referencial. 

Para cada parte criada no ADAMS/View, atribuem‑se, automaticamente, va‑
lores de massa e inércia a partir da densidade e do volume da parte criada. Assim, 
para alterar ou visualizar características da geometria das massas, com o botão 
direito do mouse, clique sobre a parte e, em seguida, aparecerá a tela mostrada na 
Figura 1.24a. Selecione a opção Modify e a tela que se apresentará é a mostrada 
na Figura 1.24b.

Na Figura 1.24b, ao acionar a barra de rolagem da aba Category várias op‑
ções são mostradas: nome e posição (Name and Position), propriedades de mas‑
sa (Mass Properties), condições de posição inicial (Position Initial Conditions), 
condições de velocidade inicial (Velocity Initial Conditions) e ground part. Cada 
uma destas opções, quando acionada, atualiza a tela mostrada na Figura1.24a, de 
acordo com as informações necessárias, a serem fornecidas pelo usuário.

Com respeito à tela Modify Body (Figura1.24 b), uma das abas a ser preen‑
chida é Define Mass By, que apresenta as seguintes opções: entrada de dados por 
meio do usuário (User Input), geometria e densidade (Geometry and Density), 
geometria e tipo de material (Geometry and Material Type).

Na primeira opção, o usuário irá fornecer manualmente valores de massa, 
momento de inércia em torno dos eixos x, y e z, além de preencher as opções 
Center of Mass Marker e Inertia Reference Marker. Nestes campos, com o botão 
direito do mouse, o usuário poderá escolher o Marker que está associado ao cen‑
tro de massa e ao referencial inercial.

MSC_ADAMS_prova-4.indb   44 17/10/14   16:06



45Maria Alzira de Araújo Nunes e Rita de Cássia Silva

A notar: Define‑se momento de inércia de área como sendo a integral do produto 
de um elemento de área, dA, e o quadrado da distância desse elemento de área a um 
determinado eixo x ou y, no caso de geometrias planas.
Matematicamente, o momento de inércia de área assemelha‑se ao momento de inércia 
de massa, porém o significado físico é distinto. Enquanto o primeiro dá uma idéia da 
rigidez da peça, o segundo se refere à distribuição da massa de um corpo em torno de 
um eixo de rotação.
Os momentos de inércia de áreas planas são dados por:
I y dAxx

A

2∫=
  

I x dAyy
A

2∫=

Os momentos de inércia de massa são dados por:

I m y zxx
2 2∑ ( )= +

   
I m x zyy

2 2∑ ( )= +
  

I m x yzz
2 2∑ ( )= +

Centro de massa de um corpo é o ponto no qual toda a massa do corpo está 
concentrada. O centro de gravidade nasce a partir do momento em que o corpo está 
sob a influência de um campo gravitacional uniforme.

Figura 1.24 – �Tela de modificação e 
visualização de propriedades 
de massa de uma parte:

(a) �abas de acesso com opções aplicáveis a 
parte selecionada Part:PART_2; 

 b) opção Modify.
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A opção Geometry and Density deixa o usuário entrar com o valor de densi‑
dade do material. No canto inferior direito dessa tela, há a opção Show calculated 
inertia. Após escolher o valor da densidade do material, apertando Apply, os valo‑
res de massa e inércia aparecem para conferência por parte do usuário.

A última opção Geometry and Material Type permite que o usuário selecione 
o material que deseja, com o botão direito do mouse sobre a aba tipo de material 
(Material Type). Para tanto, aparecerá um menu auxiliar, no qual o usuário deverá 
escolher Material → Browse e, assim se abre uma tela que o permite escolher o 
material. Conforme a escolha, os campos densidade (Density), módulo de Elas‑
ticidade (Young’s Modulus) e coeficiente de Poisson (Poisson’s Ratio) serão atu‑
alizados. A opção Show calculated inertia mostra os valores de massa e inércias 
atualizados.

1.3.2.1.	 Criação de corpos rígidos no ADAMS/View

No ADAMS/View, existem dois tipos de geometria que podem ser aplicadas 
na criação de corpos rígidos, são elas: geometrias de construção (construction 
geometry) e a geometria sólida (solid geometry), como mostrado na Tabela 1.4. A 
primeira abrange geometrias que não possuem massa como, por exemplo, pontos 
(points), markers, linhas (lines), arcos (arcs) e splines.

A geometria sólida pode ser construída a partir da pré‑definição de corpos 
rígidos como: links, cubos (box), cilindros (cylinder), esferas (spheres), tronco de 
cone (frustum), toróide (torus), sólido de revolução (revolution), placas (plate), 
planos (plane).

A criação de corpos rígidos exige a criação de geometrias, que podem tanto 
ser associadas a geometrias existentes como ao ground part. Esta escolha depende 
do usuário, que deve ter em mente a relação entre as geometrias e destas com o 
ground part, ou seja, a configuração do modelo e a cinemática do movimento 
(graus de liberdade e restrições internas ou externas).
O posicionamento das geometrias de corpo rígido pode ser estabelecido grafi‑
camente na tela de trabalho; neste caso ter a opção Grid ligada é bastante útil 
(Tabela 1.4); como também fornecer as coordenadas de posição, relativamente ao 
referencial global. Os pontos e os markers podem ser utilizados para dar o posi‑
cionamento de novas geometrias e permitir a parametrização entre elas.
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A notar: Dentro da categoria das geometrias de construção, o ponto é um elemento 
que define uma posição qualquer em 3D. Ele permite que se estabeleça uma 
parametrização ou interdependência entre as geometrias/elementos envolvidos. Isto 
implica que ao parametrizar uma geometria qualquer a um ponto, mudar este ponto 
de local acarreta a mudança automática da geometria a ele ligada.
Um ponto também pode ser criado no local onde se colocam as juntas de conexão 
entre as geometrias de um modelo, neste caso, a parametrização provoca a alteração de 
posição do elemento de ligação a cada mudança de posição do ponto. Cabe ressaltar 
que não se parametriza a orientação do elemento por meio de um ponto e nem, a 
posição do centro de gravidade de uma geometria. 
Para criar um ponto, recorra ao menu MainToolbox (item 1.3.1.2) → ícone da 1ª 
linha/2ªcoluna (botão direito do mouse para expandir opções) → ícone mostrado 
a seguir. Nesse momento, será solicitado ao usuário que indique se o ponto será 
adicionado ao solo (Add to ground) ou a uma parte (Add to part), assim como se ele 
deve ser parametrizado ou não, conforme ilustra figura a seguir. A aba Point Table 
abre o editor de tabelas para edição de informações referentes ao ponto.

Um marker define um sistema de coordenadas local em uma parte (corpo rígido, 
flexível ou ponto de massa) ou em um ground part. O marker, ao contrário do 
ponto, tem uma orientação e é, automaticamente, criado no centro de gravidade das 
geometrias sólidas e nos pontos onde juntas são inseridas.
Para criar um marker se pode utilizar o menu Main Toolbox → ícone da 1ª linha/2ªcoluna 
(botão direito do mouse para expandir opções) → ícone mostrado a seguir. A orientação 
do marker pode estar atrelada ao sistema de coordenadas global em um dos planos 
XY, XZ ou YZ, ao sistema de coordenada da vista; ao sistema de eixos definido pelo 
usuário (X,Y axis; X,Z axis; Y,X axis etc.) ou a um único eixo (X‑axis, Y‑axis, Z‑axis).
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a)	 Criando linhas (lines/polylines), arcos (arcs) e splines

O ícone de criação de linha(s) se refere ao Polyline no menu Main Toolbox 
(item 1.3.1.2). Quando acionado, solicita‑se ao usuário que escolha um ponto 
onde a linha deve iniciar em seguida novos pontos são solicitados ao usuário, que 
com o botão esquerdo do mouse deve escolhê‑los. O botão direito do mouse cria 
as linhas que passarão pelos diversos pontos, e finaliza o comando.

A interação do comando com o usuário aparece na parte inferior, canto es‑
querdo da tela. A Figura 1.25 ilustra a aba de criação de um Polyline juntamente 
com as telas das abas expandidas.

Figura 1.25 – Criação de um Polyline:
(a) tela referente ao comando no Main Toolbox;
(b) aba de especificação da posição do Polyline;
(c) aba de escolha de criação de uma linha ou de um Polyline;
(d) aba de escolha do comprimento;
(e) aba de escolha do ângulo e opção de fechamento.

(a) (b) (c) (d) (e)
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O comando permite a criação da geometria atrelada a uma parte ou ao 
ground part (Figura 1.25b). Em Figura 1.25c, há a possibilidade de se criar uma 
única linha ou Polyline. As Figuras 1.25d e 1.25e permitem que se estabeleçam 
comprimentos e ângulos para essas linhas. Quando se tratar de um Polyline, o 
usuário poderá decidir pelo fechamento ou não dessas linhas, selecionando a op‑
ção Closed, na Figura 1.25e.

Para a criação de um arco, o usuário deve recorre à opção Arc, no menu 
Main Toolbox, conforme a Figura 1.26a e Tabela 1.4. Na Figura 1.26b tem‑se a 
possibilidade de criar uma nova parte ou de adicionar essa geometria a uma parte 
ou ao ground part. Na Figura 1.26c e d, escolhem‑se o raio, ângulo de início e fim 
do arco, além de se poder decidir pela criação de um círculo, selecionando a opção 
circle. Neste caso, as opções referentes aos ângulos de início e fim são desativadas.

Figura 1.26 – Criação de um Arco: 
(a) tela referente ao comando no Main Toolbox;
(b) aba de especificação da posição do arco;
(c) aba de escolha do tamanho do raio;
(d) �aba de escolha dos ângulos de início, fim e de formação de um 

círculo.

(a) (b) (c) (d)

Para a criação de um Spline, primeiramente o usuário deve escolher se ele 
será adicionado a uma parte ou se no ground part. Em seguida, o usuário deve se‑
lecionar se o Spline será criado pela escolha de pontos, Figura 1.27c, ou por uma 
curva Figura 1.27d. Neste caso, o usuário deve especificar a curva que receberá o 
Spline. A aba Spread Points, se selecionada, distribuirá o Spline sobre a curva no 
número de pontos especificado logo abaixo.

b)	 Criando geometrias sólidas

Este item apresentará aspectos gerais de algumas geometrias sólidas que po‑
dem ser criadas no ADAMS/View, citadas no item 1.3.2.1. Neste contexto, segue 
a descrição sucinta de criação dessas geometrias.
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b.1) link

Para criá‑los recorra ao menu Main Toolbox → 1º grupo de ícones da Tabela 
1.4 → 

	
  
 Rigid body: link. 

Na área de trabalho, escolha o ponto inicial para sua construção. Essa es‑
colha pode ser feita aleatoriamente, ou por meio de coordenadas, se o usuário, 
durante o comando, acionar o botão direito do mouse.

Essa operação abre uma janela auxiliar de coordenadas, conforme a Figura 
1.28a. A barra de rolagem dá as seguintes opções: relativamente ao Grid (Relative 
to Grid), relativamente à origem (Relative to Origin) e relativamente ao objeto 
(Relative to Object). Essa janela pode ser utilizada tanto para a definição do pon‑
to de origem quanto para a extremidade do link.

Por default, ao criar qualquer geometria sólida, o ADAMS/View considera 
como uma nova parte (New Part).

Por default, a geometria terá largura equivalente a 10% do comprimento e 
espessura de 5% desse valor, conforme a Figura 1.28b. Os raios das extremidades 
terão valor igual à metade do valor da largura. Verifica‑se, na Figura 1.28b, que a 
geometria proposta vem acompanhada de três markers, um em cada extremidade 
e outro no centro de gravidade do elemento.

Nota‑se, ainda, que os dois markers das extremidades, pela regra da mão 
direita, possuem o eixo z perpendicular ao plano da peça, enquanto o do centro 
de gravidade encontra‑se no eixo da peça.

(b) representação de um link.

Figura 1.28 – �Criação de um link: 
(a) �tela auxiliar para entrada de coorde‑

nadas para criaçãode geometrias sólidas; 
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A notar: Pontos quaisquer em um espaço tridimensional podem ser colocados 
em correspondência bijetora com números reais, usando três retas coordenadas 
perpendiculares denominados eixo x, eixo y e eixo z. Estes eixos são colocados de 
tal forma que suas origens coincidam em um ponto denominado origem do sistema. 
Os três eixos coordenados formam um sistema de coordenadas retangulares ou 
cartesianas.
Este sistema de coordenadas tridimensional se divide em duas categorias: sistemas 
com a regra da mão direita e sistemas com a regra da mão esquerda.
Um sistema com a regra da mão direita tem a seguinte propriedade, posicionando o 
pulso da mão direita sobre a origem do sistema; em seguida colocando os dedos na 
direção do eixo x e os curvando (fechando) na direção do eixo y; tem‑se que o polegar 
fornece o sentido positivo do eixo z. Cabe ressaltar que a operação envolvendo os 
eixos x e y está sempre no sentido positivo desses eixos.
Fonte: ANTON, H.A, BIVINS, I., DAVIS, S.Calculo, Vol.2,BookmanCompanhia 8ª 
Ed., 2007.
Sistemas com a regra da mão esquerda são construídos analogamente, contudo os 
eixos x e y têm posições trocadas no sistema.

b.2 – Box (caixa)

Para criá‑las recorra ao menu Main Toolbox → 1º grupo de ícones da Tabela 
1.4 → Rigid 

	
  
 body: Box. 

Trata‑se de uma caixa (Box) sólida ‘3D. Na área de trabalho, escolha a coor‑
denada inicial do sólido da mesma forma que a mostrada no item b.1. A geome‑
tria gerada tem comprimento, profundidade e altura. Por default, a profundidade 
corresponde a duas vezes a menor dimensão da caixa, ou seja, comprimento ou 
altura, conforme a Figura 1.29a.

Para alterar dimensões da geometria, clique sobre ela com o botão direito do 
mouse sobre a opção Block:Box, em seguida Modify. A tela auxiliar que aparece‑
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rá permitirá que se modifique os comprimentos (x, y, z) da caixa, de acordo com 
sua orientação relativamente ao referencial global, conforme Figura 1.29b.

Note que a aba Corner Marker indica o nome do marker (MARKER_1) em 
um dos vértices da caixa, o qual é paralelo ao sistema de referência global. A aba 
Diag Corner Coords fornece as dimensões da geometria, de acordo com o siste‑
ma de referência localizado no vértice, ou seja, 200 mm ao longo de x; 150mm 
ao longo de y e 300 mm ao longo de z. Este exemplo mostra que a geometria foi 
construída no plano xy com dimensões acima especificadas.

b.3) Plate (placa)

Para criá‑las recorra ao menu Main Toolbox → 1º grupo de ícones da Tabela 
1.4 → Rigid 

	
  
 body: Plate. 

Uma placa (Plate) é formada a partir de um polígono triangular que ganha 
uma espessura (sólido extrudado), além de ter os vértices arredondados. Os vértices 
são escolhidos a partir do botão esquerdo do mouse na área de trabalho, e a fina‑
lização do comando se faz pelo botão direito do mouse. Ressalta‑se que é possível 
fazer a escolha das coordenadas do ponto, conforme ilustrado na Figura 1.28a.

Cada vértice recebe um marker com orientação paralela ao sistema de refe‑
rência global x, y, z. O quarto marker se referee ao centro de gravidade da geome‑
tria. A modificação dessa geometria remete ao clique do botão direito do mouse 
sobre a geometria, opção Modify, gerando uma tela semelhante à mostrada em 
Figura 1.30b.

Figura 1.29 – �Criação de uma caixa:  
(a) figura representativa de 
uma Box criado no ADAMS/
View; 

(b) tela de modificação padrão para esta geometria.
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A aba Marker Name mostra o nome dos três markers situados nos vértices 
da geometria. A ordem se refere àquela escolhida em sua construção, sendo a 
primeira o marker de referência (reference marker). As abas Width e Radius se 
referem à espessura e ao raio do círculo dos vértices.

(b) �figura representativa de um Box criado no 
ADAMS/View.

Figura 1.30 – �Criação de uma placa Plate: 
(a) representação de um Box; 

Figura 1.31 – �Tela representativa da 
modificação de um plano.

b.4) Plane (plano)

Para criá‑los recorra ao menu Main Toolbox → 1º grupo de ícones Tabela 1.4 
→ Rigid 

	
  
 body: Plane 

O plano é uma geometria bidimensional que pode ser construída no plano da 
tela considerando o grid ou conforme mostra a Figura 1.28a. O marker de origem 
da geometria é criado no primeiro ponto selecionado para formar a geometria.
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Ao ser criado, uma mensagem de Warning aparece em uma tela auxiliar: 
The resulting body is not a valid manifold solid. It does not have any mass. O 
conteúdo esclarece que a geometria criada não constituiu um sólido e, portanto, 
não tem massa.

Para modificá‑lo, procede‑se da mesma forma que a mostrada nos itens b.2 e 
b.3. A tela ilustrativa dessa situação é mostrada na Figura 1.31.

A Figura 1.31 mostra que se o usuário deseja alterar o nome da geometria, 
bastando, para isso, preencher o campo New Plane Name. A aba Ref Marker 
Name traz o marker que é tomado como referência para a criação da geometria.

Em seguida, os campos X Minimum e Y Minimum dão ao usuário a possibi‑
lidade de transladar as arestas que contêm o marker de um valor especificado por 
ele. As abas X Maximum e Y Maximum permitem transladar o tamanho das ares‑
tas opostas às que contêm o marker de origem. A Figura 1.32 ilustra essa situação.

Figura 1.32 – Possíveis alterações das dimensões de um plano.

b.5) Sphere (esfera)

Para criá‑las recorra ao menu Main Toolbox → 1º grupo de ícones da Tabela 
1.4 → Rigid body: 

	
  
 Sphere. 

A esfera é criada a partir de um sólido elipsoidal em que se consideram os 
raios iguais nas três direções x, y e z. O marker criado automaticamente, durante 
a geração da esfera, se situa no centro da geometria, coincidente com seu centro 
de gravidade.

As coordenadas de localização do centro podem ser estabelecidas no grid ou 
como mostra o item b.2. Durante a criação da geometria, o usuário pode infor‑
mar o valor de raio desejado.

A Figura 1.33 ilustra a tela de modificação, e esta se compõe conforme des‑
crito nos itens anteriores. 
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Figura 1.33 –  �Tela ilustrativa de mo‑
dificação da geometria 
sólida: Sphere.

As abas X Scale Factor, Y Scale Factor e Z Scale Factor permitem ao usuário 
trabalhar a geometria, ou seja, se os três fatores de escala forem distintos tem‑se 
um elipsóide; se dois deles forem iguais um elipsóide de revolução.

b.6) Cylinder (cilindro)

Para criá‑los recorra ao menu Main Toolbox → 1º grupo de ícones da Tabela 
1.4 → Rigid body: 

	
  
 Cylinder 

Ao selecionar esta opção, o usuário cria, na área de trabalho uma geometria, 
que em vista frontal (no plano da tela) se assemelha a um retângulo. Por default, o 
diâmetro desse cilindro corresponde a 25% do valor do comprimento de seu eixo. 
Ao selecionar a opção, o usuário pode fornecer o comprimento (length) e o raio 
(radius) que desejar. Dois markers se formam na geometria, um na extremidade 
onde o usuário iniciou a construção e outro no centro de gravidade.

Figura 1.34 – �Tela representativa da 
opção Modify aplicada à 
geometria sólida Cylinder.
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A aba Angle Extent, dependendo de como é preenchida, permite que o cilin‑
dro seja completo em 360º ou parcial conforme mostrado em Figura 1.34 (270º). 
Nesta situação, a geometria sólida não terá área de seção transversal plena.

As duas últimas abas Side Count For Body e Segment Count For Ends se 
referem às linhas auxiliares de construção da área correspondente a 2πrL (lateral) 
e de πr2 (seção transversal), respectivamente, Figura 1.35, onde r é o raio da seção 
e L comprimento do cilindro.

1.3.3.	 Restrições no ADAMS/View

As restrições ou vinculações internas, previstas entre as geometrias sólidas ou 
partes, podem ser definidas pelo usuário no módulo ADAMS/View. A Tabela 1.4 
(1º Grupo) mostra o ícone, que, expandido, traz as opções de restrições disponí‑
veis no módulo. Na Mecânica, essas restrições estabelecem a cinemática de uma 
parte em relação à outra em um modelo virtual. Em suma, as restrições restringem 
movimentos relativos entre partes e representam um vínculo idealizado.

A notar: De acordo com a Mecânica, os vínculos podem ser definidos como um 
elemento de ligação entre as partes de uma estrutura (elementos estruturais) ou entre a 
estrutura e o meio externo. Na primeira situação, são denominados vínculos internos, 
na segunda, externos. A finalidade destes é restringir um ou mais graus de liberdade 
do corpo rígido.

Figura 1.35 – �Diferença na construção de um cilindro variando opções 
Side Count For Body e Segment Count For Ends.
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Cabe ressaltar que um único vínculo não será responsável por restringir todos os graus 
de liberdade do modelo, mas sim o conjunto deles. Além disto, há que se considerar 
sua classificação definida em função do número de graus de liberdade que restringe. 
Outro aspecto é que, nesse conjunto, sua disposição no modelo também é responsável 
pelo sucesso da imobilidade ou mobilidade que se deseja dar ao modelo.
Os vínculos podem ser inseridos em estruturas nos planos 2D e 3D e suas classificações 
dependem do plano em que estão. Quando no plano 2D, os vínculos se classificam em 
vínculo simples ou de 1º gênero, duplo/fixo ou de 2º gênero e engaste ou 3º gênero. 
No plano 3D, surgem as nuances vínculos cilíndrico e esférico.
O número total de graus de liberdade de um sistema de corpos se refere ao número de 
movimentos possíveis e independentes de cada parte desse sistema, como um corpo livre. 
O número de graus de liberdade, após a colocação de vínculos, depende do número de 
restrições efetivas previstas, que verdadeiramente eliminem graus de liberdade.
No ADAMS/View, corpos rígidos incluem a geometria sólida tratada no item 1.3.2.1 
letra b. Nesse contexto, as restrições aqui tratadas se aplicarão na união desses 
elementos para compor um modelo, bem como desse modelo com o ground part, que 
representaria o meio externo.

No ADAMS/View, existem quatro categorias de restrições juntas idealizadas 
(idealized joints); juntas primitivas (primitives joints), geradores de movimento 
(motions generators) e higher‑pair constraints. Neste guia, serão abordadas ape‑
nas algumas juntas idealizadas. No entanto, ao longo do desenvolvimentos dos 
tutoriais nos capítulos subsequentes, caso essas juntas sejam aplicáveis, elas serão 
tratadas nos quadros A notar.

A convenção adotada pelo ADAMS/View para estabelecer um movimento 
relativo entre partes é a seguinte: quando se cria uma junta, a primeira parte que 
se seleciona é a que se movimentará relativamente à segunda. Portanto, o usuário 
deve atentar a essa operação para que a sequência de movimentação seja a dese‑
jada por ele.

Nos locais onde as juntas são colocadas, há sempre a presença de forças 
de reação, segundo o ADAMS/View. As juntas que não são completamente fixas 
permitem alguns movimentos, nesse caso as forças de reação, que surgem em de‑
corrência de movimentos restritos, variam em função do local de aplicação.
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A notar: As forças de reação refletem a reação (resposta) do corpo rígido a um sistema 
de forças aplicado. Assim ao se restringir um movimento, a ação de forças naquela 
direção ou sentido, segundo um sistema de referência, irá gerar uma reação.
Isto se mostra completamente em sintonia com a 3ª Lei de Newton estendida a corpos 
rígidos, que considera que a cada ação corresponde uma reação de mesmo módulo, 
direção e sentidos opostos, no caso: F F 0AB BA+ =  e M M 0AB BA

0 0+ = .

Para acessar no ADAMS/View os elementos de ligação (juntas) há dois ca‑
minhos a seguir pelo menu principal  acessar Build → Joints. Por meio do menu 
Main Toolbox, ícone referente à junta revoluta, que é o ícone padrão do menu de 
juntas. 

Apertando o botão direito do mouse sobre o ícone, este se expande. Das 
opções que surgem a denominada Joint: Pallete  é a mais completa e traz todas 
as juntas do ADAMS/View divididas em categorias, conforme já comentado aqui. 
A Figura 1.36 ilustra a referida janela. Note que as últimas abas mostram as in‑
formações construtivas necessárias para a inserção da referida junta no modelo 
virtual.

Figura 1.36 – �Figura ilustrativa das juntas 
disponíveis no ADAMS/View.
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1.3.3.1.	 Idealized joints (juntas idealizadas)

Essas juntas fornecem uma simbologia que traduz um modelo ou uma gama 
de movimentos (graus de liberdade), que permitem ao usuário simular e, portan‑
to, avaliar a cinemática/dinâmica multicorpos. Segundo o módulo ADAMS/View, 
elas podem ser simples ou complexas. 

Quanto às juntas idealizadas citam‑se: revoluta (revolute); de translação 
(translational), cilíndrica (cylindrical), esférica (spherical), planar; velocidade 
constante (Constant‑Velocity); parafuso (screw), fixa (fixed) e Hooke/Universal. 
A complexa é: Couplers. Neste guia, apenas algumas juntas idealizadas simples 
serão abordadas.

a)	 Revolute joint (junta revoluta)
Essa junta permite a rotação de uma parte em relação à outra. A rotação 

se dá em torno de um eixo comum a ambas as partes e que possui uma dada 
orientação. A Figura 1.37 ilustra a inserção de uma junta revoluta entre dois links 
e as janelas que o usuário precisa preencher para que ela forneça a cinemática/
dinâmica necessária.

Figura 1.37 – �Telas ilustrativas de uma junta revoluta (a) representação no ADAMS/View (vista 
isométrica) (b) informações necessárias para criação.
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A primeira aba, mostrada na Figura 1.37b, quando expandida, fornece três 
opções: 1 Location (1 posição); 2 Bodies – 1 Location (dois corpos – uma posi‑
ção) e 2 Bodies – 2 Locations (dois corpos – duas posições).

Na primeira opção, o usuário escolhe o local onde a junta deverá ser inserida 
e o ADAMS/View automaticamente escolhe as partes que serão unidas por essa 
junta. Contudo, a escolha se dá por geometrias próximas à junta, e mais, se há 
apenas uma, a outra será por default o ground part.

Nesse caso, as abas First (primeira) e Second (segunda) mostradas na Figura 
1.37 desaparecem e resta apenas a de orientação da junta que pode ser Normal to 
Grid (normal ao grid) ou Pick Geometry Feature (escolha uma forma geométri‑
ca). Quando a escolha for normal ao grid, a junta será perpendicular a ele (Figura 
1.37a); caso a outra opção seja selecionada; a junta será orientada segundo uma 
direção dada por uma face de uma parte, por exemplo.

Repare que, nessa situação, um primeiro clique com o mouse permite esco‑
lher o ponto. Nesse caso, pode ser um marker automaticamente criado com as 
geometrias envolvidas, ou um marker inserido pelo usuário para o fim de inserir 
a junta. Feito isto, uma seta branca associada ao estabelecimento da direção dará 
ao usuário a possibilidade de escolher a direção que se quer.

A segunda opção, dois corpos – uma posição, permite que o usuário selecione 
duas partes a serem vinculadas, além da posição da junta. Nesse caso, a junta se 
fixa na primeira parte (First Body). Cabe lembrar que pelas abas First (primeira) 
e Second (segunda) a sequência de movimento será da primeira relativamente à 
segunda. Essas abas dão escolha de um corpo ou uma curva. Esse caso é mostrado 
na Figura 1.37b. O marker associado à referida junta tem o eixo z perpendicular 
ao plano.

A terceira opção permite que o usuário escolha dois corpos e duas posições. As 
duas posições permitem que o usuário explicite a posição da junta nos dois corpos.

b)	 Translational joint (junta de translação)
Essa junta permite que uma parte translade em relação à outra, conforme 

estabelecido pelo usuário. Este também fornece a direção em que esse movimento 
deverá ocorrer. Não há rotação, e as abas de construção são as mesmas mostradas 
em a). A Figura 1.38 ilustra a construção dessa junta considerando a opção de 
dois corpos – uma posição; escolha uma forma geométrica como orientação para 
a junta, no caso a face da primeira geometria sólida.
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Figura 1.38 – �Representação no 
ADAMS/View de uma 
junta de translação.

c)	 Spherical Joints (juntas esféricas)
Uma junta esférica permite três graus de liberdade, ou seja, três rotações em 

torno de um ponto comum às duas partes interligadas. A escolha do ponto de 
inserção da junta fornece indiretamente o ponto de pivotamento dessa junta. A 
Figura 1.39 traz a representação gráfica de uma junta esférica entre dois links.

d)	 Planar joint (junta planar)
A junta plana permite às partes por ela vinculadas três graus de liberdade, 

quais sejam, duas translações e uma rotação. A translação ocorre nas duas direções 
do plano xy e uma rotação em torno do eixo perpendicular a este plano, conforme 
a regra da mão direita, no caso da Figura 1.40 o eixo x. As translações também 

Figura 1.39 – �Representação no ADAMS/View 
de uma junta de esférica.
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podem ocorrer de forma aleatória sendo que, nessa situação, configura‑se um 
escorregamento relativo entre as partes. A Figura 1.40 ilustra uma junta planar.

Figura 1.40 – �Representação no 
ADAMS/View de uma 
junta planar.

e)	 Fixed joint (junta fixa)
Essa junta não permite o movimento relativo entre duas partes, ou seja, não 

há translações nem rotações, seu efeito é de um engaste em 3D. Normalmente, é 
aplicada entre uma geometria sólida e o ground part.

A Figura 1.41 ilustra a fixação de um link ao ground part. Repare que a 
representação gráfica de um cadeado torna a junta bastante perceptível, de modo 
que, se o usuário desejar modificar as condições de restrição, ele facilmente iden‑
tificará a junta e poderá substituí‑la por outra.

Figura 1.41 – �Representação no ADAMS/View 
de uma junta fixa.
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f)	 Hooke/Universal joint (junta Hooke)
Este item aborda a junta Universal ou Hooke comumente chamada de cruze‑

ta. Esse tipo de junta permite que a rotação de um corpo rígido seja transferida a 
outro que também sofra rotação; como é o caso de eixos de transmissão de alguns 
veículos automotores. Nesses casos, as juntas transferem movimento rotacional 
entre dois eixos que se conectam e que podem sofrer flexão, em decorrência do 
movimento de uma suspensão, por exemplo. No ADAMS/View, para selecioná‑las 
têm‑se: um clique com o botão esquerdo do mouse sobre o ícone representativo 
da junta, na paleta, abre a junta Hooke, dois cliques abrem a junta Universal.

A notar: O eixo de transmissão veicular com cardan nas extremidades é um sistema 
de transmissão de torque cuja função é fornecer independência às forças motrizes. É 
composto por um tubo metálico suficientemente resistente que transmite potência da 
caixa de câmbio para o diferencial. Os cardans ou cruzetas presentes nas extremidades 
do eixo permitem que o ângulo deste varie, enquanto o eixo secundário da caixa de 
marchas e o pinhão de ataque do diferencial permanecem paralelos. A figura a seguir 
mostra uma junta Universal/Hooke.

1.3.3.2.	 Impondo movimentos em juntas de modelos virtuais

Dois tipos de movimentos podem ser atribuídos às geometrias sólidas: trans‑
lação e rotação.

Na translação, o ADAMS/View, em regra, permite que a primeira parte sele‑
cionada, na janela de criação de juntas (Figura 1.37b), se movimente ao longo de 
um dos eixos da segunda parte.

Fonte: Wikipedia. Disponível 
em:< http://pt.wikipedia.org/
wiki/Eixo_card%C3%A3>. 
Acesso em: 22/04/2013

MSC_ADAMS_prova-4.indb   63 17/10/14   16:06



64 MSC ADAMS: Guia Prático de Utilização

Já na rotação, o ADAMS/View permite a rotação da primeira parte selecio‑
nada no momento de criação da junta, em torno do eixo z da segunda. A regra da 
mão direita dá o sentido da rotação. Na definição desse movimento é necessário 
que o eixo z da primeira parte esteja alinhado com o eixo z da segunda, durante 
todo o movimento.

Ao definir o movimento de uma junta, uma velocidade constante, que pode 
ser estabelecida pelo usuário, é atribuída ao longo do tempo. Este valor é forneci‑
do pelo usuário e pode ser numérico, uma função, uma subrotina etc. Para impor 
esse movimento, proceda da seguinte forma:

‑ No menu Main Toolbox, escolha o ícone .
‑ Clique o botão direito do mouse sobre ele, a fim de ter acesso a novas opções.
‑ Selecione a opção no Joint:Pallete .
A tela que aparecerá é a mostrada na Figura 1.36. Escolha, então, um dos íco‑

nes  ou . O primeiro é denominado Translational Joint Motion (Applicable 
to Translational or Cylindrical Joint), ou seja, junta de movimento translacional 
(Aplicável em Juntas Translacionais ou Cilíndricas). O segundo é denominado 
Rotational Joint Motion (Applicable to Revolute or Cylindrical Joint), ou seja, 
Junta de movimento translacional (Aplicável em Juntas Revolutas ou Cilíndricas). 
As informações e campos de preenchimento de cada um dos movimentos são 
mostrados na Figura 1.41a e b.

O valor default de velocidade translacional é de 10 mm/s, enquanto a rota‑
cional é de 30º. Para especificar valores não numéricos, clique com o botão direito 
do mouse sobre a opção Trans. Speed ou Rot. Speed, e escolha a opção Parametri‑
ze. Movimente o cursor na direção da seta, ao final da opção, e ela expandirá, ofe‑
recendo novas opções. Selecione assim uma das opções: Create Design Variable; 
Reference Design Variable, Expression Builder e Unparametrize. A opção Expres‑

Figura 1.42 – �(a) informações acerca do movimento da junta translacional; 
(b) informações acerca do movimento da junta rotacional.

(a) (b)
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sion Builder mostra o ADAMS/View function builder. As opções citadas aqui não 
serão discutidas neste capítulo.

1.3.3.3.	 Modificando juntas de modelos virtuais

Para modificar algumas características atribuídas às juntas, o usuário pode 
proceder da seguinte maneira. Sobre a junta, clique com o botão direito do mouse, 
selecione o elemento Joint: JOINT_1 (após os dois pontos especifica‑se o nome do 
elemento, item 1.3.5); movimente o cursor em direção à seta situada ao final da 
opção e escolha a opção Modify.

A tela mostrada na Figura 1.43 irá aparecer, nela o usuário é capaz de alte‑
rar o nome da junta (Name), as partes envolvidas na sua definição (First Body, 
Second Body), o tipo de junta estabelecida entre duas partes (Type), local de im‑
posição de forças (Force Display), além de poder estabelecer movimentos (Impose 
Motion(s)…) e condições iniciais (Initial Conditions…).

Nas abas Type e Force Display, a barra de rolagem ao lado fornece ao usuá‑
rio outras opções.

Figura 1.43 – �Tela representativa da 
modificação de juntas.
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Figura 1.44 – �Tela de especificação de grande‑
zas a serem medidas em juntas.

1.3.3.4.	 Estabelecendo grandezas a serem medidas nas juntas

Este tópico apresenta ao usuário como ele deve proceder para escolher as 
grandezas a serem medidas em juntas. Sobre a junta, clique com o botão direito 
do mouse, selecione o elemento Joint: JOINT_1 (após os dois‑pontos, é especi‑
ficado o nome do elemento, item 1.3.5); movimente o cursor em direção à seta 
situada ao final da opção e escolha a opção Measure. A tela correspondente a essa 
opção é apresentada na Figura 1.44.

O campo Measure Name dá nome à medida que será efetuada no modelo. 
Nesse nome, são identificados o modelo, a junta e a medida propriamente dita. 
No caso em questão, o modelo se chama pendulo_fisico; o elemento em que será 
registrada a medida é uma junta identificada por JOINT_1 e após o nome atribu‑
ído à medida, no caso, MEA_1.

No campo Joint, aparecerá o nome da junta. No campo Characteristic, a bar‑
ra de rolagem permite que escolha uma força (Force), um torque; um deslocamen‑
to (Displacement); uma velocidade relativa (Relative Velocity); uma aceleração re‑
lativa (Relative Acceleration); uma velocidade angular relativa (Relative Angular 
Velocity) e uma aceleração angular relativa (Relative Angular Acceleration).

No campo Component, é escolhida a direção da componente das grande‑
zas vetoriais enumeradas aqui ou a magnitude da resultante vetorial (mag). No 
campo From/At, o usuário seleciona em qual dos markers, que definem as partes 
interligadas pela junta, se deseja efetuar a medida.
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Figura 1.45 – �Campos de caracteri‑
zação da simulação.

1.3.4.	 �Interactive Simulation Controls –  
área de simulação do ADAMS/View

Segundo a Tabela 1.4, o ícone  permite ao usuário definir parâmetros de 
simulação no modelo construído. Ao ser selecionado, na tela inferior do menu 
Main Toolbox aparecerão os campos mostrados na Figura 1.45.

As teclas ,  e  representam, respectivamente, Reset, Stop Simulation e 
Start ou Continue Simulation.

O campo Default, quando tem a barra de rolagem lateral acionada, forne‑
ce ao usuário outras três opções de simulação: dinâmica (Dynamic), cinemática 
(Kinematics) e estática (Static).

O campo End Time permite ao usuário definir um tempo final de simulação 
ou um tempo para sua duração (duration). Em ambas as possibilidades, o usuário 
deverá especificar o tempo em segundos. O campo Steps (passos) requer que o 
usuário que estabeleça os incrementos/passos ao longo do tempo de simulação. O 
campo logo abaixo permite que o usuário especifique esse valor.

Os ícones  e  permitem estabelecer um equilíbrio estático (Find static 
equilibrium) e repetir a última simulação (Replay last simulation), respectivamente.

1.3.5.	 Atribuição dos nomes de objetos no ADAMS/View

Dar nomes aos diversos elementos aplicados em um modelo virtual desenvol‑
vido no ADAMS/View exige que se siga uma determinada nomenclatura, a fim de 
se garantir uma identificação precisa do elemento a que se faz referência.

Em linhas gerais, segue‑se o seguinte model_name.part_name.geometry_
name ou .*.constructionpoints_name;.*.markers_name, neste caso, todos são 
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partes (parts). Observando os nomes atribuídos a um modelo, nota‑se a seguinte 
hierarquia:

.pendulo.ground → Trata‑se de uma parte (Ground part).

.pendulo.Link2 → Trata‑se de uma parte (Part de nome Par2).

.pendulo.Analysis_flags → Trata‑se de uma flag de análise (Adams_Analysis_
Flags).
.pendulo.upper_right_to_ground → Trata‑se de uma junta (Joint) chamada 
upper_right_to_ground.
.pendulo.MOT1 → Trata‑se de um movimento (Motion) chamado MOT1, 
estabelecido no ADAMS/View.
.pendulo.pendulo_script → Trata‑se de um script de simulação (Simulation_
Script) denominado pendulo_script.
Todos os nomes de objetos são seguidos pelo nome do modelo, ponto (.), 

nome do elemento.

1.3.6.	 Salvando um modelo virtual no ADAMS/View

As extensões de arquivo mais comuns para se salvar modelos virtuais no 
ADAMS/View são o (.*.bin) e o (.*.cmd). O primeiro se aplica aos arquivos de da‑
dos (database files) incluindo tudo o que está associado a uma sessão de trabalho 
no módulo, ou seja, o modelo propriamente dito, simulação, resultados, gráficos 
etc. Desta forma o arquivo fica muito grande, além de ser dependente da platafor‑
ma utilizada. A segunda extensão salvará os elementos (geometria de construção e 
sólida, juntas etc.) do modelo e seus atributos, isto porque ele se refere ao arquivo 
de comandos (command files). Normalmente, tem‑se um arquivo menor que é 
independente da plataforma utilizada.

No menu principal, ao se selecionar a opção File, as opções: New database, 
Open database, Save database e Save database as… guardam o arquivo com a 
extensão .*.bin. As opções Import… e Export… armazenam o arquivo com a 
extensão .*.cmd. Cabe ressaltar que outras extensões estão disponíveis, basta que 
o usuário escolha aquela que melhor se adapta a sua necessidade.

Observe que, ao retomar modelos virtuais já iniciados, ao tentar salvá‑los, o 
usuário poderá se deparar com a seguinte caixa de diálogo, mostrada na Figura 
1.46.

Nesta tela, adverte‑se o usuário da existência do modelo que se quer salvar e 
lhe é perguntado se ele deseja criar um backup.

Se o usuário responde “si”’ (Yes), o ADAMS/View irá criar um arquivo de 
mesmo nome, no caso, “pendulo”, mas com extensão .biq.
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Figura 1.46 – Caixa de diálogo do ADAMS/View para criação de backup.

1.3.7.	 Funcionalidades no ADAMS/View

O ADAMS/View permite o uso de algumas teclas facilitadoras, as quais são 
mostradas na Tabela 1.5, a seguir.

Tabela 1.5 – Descrição das teclas de função disponíveis no ADAMS/View.

Teclas Função da tecla

F1 Aciona o help do software.

F2 Abre uma janela solicitando que o usuário selecione um 
arquivo de extensão .*.cmd. Em seguida, abre‑se uma 

janela de simulação do modelo.

F3 Abre uma janela de comando (command window) em 
que ocorre uma verificação do modelo.

F4 Abre uma janela de coordenadas que identifica todos 
os pares ordenados na tela do módulo. É dinâmica, e 

a mudança do cursor pelo mouse permite o registro das 
coordenadas.

F8 Abre a janela do ADAMS/PostProcessor para o usuário.

Ctrl+N New Database (cria novo database).

Caso o usuário queira ter acesso a esse arquivo, ele deverá renomeá‑lo, atri‑
buindo um novo nome e também a extensão. Assim, por exemplo, o nome do ba‑
ckup será: pendulo.biq; ao renomear, o usuário deverá escrever: pendulo_simples.
bin”.
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Teclas Função da tecla

Ctrl+O Open Database (abre um database existente).

Ctrl+S Save Database(grava um database).

Ctrl+P Print (imprime um database).

Ctrl+Q Exit (sai do sessão do módulo).

Ctrl+E Modify (abre uma janela auxiliar denominada Database 
Navigator, na qual o usuário pode promover modifi‑
cações no modelo em diversas classes de elementos 
bodies, constraints, forces, markers, geometry etc.)

Ctrl+C Copy (copia elemento selecionado).

Como no ADAMS/Car, item 1.2.8, o ADAMS/View possui funcionalidades 
no próprio mouse. Contudo algumas se diferem, mas, em suma, a maioria perma‑
nece a mesma.

O usuário do ADAMS/View pode acessar opções do tipo Pick, Browse, Gues‑
ses etc. ao pressionar o botão direito do mouse sobre campos a serem preenchidos 
nas caixas de diálogo do módulo. Essas opções, às vezes, fornecem ao usuário 
atalhos para construção do modelo.

Por exemplo, a área de visualização o ADAMS/View permite apenas vistas 
frontais (Front), topo (Top), direita (Right) e isométrica (Iso). As manipulações 
de visualização se diferem nas teclas de ajuste, assim o ADAMS/View permite o 
ajuste da vista corrente em tela (Fit to view) e (Fit to view – no ground). Estão 
disponíveis outras duas opções, que são Align to 3 points e Align to object XY, 
ambas tratadas na Tabela 1.4, grupo View Control. 

Há, ainda, duas outras opções ausentes no ADAMS/Car; são elas: Save View 
Settings e Restore View Settings, que permitem salvar e restaurar configurações 
adotadas no desenvolvimento do modelo.

1.4.	 Módulo de Pós‑processamento do MSC ADAMS

Esse módulo permite que o usuário trate dados obtidos em simulações dos 
módulos ADAMS/Car e ADAMS/View. Sua interface possui quatro modos: de ani‑
mação (Animation), plotagem (Plotting), relatório (Report) e plotagem 3D (Plot 3D).
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Esses modos podem ser selecionados na tela do ADAMS/PostProcessor em 
um campo situado no canto superior esquerdo, conforme mostra Figura 1.47. 
Para selecioná‑los o usuário deve ativar a barra de rolagem que apresentará os 
modos disponíveis. A cada escolha, a área de trabalho principal (Figura 1.47), 
assim como algumas opções/comandos são disponibilizados, para que o usuário 
usufrua das funcionalidades do ambiente.

A área de tela logo abaixo dessa opção mostra uma árvore hierárquica com 
pastas de nomes page_1…page_n. O número n está associado às simulações re‑
alizadas no ADAMS/Car ou no ADAMS/View, pelo usuário, durante uma seção 
de trabalho, conforme mostra Figura 1.46. Assim, a cada simulação do usuário 
exportada (item 2.1.1.1) para o ADAMS/PostProcessor gerará uma nova page. 
Clicando com o botão direito do mouse sobre as pastas, o usuário terá acesso a 
novas opções.
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Abaixo do menu principal, há uma série de ícones que dão ao ADAMS/
PostProcessor algumas funcionalidades bastante úteis. A Tabela 1.6 traz alguns 
comentários, sobre cada grupo.

Outras funcionalidades estão disponíveis nesse módulo, contudo, o usuário 
irá tomar conhecimento delas durante a construção de modelos virtuais apresen‑
tados nos Capítulos 2 e 4. 

Tabela 1.6 – Apresentação de algumas funcionalidades do ADAMS/PostProcessor.

‑ Funções
1º Grupo 
Permite a importação de arquivos (Import a 
file).
Possibilita recarregar simulações (Reload 
simulations).
Permite a impressão (Print).

Ícone para desfazer (Undo) comandos. A seta 
lateral direita expande opções apertando o 
botão direito do mouse sobre esse ícone. Neste 
caso a nova opção é o refazer (Redo

Aplicável às animações, permite que a mesma 
sofra um Reset animation.
Dá início à simulação (Animate page).
3º Grupo 
Ícone para seleção (Select). Ao ser utilizado 
iluminará o elemento da seleção.
Ícone de inserção de texto. Para utilizá‑lo cli‑
que ponto no qual se quer inserir o texto e, em 
seguida, escreva.
Rastreador de plotagem (Plot tracking). Utili‑
zando este ícone, o usuário pode rastrear sobre 
a curva, pontos específicos de resultado, ou 
seja, valores de coordenadas.
Este ícone abre diversas opções de tratamen‑
to de curvas. Para tanto é necessário que o 
usuário clique sobre ele com o botão direito do 
mouse e outro menu se abre com as opções de 
soma (Add curves), subtração (Subtract one to 
another), multiplicação (Multiply two curves), 
valor absoluto (Absolute value) entre outras
Permite o zoom em uma região específica por 
meio da criação de uma janela auxiliar em 
torno da área desejada.
Ajusta todo o conteúdo da área de trabalho 
principal na janela.
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‑ Funções
4º Grupo
Este ícone quando expandido por meio do 
botão direito do mouse, permite acessar uma 
página anterior de pós‑processamento ou mes‑
mo acessar a 1ª página. 
Este ícone, quando expandido, por meio do 
botão direito do mouse, permite acessar a pró‑
xima página de pós‑processamento ou mesmo 
acessar a última página.
Cria uma nova página (page) na área de arma‑
zenamento de resultados de simulação.

Deleta uma página (page) na área de armazena‑
mento de resultados de simulação.

5º Grupo
Estes ícones se prestam à formatação da área 
de trabalho e visualização de plotagens e ani‑
mações.
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Módulo ADAMS/View 
aplicado ao estudo do MHS

Este capítulo tem como objetivo iniciar o leitor na utilização do módulo 
ADAMS/View modelando dois mecanismos clássicos para o estudo do Movimen‑
to Harmônico Simples (MHS): o pêndulo físico e o pêndulo simples. Ambos os 
modelos são criados e a análise dos resultados provenientes das simulações é 
realizada, utilizando, como aporte, o equacionamento analítico para validação 
dos mesmos.

Para o pêndulo físico será determinada a força aplicada no vínculo (junta) 
de rotação. Será realizada uma análise de sensibilidade desta força, alterando‑se a 
massa e velocidade angular do pêndulo. O período de oscilação do sistema tam‑
bém será avaliado em função das variações desses parâmetros.

Já o pêndulo simples será utilizado na determinação numérica da aceleração 
da gravidade na terra. Equações analíticas validam o modelo virtual.

Os modelos virtuais a serem obtidos ao final deste capítulo estão mostrados 
a seguir.

2
C
A
PÍTU

LO
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Pêndulo Físico Pêndulo Simples

2.1.	 Desenvolvimento de um modelo virtual de um pêndulo físico

Este item se dedica à construção e à simulação de um pêndulo físico compos‑
to de uma barra homogênea e uniforme de 2,0 kg e comprimento igual a 450 mm.

A notar: no domínio da Teoria da Elasticidade, diz‑se que um corpo é homogêneo 
quando as propriedades físicas específicas de um elemento infinitesimal deste podem 
ser extrapoladas para todo o corpo, ou seja, em qualquer ponto desse corpo no espaço 
as propriedades serão as mesmas.
Diz‑se que a mesma é uniforme se não há variação das propriedades geométricas.

A essa barra será imposta uma velocidade angular inicial constante de valor 
3 rad/s. A posição inicial do movimento será de 30º relativamente ao eixo hori‑
zontal x.

A notar: um pêndulo consiste em um objeto oscilante em torno de um ponto fixo e 
que tem como principais aplicações estudos da força peso e do movimento oscilatório. 
Isto lhe garante um caráter de mecanismo de medição ou instrumento. Galileu Galilei, 
físico, matemático, astrônomo e filósofo italiano foi quem primeiro se dedicou ao 
estudo da periodicidade do movimento pendular, dando grande contribuição à 
Mecânica Clássica.
Visto como um objeto oscilante, há duas formas de se tratar um pêndulo: como físico 
ou simples. O pêndulo físico consiste em um corpo rígido de massa “m”, que oscila 
em um plano vertical, em torno de um ponto “O” fixo, por onde passa um eixo 
perpendicular ao plano de oscilação.
Este corpo é sustentado neste ponto, sem atrito e fica a uma distância “d” do seu 
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centro de massa/centro de gravidade, conforme mostra a figura a seguir. O pêndulo 
físico é normalmente aplicado na determinação do valor local da gravidade.

Pêndulo físico.
Fonte: UNIDESC. Disponível em: <http://www.joinville.udesc.br/portal/professores/vitor
/materiais/Roteiro_7_I.pdf>. Acesso em:22/11/2012

O pêndulo encontra‑se em equilíbrio, quando o ponto “O” e o centro de massa “cm” 
deste se encontram sobre o mesmo eixo na posição vertical. Quando este é levemente 
afastado desta posição (pequenas oscilações), ele passa a executar um movimento 
oscilatório em torno dela, esse movimento é denominado movimento harmônico 
simples, se não há forças de atrito.
Durante esse movimento, um torque restaurador de valor d mgsenτ θ( )= ×  age 
sobre o pêndulo, no qual θ é o ângulo entre o eixo vertical de equilíbrio e a reta que 
posiciona o pêndulo durante seu movimento. O ângulo e o torque restaurador terão 
sempre sinal contrário, ou seja, se θ >0, τ <0 e vice‑versa, daí a atribuição restaurador. 
Convenciona‑se que valores positivos estão no sentido anti‑horário, enquanto valores 
negativos, no horário.

Com o desenvolvimento deste modelo virtual, deseja‑se obter a força aplica‑
da no ponto de apoio no instante t0.

Etapa 1 – Inicializando o ADAMS/View
•	 Inicialize o módulo conforme discutido no item 1.3.1 e escolha a opção 

Create a new model.
•	 Em seguida, preencha a aba Model name com o nome do modelo vir‑

tual, no caso, “pendulo_fisico”. Veja este é o nome do modelo virtual.
A Figura 2.1, a seguir, exibe a tela que o usuário irá obter. Ressalta‑se que o 

nome atribuído não deve conter caracteres especiais, como acentos gráficos, sím‑
bolos, formas etc. Mantenha a aba Gravity e Units nos valores default, conforme 
indicado na Figura 2.1.
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Na aba Start in, especifique o diretório no qual o database será armazena‑
do, quando gravado. No caso, escolheu‑se o diretório “Meus documentos” pasta 
“Minhas Formas”.

Figura 2.1 – �Tela inicial do ADAMS/View.

Etapa 2 – Ajustando a área de trabalho no ADAMS/View
•	 Altere o espaçamento do grid para 25 mm. Para tanto, recorra ao menu 

principal opção Settings → Working Grid aba Spacing. A tela auxiliar 
que aparecerá é a indicada na Figura 2.2.

Figura 2.2 – �Tela para alteração de espaçamento do grid na área de traba‑
lho do ADAMS/View.

Etapa 3 – Construção do corpo rígido – Barra homogênea e uniforme
•	 Crie uma geometria sólida, no caso um link, conforme tratado no item 

1.3.2.1, b.1.
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•	 Escolha no menu Main Toolbox o ícone referente ao Rigid body: link  .
•	 Após seleção da opção, as abas referentes à criação da geometria apare‑

cem nos campos inferiores do menu Main Toolbox, são eles: o compri‑
mento, Length, a largura, Width e a profundidade, Depth, que devem ser 
preenchidos como ilustrado na Figura 2.3. Cabe ressaltar que para tornar 
os valores de geometria válidos, o deve‑se tornar as abas ativas; isto se faz 
selecionando cada uma delas com um tick. Tenha atenção às unidades, 
pois o default da janela é o “cm” e as unidades mostradas estão em “mm”.

Figura 2.3 – �Tela para criação do link que representará a barra homogênea do 
pêndulo físico.

(a) (b)

Figura 2.4 – �(a) tela para criação da coordenada inicial do pêndulo físico; 
(b) link criado na área de trabalho (vista isométrica).
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•	 Escolha a coordenada inicial do link, segundo as coordenadas (X, Y, Z) 
iguais a (–225,0,0). Para tanto, posicione o cursor em qualquer ponto 
da tela e, em seguida, pressione a tecla F4 (Tabela 1.5). Essa operação 
abrirá uma janela denominada Coordinates, conforme a Figura 2.4a.

•	 Posicione, então, o cursor na posição desejada. Não clique com o mouse 
sobre a área de trabalho, pois isto dará início ao comando link. Outra 
maneira de estabelecer o ponto inicial da geometria é segundo o indica‑
do na Figura 1.28a.

•	 Em seguida, arraste o cursor para finalização da criação do link até a 
coordenada (+225,0,0). A Figura 2.4b mostra a geometria finalizada em 
vista isométrica.

•	 Após a criação do link, Figura 2.4a, selecione‑o e pressione o botão di‑
reito do mouse sobre ele. A janela que será apresentada é a mostrada na 
Figura 2.5a. Repare que a seleção se refere à Part: PART_2. Em seguida, 
como mostrado, selecione a opção Modify.

(a) (b)

Figura 2.5 – �(a) Tela referente à demanda de modificação de parâmetros do link; 
(b) tela referente à opção Modify.

•	 Na aba Category, Figura 2.5b, ative a barra de rolagem e escolha a op‑
ção Name and Position.

•	 Na opção Body, Figura 2.5b, aparece o nome PART_2. Vá à aba New 
Name e digite BARRA, como o novo nome da geometria.

•	 Em seguida, escolha a opção Apply. Verifique que a aba Body tem seu 
nome atualizado por BARRA. A tela que concretiza as operações descri‑
tas aqui é mostrada na Figura 2.5b.

•	 Tecle na opção Ok para finalizar a operação.
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•	 Para atribuir a massa de 2 kg à barra, selecione a geometria, clique com 
o botão direito do mouse sobre ela e escolha a opção Part: BARRA → 
Modify.

•	 Na aba Category escolha a opção Mass Properties e na aba Define Mass 
By escolha User Input. Repare que para ter acesso a estas opções, deve
‑se ativar as barras de rolagem ao lado de cada uma das abas. A Figura 
2.6 ilustra este passo. Note que a unidade considerada foi o “kg”, por 
isso o valor 2.0.

Etapa 4 – Definindo a posição inicial do pêndulo físico
•	 Selecione a geometria sólida.
•	 No menu Main Toolbox, selecione a opção Position: Reposition Position 

objects relative to view coordinates (x to right, y up, z out of the view) 
ícone  . Ele se encontra no 1º grupo de ícones, segundo Tabela 1.4, 4ª 
linha, 1ª coluna.

Figura 2.6 – Tela correspondente à atribuição de massa ao modelo virtual.

•	 Preencha a aba Angle com o valor de 30º.
•	 Escolha a seta da esquerda no campo Rotate About View Center, no 

sentido horário. Esta operação fará com que a barra gire segundo o eixo 
x, exatamente como estabelecido em 2.1. As Figuras 2.7a, b ilustram as 
abas preenchidas e o posicionamento inicial do pêndulo, respectivamente.
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(a) (b)

Figura 2.7 – �(a) seleção de valores para posicionamento inicial da barra do pêndulo físico; 
(b) posição inicial do pêndulo (vista frontal).

Etapa 5 – Estabelecendo restrições ao modelo virtual
A junta que será colocada no modelo é uma junta idealizada do tipo junta 

revoluta tratada em 1.3.3.1a.
•	 Escolha o ícone referente a esta junta  no menu Main Toolbox.
•	 Preencha as abas referentes a esta junta da seguinte maneira: Cons‑

truction opção 1 Location e, em seguida, na aba logo abaixo, Normal 
to Grid, Figura 2.8a. Neste caso, ao fornecer a posição de inserção, o 
ADAMS/View automaticamente selecionará as partes necessárias para 
inserção da restrição, no caso o link e o ground part.

•	 Posicione o mouse sobre a extremidade superior da barra e, com o botão 
esquerdo do mouse sobre a geometria, selecione o marker correspon‑
dente a essa extremidade, no presente modelo BARRA: MARKER_1, 
Figura 2.8b. A Figura 2.8c mostra o resultado final.
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(a) (b) (c)

Figura 2.8 – �(a) preenchimento das abas para inserção de uma junta revoluta;  
(b) seleção do marker para inserção da junta;  
(c) resultado final após inserção da junta.

Etapa 6 – Definição do movimento inicial do modelo
A velocidade angular inicial de ω = 3 rad/s será atribuída ao modelo a partir 

da escolha de um marker que se encontra no ground part. O usuário pode verifi‑
car a posição desse marker clicando com o botão direito do mouse sobre o centro 
da junta revoluta inserida. Ao clicar, aparecerão duas informações: Part: BARRA 
e Part: ground.

A primeira parte traz um link e dois markers e a segunda, um marker e uma 
junta (joint). O usuário perceberá que para inserir o movimento inicial deverá 
escolher o Marker: MARKER_4 pertencente ao Part: ground. Assim,

•	 Selecione o modelo com o mouse.
•	 Pressione o botão direito do mouse sobre o mesmo e escolha Part: BAR‑

RA → Modify.
•	 Na aba Category, ative a barra de rolagem e escolha Velocity Initial 

Conditions. Será possível perceber que a janela se divide em duas áreas: 
Translational velocity along e Angular velocity about. Vá para a área 
Angular velocity about.

•	 Selecione a opção Marker.
•	 Uma caixa de texto aparece. Clique com o botão direito do mouse so‑

bre ela. Na janela auxiliar, escolha a opção Marker. Expanda esta aba 
e vá à opção Guesses. Expanda esta opção e escolha “.pendulo_fisico.
ground:MARKER_4”.

•	 Entre as opções de eixo mostradas, escolha a opção Z axis. Preencha a 
caixa de texto lateral de fundo cinza com o valor de 3.0 r. Não coloque 
unidades e perceba a letra “r” ao final.

•	 Clique em Apply, neste momento o valor será alterado, e, em seguida, 
Ok. A Figura 2.9 ilustra esta Etapa.
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Etapa 7 – Verificação do modelo
Esta Etapa se destina à análise do modelo antes que ele seja submetido à 

simulação. Para tanto,
•	 Clique no ícone  com o botão direito do mouse. Este ícone se situa no 

canto inferior direito da tela do ADAMS/View.
•	 Escolha a opção  . Ela verifica o modelo, fornece o número de partes 

e informa o número de graus de liberdade.
•	 Feche a tela correspondente, se a mensagem ao final for Model verified 

successfully.

Figura 2.9 – Tela ilustrativa da Etapa 6.

Etapa 8 – Simulação do modelo
•	 Clique no centro da junta revoluta e acione o botão direito do mouse.
•	 Selecione a opção Joint:Joint_1 e escolha a opção Measure.
•	 Vá à aba Characteristic, acione a barra de rolagem e escolha a opção 

Force.
•	 Na aba Component, selecione mag.
•	 Mantenha as demais abas preenchidas com os valores default. A Figura 

2.10a exibe como deve ser preenchida a tela.
•	 Clique em Apply e, nesse momento, uma tela indicativa da medida 

(Measure) inserida irá aparecer, conforme a Figura 2.10b. Não feche 
a tela, pois será nela que aparecerão os resultados requeridos sobre o 
pêndulo.

•	 Para finalizar, Clique em Cancel. Se clicar em Ok, uma nova tela idênti‑
ca à anterior (Figura 2.10b) irá aparecer.
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(a) (b)

Figura 2.10 – �(a) preenchimento correspondente ao início da simulação; 
(b) tela resultante da operação efetuada.

•	 Em seguida, vá ao menu principal Main Toolbox e selecione o ícone  , 
tratado no item 1.3.4, com um simples clique sobre ele.

•	 Preencha as abas que aparecem na parte inferior do menu Main Toolbox, 
conforme mostrado na Figura 2.11a. Em seguida, clique no botão Play 

 . A tela JOINT_1_MEA_1 será preenchida conforme a Figura 2.11b.
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(a) (b)

Figura 2.11 – �(a) Preenchimento das abas referentes à simulação; 
(b) gráfico gerado após simulação

Etapa 9 – Determinação da força sobre o ponto de inserção da junta
Para a realização desta Etapa, será necessário recorrer ao ADAMS/

PostProcessor, tratado no item 1.4.
•	 Clique com o botão direito do mouse em qualquer ponto da área do 

gráfico JOINT_1_MEA_1.
•	 Aparecerá então a opção Plot:scht1.
•	 Expanda e selecione a opção Transfer to full plot. Neste momento você 

irá migrar para o módulo ADAMS/PostProcessor.
•	 No menu principal deste módulo, selecione a opção Plot Tracking repre‑

sentada pelo seguinte ícone  . Isto lhe possibilitará rastrear os valores 
de Força x Tempo ao longo da curva.

Verifica‑se que o pêndulo está submetido a uma força máxima de 38,12N 
aos 0,41s e a uma força mínima de 8,54N a 0,1s. No ponto em que x é igual a 
zero, o valor da força é de 14,54N. A pequena instabilidade no início da curva se 
deve à entrada em movimento do mecanismo. A Figura 2.12 mostra a aparência 
dessa janela.

•	 Pressione a tecla F8 para retornar ao módulo ADAMS/View.

Etapa 10 – Salvando o modelo virtual
Após finalizar a simulação, o usuário deve salvar seu trabalho procedendo 

da seguinte maneira:
•	 Vá ao menu principal do módulo e selecione a opção File.
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•	 Clique sobre ela e a faça expandir.
•	  Escolha a opção Save Database as…
•	 Clique sobre ela e uma tela irá se abrir, conforme a Figura 2.13.

Figura 2.12 – Variação da força no vínculo ao longo de um período de oscilação de 0,5 s.

Figura 2.13 – �Tela para gravação 
do modelo virtual.

•	 Clique na opção Ok.
Cabe ressaltar que o nome do arquivo aparece automaticamente e é igual 

ao nome do modelo com extensão *.*bin. O local onde ele será armazenado foi 
definido no início da seção na aba Start in, sendo esta preenchida por *.*/Meus 
documentos/Minhas Formas.
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Etapa 11 – �Comparação entre os valores de força encontrados pelo 
ADAMS/View e analiticamente

A notar: A resolução analítica do problema do pêndulo físico remete ao seguinte 
equacionamento do problema.

Considere a figura acima representativa do pêndulo físico em que no ponto “O” 
agem as forças Ft e Fn, que são, respectivamente, forças tangencial e normal ao polo 
O. A força peso age no centro de massa/centro de gravidade da barra homogênea 
e uniforme e se decompõe segundo as componentes mostradas: mgcosθ no sentido 
tangencial e mgsenθ no sentido normal.
O somatório do momento em torno do polo “O” é igual a:

M I0
0∑ a=  (1)

onde IO é o momento de inércia da barra em torno de “O” e α a aceleração tangencial.
A única força capaz de gerar momento em torno desse ponto é a componente do peso 
mgcosθ que multiplicado pelo braço de alavanca “d”, distância ao longo da barra 
entre o ponto de aplicação da força até “O”, fornece:

mg d Icos 0θ α=  (2)

Sabendo que o momento de inércia de uma barra em seu centro de massa é: 
I

mL
12CM

2

=

, onde “m” é a massa da barra e “L” seu comprimento total. Como se precisa do 
momento de inércia no ponto “O”, aplicando o Teorema dos Eixos Paralelos tem‑se: 

I
mL

30

2

=
. Substituindo este valor em (2) e sabendo que m=2kg; L=0,450m; g=9,81m/

s2; d=0,225m e =30º, obtém‑se α igual a 28,32 rad/ s2.
O equilíbrio das forças nas direções tangencial e normal geram:

F mdt∑ a=

mg A mdcos tθ α− =  (3)
e

F mdwn
2∑ =

A mgsen mdwn
2q− =  (4)

De α igual a 28,32 rad/ s2 e w=3,0rad/s, tiram‑se de (3) e (4) os valores de At e An, 
respectivamente, sendo estes iguais a 4,247N e 13,86N. A resultante de F é calculada 
usando o Teorema de Pitágoras, levando ao valor de 14,5N.
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O valor discriminado no quadro acima é aproximadamente o mesmo deter‑
minado pela simulação do pêndulo no ponto x = 0, ou seja, 14,54 N.

2.1.1.	 Estudo de sensibilidade do modelo virtual

Neste tópico será avaliada a sensibilidade do modelo virtual criado a partir 
da realização do seguinte experimento:

•	 Dobre a massa da barra, que passará de 2,0 kg para 4,0 kg e velocidade 
angular inicial de 3 rad/s.

•	 Mantenha a massa da barra em 2,0 kg e multiplique por um fator de es‑
cala 2,0 o valor da velocidade angular inicial, ou seja, a mesma passará 
de 3,0 rad/s para 6,0 rad/s.

2.1.1.1.	 Alterando o valor da massa do pêndulo físico

Os resultados destas duas operações serão comparados em seguida. Comece 
alterando a massa da barra.

•	 Modifique a massa da barra clicando com o botão direito do mouse 
sobre a barra.

•	 Selecione PART:BARRA e clique em Modify. Será aberta a tela auxiliar 
correspondente a essa opção, Figura 2.6. Coloque a aba Category em 
Mass Properties e a aba Define Mass By em User Input.

•	 Na aba Mass digite o valor 4.0.
•	 Repita a Etapa 8.
•	 Como na Figura 2.10a, crie um novo nome para a aba Measure Name. 

Sugestão: JOINT_1_MEA_m4kg.
•	 Selecione o ícone  , no menu Main Toolbox e proceda como indicado 

na Etapa 8. Na Figura 2.11a escolha 1.0 para a aba End time.
•	 Prossiga repetindo o estabelecido na Etapa 9.
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Figura 2.14 – �Variação da força no vínculo ao longo de um período de oscilação de 1,0 s 
considerando a massa da barra igual a 4,0 kg.

Note que à esquerda da tela foi criada uma pasta de nome page_3 que con‑
tém os dados desta simulação.

•	 Pressione F8, retornando ao ambiente do ADAMS/View e refaça o dito 
acima com a massa da barra sendo igual a 2 kg. Esta operação deve ser 
repetida para que se amplie o período de oscilação, que antes, para essa 
mesma massa, era de 0,5 s. Ao estabelecer o nome da nova simulação 
sugere‑se que a aba Measure Name seja preenchida com JOINT_1_
MEA_m2kg.

Para comparar os resultados obtidos, variando a massa da barra, exiba as 
duas curvas no mesmo gráfico. Para tanto, no ambiente ADAMS/PostProcessor:

•	 Selecione a curva da primeira simulação, ou seja, a curva contendo os 
resultados da barra de massa igual a 4 kg, a qual está armazenada na 
page_3. Ela deve ficar iluminada.

•	 Na caixa de diálogo Source → Result Sets, localizada no canto inferior 
esquerdo da tela do ADAMS/PostProcessor, selecione a outra curva de 
interesse, neste caso a JOINT_1_MEA_m2kg, Figura 2.15.

•	 Na caixa de diálogo Component, parte inferior da tela do ADAMS/
PostProcessor, selecione a variável de interesse, neste caso a variável 
Q (Força). Clique em Add Curves, aba no canto inferior direito da tela 
do ADAMS/PostProcessor, Figura 2.15.
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Verifique que o valor da nova força para m = 4 kg, no ponto x = 0 é de 28,17 
N, praticamente o dobro da força anteriormente encontrada para o mesmo ponto.

Figura 2.15 – �Variação da força no vínculo ao longo de um período de oscilação de 1,0 s 
considerando as massas das barras iguais a 2,0 e 4,0 kg.

2.1.1.2.	 Alterando o valor da velocidade angular inicial

Em seguida, será guardado o mesmo valor de massa da barra m = 2 kg e a 
velocidade angular inicial será dobrada, ou seja, passará a 6 rad/s. Para tanto:

•	 Clique com o botão direito do mouse sobre a barra do pêndulo, selecio‑
ne PART: BARRA e clique em Modify. Será aberta uma tela semelhante 
a Figura 2.6.

•	 Na aba Category, selecione a opção Velocity Initial Conditions ativando 
a barra de rolagem.

•	 Substitua o valor presente na caixa de texto de fundo cinza, ao lado do 
Z axis, por 6.0 r.

•	 Clique em Apply. Observe que ao fazê‑lo o valor em frente à opção 
muda para 343.7746770795. Em seguida, clique em Ok.

•	 Selecione novamente a barra e clique com o botão direito do mouse so‑
bre ela, selecione, em seguida, PART: BARRA e escolha a opção Modify.

•	 Na aba Category, selecione a opção Mass Properties.

MSC_ADAMS_prova-4.indb   91 17/10/14   16:07



92 MSC ADAMS: Guia Prático de Utilização

•	 Na aba Define Mass By, escolha User Input como opção, por meio da 
barra de rolagem.

•	 Na opção Mass, escreva 2.0. Clique em Apply, em seguida Ok.
•	 Repita a Etapa 8. Sugere‑se que a aba Measure Name tenha seu nome 

trocado para JOINT_1_MEA_w6rads.
•	 Selecione o ícone  , no menu Main Toolbox e proceda como indicado 

na Etapa 8. Na Figura 2.11a, escolha 1.0 para a aba End time.
•	 Prossiga repetindo o estabelecido na Etapa 9.
•	 Selecione novamente a barra e refaça colocando a velocidade angular 

inicial igual a 3.0 rad/s, mantendo a mesma massa.
•	 Repita a Etapa 8. Sugere‑se que a aba Measure Name tenha seu nome 

trocado para JOINT_1_MEA_w3rads.
•	 Selecione o ícone  , no menu Main Toolbox e proceda como indicado 

na Etapa 8. Na Figura 2.11a escolha 1.0 para a aba End time.
•	 Prossiga repetindo o estabelecido na Etapa 9.
•	 Selecione a curva da primeira simulação, ou seja, a curva contendo os 

resultados da barra de velocidade angular inicial igual a 6 rad/s, a qual 
está armazenada na page_4. Ela deve ficar iluminada.

•	 Na caixa de diálogo Source → Result Sets, localizada no canto inferior 
esquerdo da tela do ADAMS/PostProcessor, selecione a outra curva de 
interesse, neste caso, a JOINT_1_MEA_w3rads, Figura 2.16.

•	 Na caixa de diálogo Component, parte inferior da tela do ADAMS/
PostProcessor, selecione a variável de interesse, neste caso, a variável 
Q (Força).

•	 Clique em Add Curves, aba no canto inferior direito da tela do ADAMS/
PostProcessor, Figura 2.16.

A curva em traço cheio, mostrada na Figura 2.16, se refere à velocidade an‑
gular inicial de ω = 3,0 rad/s, enquanto a outra se refere à velocidade de ω = 6,0 
rad/s. Repare que há uma defasagem entre as curvas.
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Figura 2.16 – �Variação da força no vínculo ao longo de um período de oscilação de 1,0 s conside‑
rando as velocidades angulares iniciais da barra iguais a 3 e 6 rad/s.

2.1.1.3.	 Avaliação dos resultados obtidos

Como na situação mostrada no item 2.1.1.1, o valor da força exercida no 
ponto de apoio do pêndulo físico no caso do item 2.1.1.2, é praticamente o dobro.

A frequência angular e o período de oscilação do pêndulo físico são dados, 
respectivamente, por:

f
mgd
I0

=

2.1

f
T

T
I

mgd
2

2 op p= → =

2.2

onde os valores das variáveis das equações já foram previamente definidos 
em 2.1 – Etapa 11.

Avaliando as duas situações apresentadas em 2.1.1.1 e 2.1.1.2 relativas à 
frequência angular e ao período de oscilação do pêndulo, tem‑se o mostrado na 
Tabela 2.1.
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Tabela 2.1 – Valores de período e de frequência do pêndulo físico sob diferentes situações 

Caso 1 – Valor de m = 2kg
e ω = 3,0 rad/s

(caso referência)

Caso 2 – Valor de m = 4 kg
e ω = 3,0 rad/s

Caso 3 – Valor de m = 2 kg
e ω = 6,0 rad/s

f T f T f T
5,72Hz 1,10s 5,72Hz 1,10s 5,72Hz 1,10s

A partir dos casos 1, 2 e 3, comprova‑se que, como esperado, as frequências 
e os períodos de oscilação do pêndulo físico são iguais em todos os casos.

Isto porque as grandezas dependem, exclusivamente, do comprimento do 
pêndulo (L) ou da distância de seu centro de massa ao polo “O” (d = L/2), que é 
mantido constante nos três casos. Observa‑se que o efeito do fator multiplicativo 
da massa se anula no quociente da Equação 2.1 e é independe da velocidade an‑
gular inicial.

Contudo, percebe‑se uma diferença de amplitude entre as curvas (valores 
máximos e mínimos) com respeito aos valores da força. A Tabela 2.2 traz um 
comparativo entre esses valores em intervalos de tempo comum.

Tabela 2.2 – Comparação entre as forças em intervalos de tempo comum no pêndulo físico 

Caso 1 – Valor de m = 2 kg
e ω = 3,0 rad/s
(caso referência)

Caso 2 – Valor de m = 4 kg
e ω = 3,0 rad/s

Caso 3 – Valor de m = 2 kg
e ω = 6,0 rad/s

Tempo (s) Força (N) Força (N) Força (N)
0,0 14,54 28,17 26,38

0,12 8,77 17,51 5,85
0,40 38,16 78,76 31,13
0,70 8,56 19,13 17,41
0,88 24,46 73,32 5,11

Da Figura 2.15 e Tabela 2.2 percebe‑se que no caso 2 as forças resultantes 
ao longo da trajetória no ponto “O” (apoio) são sempre superiores que as obtidas 
no caso 1. Contudo, em alguns pontos, a razão entre elas varia. Por exemplo, em 
x = 0 este fator é de aproximadamente 2,0, mas em x = 0,88 s essa razão passa 
a ser 3,0. Isto se deve a diferenças no valor das forças componentes normal e 
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tangencial provocado pela diferença de massa, em um dado ponto num deter‑
minado tempo.

Da Figura 2.16 e Tabela 2, verifica‑se que a aceleração tangencial permanece 
a mesma entre os casos 1 e 3, havendo diferença apenas na componente normal, 
em razão do valor da velocidade angular inicial que varia.

A defasagem entre as curvas de força com respeito aos casos em que ω = 3,0 
rad/s e 6,0 rad/s se explica pela defasagem observada nas curvas de deslocamento 
ao longo do eixo y. Isto porque a diferença entre as velocidades angulares iniciais 
garante que um dos pêndulos esteja sempre à frente do outro por ter uma veloci‑
dade maior.

A Figura 2.17 esclarece o dito acima em que a curva de traço contínuo se re‑
fere à situação de deslocamento para ω = 3,0 rad/s e a tracejada para ω = 6,0 rad/s.

Para obter esse gráfico, recorre‑se ao ADAMS/PostProcessor seguindo a se‑
quência de ações semelhante àquela de 2.1.1.2, diferenciando‑se apenas nos as‑
pectos mostrados a seguir, além de nomes distintos para os Measures. Para tanto,

•	 Para definir os pontos de medida, não mais escolha Joint: JOINT_1, 
mas sim a BARRA e no caso, PART: BARRA. Clique com o botão direi‑
to do mouse sobre ela para definir o tipo de medida por meio da opção 
Measure.

•	 Na tela Part Measure, no campo Characteristic selecione ativando a bar‑
ra de rolagem CM position. No campo Component, selecione Y.

Para a plotagem dos resultados proceda como especificado em 2.1.1.2. Para 
tanto, atenção aos seguintes pontos:

•	 Selecione a curva da primeira simulação, ou seja, a curva contendo os 
resultados do pêndulo com velocidade angular inicial igual a 6 rad/s. Ela 
deve ficar iluminada.

•	 Na caixa de diálogo Source, localizada no canto inferior esquerdo da 
tela do ADAMS/PostProcessor, escolha a opção Measures ativando a 
barra de rolagem.

•	 Selecione a outra curva de interesse, tendo atenção ao nome atribuído 
ao conjunto de valores.

•	 Clique em Add Curves, aba no canto inferior direito da tela do ADAMS/
PostProcessor.
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Figura 2.17 – �Variação do deslocamento no período de oscilação de 1,0 s 
considerando as velocidades angulares iniciais da barra iguais a 3 e 6 rad/s.

2.2.	 Desenvolvimento de um modelo virtual de um pêndulo simples

A notar: define‑se o pêndulo simples como um corpo formado por uma partícula 
suspensa por um fio inextensível de massa desprezível. Quando afastado de sua posição 
de equilíbrio e solto, esse pêndulo oscilará em um plano vertical, em torno de um eixo 
perpendicular ao plano de movimento.
A oscilação se deve à ação da gravidade e o movimento é periódico possibilitando o 
cálculo da frequência e do período de oscilação.
A figura ao lado mostra um pêndulo simples de comprimento L e massa da partícula 
igual a m. Perceba que comparativamente ao pêndulo físico, o pêndulo simples tem 
seu centro de massa/centro de gravidade situado na extremidade do fio e, não mais no 
ponto L/2 = d, conforme visto anteriormente.
O pêndulo simples é visto como uma massa oscilante pontual. Sendo assim não será 
mais necessário o cálculo de um momento de inércia polar.
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Seu movimento descreve uma trajetória em forma de arco de círculo e as forças que 
atuam nesse mecanismo são a força peso, que possui duas componentes uma tangencial 
Fn,= m g senθ e outra normal Fn = m g cosθ, além da força de tração no fio, que 
se denomina T. A componente radial é a força centrípeta e a tangencial é a força 
restauradora, assim como no pêndulo físico.

Fonte ilustração: Universidad del País Vasco. Disponível em: <http://www.sc.ehu.es/sbweb/fisi‑
ca/dinamica/trabajo/pendulo/pendulo.htm>. Acesso em:11/12/2012

Este tópico apresenta a construção e simulação de um pêndulo simples com‑
posto por uma massa concentrada de 365 g e comprimento de 300 mm; desloca‑
do de sua posição de equilíbrio (eixo vertical) de um ângulo de 10º com a vertical 
e; com velocidade angular inicial igual ω = 0. Com o desenvolvimento desse mo‑
delo virtual, deseja‑se obter a força aplicada no ponto de apoio no instante t0 e a 
determinação da aceleração da gravidade.

Etapa 1 – Inicializando o ADAMS/View
•	 Inicialize o módulo, conforme discutido no item 1.3.1, e escolha a opção 

Create a new model.
•	 Em seguida, preencha a aba Model name com o nome do modelo virtual, 

no caso, “pendulo_simples”. Veja que este é o nome do modelo virtual.
A Figura 2.18, a seguir, exibe a tela que o usuário irá obter. Ressalta‑se que o 

nome atribuído não deve conter caracteres especiais, como acentos gráficos, sím‑
bolos, formas etc. Mantenha a aba Gravity e Units nos valores default, conforme 
indicado na Figura 2.18.

A aba Start in especifique o diretório no qual o database será armazena‑
do, quando gravado. No caso, escolheu‑se o diretório “Meus documentos” pasta 
“Minhas Formas”.
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Etapa 2 – Ajustando a área de trabalho no ADAMS/View
Altere o espaçamento do grid para 25 mm. Para tanto, recorra ao menu prin‑

cipal opção Settings → Working Grid aba Spacing. A tela auxiliar que aparecerá é 
a indicada na Figura 2.19.

Figura 2.18 – �Tela inicial do 
ADAMS/View.

Figura 2.19 – �Tela para alteração de espaçamento do grid na área de 
trabalho do ADAMS/View.

Etapa 3 – Construção da haste de sustentação do pêndulo simples
Para criação dessa parte, será usada a ferramenta link.
•	 No menu Main Toolbox, clique com o botão direito do mouse sobre o 

ícone  .
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•	 Dentre as opções mostradas, escolha o ícone  (Rigid Body: Link). Ao 
escolher essa geometria, serão mostradas, na parte inferior do menu 
Main Toolbox, as opções de construção da peça, ou seja, Length (com‑
primento), Width (largura) e Depth (profundidade). Nelas, deverão ser 
colocadas as dimensões do link. Para acioná‑las, deve‑se marcá‑las com 
um tick e preencher com os valores escolhidos, conforme a Figura 2.20.

•	 Atenção ao preenchimento, repare que a unidade default é o “cm” e no 
seu preenchimento será alterada por “mm”.

Figura 2.20 – �Tela para criação do link que representará 
o fio do pêndulo simples.

•	 Clique no ponto correspondente à origem do sistema de coordenadas da 
área de trabalho do módulo. Essa será a coordenada inicial do link. Se 
houver dificuldade na seleção do ponto, posicione o cursor em qualquer 
região da tela e pressione a tecla F4. Isto fará com que apareça a janela 
Coordinates, conforme discutido na Etapa 3 do item 2.1.

•	 Arraste o cursor na direção vertical para baixo, para que a geometria 
link seja criada. A Figura 2.21 ilustra o resultado final dessa operação.
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Figura 2.21 – �Link criado na área de trabalho (vista isométrica).

Etapa 4 – Construção da massa pontual do pêndulo simples
A massa que será posicionada na extremidade inferior do link criado na Eta‑

pa 3 será uma esfera. Para criá‑la proceda da forma descrita a seguir.
•	 No menu Main Toolbox clique com o botão direito do mouse sobre o 

ícone  . Isto fará com que ele se expanda.
•	 Selecione a opção  . A Figura 2.22a mostra a operação.
•	 Preencha as informações sobre a geometria sólida conforme mostra a 

Figura 2.22b. Repare que, na aba Sphere, deve‑se ativar a barra de rola‑
gem ao lado e selecionar Add to Part.

•	 Insira a nova geometria na PART_2 no ponto de coordenada (X,Y,Z) 
igual a (0, –300,0), ou seja, na extremidade inferior do link. A Figura 
2.23 ilustra esta operação.
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(a) (b)

Figura 2.22 – �Tela ilustrativa de criação de uma geometria sólida tipo Esfera.

Etapa 5 – Alterando o nome do modelo
•	 Selecione a geometria sólida PART_2.
•	 Em seguida, pressione o botão direito do mouse sobre ela.
•	 Escolha Part:Part_2, dirija‑se à seta em frente à opção. Passe o mouse 

sobre ela para que apareçam as opções disponíveis.
•	 Escolha a opção Modify.
•	 Na caixa de diálogo Modify Body vá à aba Category, ative a barra de 

rolagem e selecione a opção Name and Position.
•	 Em seguida, vá até a aba New name e coloque simples.
•	 Clique em Apply e depois Ok. Esta Etapa está demonstrada na Figura 

2.23.
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(a)

Figura 2.23 –  
(a)tela de modificação do  
nome da parte;  
(b) resultado final da operação.(b)

Etapa 6 – Modificando a massa e a posição do centro de massa do pêndulo
Geometrias criadas no ADAMS/View vêm sempre com um valor de massa 

default associado a um determinado tipo de material. Nesta Etapa, será feita a al‑
teração desse valor de massa. O novo valor, conforme definido, será de 0,365 kg. 
Para tanto,

•	 Selecione com o botão direito do mouse a Part: simples.
•	 Corra com o cursor até a seta localizada em frente a essa opção. Ela irá 

expandir.
•	 Escolha a opção Modify.
•	 Na caixa de diálogo que se abre, vá à aba Category e se certifique de 

que a opção seja Mass Properties. Se não for, acione a barra de rolagem 
e escolha essa opção.
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•	 Na aba Define Mass By, acione a barra de rolagem e selecione User 
Input.

•	 Substitua o valor que está na caixa Mass por 0.365, e os valores de Ixx, 
Iyy e Izz por 0, conforme a Figura 2.24a.

•	 No campo Center of Mass Marker, com o botão direito do mouse, apon‑
te até .pendulo_simples.simples.cm, conforme a Figura 2.24b e selecio‑
ne Modify. Na caixa Location, preencha de acordo com a Figura 2.24c. 
Repare que, se clicar sobre o Apply, aparecerá uma tela de Warning o 
alertando da modificação do centro de massa.

•	 Pressione Ok nas duas caixas de diálogo.

(a)

(b)
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(c)

Figura 2.24 –  
(a) tela representativa da modificação 
de massa do pêndulo simples; (b) 
tela representativa da modificação do 
marker do centro de massa do link 
para a extremidade inferior; (c) tela 
representativa da coordenada de alte‑
ração do centro de massa.

Etapa 7 – Inserindo uma junta no ponto de origem do pêndulo
Nesta Etapa, será criada uma restrição entre o link do pêndulo e o ground 

part. A restrição será do tipo junta revoluta tratada em 1.3.3.1a.
•	 Escolha o ícone referente a essa junta  no menu Main Toolbox.
•	 Preencha as abas referentes a essa junta da seguinte maneira: Cons‑

truction opção 1 Location e, em seguida, na aba logo abaixo, Normal 
to Grid, Figura 2.8a. Neste caso, ao fornecer a posição de inserção, o 
ADAMS/View automaticamente selecionará as partes necessárias para 
inserção da restrição, no caso o link e o ground part. O marker a ser 
escolhido é o simples.MARKER_1, conforme a Figura 2.25.
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Figura 2.25 – �Marcação do ponto de inserção da 
junta revoluta.

Etapa 8 – Alterando o nome da restrição/junta
•	 Clique com o botão direito do mouse na região próxima à junta inserida 

na Etapa 7.
•	 Selecione JOINT_1.
•	 Avance com o cursor até a seta ao final da opção, e ela irá se expandir.
•	 Em seguida, escolha a opção Rename. A caixa de diálogo ativa deve ser 

alterada conforme a Figura 2.26.

Figura 2.26 – �Tela ativa para renomear 
a junta revoluta.

Etapa 9 – Estabelecendo medidas no pêndulo simples
Nesta Etapa, serão estabelecidas os tipos de medidas que se irá determinar 

no modelo virtual. Para tanto,
•	 Clique com o botão direito do mouse na região próxima à junta inserida 

na Etapa 7.
•	 Selecione Joint: pivot.
•	 Avance com o cursor na direção da seta ao final da opção para expandi‑la.
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•	 Selecione a opção Measure.
•	 Preencha a caixa de diálogo conforme a Figura 2.27.
•	 Clique em Apply. Esta opção irá fazer com que apareça uma tela auxi‑

liar de nome pivot_MEA_1. Não feche a tela, pois será nela que apare‑
cerão os resultados requeridos sobre o pêndulo.

•	 Para finalizar, clique em Cancel. Se clicar em Ok uma nova tela idêntica 
à anterior irá aparecer.

Figura 2.27 – �Tela ilustrativa da escolha do tipo 
de medida a realizar.

Etapa 10 – Criando um marker
Nesta Etapa, serão inseridos markers em pontos chaves da geometria sólida.
•	 No menu Main Toolbox, acione o ícone  com o botão direito do 

mouse.
•	 Escolha o ícone 	
   , referente à opção Construction Geomety: Marker.
•	 Preencha as abas que aparecerem na parte inferior do menu Main Tool‑

box, conforme ilustrado na Figura 2.28.
•	 Posicione este marker na coordenada (0,–300,0). Para identificá‑la, re‑

corra à janela Coordinates, acionada com o botão F4. As Figuras 2.29a 
e b ilustram o resultado.
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Figura 2.28 – �Preenchimento de tela referente à inserção de um marker.

(a) (b)

Figura 2.29 – �(a) tela e inserção do marker com auxílio da função Coordinates;  
(b) resultado final com marker ao centro da geometria esfera.

Etapa 11 – Alterando o nome do marker
Nesta Etapa, o marker criado na Etapa 10 terá seu nome alterado de 

MARKER_6 para ponto_ref. Para tanto,
•	 Selecione o marker criado.
•	 Escolha na opção Part: ground o marker denominado MARKER_6 e 

direcione o cursor até o final da opção para que ela se expanda.
•	 Escolha a opção Rename.
•	 Digite na aba New Name, o novo nome “ponto_ref”.
•	 Acione a tecla Apply.
•	 Em seguida Ok.
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Etapa 12 – �Estabelecendo a medida de ângulos do pêndulo simples 
durante a trajetória

•	 Vá ao menu principal opção Build → Measure → Angle → New.
Na caixa de diálogo acionado, demandam‑se as seguintes informações: First 

Marker, Middle Marker e Last Marker, Figura 2.30a.
•	 Na primeira aba, First Marker, selecione com a ajuda do botão direito 

do mouse a opção Marker. Nesta aba, constará o marker correspon‑
dente à extremidade inferior do pêndulo. Seu nome é .simples. MA‑
RKER_2, Figura 2.30b.

•	 Na segunda aba, Middle Marker, selecione, operando da mesma forma, 
o marker da extremidade oposta onde se tem a junta. O nome da geo‑
metria é simples.MARKER_1,, Figura 2.30b.

•	 Para a última aba, selecione, operando da mesma forma, o marker cria‑
do na Etapa anterior de nome pont_ref, Figura 2.30b.

•	 Clique em Ok.
Para o usuário, a seleção desses markers pode ser feita pressionando‑se o 

botão direito do mouse sobre a aba ativa e escolhendo a opção Pick ou Browse.
Uma nova tabela de registro de medidas se apresenta com o nome de MEA_

ANGLE_1. Não feche a tela, pois será nela que aparecerão os resultados requeri‑
dos pelo usuário sobre o pêndulo.

•	 Para finalizar, clique em Cancel. Se clicar em Ok, uma nova tela idêntica 
à anterior irá aparecer.

A Figura 2.30 ilustra as telas referentes às operações descritas aqui.

(a) (b)

Figura 2.30 – �(a) tela representativa da inserção de medidas antes do preenchimento;  
(b) tela final após preenchimento.
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Etapa 13 – Definindo a posição inicial para o movimento do pêndulo simples
Esta Etapa definirá a posição inicial do pêndulo simples para realização do 

movimento harmônico. Para tanto,
•	 Clique com o botão direito do mouse sobre a junta revoluta inserida na 

Etapa 7.
•	 Selecione a opção Joint:pivot.
•	 Arraste o cursor na direção da seta situada ao final da opção. Novas 

opções são apresentadas.
•	 Selecione a opção Modify.
•	 Na caixa de diálogo Modify Joint, selecione a opção Initial Condi‑

tions…, conforme ilustra a Figura 2.31a. Todas as outras abas permane‑
cem com os valores default.

•	 Clique sobre a opção e uma nova caixa de diálogo se apresentará.
•	 Ative a opção Rot. Displ. (Rotational Displacement) por meio de um 

tick no quadrado ao lado.
•	 Preencha a aba cinza lateral com o valor de –10º, Figura 2.31b.

Etapa 14 – Verificação do modelo
Esta Etapa se destina à análise do modelo antes que este seja submetido à 

simulação. Para tanto,
•	 Clique no ícone  com o botão direito do mouse. Este ícone se situa no 

canto inferior direito da tela do ADAMS/View.

•	 Escolha a opção  . Ela verifica o modelo, fornece o número de partes 
e informa o número de graus de liberdade.

•	 Feche a tela correspondente se a mensagem ao final for Model verified 
successfully.

O usuário irá perceber que, ao final dessa Etapa, aparecerá uma tela auxi‑
liar de nome Message Window. A mensagem é a seguinte: WARNING: Initial 
condition specified on JOINT pendulo_simples.pivot differs from the input 
configuration specified in the data set by – 10.0 degrees. A advertência se deve ao 
fato de terem‑se alterado as condições iniciais do sistema a partir da fixação de 
um ângulo de inclinação inicial de –10º. Clique em close.
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(a) (b)

Figura 2.31 – (�a) tela Modify Joint contendo a opção Initial Conditions;  
(b) tela auxiliar ligada à opção Initial Conditions

Etapa 15 – Efetuando a simulação do modelo virtual proposto
•	 Vá ao menu principal Main Toolbox e selecione o ícone  , tratado no 

item 1.3.4, com um simples clique sobre ele.
•	 Preencha as abas que aparecem na parte inferior do menu Main Tool‑

box, conforme mostrado na Figura 2.32a.
•	 Em seguida, clique no botão Play  . As telas pivot_MEA_1 e MEA_

ANGLE_1 serão preenchidas, conforme a Figura 2.32b.
•	 Repare que, na Figura 2.32a, para tornar ativa a opção Duration é ne‑

cessário ativar a barra de rolagem e a escolher, pois o valor default é 
End Time.
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(a)

(b)

(c)

Figura 2.32 – (a) tela ilustrativa da simulação;  
(b) e (c) telas auxiliares, preenchidas após execução do comando.

Etapa 16 – Determinação da força sobre o ponto de inserção da junta
Para a realização desta Etapa, será necessário recorrer ao ADAMS/

PostProcessor, tratado em 1.4.
•	 Clique com o botão direito do mouse em qualquer ponto da área do 

gráfico pivot_MEA_1.
•	 Aparecerá então a opção Plot:scht1.
•	 Expanda e selecione a opção Transfer to full plot. Nesse momento, você 

migrará para o módulo ADAMS/PostProcessor.
•	 No menu principal desse módulo, selecione a opção Plot Tracking re‑

presentada pelo seguinte ícone  . Isso permitira rastrear os valores de 
Força x Tempo ao longo da curva.

A Figura 2.12 mostra a aparência dessa janela.
Pressione a tecla F8 para retornar ao módulo ADAMS/View.

A notar: a figura mostrada a seguir traz as forças atuantes no mecanismo de pêndulo 
simples que são a tração no fio “T” e a força peso “P” que se decompõe segundo duas 
componentes.

P P cosn q= e P Psent q=
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Fonte ilustração:Universidad del País Vasco. Disponível em: <http://www.sc.ehu.es/sbweb/fisica/
dinamica/trabajo/pendulo/pendulo.htm>. Acesso em:11/12/2012
O equilíbrio na direção normal leva a Pn = T que fornece o valor da tração no fio e, 
consequentemente, a força no ponto de apoio (junta revoluta). Então, analiticamente, 
na posição x = 0, coincidente com o eixo vertical, a força é igual a 3,51N, considerando 
m = 0,365 kg, g = 9,81 m/s2 e cos(–10º) = 0,98. Pela simulação numérica, este valor no 
mesmo ponto foi igual a 3,47 N, ou seja, bem próximo.
A curva que descreve o movimento harmônico do pêndulo na direção y gerado 
pelo ADAMS/PostProcessor é a mostrada a seguir. Cabe ressaltar que o movimento 
harmônico só se confirma no pêndulo se os ângulos considerados forem pequenos.

Ainda da avaliação de forças, nota‑se que a única força responsável pelo movimento 
oscilatório é F Psent q= .
O período de oscilação T é o tempo necessário para a massa passar duas vezes consecutivas 
pelo mesmo ponto, movendo‑se na mesma direção, isto é, o tempo que a massa leva 
para sair de um ponto e voltar ao mesmo ponto percorrendo o mesmo arco. O pêndulo 
descreve uma trajetória circular um arco de circunferência de raio L. Um pêndulo simples 
é formalmente equivalente a um oscilador linear. Pode afirmar então que:
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T L g2 ( / )0,5p=
onde L é o comprimento da haste de 0,30 m, no caso T = 1,10 s, enquanto a frequência 
é de 0,91 Hz. Portanto a aceleração da gravidade é dada por g L T(4 ) /2 2p= .

Etapa 17 – Determinação da aceleração da gravidade
Nesta Etapa a aceleração da gravidade será determinada a partir do período 

de oscilação do pêndulo simples. Os dados referentes ao período são calculados 
pelo ADAMS/View no marker criado na Etapa 10. Para tanto,

•	 Feche a janela de medidas pivot_MEA_1.
•	 No menu principal Main Toolbox, selecione o ícone  , tratado no item 

1.3.4, com um simples clique sobre ele.
•	 Preencha as abas que aparecem na parte inferior do menu Main Tool‑

box, conforme mostrado na Figura 2.33.

Figura 2.33 – �Tela ilustrativa dos campos de preenchimento para simulação 
para obtenção do período.

Em seguida, clique no botão Play  . Nesse instante, a simulação será efe‑
tuada e aparecerá a seguinte tela, conforme a Figura 2.34.

Figura 2.34 – �Tela ilustrativa da simulação de 
obtenção do período.
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O usuário irá perceber que, ao final dessa Etapa, aparecerá uma tela auxiliar 
de nome Message Window. A mensagem é a seguinte: WARNING: Initial condi‑
tion specified on JOINT pendulo_simples.pivot differs from the input configura‑
tion specified in the data set by – 10.0 degrees. A advertência se deve ao fato de 
ter‑se alterado as condições iniciais do sistema a partir da fixação de um ângulo 
de inclinação inicial de –10º. Clique em close.

•	 Clique com o botão direito do mouse em qualquer ponto da área do 
gráfico MEA_ANGLE_1.

•	 Aparecerá então a opção Plot:scht1.
•	 Expanda e selecione a opção Transfer to full plot. Nesse momento, você 

migrará para o módulo ADAMS/PostProcessor. A Figura 2.35 ilustra o 
gráfico do período obtido.

Figura 2.35 – �Tela ilustrativa da simulação de obtenção 
do período no módulo ADAMS/PosProcessor.

•	 No menu principal desse módulo, selecione a opção Plot Tracking, re‑
presentada pelo seguinte ícone   . Isto possibilitará, ao usuário, ras‑
trear os valores de Ângulo x Tempo, ao longo da curva. A Figura 2.36 
mostra o tempo que o pêndulo leva para percorrer a distância corres‑
pondente a dois picos da curva, o que fornece o período.
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Figura 2.36 – �Tela ilustrativa da simulação de obtenção do período no módulo  
ADAMS/PosProcessor, destacando o ponto de obtenção do período X = 1.1 s

Sabendo que g
L

T
(4 )2

2

p
= , sT 1,1=  obtido da Figura 2.36, L= 0,30 m, disto 

tem‑se g = 9,79 m/s2.

Etapa 18 – Salvando o modelo virtual
Após finalizar a simulação, o usuário deverá salvar seu trabalho, procedendo 

da seguinte maneira:
•	 Vá ao menu principal do módulo e selecione a opção File.
•	 Clique sobre ela e a faça expandir.
•	 Escolha a opção Save Database as…
•	 Clique sobre ela, e uma tela irá se abrir, conforme a Figura 2.13.
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3
C
A
PÍTU

LO

Módulo ADAMS/View com 
aplicação em mecanismos 
automotivos

Ao fim deste tutorial, o usuário estará apto a modelar e simular dois meca‑
nismos clássicos utilizados na área automotiva: o primeirocame‑seguidor, e o se‑
gundo corresponde ao um comando válvulas composto por uma came, seguidor, 
balancim e válvula. Este último é comumente conhecido como valvetrain.

3.1.	 Desenvolvimento do mecanismo came‑seguidor utilizando o módulo 
ADAMS/View

Este item tem como finalidade modelar um mecanismo came‑seguidor. À 
came será imposta uma rotação de 360°/s. O deslocamento imposto pela came ao 
seguidor, bem como a velocidade e aceleração deste serão determinados por meio 
de uma simulação cinemática. A Figura 3.1 ilustra o mecanismo a ser obtido ao 
final deste tópico.
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Came

A notar: A came é um elemento no qual sua superfície externa possui um formato 
especial, comumente designada por um excêntrico, isto é, essa superfície possui uma 
excentricidade que produz movimento em um segundo elemento denominado seguidor. 
Dessa maneira, a partir de sua rotação em torno de um eixo fixo, ela transmite um 
movimento de translação alternado ou variável a um segundo elemento denominado 
seguidor. As cames possuem diversas aplicações tais como: máquinas operatrizes, 
máquinas têxteis, armas automáticas, motores térmicos e comandos de válvulas.

Considera‑se essa modelagem como requisito fundamental para que o usuá‑
rio possa avançar para o tópico seguinte, visto que a came é parte integrante do 
mecanismo valvetrain.

Fonte: Popular Hot Rodding. Fonte: Hub Pages. Fonte: Wikimedia Commons.

Figura 3.1 – �Mecanismo virtual a ser 
obtido: came-seguidor.
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Etapa 1 – Inicializando o ADAMS/View
•	 Ao inicializar o módulo do ADAMS/View escolha a opção Create a new 

model.
•	 Especifique o diretório em que o modelo (database) será gravado no 

campo Start in. Você poderá digitar o caminho ou utilizar o ícone na 
lateral desse campo (pasta amarela).

•	 Em seguida, atribua um nome ao modelo virtual, preenchendo a aba 
Model name. Nesse caso, denominamos de came. É importante ressaltar 
que o nome do modelo não deve conter caracteres especiais, como acen‑
tos gráficos, símbolos, formas etc.

•	 Os campos Gravity e Units não devem ser alterados, conforme mostra‑
dos na Figura 3.2.

A Figura 3.2 ilustra esta etapa.

Etapa 2 – Configurando a área de trabalho
•	 Para melhor visualização do mecanismo durante a modelagem altere o 

espaçamento do grid do fundo de trabalho para 10 mm. No menu principal 
clique em Settings Working Grid. No campo Spacing digite (10 mm) tanto 
no campo X quanto em Y, conforme ilustrado na Figura 3.3.

Figura 3.2 – Configuração inicial.
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Etapa 3 – Construção da came
Nesta etapa, será modelada a geratriz da came. Para isto, será utilizada a fer‑

ramenta spline. Antes de iniciar a construção da came, sugere‑se aplicar um zoom 
+ na área onde será contruída a geratriz, compreendendo a área próxima a origem 
no sentido negativo de Y. Isto facilitará a marcação de pontos para definição da 
superfície da peça.

Aconselha‑se também ativar a caixa de diálogo Coordinates para que as 
coordenadas dos pontos do grid sejam exibidos facilitando, portanto, a constru‑
ção da spline. Para isso posicione o mouse na área de trabalho e ative a função F4 
no teclado do seu computador.

A Figura 3.4 mostra a área de trabalho após o zoom + e com a caixa de diá‑
logo Coordinates.

Figura 3.3 – �Alterando o espaçamento do 
grid na área de trabalho.

Figura 3.4 – Área de trabalho pronta para construção da spline.
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•	 Na caixa de diálogo Main Toolbox, clique com o botão direito do mou‑
se sobre o ícone .

•	 Dentre as opções exibidas, clique com o botão esquerdo no ícone  
(Construction Geometry: Spline).

•	 Na parte inferior dessa caixa de diálogo, selecione, no primeiro cam‑
po, a opção New Part. Ative a opção Closed. E, no campo Create by 
picking, selecione Points (Figura 3.5).

Dessa forma, a geratriz da came será criada, clicando‑se nos pontos de inte‑
resse na área de trabalho com o botão esquerdo do mouse. Na Tabela 3.1 estão 
apresentadas as coordenadas em x e y desses pontos (denominados de hot points). 
A coordenada z será nula para todos os pontos. Note nesta tabela que o primeiro 
e último ponto possuem a mesma coordenada, de modo a fechar a curva gerada.

•	 Clique com o botão esquerdo do mouse nos 13 pontos, e finalize a peça 
clicando com o botão direito do mouse. Uma caixa de diálogo aparece‑
rá, alertando que a geometria (PART) não tem massa. Feche essa caixa 
de diálogo.

Obs.: Note que, ao ativar uma opção da caixa de diálogo Main Toolbox, o 
software indica, no canto inferior esquerdo, as etapas a serem realizadas para a 
opção selecionada.

A Figura 3.6 ilustra a geometria resultante. Caso sua geometria não esteja 
de acordo com a mostrada nessa figura, esta pode ser alterada clicando sobre o 
hot point (quadrados na cor pink ao longo da superfície) e arrastado este para a 
posição desejada.

Figura 3.5 - Configurando a Spline.
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Tabela 3.1 – Pontos para construção da Spline fechada

Pontos X (mm) Y (mm)
1 0 0
2 -50 -30
3 -70 -70
4 -80 -120
5 -70 -160
6 -50 -180
7 0 -190
8 50 -180
9 70 -160
10 80 -120
11 70 -70
12 50 -30
13 0 0

Figura 3.6 – Came.

Etapa 4 – Inserindo a junta de rotação
Nesta etapa será inserida uma junta do tipo revolute, a qual permite apenas 

rotação da came em torno de um eixo normal à área de trabalho.
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Junta “Revolute”

A notar: A junta do tipo “revolute” permite a rotação de um corpo (PART) em 
relação a outro em torno de um eixo comum aos dois. A junta pode ser localizada em 
qualquer posição desse eixo. A orientação dessa junta define a direção do eixo ao qual 
os corpos irão rotacionar. Já o eixo de rotação desta é paralelo ao vetor de orientação 
e este passa pela localização atribuída.

Na caixa de diálogo Main Toolbox clique com o botão direito do mouse so‑
bre o ícone  e então selecione com o botão esquerdo a junta  Joint Revolute.

Na parte inferior desta caixa de diálogo selecione no primeiro campo a op‑
ção 1 Location e no segundo campo a opção Normal To Grid, conforme a Figura 
3.7(a).

Com o cursor do mouse, aponte para o ponto com coordenada (0, – 130, 0) 
e clique uma vez com o botão esquerdo do mouse. A junta será criada neste ponto 
como ilustrada na Figura 3.7(b).

Figura 3.7(a) –  
Parâmetros defini‑
dos para a junta.

Figura 3.7(b) – 
Junta de rotação 
construída.

Exemplo de junta Revolute.
Fonte: ADAMS View help.
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Etapa 5 – Construção do seguidor
•	 Nesta etapa, será construído o seguidor que compõe o mecanismo em 

questão, utilizando novamente a ferramenta spline, porém com carac‑
terística aberta.

•	 Na caixa de diálogo Main Toolbox, clique com o botão esquerdo do 
mouse na opção Spline .	
  .

•	 Na parte inferior dessa caixa de diálogo, desative a opção Closed, con‑
forme ilustrado na Figura 3.8. Os demais campos permanecem sem 
alteração. 

Figura 3.8 – Parâmetros definidos para a Spline do seguidor.

•	 Com o botão esquerdo do mouse, clique nas coordenadas descritas na 
Tabela 3.2. Ressalta‑se novamente que a coordenada em z é nula. Para 
finalizar a construção da curva, após selecionar o último ponto, clique 
com o botão direito do mouse. A Figura3.9 ilustra a curva resultante 
(em verde).

Uma caixa de diálogo aparecerá alertando que a PART criada não tem mas‑
sa. Feche essa caixa de diálogo.

Tabela 3.2 – Pontos para criação da Spline aberta

Pontos X [mm] Y [mm]
1 ‑250 50
2 ‑200 40
3 ‑150 40
4 ‑100 30
5 ‑50 10
6 0 0
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Pontos X [mm] Y [mm]
7 50 10
8 100 30
9 150 40

10 200 40
11 250 50

•	 Na caixa de diálogo Main Toolbox, clique com o botão direito do mou‑
se sobre o ícone .	
  , para que as demais opções de construção de geome‑
tria sejam exibidas.

Figura 3.9 – Spline construída.

•	 Clique sobre o ícone  	
   (Rigid Body: Box), conforme ilustrado na Fi‑
gura 3.10(a).

•	 Na parte inferior da caixa de diálogo Main Toolbox, selecione, no pri‑
meiro campo, a opção Add to Part, pois assim esta caixa petencerá ao 
PART já criado e definido pela spline aberta. Os demais campos deverão 
ser mantidos desativados, conforme ilustrado na Figura 3.10(b).

•	 Clique sobre a spline aberta, informando que o PART, neste caso o box, 
a ser construído pertencerá a ela.

•	 Para definir a dimensão do box, clique no ponto (‑250, 50, 0) locali‑
zado na extremidade esquerda da spline. Mantenha o mouse apertado 
e arraste até a ponto localizado na coordenada (250, 180, 0). A geo‑
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metria resultante é o que denominamos de seguidor e está ilustrada na 
Figura 3.11.

Figura 3.10(a) –  
Selecionando a ferra‑
menta para construção 
do box.

Figura 3.10(b) –  
Parâmetros de cons‑
trução do box.

Figura 3.11 – Geometria do seguidor (em verde).

Etapa 6 – Inserindo a junta de translação
O seguidor se movimentará segundo o perfil da came na direção vertical, ou 

seja, ao longo do eixo Y, sendo necessário atribuir uma junta de translação a esse 
seguidor.
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Junta “Translational”

A notar: A junta “translational” permite a translação de um corpo (PART) em 
relação a outro, ao longo de uma direção definida por um vetor. Nenhum corpo pode 
rotacionar em relação ao outro. Para criar a junta de translação é necessário especificar 
a localização e orientação desta. A localização da junta não afeta o movimento, 
ela simplesmente informa onde o software irá localizá‑la. Contudo, a orientação 
determina a direção do eixo ao longo do qual os corpos irão transladar com relação 
ao outro. A direção do movimento da junta é paralela ao vetor de orientação, e passa 
pela localização atribuída.

•	 Na caixa de diálogo Main Toolbox, clique com o botão direito do mouse 
no ícone  . 	
  . Clique no ícone ,	
  , selecionando uma junta de translação 
(Joint: Translational), conforme ilustrado na Figura 3.12(a).

•	 Na parte inferior dessa caixa de diálogo, selecione no primeiro campo 
a opção 1 Location e no segundo campo Pick Feature (Figura 3.12(b)).

Exemplo de junta Translational.

Fonte: ADAMS View help.

Figura 3.12(a)-  
Selecionando a junta 
de translação

Figura 3.12 (b) -  
Parâmetros de cons‑
trução da junta de 
translação.
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Figura 3.14 – Junta de translação construída.

•	 O próximo passo é selecionar a coordenada onde a junta será locazida. 
Para facilitar a seleção desse ponto, sugere‑se rotacionar levemente a 
peça, conforme ilustrado na Figura 3.13, uma vez que o box construído 
compreende um volume. E, então, selecione o ponto localizado na coor‑
denada (0,160,0). Lembre‑se sempre de deixar ativa a caixa de diálogo 
Coordinates, de modo a ajudar na localização dos pontos.

•	 Mova o cursor do mouse na direção vertical no sentido positivo de Y 
até que uma seta seja mostrada, conforme ilustrado na Figura 3.13. 
Clique com o botão esquerdo do mouse para que ele defina a direção de 
translação da junta. Na Figura 3.14 está mostrada a junta construída.

Figura 3.13 – �Peça levemente rota‑
cionada e o sentido de 
translação da junta

Etapa 7 – Definindo o contato entre came e seguidor
Sugere‑se que, antes de prosseguir nesta etapa, o usuário retorne a visualiza‑

ção do mecanismo para a vista frontal, clicando com o botão direito do mouse 
sobre a área de trabalho e selecionando a opção Front.

Nesta etapa, será definido o contato entre as duas peças: a came e o seguidor, 
para que, assim o movimento translação resultante da rotação da came possa ser 
transmitido ao seguidor.
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Contato tipo “2D curve‑curve constraint”

A notar: O contato tipo “2D curve‑curve constraint ou ainda definido como No lift
‑off restringe uma curva definida no primeiro corpo a permanecer em contato com 
uma segunda curva definida no segundo corpo. Esse tipo de restrição possui aplicação 
direta na modelagem de cames onde o ponto de contato entre os dois corpos muda 
durante o movimento do mecanismo. Esse tipo de restrição elimina três graus de 
liberdade do modelo. As duas curvas selecionadas precisam estar necessariamente no 
mesmo plano. Durante a simulação, ambas as curvas estarão sempre em contato.

•	 Na caixa de diálogo Main Toolbox, clique no ícone  	
   com o botão 
direito do mouse. Selecione a opção   	
   (2D curve‑curve constraint), con‑
forme ilustrado na Figura 3.15(a).

•	 Na parte inferior dessa caixa de diálogo, certifique‑se de que, nos dois 
campos, estejam selecionadas as opções Curve (Figura 3.15(b)).

Exemplo de contato Curve‑Curve.

Fonte: ADAMS View help.

Figura 3.15(a) – 
Selecionando o tipo 
de contato.

Figura 3.15(b) - 
Configurações do contato.
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Etapa 8 – Definindo a velocidade de rotação da came
Nesta etapa será imposta uma velocidade de rotação à came.
•	 Na caixa de diálogo Main Toolbox clique no ícone  (Rotational Joint 

Motion).
•	 Na parte inferior desta caixa de diálogo, defina a velocidade de rotação 

no campo Speed como sendo 360d (onde d se refere a degrees), a qual 
corresponde a 360°/s (Figura 3.17).

Figura 3.17 – Definindo a velocidade de rotação da came.

•	 O próximo passo é informar onde ocorrerão os contatos. Clique pri‑
meiramente na curva da came (spline fechada) e em selecione na cur‑
va do seguidor (spline fechada). O resultado dessa operação pode ser 
visualizado na Figura 3.16.

Figura 3.16 – �Definição do contato entre 
came e seguidor.
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•	 O próximo passo é informar em que ponto essa velocidade será aplica‑
da. Para isso, clique sobre a junta de rotação (revolute joint) a qual foi 
definida na came (Figura 3.18(a)). A Figura 3.18(b) ilustra o resultado 
desta etapa.

Figura 3.18(a) – 
Junta na qual a 
velocidade será 
imposta.

Figura 3.18(b) – 
Velocidade de 
rotação definida.

Etapa 9 – Verificação do modelo
Nesta etapa será verificado se o modelo foi construído adequadamente. O 

software verifica se há erros de construção e avisa sobre possíveis erros de mode‑
lagem.

•	 Clique com o botão direito do mouse no ícone , localizado no canto 
inferior direito da tela, e selecione o ícone .

•	 Uma janela com as informações do modelo aparecerá, conforme mos‑
trado na Figura 3.19. Analise as informações exibidas e feche a janela 
clicando em Close.

Figura 3.19 – Verificação do modelo.
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Figura 3.20(a) – Selecionando o seguidor. Figura 3.20(b) – �Criando janela gráfica para o 
deslocamento do seguidor.

Etapa 10 – Simulação
Nesta etapa o mecanismo modelado será simulado numericamente a fim de 

obter‑se o deslocamento, velocidade e aceleração do dentro de massa da came.

Etapa 10.1 – Definindo as variáveis de saída da simulação
Nesta etapa, serão definidas as variáveis de interesse na simulação, ou seja, 

as variáveis de saída do modelo. Neste caso, serão: deslocamento, velocidade e 
aceleração no centro de massa do seguidor.

•	 Clique com o botão direito do mouse sobre a geometria do seguidor. 
Uma caixa de diálogo aparecerá. Selecione a PART correspondente ao 
seguidor e então selecione a opção Measure, conforme ilustrado na Fi‑
gura 3.20(a).

•	 Uma nova caixa de diálogo denominada Part Measure abrirá (Figura 
3.20(b)).

•	 No campo Measure Name modifique o nome para desloc_CM. Observe 
que apenas o texto final pode ser alterado (após o ponto “.”).

•	 No campo Characteristic selecione a opção CM position.
•	 No campo Component selecione a opção Y.
•	 Clique em Apply. Uma janela gráfica se abrirá onde o gráfico da variável 

em questão será exibido, após a simulação.
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•	 O próximo passo é criar uma janela gráfica para mostrar a variação da 
velocidade do seguidor. Ainda na caixa de diálogo Part Measure, altere 
o Measure Name para “veloc_CM”. No campo Characteristic selecione 
a opção CM velocity. No campo Component mantenha selecionada a 
opção Y (Figura 3.21). Clique em Apply.

Uma nova janela gráfica se abrirá na área de trabalho.

Figura 3.21 – �Criando janela gráfica para a velocida‑
de do seguidor.

•	 Para finalizar, o próximo passo é criar a janela para mostrar a variação 
da aceleração do seguidor. Na caixa de diálogo Part Measure, altere o 
Measure Name para “accel_CM”. No campo Characteristic selecione a 
opção CM acceleration. No campo Component mantenha selecionada a 
opção Y (Figura 3.22). Clique em OK.

Figura 3.22 – �Criando janela gráfica para a 
aceleração do seguidor.
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Etapa 10. 2 – Simulação e visualização dos resultados
•	 Na caixa de diálogo Main Toolbox, clique no ícone  (Interactive Si‑

mulation Control).
•	 Na parte inferior desta caixa de diálogo, preencha os campos, conforme 

ilustrado na Figura 3.24(a). O parâmetro End Time é definido como 1.0 
e o parâmetro Steps é igual a 50.

•	 Para executar a simulação, clique no ícone  dessa caixa de diálogo.
Durante a simulação pode‑se observar o movimento do mecanismo e a gera‑

ção dos gráficos previamente definidos (Figura 3.24(b)).

Figura 3.23 – �Janelas gráficas para visualização do deslocamento, 
velocidade e aceleração do seguidor.

Na Figura 3.23 estão mostradas as três janelas gráficas criadas nesta etapa.
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Para manipular os resultados gráficos obtidos, sugere‑se a ativação do mó‑
dulo ADAMS/PostProcessor. Nesse módulo, será possível visualizar as três curvas 
simultaneamente em um só gráfico, facilitando sua análise.

•	 Clique, com o botão direito do mouse, sobre a janela gráfica do desloca‑
mento (desloc_CM). Selecione a opção Transfer To Full Plot, conforme 
a Figura 3.25. O módulo do ADAMS/PostProcessor se abrirá em uma 
nova janela.

Figura 3.24(a) –  
Parâmetros da simulação.

Figura 3.24(b) – 
Gráficos gerados 
na simulação.

Figura 3.25 – �Ativação do módulo 
ADAMS/PostProcessor.
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•	 O mesmo procedimento pode ser repetido para inserir, neste gráfico, a 
curva da velocidade. Para isso clique sobre o texto veloc_CM no campo 
Result Set (observe que há uma barra de rolagem nesse campo, indi‑
cando que há mais parâmetros do que os exibidos na tela). No campo 
Component, selecione a opção Q. Clique em Add Curves. O gráfico 
resultante está mostrado na Figura 3.27.

Figura 3.26 – Visualização de duas curvas no mesmo gráfico.

•	 Para exibir a curva da aceleração neste mesmo gráfico clique sobre o 
texto accel_CM, no campo Result Set. No campo Component, selecione 
a opção Q. Clique em Add Curves, conforme mostrado na Figura 3.26.
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Neste módulo estão disponíveis várias opções, visando tratar os resultados 
obtidos, cabendo ao usuário sua exploração.

Para retornar à área de trabalho do ADAMS/View, feche a janela do ADAMS/
PostProcessor.

3.2.	 Desenvolvimento do mecanismo valvetrain, utilizando  
o módulo ADAMS/View

Este tópico tem por finalidade a modelagem e simulação de um mecanismo 
denominado comando de válvula, comumente conhecido por valvetrain. Este será 
composto pelas seguintes geometrias: came, seguidor, haste do seguidor (Rod), 
balancim (rocker) e válvula. À came, será imposta uma rotação de 360°/s. Como 
resultado, serão obtidos: o deslocamento, a velocidade e a aceleração na válvula, 
alémdo torque na came. A análise desses resultados será apresentada. A Figura 
3.28 ilustra o mecanismo a ser obtido ao final deste item.

Figura 3.27 – Visualização de todos os resultados em um mesmo gráfico.
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Obtenha as coordenadas cartesianas das partes mostradas na Figura 3.28 no 
link: http://www.blucher.com.br/materiaisdeapoio/mscadams/dados_valvetrain.zip

Comando de válvula (Valvetrain)

A notar: O comando de válvulas comanda as válvulas de admissão e as válvulas de 
escapamento do cabeçote do motor, por meio das cames (lóbulos ou ressaltos). Esse 
comando pode ser definido simplesmente como uma roda excêntrica montada em um 
eixo que converte movimento rotatório em movimento linear. As cames são as partes 
mais importantes do eixo de comando, pois são os responsáveis pelo acionamento das 
válvulas do cabeçote. O perfil da came determina as cotas de abertura e fechamento 
dessas válvulas. Além do comando, existe todo o resto do conjunto do cabeçote, ou 
seja, válvula, mola, balancim, vareta ou haste e seguidor. O comando de válvulas 
é conectado ao virabrequim pela corrente de comando, engrenagens ou correia 
dentada (mais comum em motores de alto desempenho). O projeto desse mecanismo 
é altamente sensível e diretamente impactante no desempenho do automóvel, sendo, 
portanto, de extrema viabilidade seu estudo por meio da modelagem virtual

Figura 3.28 – Modelo virtual do mecanismo valvetrain.

Fonte: Advanced Actuators Research 
Group of University of South Carolina.
Fonte: Second Chance Garage. Disponível 
em: <http://www.secondchancegarage.com
/public/156.cfm>. Acesso em:15/12/2012
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Etapa 1 – Iniciando o ADAMS/View
•	 Inicialize o módulo ADAMS/View e selecione a opção Create a new 

model.
•	 No campo Start in, especifique o diretório no qual seu modelo será sal‑

vo.
•	 No campo Model name, insira o nome do seu modelo, nesse caso, 

Valvetrain.
•	 Mantenha os demais campos inalterados, conforme ilustrado na Figura 

3.29.

Figura 3.29 –
Tela de abertura.

Etapa 2 – Alterando as unidades de medidas
Em virtude do fato de o modelo ter dimensões pequenas, sugere‑se alterar o 

sistema de unidades de modo a facilitar a visualização do mecanismo durante a 
modelagem.

•	 No menu principal, selecione Settings e, em seguida, Units, conforme a 
Figura 3.30(a).

•	 Uma caixa de diálogo, denominada Units Settings, será aberta e seus 
campos deverão ser selecionados, conforme ilustrado na Figura 3.30(b).
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Figura3.30(a) –
Configurando 
unidades.

Figura 3.31(a) – 
Selecionando 
Spline.

Figura 3.30(b) – 
Unidades definidas

Figura 3.31(a) – 
Parâmetros da  
Spline.

Etapa 3 – Modelagem do balancim
•	 Na caixa de diálogo Main Toolbox, selecione o ícone ,	
  , com o bo‑

tão direito do mouse, e, em seguida, selecione o ícone  	
   (Construction 
Geometry: Spline), com o botão esquerdo do mouse, conforme a Figura 
3.31(a).

•	 Na parte inferior dessa caixa de diálogo, selecione New Part, no primei‑
ro campo, e ative a opção Closed. No segundo campo, deve ser selecio‑
nada a opção Points, conforme a Figura 3.31(b).
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•	 Clique na área de trabalho (pontos do grid) em oito pontos, de forma 
aleatória, de modo a construir uma spline fechada. Lembre‑se que o pri‑
meiro ponto e o último devem ser os mesmos. Para finalizar, clique com 
o botão direito do mouse. Uma caixa de diálogo se abrirá alertando que 
a spline não tem massa. Feche essa janela.

Observe que o software recomenda (no canto inferior esquerdo da área de 
trabalho) a seleção de, no mínimo, oito pontos na tela, de forma aleatória.

A Figura 3.32 ilustra a geometria resultante.

Figura 3.32 –  
Spline fechada.

Etapa 3.1 – Definindo o formato externo do balancim
•	 Clique com o botão direito do mouse sobre a geometria construída 

(também denominada de PART).
•	 Selecione a Spline construída, nesse caso, BSpline: GCURVE_1 → modify, 

conforme a Figura 3.33.

Figura 3.33 –  
Modificando a Spline.
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•	 Uma caixa de diálogo Modify Geometric Spline será aberta. No campo 
Values selecione o ícone 	
    	
   (Figura 3.34(a)). Uma nova janela se abrirá 
denominada Location Table (Figura 3.34(b)).

Figura 3.34(a) – �Alterando a posição 
dos pontos da Spline.

Figura 3.34(b) – �Alterando a posição 
dos pontos da  Spline.

Obs.: Existem duas maneiras de modificar a localização dos pontos que de‑
finem a Spline: Importando um arquivo com as coordenadas desses pontos (item 
3.1.1) ou inserindo manualmente (item 3.1.2) de acordo com as tabelas forneci‑
das neste capítulo.

Etapa 3.1.1 – Importando a posição dos pontos da Spline
Nesta etapa, é necessário utilizar um arquivo texto (extensão txt) previamen‑

te editado, com as coordenadas dos pontos que definem a geometria do balancim. 
No arquivo, cada linha corresponde à localização de um ponto nas coordenadas 
x, y e z. Cada coordenada é separa por espaço, gerando, então, três colunas.

•	 Na caixa de diálogo Location Table, selecione a opção Read.
•	 A janela Select File aparecerá, conforme a Figura 3.35.
•	 Selecione o arquivo “balancim.txt” e clique em Abrir.
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Note que a janela “Location Table” será atualizada com as coordenadas x, y 
e z de cada ponto que compõe a spline do balancim. C

•	 Feche as duas janelas, clicando em OK. Clique na área de trabalho para 
que a geometria seja alterada.

Figura 3.35 – Selecionando o arquivo com os pontos do balancim.

Figura 3.36 – �Lista de pontos importados 
do arquivo balancim.txt.
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Etapa 3.1.2 – Modificando manualmente a posição dos pontos da Spline
Outra opção é inserir manualmente as coordenadas dos pontos que com‑

põem a spline do balancim. Para isso, os procedimentos do item 3.1.1 não devem 
ser realizados previamente.

•	 Ao final do item 3.1 a janela Location Table é aberta na área de traba‑
lho, conforme ilustrado na Figura 3.34(b).

•	 No campo Set Selected, digite o número “0”. Selecione todas as células 
da tabela e, então, clique em Set Selected. Dessa maneira, todas as célu‑
las serão preenchidas com o valor zero. Mais linhas podem ser inseridas 
na tabela, selecionando‑se as linhas existentes e clicando em Insert, to‑
talizando 30 linhas.

Selecione cada célula e digite a coordenada do ponto conforme Tabela 3.3.

Tabela 3.3 – Pontos para o rocker

Pontos X Y Z
1 -3.98E-003 -1.20E-002 0.0
2 3.57E-002 -5.81E-003 0.0
3 7.79E-002 1.45E-002 0.0
4 0.1055622831 4.45E-002 0.0
5 0.1274725877 7.29E-002 0.0
6 0.1697598515 7.64E-002 0.0
7 0.1998631059 7.36E-002 0.0
8 0.2290050815 5.83E-002 0.0
9 0.2323774714 3.42E-003 0.0

10 0.2338424834 2.64E-003 0.0
11 0.3640568769 2.72E-002 0.0
12 0.3657645705 3.38E-002 0.0
13 0.3672717487 7.17E-002 0.0
14 0.3578145468 0.1559180655 0.0
15 0.2855237486 0.2313290021 0.0
16 0.2056898364 0.2810098793 0.0
17 0.1241466417 0.3073070066 0.0
18 9.16E-004 0.3158621211 0.0
19 -0.1064987061 0.3023844535 0.0
20 -0.1956887924 0.2715248233 0.0
21 -0.2821637068 0.2256255374 0.0
22 -0.3345648037 0.1873309893 0.0
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Pontos X Y Z

23 -0.3673198097 0.1282151613 0.0
24 -0.3618349064 9.59E-002 0.0
25 -0.3420651281 7.18E-002 0.0
26 -0.3053776919 6.00E-002 0.0
27 -0.1476710471 5.64E-002 0.0
28 -0.1339959806 5.39E-002 0.0
29 -9.62E-002 2.41E-002 0.0
30 -4.63E-002 -6.31E-003 0.0

•	 Clique em OK. A geometria resultante está apresentada na Figura 3.37.

Figura 3.37 – Balancim

Etapa 3.2 – Reposicionando o balancim
A fim de facilitar a construção das demais geometrias o balancim será re‑

posicionado na área de trabalho. O objetivo é posicionar o centro do suporte do 
balancim (peça 5 da Figura 3.28) na origem da coordenada global.

•	 Clique com o botão direito do mouse próximo ao sistema de coordena‑
das, local da spline.

•	 Selecione Marker: MARKER_1 → Modify, conforme ilustrado na Figura 
3.38(a).

Na janela Marker Modify, preencha o campo Location com as coordenadas: 
(4.6011020907E‑003, – 0.1239571525,0.0) conforme a Figura 3.38(b).

Note que a geometria foi deslocada em relação à posição inicial, conforme 
ilustrado na Figura 3.39.
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Etapa 3.3 – Construção da geometria de ligação entre o balancim e a haste
Nesta etapa será construída uma geometria que servirá de ligação entre o ba‑

lancim e a haste, ou seja, a haste será conectada ao balancim por esta geometria.
•	 Na caixa de diálogo Main Toolbox, com o botão direito do mouse, sele‑

cione o ícone  	
   e, então, selecione a opção  	
   (Construction Geometry: 
Arc/Circle), conforme a Figura 3.40(a).

•	 Na parte inferior dessa caixa de diálogo, preencha os campos, conforme 
mostrado na Figura 3.40(b). Antes de iniciar o preenchimento, a op‑
ção Circle deve ser selecionada. No primeiro campo, selecione a opção 

Figura 3.38(a) – �Caminho para modificar a 
posição.

Figura 3.39 – Balancim reposicionado.

Figura 3.38(b) – Preenchimento.
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Add to part. Selecione a opção Radius e digite o raio do círculo a ser 
construído: 4.9067565294E‑002.

Figura 3.40(a) –  
Seleção da geometria 
circle.

Figura 3.40(b) – 
Parâmetros.da 
geometria circle

•	 Selecione o PART ao qual esse círculo pertencerá, nesse caso, clique na 
geometria do balancim.

•	 O próximo passo é informar a localização do centro do círculo. Para 
isso sugere‑se selecionar algum ponto próximo à extremidade esquerda 
do balancim. Essa localização poderá ser aleatória, uma vez que no pró‑
ximo passo será feito o reposicionamento do círculo. Feche a caixa de 
diálogo que se abrirá alertando que a geometria criada não tem massa.

O resultado será similar ao mostrado na Figura 3.41.

Figura 3.41 – Construção do círculo.
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Etapa 3.3.1 – Reposicionamento da geometria de ligação entre o balancim 
e a haste
•	 Com o botão direito do mouse, clique sobre o círculo construído na eta‑

pa anterior. Selecione Marker: MARKER_2 → Modify, conforme ilustra‑
do na Figura 3.42(a).

•	 A caixa de diálogo Marker Modify será aberta. Preencha o campo 
Location, conforme mostrado na Figura 3.42(b).

Figura 3.42(a) – Caminho para modificar Figura 3.42(b) – Parâmetros de preenchimento.

Figura 3.43 – Círculo construído.

A Figura 3.43 ilustra o círculo na posição correta.
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Etapa 3.4 – Construção do eixo do balancim
•	 Na caixa de diálogo Main Toolbox, selecione o ícone  	
   (Construction 

Geometry: Arc/Circle).
•	 Nessa mesma caixa de diálogo, preencha os campos, conforme mostra‑

do na Figura 3.44(a). Observe que esta geometria será adicionada na 
geometria já existente do balancim.

•	 Selecione a geometria à qual pertencerá o círculo a ser contruído, nesse 
caso, o balancim.

•	 Selecione, na área de trabalho, a localização do centro desse círculo, 
que, nesse caso, será a origem do sistema de referência global (0,0,0). 
Fecha a caixa de diálogo que informa a não existência de massa no cír‑
culo criado.

O resultado pode ser observado na Figura 3.44(b).

Figura 3.44(b) – Círculo construído na origem (0,0,0).Figura 3.44(a) – �Construção da 
geometria do 
círculo.

•	 Para construir o eixo, selecione a ferramenta  (Rigid Body:Cylinder) na 
caixa de diálogo Main Toolbox, conforme mostrado na Figura 3.45(a).

•	 Preencha os campos inferiores dessa caixa de diálogo, conforme mos‑
trado na Figura 3.45(b). Note que o cilindro a ser construído terá com‑
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primento e raio igual a 0,2 e 0,1 pés, respectivamente. Vale ressaltar 
também que essa geometria pertencerá ao Ground, conforme pode ser 
observado no primeiro campo.

Figura 3.46 – Cilindro construído.

Figura 3.45(a) –  
Seleção da ferramenta 
cylinder.

Figura 3.45(b) – 
Parâmetros do 
cilindro.

•	 Clique na coordenada (0,0,0) da área de trabalho, ou seja, na origem 
do sistema de coordenadas e arraste o cursor do mouse na direção y e 
no sentido negativo desse eixo. Caso haja dificuldade em selecionar a 
localização, clique com o botão direito do mouse nas proximidades do 
ponto, e uma caixa de diálogo será aberta com as opções que poderão 
ser selecionadas.

A geometria resultante está mostrada na Figura 3.46.
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Etapa 3.4.1 – Reposicionando o eixo
Nesta etapa, a geometria cilíndrica construída terá sua orientação modificada.
•	 Clique sobre o cilindro com botão direito do mouse e selecione Marker: 

MARKER_4 → Modify, conforme a Figura 3.47(a). Preencha o campo 
Orientation, conforme mostrado na Figura 3.47(b): 90,180,0.

Figura 3.47(a) – Rotação do cilindro.

Figura 3.48 – Balancim e eixo.

Figura 3.47 (b) – Definindo a orientação do cilindro

A peça será rotacionada de modo a apresentar a visualização mostrada na 
Figura 3.48.
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Etapa 4 – Construção da haste
Para construção da haste será utilizada uma geometria cilíndrica.
•	 Na caixa de diálogo Main Toolbox, selecione o corpo rígido cylinder 

 e preencha os campos inferiores dessa caixa de diálogo, conforme 
mostrado na Figura 3.49(a).

•	 Clique no centro do círculo, localizado à esquerda do balancim, e ar‑
raste o mouse no sentido negativo do eixo Y. Ao arrastar o mouse na 
direção horizontal, a peça pode também ser construída com uma incli‑
nação, conforme ilustrada na Figura 3.49(b). Nessa etapa, a orientação 
será arbitrária, pois será definida nós próximos passos.

Figura 3.49 (a) – �Parâmetros para construção da haste.

Figura 3.49 (b) – Haste construída.
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Etapa 4.1 – Renomeando o corpo rígido correspondente à haste
•	 Clique com o botão direito do mouse sobre o cilindro previamente 

construído o qual representa a haste. Selecione Part: PART_3 → Modify, 
conforme a Figura 3.50(a).

•	 Na caixa de diálogo Modify Body selecione no campo Category a opção 
Name and Position. No campo New Name, insira ROD (nomenclatura 
em inglês), conforme Figura 3.50 (b). Clique em OK.

Figura 3.50(a) – �Modificando o nome do corpo rígido.

Figura 3.50(b) – Alteração do nome.

Etapa 4.2 – Definindo a orientação da haste
•	 Clique com o botão direito do mouse sobre a haste e selecione Marker: 

MARKER_5 → Modify, conforme Figura 3.51(a).
•	 Na caixa de diálogo Marker Modify altere o campo Location e Orien‑

tation conforme mostrado na Figura 3.51(b).
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Figura 3.51(a) – �Modificando a incli‑
nação da haste.

Figura 3.51(b) – Alterando a orientação da peça.

O resultado está apresentado na Figura 3.52.

Figura 3.52 – Haste na sua posição e orientação final.

Etapa 4.3 – Construção do círculo superior da haste
Na extremidade superior da haste (Rod) será inserido um círculo, de modo 

a facilitar a construção do mecanismo em etapas futuras, uma vez que o marker 
dessa geometria terá um de seus eixos orientado ao longo da haste.
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•	 Selecione a ferramenta arc/circle ,	
  , na caixa de diálogo Main Toolbox, 
conforme mostrado na Figura 3.53(a).

•	 Na parte inferior dessa caixa de diálogo, selecione primeiramente a op‑
ção Circle. No primeiro campo, selecione Add to Part (este corpo rígido 
será adicionado ao balancim). Selecione a opção Radius e, na caixa de 
texto, insira o valor mostrado na Figura 3.53(b).

Figura 3.53(b) – 
Parâmetros do 
círculo.

Figura 3.53(a) –  
Selecionando a ferra‑
menta arc/circle.

•	 Primeiramente, selecione a geometria do balancim, de modo a informar 
que o círculo pertencerá a essa geometria. Posteriormente, selecione a 
localização do centro do círculo, que será o MARKER_2 (marker do 
círculo já existente na extremidade superior da haste). Feche a caixa de 
diálogo que informa que a geometria não possui massa.

A Figura 3.54 ilustra o círculo construído.
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Figura 3.55(a) – Modificando a orientação do Marker.

Etapa 4.3.1 – – Definindo localização e orientação do Marker do círculo 
superior da haste
•	 Clique com o botão direito do mouse e selecione Marker: MARKER_6 

→Modify, conforme mostrado na Figura 3.55(a).
•	 Preencha o campo Location e Orientation, conforme mostrado na Fi‑

gura 3.55(b).

Figura 3.54 – Círculo construído.
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Figura 3.55(b) – �Parâmetros do Marker.

Figura 3.56 (b) –  
Parâmetros do cilindro.

Figura 3.56(a) –  
Selecionando Cylinder.

Etapa 4.4 – Construção do seguidor
•	 Na extremidade inferior da haste, será construído o seguidor. Este será 

constituído de dois cilindros.
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta Cylinder ,  

conforme a Figura 3.56(a).
•	 Selecione as opções Length e Radius, e preencha os campos de acordo 

com a Figura 3.56(b). Note que essa geometria será adicionada ao cor‑
po rígido Rod.
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•	 Primeiramente, selecione a geometria do Rod.
•	 Selecione a extremidade inferior do Rod e arraste o cursor do mouse na 

direção vertical para baixo. O resultado está apresentado na Figura 3.57.

Figura 3.57 – Construção do primeiro cilindro.

Figura 3.58(a) – Modificando o cilindro 1 do seguidor.

Etapa 4.4.1 – Reposicionando o primeiro cilindro do seguidor
•	 Selecione o cilindro recém‑criado. Com o botão direito do mouse, sele‑

cione Marker: MARKER_7→Modify, conforme a Figura 3.58(a).
•	 Na caixa de diálogo Marker Modify preencha os campos Location e 

Orientation, de acordo com a Figura 3.58(b).
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Figura 3.58(b) – �Parâmetros do cilindro 1 
do seguidor.

A Figura 3.59 ilustra o resultado dessa modificação.

Figura 3.59 – Cilindro 1 reposicionado.

•	 Repita os passos descritos no item 4.4 e 4.4.1, de modo a obter um novo 
cilindro idêntico ao já criado nesses tópicos. No entanto, atente ao fato 
de que ao reposicionar o cilindro 2 deve‑se selecionar o marker corres‑
pondente a este útimo, nesse caso, o MARKER_8, conforme ilustrado 
nas Figuras 3.60(a) e 3.60(b).

A Figura 3.61 ilustra o mecanismo em vista isométrica, permitindo o usuário 
visualizar que ambos os cilindros ocupam a mesma posição.
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Etapa 4.4.2 – Reposicionando o segundo cilindro do seguidor
No segundo cilindro, será alterada a orientação do seu comprimento, de 

modo que ambos os cilindros fiquem adjacentes.
•	 Clique com o botão direito do mouse sobre os cilindros e selecione 

Cylinder:CYLINDER_8 → Modify, conforme mostra a Figura 3.62(a).
•	 A caixa de diálogo para alterar a geometria do cilindro será aberta, con‑

forme mostrado na Figura 3.62(b). No campo Lenght insira um sinal 

Figura 3.61 – Cilindros do seguidor construídos.

Figura 3.60(a) - Modificando o cilindro 2. Figura 3.60(b) - Parâmetros do cilindro 2.
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Figura 3.62(a) – �Modificando a geo‑
metria do cilindro 2.

Figura 3.62(b) – �Alterando o sentido do vetor 
comprimento do cilindro 2.

Figura 3.63 – Seguidor finalizado.

negativo antes do valor corrente. O resultado da operação é apresenta‑
do na Figura 3.63.

Etapa 5 – Construção da came
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta Spline 	
  , 

conforme mostrado na Figura 3.64(a).
•	 Na parte inferior dessa janela, selecione a opção Closed e, no primeiro 

campo, selecione New Part. No campo Create by picking, selecione a 
opção Points.(Figura 3.64(b)).
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•	 Na área de trabalho, selecione oito pontos aleatórios, lembrando que o 
primeiro ponto e o último deverão ser coincidentes. Para finalizar a geo‑
metria, clique com o botão direito do mouse. Feche a caixa de diálogo 
que informa que a geometria construída não tem massa.

Um exemplo está apresentado na Figura 3.65.

Figura 3.64(b) -  
Parâmetros da Spline.

Figura 3.65 – Geometria criada aleatoriamente.

Figura 3.64(a) –  
Selecionando a fer‑
ramenta Spline.

Etapa 5.1 – – Definindo a forma da came
De maneira análoga à construção do balancim, a spline criada será modifi‑

cada para o formato correto, conforme a sequência ilustrada nas Figuras 3.66(a), 
3.66(b) e 3.67. Observe que, nesse caso, os pontos corretos da spline serão impor‑
tados de um arquivo de dados chamado came.txt. Caso não tenha esse arquivo 
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disponível, os pontos poderão ser inseridos manualmente, na caixa de diálogo 
Location Table, segundo a Tabela 3.4, totalizando 202 pontos.

Figura 3.66(a) – Caminho para modificar a Spline.

Figura 3.66(b) – Modificando a Spline.

Figura 3.67 – Location Table.
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Pontos X Y Z
1 -3,40E+08 -4,16E+07 0.0
2 -3,75E+08 -2,85E+06 0.0
3 -4,11E+08 -1,65E+06 0.0
4 -4,47E+08 -5,69E+06 0.0
5 -4,84E+08 4,01E+06 0.0
6 -5,20E+07 1,26E+07 0.0
7 -5,57E+08 2,00E+07 0.0
8 -5,95E+08 2,62E+07 0.0
9 -6,32E+08 3,13E+07 0.0
10 -6,70E+08 3,52E+07 0.0
11 -7,07E+08 3,79E+07 0.0
12 -7,45E+08 3,94E+07 0.0
13 -7,83E+08 3,98E+07 0.0
14 -8,21E+08 3,90E+07 0.0
15 -8,58E+08 3,70E+07 0.0
16 -8,96E+08 3,38E+07 0.0
17 -9,34E+08 2,95E+07 0.0
18 -9,71E+08 2,40E+06 0.0
19 -0.1008058773 1,73E+07 0.0
20 -0.1045006998 9,43E+06 0.0
21 -0.1081692053 4,40E+05 0.0
22 -0.1118078094 -9,70E+06 0.0
23 -0.115412957 -2,10E+07 0.0
24 -0.1189811254 -3,34E+07 0.0
25 -0.1225088282 -4,69E+07 0.0
26 -0.1259926187 -6,14E+07 0.0
27 -0.1294290928 -7,71E+07 0.0
28 -0.1328148928 -9,39E+07 0.0
29 -0.1361467104 -1,12E+07 0.0
30 -0.1394212903 -1,30E+07 0.0
31 -0.1426354329 -1,50E+08 0.0
32 -0.1457859977 -1,71E+08 0.0
33 -0.1488699062 -1,93E+08 0.0
34 -0.1518841454 -2,16E+08 0.0
35 -0.15482577 -2,39E+08 0.0
36 -0.1576919057 -2,64E+08 0.0
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Pontos X Y Z
37 -0.1604797522 -2,90E+08 0.0
38 -0.1631865854 -3,16E+08 0.0
39 -0.1658097606 -3,43E+08 0.0
40 -0.1683467147 -3,71E+08 0.0
41 -0.1707949688 -4,00E+08 0.0
42 -0.1735955481 -4,34E+08 0.0
43 -0.1769386674 -5,11E+08 0.0
44 -0.1797915609 -5,11E+08 0.0
45 -0.1827356 -5,48E+08 0.0
46 -0.1856286247 -5,85E+08 0.0
47 -0.1884613803 -6,23E+08 0.0
48 -0.1912292033 -6,60E+08 0.0
49 -0.1939273333 -6,97E+08 0.0
50 -0.1965508616 -7,35E+08 0.0
51 -0.1990946879 -7,73E+08 0.0
52 -0.2015534906 -8,11E+08 0.0
53 -0.2039217119 -8,50E+08 0.0
54 -0.2061935568 -8,89E+08 0.0
55 -0.2083630069 -9,29E+08 0.0
56 -0.2104238463 -9,69E+07 0.0
57 -0.2123696979 -0.1009680174 0.0
58 -0.2141940684 -0.1050939064 0.0
59 -0.2158904 -0.1092725812 0.0
60 -0.2174521269 -0.1221064247 0.0
61 -0.2188727356 -0.1177816539 0.0
62 -0.2201458269 -0.1221064247 0.0
63 -0.2212651795 -0.1264727668 0.0
64 -0.2222248143 -0.1308756531 0.0
65 -0.2230190574 -0.13530922 0.0
66 -0.2236426033 -0.1397667988 0.0
67 -0.2240905771 -0.1442409512 0.0
68 -0.2243585942 -0.1487235062 0.0
69 -0.2244428202 -0.1532056005 0.0
70 -0.2243400277 -0.1576777212 0.0
71 -0.2240476521 -0.1621297513 0.0
72 -0.2235638459 -0.1665510183 0.0
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Pontos X Y Z
73 -0.2228875308 -0.1709303449 0.0
74 -0.2220184479 -0.1752561044 0.0
75 -0.2209572063 -0.1795162782 0.0
76 -0.2197053296 -0.1836985185 0.0
77 -0.2182652992 -0.1877902144 0.0
78 -0.2166405958 -0.1917785638 0.0
79 -0.2148357369 -0.1956506505 0.0
80 -0.21285631 -0.1993935276 0.0
81 -0.2107090003 -0.202994308 0.0
82 -0.2083989285 -0.206444865 0.0
83 -0.2058930063 -0.2097966503 0.0
84 -0.2031925763 -0.2130477378 0.0
85 -0.2003217639 -0.2161708771 0.0
86 -0.1972843235 -0.2191653826 0.0
87 -0.1940903141 -0.2220237557 0.0
88 -0.1907501663 -0.2247392196 0.0
89 -0.1872744148 -0.22730593 0.0
90 -0.1836736218 -0.2297189657 0.0
91 -0.179958303 -0.2319743122 0.0
92 -0.1761388562 -0.2340688425 0.0
93 -0.1722254931 -0.2360002934 0.0
94 -0.1682281726 -0.2377672377 0.0
95 -0.1641565369 -0.2393690541 0.0
96 -0.1600198501 -0.2408058936 0.0
97 -0.1558269383 -0.242078643 0.0
98 -0.1515861331 -0.2431888862 0.0
99 -0.1473052163 -0.2441388631 0.0

100 -0.1429913677 -0.2449314264 0.0
101 -0.1386511157 -0.2455699965 0.0
102 -0.1342902908 -0.2460585154 0.0
103 -0.1299139825 -0.2464013987 0.0
104 -0.1255265008 -0.246603488 0.0
105 -0.1211313423 -0.2466700032 0.0
106 -0.1167311619 -0.2466064948 0.0
107 -0.1123277521 -0.2464187988 0.0
108 -0.1079220303 -0.2461129933 0.0
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Pontos X Y Z
109 -0.1035140366 -0.2456953594 0.0
110 -9,91E+08 -0.245172345 0.0
111 -9,47E+08 -0.2445505349 0.0
112 -9,03E+08 -0.2438366256 0.0
113 -8,58E+08 -0.2430374053 0.0
114 -8,14E+08 -0.2421597387 0.0
115 -7,69E+08 -0.241210554 0.0
116 -7,24E+08 -0.2401968293 0.0
117 -6,79E+08 -0.239125574 0.0
118 -6,34E+08 -0.2380037993 0.0
119 -5,88E+08 -0.2368384713 0.0
120 -5,41E+08 -0.2356364393 0.0
121 -4,94E+08 -0.2344043349 0.0
122 -4,49E+08 -0.2331801714 0.0
123 -4,17E+08 -0.2322370132 0.0
124 -3,80E+08 -0.2310257877 0.0
125 -3,44E+08 -0.2297091184 0.0
126 -3,09E+08 -0.2283042951 0.0
127 -2,74E+08 -0.2267905743 0.0
128 -2,40E+08 -0.2251694349 0.0
129 -2,06E+08 -0.2234424611 0.0
130 -1,73E+08 -0.2216113401 0.0
131 -1,41E+08 -0.2196778612 0.0
132 -1,09E+08 -0.2176439136 0.0
133 -7,80E+07 -0.2155114845 0.0
134 -4,75E+07 -0.2132826575 0.0
135 -1,77E+07 -0.2109596105 0.0
136 1,14E+06 -0.2085446131 0.0
137 3,96E+07 -0.2060400252 0.0
138 6,71E+07 -0.2034482937 0.0
139 9,38E+07 -0.2007719512 0.0
140 1,20E+08 -0.1980136127 0.0
141 1,44E+08 -0.1951759731 0.0
142 1,69E+08 -0.1922618052 0.0
143 1,92E+08 -0.1892739564 0.0
144 2,14E+08 -0.1862153459 0.0
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Pontos X Y Z
145 2,35E+08 -0.1830889626 0.0
146 2,55E+08 -0.1798978608 0.0
147 2,74E+08 -0.1766451588 0.0
148 2,93E+08 -0.1733340346 0.0
149 3,10E+08 -0.1699677234 0.0
150 3,26E+08 -0.1665495146 0.0
151 3,41E+08 -0.1630827479 0.0
152 3,55E+08 -0.1595708106 0.0
153 3,67E+08 -0.1560171343 0.0
154 3,79E+08 -0.1524251911 0.0
155 3,90E+08 -0.1487984907 0.0
156 3,99E+08 -0.1451405768 0.0
157 4,07E+08 -0.1414550232 0.0
158 4,14E+08 -0.1377454314 0.0
159 4,20E+08 -0.1340154257 0.0
160 4,25E+08 -0.1302686505 0.0
161 4,29E+08 -0.1265087672 0.0
162 4,31E+08 -0.122739449 0.0
163 4,33E+08 -0.1189643791 0.0
164 4,33E+08 -0.1151872462 0.0
165 4,31E+08 -0.1114117405 0.0
166 4,29E+08 -0.1076415514 0.0
167 4,26E+08 -0.1038803624 0.0

168 4,21E+08 -0.1001318485 0.0
169 4,15E+08 -9,64E+08 0.0
170 4,08E+08 -9,27E+08 0.0
171 4,00E+08 -8,90E+08 0.0
172 3,91E+08 -8,53E+08 0.0
173 3,80E+08 -8,17E+08 0.0
174 3,69E+08 -7,81E+08 0.0
175 3,56E+08 -7,46E+08 0.0
176 3,42E+08 -7,10E+08 0.0
177 3,28E+08 -6,76E+08 0.0
178 3,12E+08 -6,41E+07 0.0
179 2,95E+08 -6,08E+08 0.0
180 2,77E+08 -5,74E+07 0.0
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Pontos X Y Z
181 2,58E+08 -5,42E+08 0.0
182 2,37E+08 -5,10E+08 0.0
183 2,16E+08 -4,79E+08 0.0
184 1,94E+08 -4,48E+08 0.0
185 1,71E+08 -4,18E+08 0.0
186 1,47E+08 -3,89E+08 0.0
187 1,23E+08 -3,60E+08 0.0
188 9,68E+05 -3,33E+08 0.0
189 7,03E+07 -3,06E+07 0.0
190 4,29E+07 -2,80E+08 0.0
191 1,47E+07 -2,55E+08 0.0
192 -1,42E+07 -2,30E+08 0.0
193 -4,39E+07 -2,07E+08 0.0
194 -7,43E+07 -1,85E+08 0.0
195 -1,05E+07 -1,63E+08 0.0
196 -1,37E+08 -1,43E+08 0.0
197 -1,70E+08 -1,23E+08 0.0
198 -2,03E+08 -1,05E+07 0.0
199 -2,36E+08 -8,73E+07 0.0
200 -2,70E+07 -7,10E+07 0.0
201 -3,05E+08 -5,57E+07 0.0
202 -3,40E+08 -4,16E+07 0.0

•	 Após especificar os novos pontos da Spline, a geometria da peça terá a 
aparência mostrada na Figura 3.68.

Figura 3.68 – Came editada.
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Etapa 5.2 – Reposicionando a came
O próximo passo é posicionar a geometria da came no local adequado. Este 

reposicionamento deve ser feito alterando‑se a localização do marker.
•	 Clique, com o botão direito do mouse, sobre a came, e selecione Marker: 

MARKER_9 → Modify, conforme mostrado na Figura 3.69(a). A cai‑
xa de diálogo Marker Modify será aberta (Figura 3.69(b)). No campo 
Location digite: – 0.4724334605, – 0.633147181, 0.0. A Figura 3.70 
ilustra a came reposicionada.

Figura 3.69(a) – Caminho para modificação. Figura 3.69(b) – Parâmetros para modificação.

Figura 3.70 – Came reposicionada.
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Etapa 5.3 – Construção do eixo da came
•	 Na caixa de diálogo Main Toolbox selecione a ferramenta Cylinder  

conforme mostrado na Figura 3.71(a).
•	 Na parte inferior dessa janela, selecione as opções Length e Radius, 

preenchendo os respectivos campos com: 0.1 e 5.0E‑002, conforme ilus‑
trado na Figura 3.71(b). No campo Cylinder, selecione Add to Part.

•	 Selecione a geometria da came, de modo a informar que o cilindro per‑
tencerá a esta.

•	 Selecione uma localização para criar o cilindro. Lembre‑se que é neces‑
sário deslizar o mouse a fim de definir sua orientação. Ambas as infor‑
mações podem ser aleatórias visto que o mouse será reposicionado.

Figura 3.71(b) – Parâmetros do Cylinder.Figura 3.71(a) – �Selecionando a  
ferramenta Cylinder.
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A Figura 3.72 apresenta o resultado desta etapa.

Figura 3.73(a) – �Modificando a posição 
do cilindro.

Figura 3.73(b) – Alterando a localização do cilindro.

Etapa 5.4 – Reposicionamento do eixo da came
De maneira análoga ao reposicionamento de geometrias já descritas anterior‑

mente, o reposicionamento desse cilindro, representando o eixo da came, pode ser 
realizado seguindo a sequência ilustrada nas Figuras 3.73(a) e 3.73(b).

Figura 3.72 – Eixo construído.
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A Figura 3.74 ilustra a came finalizada.

Figura 3.74 – Came finalizada.

Etapa 6 – Construção da válvula
A partir desta etapa uma nova ferramenta do ADAMS/View será utilizada 

para construção de geometrias, denominada de Revolution. Esta será empregada 
na construção da válvula, bem como na construção das geometrias de apoio do 
mecanismo.

Ferramenta Revolution

A notar: A ferramenta de criação de corpos rígidos, denominada Revolution, é 
utilizada para construir sólidos de revolução. Essa ferramenta está disponível na caixa 
de diálogo Main Toolbox cujo nome é Rigid Body: Revolution. Primeiramente, define
‑se o eixo no qual a superfície será rotacionada. Posteriormente, a superfície deverá ser 
definida pelo usuário, por meio de pontos selecionados na área de trabalho. A peça é 
finalizada, resultando em um sólido de revolução. 

•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta Revolution 
	
  	
   conforme ilustrado na Figura 3.75(a).

•	 Na parte inferior dessa caixa de diálogo selecione as opções Closed e 
Analytical. No primeiro campo, selecione New Part e, no campo Create 
by picking, selecione Points, conforme ilustrado na Figura 3.75(b).
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•	 Primeiramente, deve ser definido, na área de trabalho, o eixo no qual a 
superfície será rotacionada. Em uma posição aleatória do grid, selecione 
dois pontos, de modo a definir um reta vertical (direção do eixo verti‑
cal), nesse caso, pontos 1 e 2, respectivamente (Figura 3.76(a)). Note 
que o software indica a ação a ser realizada no canto inferior esquerdo.

•	 Após selecionado os dois pontos definindo o eixo de rotação, selecione 
os dois próximos pontos (3 e 4 da Figura 3.76(a)) que irão constituir 
a superfície a qual será rotacionada em torno do eixo definido pelos 
pontos 1 e 2. Para finalizar a peça clique com o botão direito do mouse. 
Feche a caixa de diálogo que alerta que a geometria não tem massa.

A Figura 3.76(b) ilustra o sólido de revolução construído.

Figura 3.75(b) –  
Parâmetros da ferra‑
menta Revolution.

Figura 3.75(a) – 
Selecionando a ferramenta 
Revolution.

Figura 3.76(a) – Criação do eixo de rotação e da superfície.
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Etapa 6.1 – Atribuindo formato à válvula
•	 Clique com o botão direito do mouse sobre o sólido de revolução cons‑

truído no passo anterior, selecione Revolution: REVOLUTION_11 → 
Modify, conforme mostra a Figura 3.77(a).

•	 Na caixa de diálogo Modify Surface of Revolution selecione o ícone  	
   
(Figura 3.77(b)).

•	 Na janela Location Table que se abrirá edite os pontos de acordo com a 
Tabela 3.3. Ou importe estes pontos do arquivo valvula.txt selecionan‑
do o comando File → Read.

Figura 3.76(b) – Sólido de revolução construído.

Figura 3.77(a) – �Modificando a forma 
geométrica da válvula.

Figura 3.77(b) – Modificando o sólido de revolução.
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Tabela 3.3 – Pontos da geometria da válvula.

Pontos X Y Z
1 0.0 0.0 -2.2E-003
2 2.5E-002 0.0 0.0
3 2.5E-002 0.0 0.6
4 2,78E+08 0.0 0.6556142179
5 3,27E+08 0.0 0.6763197432
6 4,81E+08 0.0 0.6958073136
7 7,16E+08 0.0 0.7136710095
8 0.1 0.0 0.725
9 0.1248146525 0.0 0.7270687569
10 0.1248146525 0.0 0.75
11 0.0 0.0 0.75
12 0.0  0.0 -2.2E-003

A válvula com o formato correto está apresentada na Figura 3.78.

Etapa 6.2 – Reposicionamento da válvula
As Figuras 3.79(a) e 3.79(b), respectivamente, ilustram o reposicionamento 

da válvula para a posição correta no mecanismo em questão. A Figura 3.80 ilustra 
a válvula na posição correta.

Figura 3.78 – Válvula construída.
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Figura 3.79(a) – �Modificando posição da válvula. Figura 3.79(b) – �Localização do 
marker da válvula.

Figura 3.80 – Válvula na posição correta.

Etapa 7 – Criação dos suportes
Nesta etapa, serão construídos os suportes do mecanismo, conforme defini‑

dos na Figura 3.28. Ressalta‑se que esses suportes serão geometrias definidas no 
Ground, totalizando três peças (duas na válvula e uma na haste).

Etapa 7.1 – Criando os suportes da válvula
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta Polyline 	
    

conforme a Figura 3.81(a).
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Figura 3.81(b) –  
Parâmetros da ferra‑
menta Polyline. 

Figura 3.81(a) – 
Selecionando 
a ferramenta 
Polyline.

•	 Na parte inferior dessa caixa de diálogo, no primeiro campo, selecione 
a opção On Ground. Selecione a opção Closed. As configurações dessa 
ferramenta devem estar de acordo com a Figura 3.81(b).

•	 Clique em quatro pontos da área de trabalho (posição aleatória) for‑
mando um quadrado, conforme mostra a Figura 3.82(a).

•	 Repita essa operação (segundo as Figuras 3.81(a) e 3.81(b), novamente 
construindo um segundo quadrado, conforme ilustrado na Figura 3.82(b).

Figura 3.82(a) – �Construindo a 
superfície polyline.

Figura 3.82 (b)- �Duas superfícies 
polyline construídas. 
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Etapa 7.2 – Modificando a geometria e reposicionando os suportes da 
válvula
As Figuras 3.83(a) e 3.83(b) ilustram a modificação da forma geométrica para 

o primeiro suporte (superior) da válvula. Já as Figuras 3.84(a) e 3.84(b) ilustram a 
modificação da forma geométrica do segundo suporte (inferior) da válvula.

As posições desses pontos podem ser importadas diretamente dos arquivos 
“suporte1_valvula.txt” e “suporte2_valvula.txt” respectivamente. Ou, ainda, 
podem ser editadas manualmente, conforme os pontos mostrados nas Figuras 
3.83(b) e 3.84(b) respectivamente.

Figura 3.83(a) – �Modificando a forma 
geométrica do primeiro 
suporte.

Figura 3.83(b) – �Localilzação dos pontos do 
primeiro suporte da válvula.
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A Figura 3.85 ilustra as duas geometrias após as alterações realizadas nesta 
etapa.

Figura 3.84(a) – �Modificando a forma geomé‑
trica do segundo suporte.

Figura 3.85 – Suportes da válvula reposicionados.

Figura 3.84(b) – �Localização dos pontos do 
segundo suporte da válvula.
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Etapa 7.3 – Atribuindo volume aos suportes da válvula
•	 Até o momento, foram construídas as superfícies que resultarão no 

volume dos suportes. Para isto, se recorrerá novamente à ferramenta 
Revolution .

•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta Revolution 
, conforme mostrado na Figura 3.86(a).

•	 Na parte inferior dessa caixa de diálogo, selecione no primeiro campo 
a opção Add to Part. No campo Create by picking, selecione Curve. 
Certifique‑se de que a opção Analytical está ativada, conforme ilustrado 
na Figura 3.86(b).

Figura 3.86 (b) –  
Parâmetros da ferra‑
menta Revolution.

Figura 3.86(a) -  
Selecionando a ferra‑
menta Revolution.

•	 Siga as instruções fornecidas pelo software no canto inferior esquerdo 
da área de trabalho (para que essas informações estejam visíveis, é ne‑
cessário que o curso do mouse esteja sobre o grid) para construção do 
sólido de revolução.

•	 Selecione a geometria a qual será transformada em um sólido de revolu‑
ção. Para isto, selecione a polyline referente ao suporte superior.

•	 Defina o eixo em torno do qual a superfície do suporte será rotacionado. 
Este eixo deverá ser definido na linha de centro da válvula, ao longo de 
seu comprimento. Para isso, clique no ponto central da linha superior da 
válvula (Ponto 1 da Figura 3.87) e, posteriormente, clique no ponto central 
da linha inferior (Ponto 2 da Figura 3.87). Note que, para esses pontos, o 
software reconhece automaticamente os markers localizados nessas linhas.
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•	 Após definido o eixo, clique sobre a curva que define a superfície do su‑
porte. Ao clicar com o botão direito do mouse a peça é finalizada e um 
sólido de revolução é gerado.

O resultado é apresentado na Figura 3.87.

Figura 3.85 – Suportes da válvula reposicionados.

Figura 3.88 – Suporte inferior finalizado.

A mesma operação deve ser realizada para geração do sólido de revolução 
correspondente ao suporte inferior da válvula. A Figura 3.88 ilustra o segundo 
suporte finalizado.
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Etapa 7.4 – Visualização em corte dos suportes da válvula
Apenas para efeito de visualização os dois suportes da válvula serão mo‑

dificados para uma vista em corte. Para isso, o ângulo no qual a superfície foi 
rotacionada em torno do eixo deverá ser alterado, uma vez que a superfície foi 
rotacionada em 360º.

•	 Clique com o botão direito do mouse sobre o suporte superior e se‑
lecione Revolution: REVOLUTION_12 → Modify conforme a Figura 
3.89(a). Na caixa de diálogo Modify Surface of Revolution, altere o 
campo Angle Extent para – 180.0 (Figura 3.89(b)). Para melhor visu‑
alização do resultado gire o mecanismo usando o comando Rotate (o 
atalho corresponde à letra R no teclado e utilize o mouse para rotacio‑
nar o mecanismo).

Figura 3.89(a) – �Modificando o suporte 
superior da válvula.

Figura 3.89(b) – �Alterando o ângulo de revolução 
do suporte superior da válvula.

O mesmo procedimento deve ser seguido para o suporte inferior da válvula, 
conforme ilustrado nas Figuras 3.90(a) e 3.90(b).
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Figura 3.90(a) – �Modificando o suporte 
inferior da válvula.

Figura 3.90(b) – �Alterando o ângulo de revolução 
do suporte inferior da válvula.

O resultado está ilustrado na Figura 3.91, o qual está sendo visualizando no 
formato Shaded (clique com o botão direito do mouse no grid e selecione a opção 
Shaded).

Figura 3.91 – �Suportes da válvula em 
visualização de corte.

Etapa 7.5 – Criando o suporte da haste
•	 Selecione a ferramenta Revolution na caixa de diálogo Main Toolbox. 

(Figura 3.92(a)).
•	 Na parte inferior desta caixa de diálogo selecione a opção On Ground 

no primeiro campo e no segundo campo selecione a opção Points. Ative 
as opções Closed e Analytical, conforme a Figura 3.92(b).
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Figura 3.92(b) –  
Parâmetros da ferra‑
menta Revolution.

Figura 3.92(a) -  
Selecionando a ferra‑
menta Revolution.

•	 Crie um quadrado, selecionando quatro pontos próximo à haste, con‑
forme ilustrado na Figura 3.93(a). A priori, a localização dessa peça 
pode ser aleatória, pois na próxima etapa ela será reposicionada. Note 
que, primeiramente, deverá ser definido o eixo (linha 1‑2) no qual a peça 
será rotacionada gerando o volume. Posteriormente, defina os pontos 3 
e 4. Para finalizar a superfície clique com o botão direito do mouse.

Figura 3.93(b) – 
Volume do suporte 
da haste criado.

Figura 3.93(a) – 
Criando a superfí‑
cie do suporte.
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Etapa 7.6 – Reposicionando o suporte da haste
•	 Selecione a geometria criada no passo anterior, utilizando o botão direi‑

to do mouse.
•	 Selecione a opção Revolution: REVOLUTION_12_3 →Modify, confor‑

me ilustrado na Figura 3.94(a).
•	 Na caixa de diálogo que se abrirá, selecione o ícone , localizado à 

direita do campo Profile Points. A caixa de diálogo Location Table será 
aberta e as coordenadas dos pontos deverão ser preenchidas, conforme 
ilustrado na Figura 3.94 (b). Essas coordenadas também poderão ser 
importadas do arquivo suporte3_haste.txt. Para isto deve‑se selecionar 
a opção Read, localizado na parte inferior da janela Location Table.

Figura 3.94 (a) – �Modificando posição 
do suporte da haste.

Figura 3.94 (b) – �Localização dos pontos 
do suporte da haste.
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A Figura 3.95 apresenta o resultado a ser obtido, ou seja, o suporte teve sua 
geometria alterada.

Figura 3.95 - Alteração geométrica do suporte da haste.

O próximo passo é reposicionar o suporte. Para isso, o marker dessa geome‑
tria deverá ser modificado.

•	 Com o botão direito do mouse, selecione o marker da geometria em 
questão, conforme ilustrado na Figura 3.96(a). Note que o marker está 
localizado fora da geometria definida (na Figura 3.95 este marker está 
na cor verde). Selecione a opção Marker: MARKER_14 →Modify.

•	 A caixa de diálogo Marker Modify será aberta. Preencha os campos, 
conforme mostrado na Figura 3.96(b).

Figura 3.96(a) - �Modificando o marker 
do suporte da haste.
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A Figura 3.97 ilustra o suporte da haste finalizado.

Figura 3.97 – Resultado da operação

Etapa 8 – Construção da mola

Etapa 8.1 – Criando o apoio da mola
•	 O apoio da mola possui uma geometria cilíndrica. Para isto, na caixa 

de diálogo Main Toolbox selecione a ferramenta Cylinder 	
  	
   (Figura 
3.98(a)) e preencha os campos da parte inferior dessa janela, conforme 
a mostrado na Figura 3.98(b).

Figura 3.96(b) – �Parâmetros do marker 
do suporte da haste
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Figura 3.98(b)– 
Parâmetros da ferra‑
menta Cylinder. 

Figura 3.98(a) –  
Selecionando a fer‑
ramenta Cylinder.

•	 Uma vez que está definido o comprimento e o raio do cilindro a ser 
construído, selecione no mecanismo a que Part essa geometria perten‑
cerá, que, nesse caso, é a válvula. Clique sobre a geometria da válvula 
perto de sua extremidade superior (este ponto pode ser aleatório pois a 
peça será reposicionada na próxima etapa). Com o cursor do mouse, de‑
fina a direção do eixo longitudinal do cilindro (mova o cursor do mouse 
na direção vertical para baixo).

A Figura 3.99(a) ilustra o cilindro construído. Note que este foi construído 
inclinado apenas para ilustração. Na próxima etapa, sua localização e orientação 
serão definidas.
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Figura 3.99 – Cilindro construído.

•	 Para reposicionar o apoio da mola, selecione a geometria recém
‑construída com o botão direito do mouse, conforme ilustrado na Fi‑
gura 3.100(a). Selecione o Marker:Marker_15→Modify. Na caixa de 
diálogo Marker Modify, preencha os campos Location e Orientation, 
conforme ilustrado na Figura 3.100(b).

Figura 3.100(a) – �Selecionando o 
apoio da mola.

Figura 3.100(b) – Parâmetros de modificação

O resultado pode ser visualizado na Figura 3.101.
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Figura 3.101 – Apoio da mola construído.

Etapa 8.2 – Inserindo a mola no mecanismo
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta  	
   (Connec‑

tor: Translational Spring‑Damper), como ilustrado na Figura 3.102(a). 
Os campos inferiores dessa caixa de diálogo deverão permanecer sem 
alterações, como mostrado na Figura 3.102(b).

Figura 3.102 (b) – 
Parâmetros da 
ferramenta mola.

Figura 3.102 (a) –  
Selecionando a 
ferramenta mola.
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•	 Para criar a mola, é necessário selecionar os dois pontos extremos desta, 
e que sejam pertencentes a dois PARTS diferentes, nesse caso, a válvula e 
o ground. Primeiramente, defina o ponto superior, selecionando o marker 
pertencente ao cilindro de apoio da mola (Figura 3.103(a)). Em seguida, 
defina o ponto inferior, selecionando o marker pertencente ao suporte 
superior da válvula (Figura 3.103(b)), o qual está localizado no ground.

A Figura 3.104 ilustra a mola construída (em azul).

Figura 3.103 (a) – �Definindo ponto 
superior da mola.

Figura 3.103 (b) – �Definindo ponto 
inferior da mola.

Figura 3.104 – Mola construída.
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Etapa 8.3 – Definindo parâmetros da mola
Nesta etapa, serão definidos os valores da constante elástica (K) e o coeficien‑

te de amortecimento (C).
•	 Clique com o botão direito do mouse sobre a mola e selecione Spring: 

SPRING_1 → Modify conforme a Figura 3.105(a).
•	 A caixa de diálogo Modify a Spring‑Damper Force será aberta. Esta de‑

verá ser preenchida conforme a Figura 3.105(b). Note que, nessa janela, 
deverão ser inseridos os parâmetros K (100 lbf/foot), C (0.1 lbf.seg/foot) 
e a pré‑carga (preload) de 100 lbf.

Figura 3.105(a)- Modificando a mola.

Figura 3.105(b) – Atribuindo parâmetros à mola.
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A mola sofrerá uma pequena modificação visual, conforme mostrado na Fi‑
gura 3.106.

Etapa 9 – Construção das juntas
Serão criadas um total de 8 juntas. Destas, duas serão do tipo revolute, três 

serão juntas primitivas do tipo inplane, uma junta também primitiva do tipo 
orientation, uma junta do tipo translational e, por fim, uma junta de restrição do 
tipo No lift‑off (2D curve‑curve constraint).

Vale ressaltar que, na criação das juntas, é necessário selecionar os markers 
que serão atribuídos a elas. Por isso, o leitor não deve se prender ao fato de que 
a numeração dos markers apresentados neste capítulo (inclusive nas figuras) seja 
idêntico ao do modelo que ele esteja criando, pois alguns detalhes e sequência 
na construção são suficientes para que haja alteração nessa numeração. O im‑
portante é definir o marker correspondente à peça que receberá a junta, ou seja, 
é necessário, antes de tudo, compreender o mecanismo para que se obtenha um 
bom modelo.

Etapa 9.1 – Criação das juntas tipo revolute
A primeira junta revolute será definida na came.
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta revolute joint 

,	
  , conforme mostrado na Figura 3.107(a). Preencha os campos inferio‑
res dessa caixa de diálogo, conforme apresentado na Figura 3.107(b).

Figura 3.106 – Mola finalizada.
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•	 Note que, no campo Construction, está definida a opção 2 Bod‑1 Loc. 
Dessa maneira, é necessário selecionar os dois corpos (body) que serão 
interligados pela junta. Para isso, clique primeiramente com o botão 
esquerdo do mouse na came e, depois, no ground.

•	 O próximo passo é selecionar a localização da junta. Selecione o marker 
localizado no centro da came (eixo em torno do qual a came rotacio‑
na). Note que o segundo campo da Figura 3.107(b) está definido como 
Normal to Grid, sendo assim, o eixo de rotação dessa junta será defini‑
do normal à área de trabalho.

A Figura 3.108 ilustra a junta construída.

Figura 3.107(b) – 
Parâmetros da junta 
revolute da came.

Figura 3.107(a) – 
Criando a junta 
revolute na came.

Figura 3.108- Junta revolute na came.
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A segunda junta revolute deverá ser inserida no balancim, de modo que este 
possa rotacionar em torno de seu eixo.

A mesma operação descrita anteriormente para criação da junta revolute da 
came deverá ser refeita. Os dois corpos a serem conectados serão o balancim e 
ground. E a junta será localizada no marker definido no eixo dessa peça. A Figura 
3.109 ilustra a junta revolute criada no balancim.

Etapa 9.2 – Criação da junta primitiva tipo orientation
Para construção dessa junta, será necessário criar um marker, o qual será 

utilizado no processo de construção para definir sua localização. Ressalta‑se que 
essa junta estará interligando a haste e o ground.

Junta Primitiva “Orientation”

A notar: Uma junta primitiva estabelece uma restrição no movimento relativo entre 
corpos, tal como restringir que um determinado corpo sempre se mova paralelamente 
em relação a outro corpo. A junta primitiva do tipo “Orientation” restringe o marker 
do primeiro corpo tal que ele não possa rotacionar em relação ao segundo corpo, 
removendo assim três graus de liberdade de rotação do modelo. Os eixos do sistema 
de coordenadas precisam estar na mesma orientação. A localização da origem dos 
sistemas de coordenadas não é importante.

Figura 3.109 – Junta revolute criada no balancim.

Exemplo de junta primitiva Orientation. 
Fonte: ADAMS View help.
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•	 Na caixa de diálogo Main Toolbox selecione a ferramenta marker 	
  	
   
conforme ilustrado na Figura 3.110(a).

•	 Na parte inferior dessa caixa de diálogo, selecione no primeiro campo 
a opção Add to Part. No segundo campo (Orientation), deverá estar 
selecionado a opção GlobalXY, conforme ilustrado na Figura 3.110(b). 
Note que esse marker será adicionado à geometria da haste, sendo loca‑
lizado em seu centro de massa.

Figura 3.110(b) – 
Parâmetros de cons‑
trução do marker.

Figura 3.110(a) - 
Selecionando a 
ferramenta marker.

•	 Para criar o marker, primeiramente deve‑se selecionar o corpo a que ele 
será atribuído. Selecione o corpo rígido correspondente à haste. Poste‑
riormente, informe a localização do marker. Para isso, selecione o centro 
de massa da haste (ao deslizar o mouse sobre a haste o centro de massa 
será identificado automaticamente e a ele estará atribuído a extensão 
.cm). A Figura 3.111(a) ilustra o centro de massa da haste.

O marker criado está apresentado na Figura 3.111(b).
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Recomenda‑se renomear este marker de modo a facilitar sua identificação 
nos passos futuros.

•	 Clique com o botão direito do mouse selecionando Marker:  
MARKER_22→ Rename, conforme mostrado na Figura 3.112(a).

•	 Altere o nome deste na caixa de diálogo que será aberta. No campo 
New Name, deverá ser inserido o novo nome após o último ponto (note 
que, neste exemplo, a haste é denominada de ROD). Ao marker será 
atribuído o nome: Joint_Orientation (Figura 3.112(b)).

Figura 3.111(a) – �Seleção do centro 
de massa da haste.

Figura 3.111(b) – Marker criado na haste.

Figura 3.112(a) – renomeando o marker Figura 3.112(b) – Renomeando o marker.
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A próxima etapa é definir a orientação deste marker. As Figuras 3.113(a) e 
3.113(b) ilustram essa modificação.

Figura 3.113 (a) – �Alterando a orienta‑
ção do marker.

Figura 3.113(b) – Parâmetros do marker.

•	 Para criar a junta, selecione a ferramenta Joint: Palette na caixa de diá‑
logo Main Toolbox conforme a Figura 3.114(a).

•	 A caixa de diálogo Joints se abrirá. Selecione o ícone  	
   correspondente 
à Orientation Joint. Preencha a parte inferior da janela, conforme mos‑
trado na Figura 3.114(b).
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Figura 3.114(b) –  
Parâmetros para constru‑
ção da junta Orientation.

Figura 3.114(a) -  
Selecionando a ferramenta 
Joint Palette.

•	 Para construir a junta, selecione primeiramente o corpo rígido corres‑
pondente à haste. O segundo corpo a ser selecionado deve ser o ground. 
E, por fim, selecione a localização dessa junta, clicando no marker defini‑
do anteriormente, denominado de Joint_Orientation (Figura 3.115(a)). 
Por fim, deverá ser informada a orientação da junta. Para isso, mova o 
cursor do mouse até que uma seta seja exibida na direção denominada 
Joint_orientation.Z, conforme ilustrado na Figura 3.115(b).

Figura 3.115(a) – �Selecionando a localização 
da junta Orientation.
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Figura 3.115(b) – Definindo a direção da junta Orientation.

A Figura 3.116 ilustra a junta Orientation construída (para uma melhor vi‑
sualização desta junta recomenda‑se rotacionar o mecanismo).

Figura 3.116 – Junta Orientation finalizada.
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Etapa 9.3 – Criação das juntas primitivas tipo Inplane

Junta Primitiva Inplane

A notar: Restringe um corpo tal que ele somente possa se mover em um plano do 
segundo corpo. O primeiro corpo é restringido com relação ao segundo. A origem da 
junta no primeiro corpo precisa permanecer no plano xy do segundo corpo.

Para criação destas juntas deverão ser criados os markers que serão atribuí‑
dos a elas.

Para a primeira junta Inplane (ligação entre a haste e o ground) o marker 
deverá ser criado conforme ilustrado nas Figuras 3.117(a) e 3.117(b). Esse marker 
pertencerá ao corpo rígido “haste” e será localizado em seu centro de massa.

Exemplo de junta primitiva Inplane.
Fonte: ADAMS View help.

Figura 3.117(a) – �Parâmetros 
para construir o 
marker na haste.

Figura 3.117(b) – �Selecionando a posição do 
marker (CM da haste).
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As Figuras 3.118(a) e 3.118(b) ilustram os passos para renomear o marker 
criado.

Figura 3.118 (a) – Renomeando o marker Figura 3.118 (b) – �Novo nome atribuído 
ao marker.

Nas Figuras 3.119(a) e 3.119(b) são mostrados os passos para reposicionar 
o marker bem como definir sua orientação.

Figura 3.119(a) – Modificando o marker. Figura 3.119(b) – �Definindo localização e orienta‑
ção do marker.
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A Figura 3.120 apresenta o resultado obtido.

Depois de construído o marker, a junta será criada nos passos a seguir.
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta  	
   (Joint 

Primitive: Inplane), a qual é encontrada expandindo‑se o ícone Joint:Palette.
•	 O campo inferior da caixa de diálogo Joints deverá ser preenchido, con‑

forme ilustrado na Figura 3.121.

Figura 3.120 – �Marker “Joint_inplane1” 
construído.

•	 Conforme as instruções fornecidas pelo software no canto inferior es‑
querdo, selecione o primeiro corpo rígido como sendo a haste e o segun‑
do corpo deverá ser o ground. Posteriormente, selecione a localização 
dessa junta como sendo o marker Joint_inplane1 (Figura 3.122(a)). Para 
fornecer a orientação, deslize o mouse para a esquerda até que auto‑

Figura 3.121 – Parâmetros da junta Inplane.
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maticamente uma seta apareça com a denominação Joint_inplane1.Z 
(Figura 3.122(b)). Selecione para construir a junta primitiva.

Figura 3.122(a) – �Localização da pri‑
meira junta Inplane.

Figura 3.122(b) – �Direção da primeira 
junta Inplane.

As Figuras 3.123(a) e 3.123(b) ilustram a primeira junta Inplane construída. 
Para uma melhor visualização, rotacione o mecanismo. Note que essa junta é per‑
pendicular à junta construída anteriormente, denominada de Orientation.

Figura 3.123(a) – �Vista isométrica 
da junta Inplane.

Figura 3.123(b) – �Vista frontal da 
junta Inplane.
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Para construção da segunda junta primitiva Inplane (ligação entre balancim 
e a haste) será construído um novo marker que será atribuído a ela.

As Figuras 3.124(a) e 3.124(b) ilustram a criação desse marker. Este será adi‑
cionado ao corpo rígido correspondente ao balancim. Observe que esse marker 
foi criado na extremidade esquerda do balancim. A priori, a posição e orientação 
do maker é irrelevante, pois a seguir ele será reposicionado. O importante é que 
ele seja atribuído ao balancim.

Figura 3.124(a) – Criação do marker.

Figura 3.124(b) – �Posição de cria‑
ção do marker no 
balancim.`
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A Figura 3.125 ilustra o marker construído no balancim.

Figura 3.125– Marker criado no balancim.

A Figura 3.126 ilustra o procedimento para renomear o marker. Com o bo‑
tão direito do mouse, selecione o marker recém‑criado e, então, selecione a opção 
Rename.

Figura 3.126 – Renomeando o marker.

Nas Figuras 3.127(a) e 3.127(b) estão mostrados os procedimentos para re‑
posicionar o marker, bem como a definição de sua orientação.
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Figura 3.127(a) – Modificando o marker. Figura 3.127(b) – �Posição e orientação do 
marker.

A Figura 3.128 ilustra o marker finalizado.

Figura 3.128 – Marker criado.
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Figura 3.129 – �Parâmetros para a segunda Joint Inplane.

A segunda junta Inplane será construída de forma análoga à anterior.
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta  	
   (Joint Pri‑

mitive: Inplane) a qual é encontrada expandindo‑se o ícone Joint:Palette. 
Os campos inferiores da caixa de diálogo Joints deverão ser preenchi‑
das, conforme mostrado na Figura 3.129.

•	 Primeiramente, selecione os dois corpos rígidos que serão interligados 
pela junta: o balancim e a haste.

•	 Selecione a localização para construção da junta, neste caso, o marker 
Joint_inplane2. Para facilitar a seleção, aproxime o mouse da região 
onde foi construído o marker e clique com o botão direito do mouse. 
Uma caixa de diálogo Select (Figura 3.130) será aberta e, então, selecio‑
ne o marker desejado.

Figura 3.130- Selecionando o marker Joint_inplane2.
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•	 Para atribuir a direção dessa junta, deslize o mouse na vertical até que 
uma seta na cor branca seja exibida com a indicação Joint_inplane2.Z. 
Para auxiliar na escolha dessa direção pode‑se optar também por cli‑
car com o botão direito do mouse e selecionar a opção PART_2.Joint_
inplane2.Z na caixa de diálogo Select, conforme ilustrado na Figura 
3.131(a). A Figura 3.131(b) ilustra a junta construída.

A terceira junta Inplane será construída interligando os corpos rígidos, ba‑
lancim e válvula.

Primeiramente, crie o marker a ser utilizado na construção dessa junta, con‑
forme ilustrado nas Figuras 3.132(a) e 3.132(b). Esse marker pertencerá à válvula. 
Com relação à localização dele, a priori, selecione um ponto aleatório identificado 
automaticamente pelo software, desde que pertença à válvula. Posteriormente, o 
marker será reposicionado e receberá a orientação correta.

Figura 3.131(a) – �Direção da junta se‑
gunda junta Inplane.

Figura 3.131(b)– Segunda junta Inplane construída.
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A Figura 3.133 ilustra o marker construído.

Figura 3.132(a) - Parâmetros do marker. Figura 3.132(a) - Posição do marker.

Figura 3.133 - Marker construído.
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As Figuras 3.134(a) e 3.134(b) ilustram o procedimento para renomear o 
marker, que nesse caso receberá o nome de Joint_inplane3.

O reposicionamento e a definição da orientação do marker são mostrados 
nas Figuras 3.135(a) e 3.135(b).

Figura 3.134(a) – Renomeando o marker.

Figura 3.135(a) – Modificando o marker. Figura 3.135(b) – �Localização e orientação 
do marker.

Figura 3.134(a) – Novo nome do  marker.
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De posse do marker criado, será construída a terceira junta inplane.
•	 Na caixa de diálogo Main Toolbox, selecione a ferramenta  (Joint 

Primitive: Inplane) a qual é encontrada expandindo o ícone Joint:Palette. 
Os campos inferiores da caixa de diálogo Joints deverão ser preenchi‑
dos, conforme mostrado na Figura 3.136(a).

•	 Selecione como primeiro corpos rígido a válvula e como segundo o bal‑
ancim.

•	 Selecione o marker Joint_inplane3 para definir a localização da junta 
(Figura 3.136(b)).

Figura 3.136(a) – �Parâmetros da ter‑
ceira junta inplane.

Figura 3.136(b) – �Selecionando o marker 
Joint_inplane3.

•	 Para selecionar a direção da junta, selecione Joint_Inplane3.Z conforme 
mostrado na Figura 3.137(a). A Figura 3.137(b) ilustra a junta cons‑
truída. Para melhor visualizá‑la, rotacione o mecanismo.
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Etapa 9.4 – Criação da junta translacional
Será construída apenas uma junta translacional que interligará a válvula com 

o ground.
Primeiramente, o marker a ser atribuído a essa junta será criado. Vale ressal‑

tar que esse marker pertencerá à válvula.
As Figuras 3.138(a) e 3.138(b) ilustram a criação do marker que, inicialmen‑

te, estará localizado no centro de massa da válvula.

Figura 3.138(a) –  
Inserindo o 
marker.

Figura 3.137(a) – �Direção da terceira 
junta Inplane.

Figura 3.138(b) – 
Posicionando o 
marker.

Figura 3.137(b) – �Terceira junta 
Inplane criada.
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Figura 3.139(a) – Renomenado o marker. Figura 3.139(b) – Novo nome atribuído ao marker.

Figura 3.139 - Marker construído.

A Figura 3.139 ilustra o marker construído.

Renomeie o marker, conforme ilustrado nas Figuras 3.140(a) e 3.140(b).

•	 Para finalizar a construção desse marker, modifique a localização e a 
orientação, conforme ilustrado na Figuras 3.140(a) e 3.140(b).
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•	 Para criar a junta translacional, selecione o ícone referente a esta, na 
caixa de diálogo Main Toolbox (Figura 3.141(a)).

•	 Preencha os campos da parte inferior dessa caixa de diálogo, conforme 
mostrado na Figura 3.141(b).

Figura 3.140(a) – Modificando o marker. Figura 3.140(b) – �Localização e orientação 
do marker

Figura 3.141(a) -  
Selecionando a ferramen‑
ta Joint:Translational.

Figura 3.141(b) – 
Parâmetros para cons‑
trução da junta transla‑
cional.

MSC_ADAMS_prova-4.indb   216 17/10/14   16:08



217Maria Alzira de Araújo Nunes e Rita de Cássia Silva

•	 Selecione os dois corpos pertencentes a essa junta: a válvula e o ground.
•	 Ao ser solicitado (no campo inferior esquerdo da área de trabalho) a 

localização da junta, selecione o marker Joint_Translational (Figura 
3.142(a)).

•	 A direção da junta será definida deslizando o mouse até o software exi‑
bir a coordenada Joint_translational.Z (Figura 3.142(b)). Clique com o 
mouse selecionando esta direção.

A Figura 3.142(c) ilustra a junta construída.

Figura 3.142(a) –  
Localização da junta 
translacional.

Figura 3.142(b) –  
Direção da junta 
translacional.

Figura 3.142(c) –  
Junta translacional 
construída.

Etapa 9.5 – Criação da junta de restrição tipo No lift‑off
Esta junta será construída de modo que o contato entre a came e o seguidor 

seja realizado de acordo com a curva da superfície definida para esta última.
•	 Na caixa de diálogo Main Toolbox selecione o ícone 	
   conforme mos‑

trado na Figura 3.143(a). Na parte inferior desta caixa de diálogo altere 
ambos os campos para a opção Edge (Figura 3.143(b)).
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•	 Selecione as duas bordas solicitadas para construção da junta. A primei‑
ra corresponde à do cilindro construído na extremidade da haste, ou 
seja, o seguidor. A segunda é a borda da came. Ao apontar o ponteiro do 
mouse algumas opções serão exibidas automaticamente. A junta criada 
está ilustrada na Figura 3.144.

Figura 3.143(a) - 
Selecionando a 
junta No lift-off.

Figura 3.144 – Junta No lift-off  criada.

Figura 3.143(b) – 
Parâmetros da junta 
No lift-off.
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Etapa 10 – Atribuindo movimento ao mecanismo
Uma velocidade angular no valor de 360°/s será imposta à came.
•	 Clique com o botão direito do mouse sobre a came e selecione a jun‑

ta revolute denominada Joint: JOINT_1→Modify, conforme a Figura 
3.145(a).

Na caixa de diálogo Modify Joint selecione a opção Impose Motion(s).

Figura 3.145(a) – Caminho para modificar a junta. Figura 3.145(b) – �Atribuindo movimen‑
to à junta. 

A caixa de diálogo Impose Motion(s) será aberta.
•	 No campo RotZ’’ selecione a opção disp(time)=. No campo ao lado, 

insira o valor: 360d*time. A Figura 3.146 ilustra o preenchimento dessa 
janela.
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Na Figura 3.147 está mostrado o resultado dessa etapa na visualização do 
mecanismo. Uma seta curva (na cor verde) é mostrada em torno da came.

Figura 3.146 – Inserindo o valor da velocidade angular na came.

Figura 3.147– �Visualização do mecanismo após 
inserção da velocidade angular.
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Etapa 11 – Verificação do modelo
A verificação do modelo é realizada selecionando‑se o ícone ,	
  , o qual está 

localizado no canto direito inferior da área de trabalho. Primeiramente, clique 
com o botão direito do mouse no ícone com a letra i e, posteriormente, selecione 
o ícone supracitado. A Figura 3.148 ilustra o procedimento.

Figura 3.148 – Verificando o modelo.

Figura 3.149 – Informações sobre a verificação do modelo.

A janela mostrada na Figura 3.149 será aberta com as informações a cerca 
do modelo.
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Etapa 12 – Simulação
Na simulação do mecanismo, serão obtidos os seguintes parâmetros: deslo‑

camento, velocidade e aceleração do centro de massa (CM) da válvula; torque na 
came.

Etapa 12.1 – Determinação do deslocamento, da velocidade e da aceleração 
na válvula
•	 Clique com o botão direito sobre a válvula e selecione o marker locali‑

zado em seu centro de massa (cm). Selecione a opção Measure, confor‑
me ilustrado na Figura 3.150(a) (Marker: cm → Measure).

•	 Na caixa de diálogo Point Measure, selecione a opção Translational dis‑
placement, no terceiro campo denominado Characteristic. No campo 
Component, selecione a opção Y,. Os demais campos não precisam ser 
alterados, mas, caso queira, o nome desse ponto de medição pode ser al‑
terado no primeiro campo (altere o texto contido após o último ponto). 
Clique em Apply. A Figura 3.150(b) ilustra este passo.

Note que a janela gráfica para exibição do deslocamento do cm da válvula 
aparecerá na área de trabalho.

Figura 3.150 (a) – �Criando um ponto 
de saída de dados.

Figura 3.150 (b) –� Parâmetro de saída: desloca‑
mento linear na direção Y.

•	 Para inserir as demais janelas gráficas, neste caso da velocidade e acele‑
ração, selecione a opção Translational velocity no campo Characteristic 
da caixa de diálogo Point Measure. Novamente selecione a opção Apply.
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Uma segunda janela gráfica será aberta, na qual será exibida a curva da ve‑
locidade após simulação do mecanismo.

Figura 3.151 (b) – �Parâmetro de saída: velocidade 
linear na direção Y.

O mesmo procedimento deverá ser repetido para criação da janela gráfica 
para exibição da aceleração linear. Clique em Ok, na caixa de diálogo Point Mea‑
sure, para finalizar a definição dos parâmetros de saída referentes à válvula.

•	 Na caixa de diálogo Main Toolbox, selecione o ícone  	
   (Interactive 
Simulation Controls). Na parte inferior desta caixa de diálogo defina 
os campos, como mostrado na Figura 3.150(a). Note que o tempo de 
simulação será de 5 segundos (End Time) com 500 incrementos de tem‑
po (Steps).

•	 Selecione o ícone 	
   para dar início à simulação (Figura 3.152(a)).
Automaticamente, as curvas (no marker selecionado) serão exibidas nas 

janelas gráficas. A Figura 3.152(b) ilustra o gráfico do deslocamento no cm da 
válvula.
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•	 Para manipulação das curvas geradas é necessário migrar para o mó‑
dulo ADAMS/PostProcessor. Para isto, basta selecionar a tecla F8 do 
teclado. Será exibida a janela mostrada na Figura 3.153.

Figura 3.152(b) – Gráfico do deslocamento.Figura 3.152(a) –  
Parâmetros da simulação

Figura 3.153 – Curva de deslocamento exibido no módulo ADAMS/PostProcessor.
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Etapa 12.2 – Determinação do torque na came
•	 Para gerar a curva do torque na came selecione a junta tipo revolute 

atribuída a este corpo rígido. Selecione a opção Measure conforme ilus‑
trado na Figura 3.154 (a).

•	 A Figura 3.154(b) ilustra o preenchimento da caixa de diálogo Joint 
Measure. Note que será obtido a magnitude do torque. Uma janela grá‑
fica aparecerá na tela de trabalho.

Figura 3.154(a) – �Seleção da junta para 
obtenção do torque.

Figura 3.154(b) – �Parâmetros para determinação 
do torque na came.
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Figura 3.155 – Curva do torque obtido na came.

Ainda no módulo ADAMS/PostProcessor, duas curvas podem ser exibidas no 
mesmo gráfico, tal como mostrado na Figura 3.156.

•	 Para exibir as duas curvas no mesmo gráfico, selecione a variável de 
interesse, nesse caso, cm_Translational_displacement no campo Result 
Set.

•	 No campo Component, selecione Q.
•	 Selecione a opção Add Curves.
Outras manipulações poderão ser realizadas utilizando este módulo, não 

sendo, portanto o escopo deste capítulo.

A Figura 3.155 ilustra a curva do torque na came, exibida no módulo ADAMS/
PostProcessor.
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Figura 3.156 – Curvas do torque na came e deslocamento no CM da válvula.
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4
C
A
PÍTU

LO

Módulo ADAMS/Car aplicado 
ao desenvolvimento de uma 
suspensão automotiva do 
tipo Macpherson

A notar: Em meados dos anos 1930, o engenheiro automotivo norte-americano 
Earle Steele MacPherson desenvolveu um inovador sistema de suspensão que une um 
amortecedor em formato de torre a uma mola do tipo helicoidal, formando assim 
uma estrutura resistente, leve e compacta, atendendo perfeitamente as necessidades 
dos veículos de pequeno e médio porte, de tração dianteira ou traseira. A utilização da 
mola do tipo helicoidal não é uma regra, pois a estrutura poderá ser equipada também 
com molas do tipo pneumáticas ou hidropneumáticas. Uma de suas vantagens é a 
independência entre uma roda e outra, que resulta em superior nível de conforto, 
quando comparada a uma suspensão com eixos interligados e dependentes. Já uma 
desvantagem do sistema é a limitação quanto ao porte e peso do veículo que a utiliza. 

A construção da suspensão MacPherson pode ser considerada como uma das opções 
mais compactas, simples e baratas disponíveis. Projetar um sistema de suspensão é um 
grande desafio, pois além de oferecer robustez, níveis aceitáveis de conforto, facilidade
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de manutenção, dimensões compactas e custo economicamente viável para produção 
em larga escala, o projeto escolhido deve também ser indiscutivelmente seguro. Neste 
capítulo será construída uma suspensão dianteira do tipo Macpherson.

	
Ao fim deste capítulo o leitor estará apto a criar um modelo virtual multi-

corpos de um susbsistema suspensão do tipo Macpherson. Simulações utilizando 
uma plataforma de testes virtual serão realizadas e os resultados analisados. O 
subsistema de direção, proveniente da biblioteca do software, será adicionado ao 
modelo criado com o intuito de realizar simulações e análises adicionais. O mo-
delo final a ser obtido está apresentado na figura a seguir:

Suspensão Macpherson. 

Fonte: Subaru Portugal. Dispo-
nível em: <http://www.subaru.pt/
novo/10impreza_drivability.html>. 
Acesso em:22/04/2013 )

Subsistemas suspensão Macpherson e direção sob 

Obtenha o arquivo da suspensão Macpherson no seguinte link: http://www.
blucher.com.br/materiaisdeapoio/mscadams/tutorial_macpherson.cdb.zip

Etapa 1 – Inicializando o Módulo ADAMS/Car
Ao inicializar o módulo ADAMS/Car, as seguintes opções estarão disponí-

veis na janela de abertura: Standard Interface e Template Builder (item 1.2.1), 
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Figura 4.1 – �Tela de inicialização do 
Módulo ADAMS/Car.

Figura 4.2 – Definição do New Template.

Figura 4.3 – Etapa 3.

conforme mostra a Figura 4.1. O usuário deverá marcar a opção Template Buil-
der uma vez que um novo projeto será criado, depois clicar na opção OK. 

Etapa 2 – Criando o Template
•	 Abra o menu File e clique na opção New. 
•	 Na caixa de diálogo aberta, digite o nome do projeto na caixa Template 

Name.
•	 Especifique o tipo de Subsystem a ser construído na opção Major Role, 

conforme ilustrado na Figura 4.2. 

Etapa 3 –  Definição do Diretório de Trabalho	
•	 Abra o menu Tools e clique na opção Database Management.
•	 Em seguida, clique em Create Database. A Figura 4.3 ilustra a Etapa 3.
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•	 Na caixa de diálogo Create New Database, preencha o campo Database 
Alias com o nome do diretório de trabalho, e, no campo Database Path, 
informe o caminho desse diretório (Figura 4.4).

Figura 4.4 – �Criação do diretório 
de trabalho.

Figura 4.5 – �Confirmação 
da criação do 
diretório de 
trabalho.

Figura 4.6 – �Menssagem de 
alerta referente 
à criação do 
diretório de 
trabalho

•	 Clique em OK.
Uma nova janela será aberta para que o usuário aceite a criação do diretório 

de trabalho definido nas etapas anteriores, conforme ilustra a Figura 4.5.

•	 Uma mensagem de confirmação da criação do diretório será aberta ape-
nas para verificação por parte do usuário (Figura 4.6). Caso a tarefa 
tenha sido executada com sucesso, clique em Close.

Para obter informações sobre o diretório de trabalho criado, abra o menu 
Tools, clique em Database Management e, em seguida, clique em Database Info 
(Figura 4.7). 
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•	 A próxima etapa é definir o diretório de trabalho criado como sendo o 
diretório padrão onde os arquivos referentes ao projeto executado serão 
salvos. Para isso, abra o menu Tools, clique em Database Management 
e, em seguida, clique em Set Default Writable (Figura 4.8).  

Figura 4.7 – �Obtendo informações sobre 
o diretório de trabalho.

Figura 4.8 – Definindo o diretório padrão.

Figura 4.9 – Definindo o diretório padrão.

•	 Uma caixa de diálogo será aberta (Set Default Writable Database). No 
campo Database Name, selecione o diretório de trabalho criado ante-
riormente.
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Etapa 4 – Parametrização da Geometria da Suspensão

A notar: Para alterar/verificar unidades de medidas no ADAMS/Car, acesse o menu 
Settings → Units.

O primeiro passo para a construção da geometria da suspensão é a criação 
dos Hardpoints. Dessa maneira, o modelo se torna parametrizado, facilitando, 
portanto, a realização de alterações geométricas, evitando assim o desenvolvimen-
to de um novo projeto. Na Figura 4.10 é mostrado um esquema dos Hardpoints 
a serem definidos e sua respectiva representação em uma suspensão Macpherson.

Figura 4.10 – Esquema dos Hardpoints a serem construídos.

Figura 4.11 – Criação de Hardpoints.

•	 Para criação dos Hardpoints ilustrados na Figura 4.10 acesse o menu 
Build, clique em Hardpoints e, em seguida, clique em New (Figura 4.11).
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•	 Na caixa de diálogo Create Hardpoint, defina o nome (Hardpoint Name) 
e selecione o tipo (Type): simetria à esquerda – left –, à direita – right – ou, 
caso não haja simetria, defina como single. A localização dos Hardpoints 
com relação às coordenadas globais (x, y e z) do sistema deverá ser 
inserida no campo Location (Figura 4.12). Caso haja algum erro nos 
campos preenchidos, esse erro se destacará na cor amarela, para alertar 
o usuário. Após o preenchimento dos campos, clique em Apply para in-
serir os demais Hardpoints (Tabela 4.1) ou, para finalizar, clique em OK.

Figura 4.12 – Definindo o Hardpoint.

Tabela 4.1 – Nomes e coordenadas dos Hardpoints

Nome Coordenadas (x,y,z)
1 arm front (-150,-350,0)
2 arm rear (150,-350,0)
3 LBJ (0,-700,0)
4 Wheel_ Center (0,-800,100)
5 Strut_ Lower (0,-650,250)
6 Tierod_ Outer (150,-650,250)
7 Tierod_ Inner (200,-350,250)
8 Strut_Upper (0,-600,600)

•	 Após criar os oito Hardpoints, poderão ser feitas alterações em suas 
coordenadas acessando-se o menu Build, clicando em Hardpoint e, em 
seguida, em Table. Uma tabela com o nome do Hardpoint e as respec-
tivas localizações x, y e z abrirá na tela principal, possibilitando sua 
edição (Figura 4.13).

A notar: O termo hpl ou hpr é inserido automaticamente no nome do Hardpoint pelo 
próprio software, de modo a indicar sua simetria.
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A Figura 4.14 ilustra a tela do software após criação dos Hardpoints. 
Etapa 5 – Criação da bandeja da suspensão (Control Arm)

Figura 4.13 – Tabela de modi-
ficação da coordenada do 
Hardpoint.

Figura 4.14 – Hardpoints definidos.

A notar: A bandeja ou braço de suspensão oscilante é 
um subconjunto do sistema de suspensão. Em condições 
ideais, ela trabalha em harmonia com os demais 
componentes da suspensão, ligando a roda ao chassi 
do veículo, e participa na estabilidade, do conforto e da 
segurança do sistema. Sua construção é formada por sua 
estrutura estampada, forjada ou fundida, buchas e pivô. 
A bandeja, por ser o componente de suspensão mais 
próximo do solo, é a primeira a receber o choque de um 
impacto sofrido pela suspensão, a qual está intimamente 
ligada à segurança do veículo e de seus ocupantes.

Bandeja da suspensão.
Fonte: ADAMS View help. 
Subaru Portugal. Disponível 
em: <http://www.subaru.pt/
novo/10impreza_drivability.
html>. Acesso em: 22/04/2013) 
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A bandeja da suspensão é definida por três Hardpoints: arm_front; arm_rear 
e LBJ, sendo esta uma bandeja triangular.

Para criação da bandeja, será necessário criar um General Part (item 
1.2.5.2.1), o qual, no ADAMS/Car, é indicado pela abreviação gel (general part 
left) ou ger (general part right). 

Para criação do General Part é possível utilizar-se de dois tipos de construto-
res: New (criação do corpo rígido sem atribuir uma geometria a ele) ou Wizard 
(criação do corpo rígido e da geometria simultaneamente). Ambos serão mostra-
dos neste capítulo.

•	 Para criação do General Part acesse o menu Build → Parts → General Part 
→ New (Figura 4.15).

Figura 4.15 – �Construção de um 
General Part.

•	 A janela mostrada na Figura 4.16 será aberta e deverá ser preenchida con-
forme mostrado. O preenchimento dos campos pode ser manual ou pode-
-se clicar com o botão direito do mouse no campo de interesse e optar 
por umas das opções disponíveis, sendo essa segunda opção um atalho.

Os dados relativos à geometria deste General Part, como massa, e momentos 
de inércia, inclusive o centro de massa, foram definidos, a priori, por um valor 
aleatório (como pode ser observado na Figura 4.16). Após inclusão da geometria 
(próxima etapa), esses dados serão recalculados. Caso o usuário já possua os 
valores corretos, estes já podem ser inseridos sem a necessidade de recalculá-los 
posteriormente.
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Figura 4.16 – �Definição do General 
Part “Control Arm”.

•	 Após o preenchimento dos campos da Figura 4.16, clique em OK.
A Figura 4.17 ilustra a tela principal do software, destacando a criação do 

General Part.

Figura 4.17 – General Part “Control Arm” construído e sua orientação.
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Etapa 6 – Criação da geometria relacionada ao General Part “Control Arm”
A bandeja da suspensão “Control Arm” a qual está relacionada ao General 

Part criado na etapa anterior será composta por duas geometrias cilíndricas do 
tipo Link e três esféricas do tipo Ellipsoid localizadas nas extremidades dos Links.

A notar: Para definir a geometria Link é necessário dois Hardpoints localizados em 
ambas as extremidades e um raio, em virtude de sua forma cilíndrica.

•	 Para construção do primeiro Link, o qual será formado pelos Hardpoints 
hpl_arm_front e hpl_LBJ, acesse o menu Build   Geometry  Link  New 
como mostrado na Figura 4.18.

Figura 4.18 – �Criação do primeiro Link 
da bandeja da suspensão.

•	 A janela Create Link Geometry será aberta e deverá ser preenchida 
conforme ilustrado na Figura 4.19. Observe que o item para recalcular 
as propriedades de massa do General Part deve estar ativado caso o 
usuário deseje atualizar os dados de propriedades de massa inseridos 
na Etapa 5.

•	 Clique em Apply.
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Figura 4.19 – Criação do Link 1.

O Link construído está ilustrado na Figura 4.20.

Figura 4.20 – Link 1 construído.

•	 Repetir o mesmo procedimento relatado anteriormente para construção 
do Link 2, o qual terá em suas extremidades os Hardpoints hpl_arm_
rear e hpl_LBJ. A Figura 4.21 ilustra os campos da janela Create Link 
Geometry preenchidos para construção do Link 2.

•	 Clique em OK.
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Figura 4.21 – Criação do Link 2.

Nas extremidades dos Links serão construídos volumes esféricos (denomina-
dos Ellipsoid) para complementação da geometria da bandeja da suspensão. Para 
isso acesse o menu Build → Geometry → Ellipsoid → New (Figura 4.22).

A notar: A geometria Ellipsoid pode ser utilizada para gerar geometrias esféricas desde 
que os raios definidos em cada coordenada (x, y e z) sejam iguais. 

Figura 3.60(a) - Modificando o cilindro 2.
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•	 A janela Create Ellipsoid Geometry será aberta. Os campos deverão 
ser preenchidos conforme ilustrado na Figura 4.23. Observe que essa 
primeira esfera terá como referência o Hardpoint hpl_arm_front, e 
pertencerá ao General Part gel_control_arm. Lembre-se que o campo 
Calculate Mass Properties of General Part deverá estar selecionado para 
atualização das propriedades de massa do General Part control_arm.

•	 Clique em Apply.

•	 O procedimento do item anterior deverá ser seguido para construção do 
Ellipsoid 2. A segunda esfera será localizada no Hardpoint arm_rear. O 
preenchimento da janela Create Ellipsoid Geometry para essa geome-
tria está ilustrado na Figura 4.24.

Figura 4.23 – Construção do Ellipsoid 1.

Figura 4.24 – Construção do Ellipsoid 2.
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•	 A terceira esfera será construída na intersecção dos dois Links (1 e 
2). A Figura 4.25 ilustra o preenchimento da janela Create Ellipsoid 
Geometry para construção dessa geometria.

•	 Clique em OK.

Figura 4.24 – Construção do Ellipsoid 3.

Após construção das geometrias que compõem o braço da suspensão, o Ge-
neral Part control_arm será atualizado com relação às suas propriedades de massa.

•	 Na tela principal do software, clique com o botão direito do mouse 
sobre o General Part gel_control_arm. Em seguida, clique em Modify 
(Figura 4.26).

Figura 4.26 – Modificando o General Part control_arm.
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•	 A janela Modify General Part será aberta. Para atualização das pro-
priedades de massa, clique no ícone da calculadora, como destacado na 
Figura 4.27. Após essa ação os dados serão automaticamente recalcu-
lados.

•	 Clique em OK.

Figura 4.27 – �Atualização das propriedades 
de massa do General Part 
“gel_control_arm”.

Etapa 7 – Criação da manga de eixo (Wheel Carrier)
Nesta etapa, será utilizada uma ferramenta a qual criará o General Part 

“wheel Carrier” juntamente com a geometria relacionada a este, ao contrário do 
que foi executado na Etapa 6, na qual, primeiramente, criou-se somente o corpo 
rígido (General Part) e, posteriormente, a geometria associada a ele. Ambos os 
procedimentos fornecem o mesmo resultado. 

•	 Primeiramente acesse o menu Build, clique em Parts → General Part → 
Wizard, conforme ilustra a Figura 4.28.
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A janela General Part Wizard será aberta e seu conteúdo deverá estar de 
acordo com a Figura 4.29.

Figura 4.28 – �Construção do General 
Part “Wheel Carrier”. 

Figura 4.29 – �Construção do General Part 
“Wheel Carrier” e geometria 
associada.
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O resultado está ilustrado na Figura 4.30. Observa-se a criação do General 
Part e de parte da geometria do Wheel Carrier (superfície plana triangular).

Figura 4.30 – General Part “Wheel Carrier” construído.

Nas próximas etapas, serão construídas as geometrias complementares do 
General Part “Wheel Carrier”, as quais correspondem a dois Links. 

•	 Acesse o menu Build → Geometry → Link → New (Figura 4.31) para 
construir o Link formado pelos Hardpoints Strut_Lower e Tierod_Outer.

Figura 4.31 – �Construção do Link do General 
Part “Wheel Carrier”.
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Figura 4.32 – Criação do primeiro Link pertencente ao General Part “Wheel Carrier”.

Figura 4.33 – Criação do primeiro Link pertencente ao General Part “Wheel Carrier”.

A janela Create Link Geometry será aberta e a Figura 4.32 ilustra seu preen-
chimento.

O mesmo procedimento do item anterior deve ser seguido para constru-
ção do segundo Link, o qual é formado pelos Hardpoints hpl_wheel_carrier e 
hpl_tierod_outer, conforme ilustrado na Figura 4.33.
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A Figura 4.34 mostra a geometria resultante para o General Part “Wheel 
Carrier”.

Figura 4.34 – Geometria completa do General Part “Wheel Carrier” e “Control Arm”.

Etapa 8 – Criação do corpo rígido para ancoragem no chassi
Nesta etapa, será construído o corpo rígido para ancoragem no chassi. É 

nesse mesmo corpo rígido que definiremos a mola e o amortecedor da suspensão.
•	 Antes de criar o “General Part” de interesse e suas geometrias, será cria-

do um Construction Frame para definir a orientação da estrutura a ser 
criada. Para isso, acesse o menu Build → Construction Frame → New 
(Figura 4.35).

A notar: O Construction Frame é parametrizável, e acompanha as alterações realizadas 
nos Hardpoints relacionados a ele.
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Figura 4.35 – Criação de um Construction Frame.

Figura 4.36 – �Construção do Construction 
Frame “Strut_midle”.

A janela Create Construction Frame será aberta e os campos deverão ser 
preenchidos, conforme ilustrado na Figura 4.36. Note que esse Construction Fra-
me será construído entre os seguintes Hardpoints: hpl_strut_lower e hpl_strut_
upper, e terá seu eixo Z definido na direção desses Hardpoints.

•	 Clique em OK.
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A Figura 4.37 ilustra o Construction Frame construído.

Figura 4.37 – Construction Frame “Strut_midle”.

•	 Após a construção do Construction Frame, a próxima etapa é a criação 
do corpo rígido ou General Part “Strut”. Neste General Part serão de-
finidos os parâmetros da mola e do amortecedor da suspensão. Acesse 
o menu Build  Parts → General Part → Wizard, conforme ilustrado na 
Figura 4.38.

Figura 4.38 – �Construção de um General 
Part com opção Wizard.
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Figura 4.39 – Construção do General Part “Strut”.

Figura 4.40 – Criando uma nova geometria do tipo Link.

A janela General Part Wizard será aberta e seus campos deverão ser preen-
chidos, conforme mostrado na Figura 4.39. Note que, nessa etapa, está sendo 
construído um General Part de nome Strut e também uma geometria associada a 
ele, correspondendo a um Link definido pelo Hardpoint “hpl_strut_upper” e pelo 
Construction Frame “strut_midle”.

Ainda nesta etapa, será construída uma geometria pertencente ao General 
Part “Wheel_Carrier”, a qual necessita do Construction Frame “strut_midle” 
para definir sua orientação.

•	 Acesse o menu Build → Geometry → Link → New (Figura 4.40).
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A janela Create Link Geometry será aberta e seus campos deverão ser preen-
chidos conforme mostrado na Figura 4.41. Note que esse Link é formado pelo 
Hardpoint “hpl_Strut_Lower” e o Construction Frame “cfl_strut_midle”.

•	 Clique em OK. 

Figura 4.41 – �Construção do Link perten-
cente ao General Part “Wheel_
Carrier”.

A Figura 4.42 ilustra a geometria construída.

Figura 4.42 – Ilustração da geometria da suspensão parcialmente construída.
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Etapa 9 – Definindo parâmetros da suspensão
Nest a etapa, serão definidos os parâmetros de Camber e Toe (convergência) 

da suspensão.

A notar: Na vista frontal do veículo, o câmber é o ângulo de inclinação vertical de 
uma roda e é medida em graus entre a linha de centro vertical no referencial da roda e 
a linha vertical no referencial do solo. Quando a parte superior da roda está para fora 
em relação à linha vertical do referencial do solo, o câmber é positivo. O inverso resulta 
em câmber negativo. De uma forma geral, deseja-se que o câmber do veículo esteja, na 
maior parte do tempo, o mais próximo possível de zero grau, quando o veículo estiver 
percorrendo trajetórias retas, de forma a reduzir o desgaste do pneu e aumentar a 
aderência entre os pneus e o solo, garantindo assim o melhor desempenho possível nas 
frenagens e acelerações do veículo. O fundamento da utilização do câmber é manter 
a maior área possível da banda de rodagem do pneu em contato com o solo, de modo 
que o desgaste dessa banda de rodagem ocorra de forma uniforme. Se o câmber estiver 
muito acentuado poderá ocorrer desgaste prematuro do pneu.

Na vista de topo do veículo define-se como convergência (toe setting) a abertura 
horizontal entre duas rodas de um mesmo eixo. Se estiverem mais afastadas na frente, 
a direção é definida como divergente (toe out) e; se mais abertas atrás, convergente 
(toe in). Geralmente os carros de tração traseira utilizam rodas dianteiras convergentes 
e traseiras divergentes. Da mesma forma, os de tração dianteira possuem rodas 
dianteiras divergentes e traseiras convergentes. Essas implementações aos sistemas de 
suspensão do veículo são utilizadas, pois o torque que as rodas causam ao tracionar 
o veículo ocasionam a geração de força nos braços da suspensão, para frente, no caso 
de tração no eixo, e para trás, no caso de frenagem.

Camber. 

Fonte: DISCOUNT. Disponível em: 
<http://www.discounttiredirect.com/di-
rect/brochure/info/tmpInfoAlignment.
jsp>. Acesso em: 22/04/2013

Toe. 

Fonte: Reglajes del Mugen Seiki MTX – 
3 1. Disponível em: <http://usuarios.
multimania.es/koldolo/reglajes-mtx3/
Reglajes.htm>. Acesso em: 22/04/2013
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•	 Acesse o menu Build → Suspension Parameters → Toe/Camber Values → 
Set (Figura 4.43). 

Figura 4.43 – �Definindo parâmetros de Toe 
e Camber da suspensão.

Figura 4.44 – �Definição dos valores 
de Toe e Camber.

A janela Set Toe & Camber Values será aberta e os valores desses parâmetros 
deverão ser inseridos nos campos disponíveis, de acordo com o projeto. Note 
que os valores requeridos se referem a ambos os lados: esquerdo (Left) e direito 
(Right) (Figura 4.44).

•	 Clique em OK.

Etapa 10 – Construção do cubo de roda (Hub Bearing) 

A notar: Os cubos de roda são o suporte do disco de freio ou do tambor de freio. 
Nele, estão fixados os parafusos de roda e o rolamento de roda. O cubo também 
serve para transmitir o torque da junta homocinética para as rodas do veículo, dando 
movimento a ele.
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Para construção do corpo rígido denominado Cubo de Roda (General Part 
“Hub Bearing”) é necessário primeiramente criar um novo Construction Frame, 
o qual irá fornecer a orientação definida pelas variáveis Toe e Camber para o 
General Part a ser criado.

•	 Acesse o menu Build → Construction Frame → New (Figura 4.45). 

Figura 4.45 – Construção de um novo Construction Frame.

Cubo de roda. 
Fonte: AUTO PEÇAS VRS. Disponível em: 
<http://autopecasvr2.lojatemporaria.com/
pecas-mecanicas/cubos-de-roda.html.> 
Acesso em:22/04/2013

A janela Create Construction Frame será aberta e os campos deverão ser 
preenchidos, conforme mostrado na Figura 4.46. Observe que o Construction 
Frame estará localizado no hpl_Wheel_Center e terá sua orientação definida pelas 
variáveis Toe e Camber declaradas anteriormente.

•	 Clique em OK. 

MSC_ADAMS_prova-4.indb   255 17/10/14   16:08



256 MSC ADAMS: Guia Prático de Utilização

Figura 4.46 – �Definindo a posição da 
Construction Frame.

Figura 4.47 – �Construction Frame “hub_
bearing” construído.

A Figura 4.47 ilustra o Construction Frame “hub_bearing” construído. 

Após construção do Construction Frame, a próxima etapa será criar o cor-
po rígido que representará o Cubo de Roda. 

•	 Menu Build → Parts → General Part → New (Figura 4.48).
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•	 Os campos da janela Create General Part deverão ser preenchidos, con-
forme ilustrado na Figura 4.49. Note que a orientação deste General 
Part é dada pelo Construction Frame “hub_bearing” criado anterior-
mente. As propriedades de massa são inseridas, a priori, com valores 
fictícios para que, após a construção da geometria, esses dados sejam 
recalculados e atualizados.

•	 Clique em OK.

Figura 4.48 – �Construction Frame “hub_
bearing” construído.
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Na Figura 4.50 está mostrado o General Part “hub_bearing” construído.

Figura 4.49 – �Criação do General 
Part “hub_bearing”.

Figura 4.50 – General Part “hub_bearing” construído.
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•	 Para construção da geometria associada ao General Part “hub_bearing” 
acesse o menu Build  Geometry → Cylinder → New (Figura 4.51).

Figura 4.51 – �Criação de uma geometria 
do tipo Cylinder.

A notar: A diferença entre as geometrias Link e Cylinder são sutis visualmente, 
diferenciando apenas no modo de construção das mesmas. Enquanto o Link necessita 
da definição de dois Hardpoints e do raio, o Cylinder requer a definição de um 
Construction Frame. O eixo z do Construction Frame define o eixo longitudinal do 
Cylinder, e seu comprimento é fornecido tanto no sentido positivo quanto negativo do 
eixo z. O raio do Cylinder também é um parâmetro requisitado.

A janela Create Cylinder Geometry será aberta e os campos a serem preenchidos 
estão ilustrados na Figura 4.52. Note que, para construção de uma geometria 
cilíndrica, é necessário definir um Construction Frame (3º campo) o qual já foi 
criado anteriormente nesta mesma etapa.

•	 Clique em OK.
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A Figura 4.53 ilustra o General Part “hub_bearing” construído.

Figura 4.52 – �Construção da geometria 
Cylinder pertencente 
ao General Part 
“hub_bearing”.

Figura 4.53 – General Part “hub_bearing” construído.
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Etapa 11 – Construção da barra de direção (Tie rod)

A notar: A barra de direção transfere o movimento de direção aplicado à caixa de 
direção para as rodas.

Nesta etapa, será construída a barra de direção, o qual será um General Part 
denominado por “Tierod”.

•	 Acesse o menu Build → Parts → General Part → Wizard (Figura 4.54).

Figura 4.54 – �Criação de um novo 
General Part.

Barra de direção lateral Scania f-94 (padrão 
cdm c/ reg. Dupla) 660.

Fonte: <Disponível em: http://www.
cdmbarras.com.br/catalogov.php>. Acesso 
em:22/04/2013

•	 Preencha os campos da janela General Part Wizard, conforme ilustrado 
na Figura 4.55. Note que a geometria associada a esse General Part é do 
tipo Link sendo este último definido pelos Hardpoints hpl_Tierod_Inner 
e hpl_Tierod_Outer.

•	 Clique em OK.
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A Figura 4.56 ilustra o General Part “tierod” construído.

Figura 4.55 – �Construção do 
General Part “tierod

Figura 4.56 – General Part “tierod” construído.

Etapa 12 – Criação das juntas da suspensão
Nesta etapa, serão inseridas quatro juntas no modelo multicorpos. Essas jun-

tas definem o tipo de movimento (graus de liberdade) entre os General Parts. A 
Tabela 4.2 relaciona as juntas a serem criadas.
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Tabela 4.2 – Juntas do modelo multicorpos da suspensão

Junta Tipo General Parts
1 Esférica control_arm e wheel_carrier
2 Esférica wheel_carrier e tierod
3 Cilíndrica strut e wheel_carrier
4 Revoluta wheel_carrier e hub_bearing

•	 Para inserção das juntas da suspensão, acesse o menu Build → Attach-
ments → Joints → New (Figura 4.57).

Figura 4.57 – �Criando uma 
junta (Joint).

•	 Os campos da janela Create Joint Attachment deverão ser preenchidos, 
conforme ilustrado na Figura 4.58, e de acordo com a Tabela 4.2.

•	 Clique em Apply, para definir a segunda junta.
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A Figura 4.59 ilustra a junta 1 construída.

Figura 4.58 – Criação da Junta 1.

Figura 4.59 – Junta 1 construída.

•	 Para construção da junta 2, preencha os campos da janela Create Joint 
Attachment, conforme mostrado na Figura 4.60.
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•	 Clique em Apply.

Figura 4.60 – Criação da Junta 2.

Figura 4.61 – Junta 2 construída.

A Figura 4.61 ilustra a junta 2 construída.
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•	 Para construção da junta 3 preencha os campos da janela Create Joint 
Attachment conforme ilustrado na Figura 4.62.

•	 Clique em Apply.

Figura 4.62 – Criação da Junta 3.

A Figura 4.63 ilustra a junta 3 construída.

Figura 4.63 – Junta 3 construída.
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•	 Para construção da junta 4, preencha os campos da janela Create Joint 
Attachment conforme a Figura 4.64.

•	 Clique em OK.

Figura 4.64 – Criação da Junta 4.

Figura 4.64 (a) – Junta 4 construída.
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Etapa 13 – Construção da mola (Spring)

A notar: As molas são o principal elemento elástico da suspensão e, a partir do momento 
de sua instalação, já estão em trabalho, permanecendo acionadas pelo peso da carroceria 
do veículo mais as cargas que ele estiver carregando (Pré-carga). Elas absorvem as 
irregularidades do terreno, controlam a altura do veículo e atuam sobre o alinhamento 
e o equilíbrio da suspensão. Os efeitos das molas fadigadas são verificados por impactos 
constantes na suspensão, desgaste acentuado dos pneus, amortecedores e batentes. Com o 
veículo em movimento, todas as oscilações de pista são absorvidas pela mola. Sendo assim, 
uma lombada causa o fechamento da mola, enquanto um buraco provoca sua abertura. 
Tanto na abertura quanto no fechamento, a mola irá absorver energia, que, ao ser liberada, 
será controlada pelo amortecedor, suavizando assim os movimentos de retorno da mola 
para a posição original. Portanto, a mola é quem absorve grande parte dos movimentos 
recebidos pela suspensão. Dessa forma, se as molas não estiverem boas, as condições de 
conforto, estabilidade e segurança ficam seriamente comprometidas.

Nesta etapa, será definida a mola da suspensão. Ressalta-se que a mola não 
é considerada um corpo rígido, portanto sua criação não se dará por meio da 
criação de um General Part. No ADAMS, a mola é definida por meio da criação 
de uma força.

•	 Acesse o menu Build → Forces → Spring → New (Figura 4.65). 

Molas helicoidais. 
Fonte: Seat Edition . Disponível 
em: <http://seatedition.livreforum.
com/>. Acesso em 22/04/2013:
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•	 Preencha os campos da janela Create Spring conforme mostrado na Fi-
gura 4.66. Note que a mola é definida entre os corpos rígidos strut 
e wheel_carrier. Atente para o preenchimento do valor de pré-carga 
(Preload) a ser definido para a mola, como destacado na Figura 4.66. A 
curva característica da mola pode ser editada manualmente pelo usuá-
rio e salva em arquivo externo ou o usuário poderá utilizar informações 
da própria biblioteca do software (campo Property File), como é o caso 
deste modelo.

•	 Clique em OK.

Figura 4.65 – Criando uma mola.

Figura 4.66 – Definição da mola da suspensão.
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A Figura 4.67 ilustra a mola construída.

Figura 4.67 – Mola construída.

Etapa 14 – Construção do amortecedor (Damper)

A notar: O amortecedor é um elemento de ligação entre a suspensão e a carroceria, capaz 
de controlar os movimentos das molas, fazendo com que o veículo mantenha a aderência 
ao solo. A estabilidade, o conforto e a segurança ficam diretamente comprometidos, se os 
amortecedores não estiverem atuando corretamente. O amortecedor possui, em seu interior, 
um fluido denominado óleo hidráulico, de características especiais para suportar baixas e 
altas temperaturas, funcionando segundo princípios hidráulicos.

Da mesma maneira que a mola, o amortecedor também é criado por meio da 
definição de uma força.

•	 Acesse o menu Build → Forces → Damper → New (Figura 4.68). 

Amortecedor. 
Fonte: WOLLOKO. Disponível 
em: <http://www.wollokoclube.
com.br/index.php/qual-a-vida-
-util-de-um-amortecedor/>. Acesso 
em:22/04/2013
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•	 O preenchimento dos campos da janela Create Damper é muito seme-
lhante ao da Etapa 13, conforme mostrado na Figura 4.69. O amorte-
cedor também é definido entre os corpos rígidos strut e wheel_carrier e 
sua curva característica pode ser inserida do próprio software ou editada 
manualmente pelo usuário e utilizada no modelo. Como se pode obser-
var na Figura 4.69, no campo Property File, as propriedades do amor-
tecedor são definidas no arquivo especificado na biblioteca do software.

Figura 4.68 – Definição do amortecedor da suspensão.

Figura 4.69 – Definição do amortecedor da suspensão.
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A Figura 4.70 ilustra o amortecedor construído.

Figura 4.70 – Amortecedor construído.

Etapa 15 – Definindo parâmetros da suspensão 	
Ao finalizar esta etapa, o software terá informações suficientes para determi-

nar o ângulo de esterçamento e Caster da suspensão em construção.
•	 Acesse o menu Build → Suspension Parameter → Characteristics Array → 

Set (Figura 4.71).

Figura 4.71 – �Determinando os parâ-
metros da suspensão.
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•	 A janela Suspension Parameters Array deverá ser preenchida conforme 
ilustrado na Figura 4.72. Note que a suspensão foi definida como do 
tipo Independente, tendo o Steer Axis na direção definida pelos Hard-
points hpl_Strut_Lower e hpl_LBJ.

•	 Clique em OK.

Figura 4.72 – �Definição dos parâme-
tros da suspensão.

Figura 4.73 – Criando um novo Mount.

Etapa 16 – Criação do Mount “subframe_to_body”
Nesta etapa, será criado o Mount denominado subframe_to_body, o qual 

tem como função estabelecer a conexão do subsistema suspensão ao subsistema 
chassi (body). Durante a simulação, a transferência de dados de um subsistema 
para o outro é feita por meio dessa comunicação (Mount).

•	 Para criar um novo Mount, acesse o menu Build → Parts → Mount → 
New (Figura 4.73). 
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•	 A janela Create Mount Part deverá ter seus campos preenchidos, confor-
me mostrado na Figura 4.74. Note que o nome do Mount deve ser exa-
tamente o mesmo definido no outro susbsistema, nesse caso, o chassi. 
Ainda com relação à Figura 4.74, a coordenada de referência utilizada 
é o Hardpoint “hpl_arm_front” e definiu-se a suspensão como dianteira 
(front).

•	 Clique em OK.

Figura 4.75 – Mount “subframe_to_body” definido no modelo da suspensão.

Figura 4.74 – �Criação do Mount 
“subframe_to_body”.

Na Figura 4.75 o Mount “subframe_to_body” está destacado. 

Após criação do Mount “mtl_subframe_to_body” uma nova junta será cons-
truída, a qual restringe os movimentos de ligação do braço da suspensão com o 
chassi.

•	 Acesse o menu Build → Attachments → Joint → New (Figura 4.76). 
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•	 Na janela Create Joint Attachment, preencha os campos, confor-
me mostrado na Figura 4.77. Note que essa junta é do tipo revolu-
ta e é construída entre o General Part “gel_control_arm” e o Mount 
“mtl_subframe_to_body”.

•	 Clique em OK.

Figura 4.76 – Criando uma nova junta.

Figura 4.77 – Criação da junta 5.
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A Figura 4.78 ilustra a junta construída.

Figura 4.78 – Junta 5 construída.

Etapa 17 – Criação de Communicators
Nesta etapa, serão criados communicators do tipo output, os quais estabele-

cerão a comunicação do subsistema suspensão com os diversos subsistemas que se 
acoplará a esse subsistema de suspensão (roda e sistema de direção, entre outros). 
Resalta-se novamente que os nomes designados aos communicators devem ser 
iguais aos dos communicators dos susbsistemas de interesse.

•	 Para criação do primeiro Communicator do tipo output, acesse o menu 
Build → Communicator → Output → New (Figura 4.79). Esse communi-
cator fará a comunicação entre o General Part “hub_bearing” (cubo de 
roda) e o subsistema Roda.

•	 A janela Create Output Communicator deverá ser preenchida conforme 
ilustrado na Figura 4.80.

•	 Clique em Apply.
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Figura 4.79 – Criando um 
Communicator do tipo Output.

Figura 4.80 – �Criação do Communicator 
“suspension_mount”.

Figura 4.81 – Criação do Communicator “suspension_upright”.

•	 Para criação do communicator “suspension_upright”, preencha os cam-
pos da janela Create Output Communicator, conforme mostrado na 
Figura 4.81.

•	 Clique em Apply.
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A Figura 4.82 ilustra a criação do communicator “wheel_center”.
Clique em OK.

Figura 4.82 – �Criação do Communica-
tor “wheel_center”.

Etapa 18 – Criação da junta Universal (Hooke)u

A notar: A junta universal (junta de Cardan, ou ainda junta de Hooke) permite a 
transmissão de um conjugado motor, assegurando, ao mesmo tempo, um deslocamento 
angular entre o eixo motriz e o eixo receptor. Em suma, ela transfere o movimento 
de um eixo a outro com direção diferente, porém sem modificar o sentido de giro. 
Sua função nos automóveis é transmitir às rodas (quando forem ao mesmo tempo 
motrizes e diretrizes) um movimento de rotação. A extremidade de cada um dos dois 
eixos é terminada por um garfo; os dois garfos são ligados entre si por uma cruzeta 
central. 

Nesta etapa, será construída a junta universal ou Hooke a qual tem como 
coordenada de referência o Hardpoint “hpl_Strut_Upper”.

•	 Acesse o menu Build → Attachments → Joint → New (Figura 4.83).

Junta universal. 
Fonte: Aguamarket. Disponí-
vel em: < http://www.aguama-
rket.com/diccionario/terminos.
asp?Id=7441&termino=Cardn >. 
Acesso em: 22/04/2013
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O preenchimento dos campos da janela Create Join Attachment deve estar de 
acordo com a Figura 4.84. Note que essa junta está sendo criada entre o General 
Part “gel_strut” e o Mount “mtl_subframe_to_body”.

•	 Clique em OK.

Figura 4.83 – Criando uma nova junta.

Figura 4.84 – Criação da junta Hooke.
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A Figura 4.85 ilustra a junta Hooke construída.

Figura 4.85 – Junta Hooke construída.

Etapa 19 – Criação da junta no eixo de direção (Convel Joint)
Nesta etapa, será criada uma junta do tipo convel no eixo de direção (Tie 

rod), a qual restringirá os movimentos desse eixo para o subsistema “Sistema de 
Direção”.

Primeiramente, crie um Mount denominado tierod_to_steering. Acesse o 
menu Build → Parts → Mount → New (Figura 4.86).

Figura 4.86 – Criando um novo Mount.
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•	 Preencha os campos da janela Create Mount Part, conforme ilustrado 
na Figura 4.87. Note que ele está localizado nas coordenadas do Hard-
point hpl_Tierod_Inner.

•	 Clique em OK.

Figura 4.88 – Criação do Mount “tierod_to_steering”.

Figura 4.87 – �Criação do Mount 
“tierod_to_steering”.

A Figura 4.88 destaca o Mount criado. 

Para criar a junta no eixo de direção, acesse o menu Build → Attachments → 
Joint → New (Figura 4.89). 
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Crie a junta do tipo convel, conforme ilustrado na Figura 4.90. Note que 
essa junta é definida pelo General Part “gel_tierod” e o Mount “mtl_tierod_to_
steering”. Atente para o Hardpoint destacado na Figura 4.90.

Figura 4.89 – Criando uma nova junta.

Figura 4.90 – Criando uma nova junta.

A Figura 4.91 ilustra a junta do eixo de direção construída.
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Figura 4.92 – Obtendo informações sobre os communicators.

Figura 4.91 – Junta do eixo de direção construída.

Etapa 20 – Realizando teste de compatibilidade entre communicators
Nesta etapa serão obtidas informações sobre os communicators criados, e 

ainda será feito um teste de compatibilidade entre estes e os communicators do 
subsistema de interesse (nesse caso, o subsistema MDI_ Suspension_ Testrig, o 
qual corresponde ao subsistema de teste da suspensão).

Para se obter informações sobre os Communicators criados, acesse o menu 
Build → Communicator → Info (Figura 4.92).
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A janela Communicators Info será aberta.
•	 No campo Type, selecione o item All. 
•	 No campo Entity selecione o item All.
•	 Clique em OK.

Figura 4.93 – Selecionando os tipos de Communicators.

Figura 4.94 – �Informações sobre 
os Communicators.

A janela Information será aberta e, nela, constam as informações requeridas.
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Figura 4.95 – �Realizando teste de compati-
bilidade dos communicators.

Figura 4.96 – �Subsistemas a serem submetidos 
a teste de compatibilidade de 
Communicators.

•	 Após análise das informações clique em Close nesta mesma janela.
•	 Para teste de compatibilidade dos communicators com o susbsistema 

MDI_ Suspension_ Testrig, acesse o menu Build→Communicator→Test 
(Figura 4.95).

•	 Na janela Test Communicators, verifique os subsistemas a serem testa-
dos. Nesse caso, observa-se na Figura 4.96 que o teste será feito entre o 
subsistema da suspensão em construção e do subsistema corresponden-
te a uma plataforma de teste denominado MDI_ Suspension_ Testrig.

•	 Clique em OK.
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A janela Information será aberta e nela é possível verificar se há algum erro 
de comunicação entre communicators, para que possam ser realizadas as corre-
ções necessárias.

Figura 4.97 – �Informação de compatibili-
dade dos communicators. 

Figura 4.98 – Criando uma bucha.

Etapa 21 – Construção das buchas (Bushing)
Nesta etapa, serão criadas as buchas da suspensão, totalizando três buchas. 

A construção da suspensão (projeto) será finalizada ao fim desta etapa.  
•	 Para criar a primeira bucha, a qual estará localizada na mesma coorde-

nada que o Hardpoint “hpl_arm_front”, acesse o menu Build → Attach-
ments → Bushing → New (Figura 4.98).
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Figura 4.99 – Criação da primeira bucha.

•	 Os campos da janela Create Bushing Attachment deverão ser preenchi-
dos conforme ilustrado na Figura 4.99. Note que essa bucha é criada 
entre o General Part “gel_control_arm” e o Mount “mtl_subframe_to_
body”. Um arquivo com as propriedades da bucha deve ser selecionado 
(no campo Property File), podendo este ser da biblioteca do software ou 
editado pelo usuário.

•	 Clique em OK.
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A Figura 4.100 ilustra a bucha criada no passo anterior.

Figura 4.100 – Primeira bucha construída e inserida no modelo.

•	 Para construção da segunda bucha, a qual estará localizada no Hard-
point hpl_arm_rear, acesse o menu Build → Attachments → Bushing → 
New (Figura 4.101).

Figura 4.101 – Criando a segunda bucha.
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•	 Preencha os campos da janela Create Bushing Attachment, como ilus-
trado na Figura 4.102. Note que essa bucha também é construída entre 
o General Part “gel_control_arm” e o Mount “mtl_subframe_to_body”.

Figura 4.102 – Criação da primeira bucha.
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A Figura 4.103 ilustra a segunda bucha construída.

Figura 4.103 – Segunda bucha construída e inserida no modelo.

Figura 4.104 – Modificando a Junta joint5.

•	 Com a inserção dessas duas primeiras buchas, a junta revoluta joint5 
deverá ser modificada. Para isso, selecione essa junta na tela principal 
do software, com o botão direito do mouse (sobre a junta). Selecione a 
opção Modify (Figura 4.104).
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•	 Na janela Modify Joint Attachment, selecione o item Kinematic mode 
(Figura 4.105).

•	 Clique em OK.

Figura 4.105 – Modificação realizada na junta joint5.

Figura 4.106 – Criando a terceira bucha.

•	 Para construção da terceira bucha, acesse o menu Build → Attachments 
→ Bushing → New (Figura 4.106). 
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•	 Preencha os campos da janela Create Bushing Attachment, conforme 
mostrado na Figura 4.107. Note que essa bucha está localizada entre a 
suspensão e o chassi, uma vez que envolve o General Part “gel_strut” e 
o Mount “mtl_subframe_to_body”.

•	 Clique em OK.

Figura 4.107 – Criação da terceira bucha.
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O Template da suspensão agora está finalizado. Aconselha-se salvar esse pro-
jeto.

Em função do usuário, o projeto pode ser salvo e aberto posteriormente, 
podendo ter continuidade. No entanto, quando o Template é aberto a partir de 
um arquivo salvo, comumente, o modelo aparece na tela principal sem todos os 
detalhes construídos, comumente vistos pelo usuário durante a construção do 
modelo, tais como buchas, juntas etc.

•	 Para que todos os detalhes construtivos estejam visíveis no modelo, cli-
que com o botão direito do mouse em qualquer região da tela principal.

•	 Na janela que se abriu, clique em Toogle Icon Visibility (Figura 4.109). 

Figura 4.108 – Terceira bucha construída e inserida no modelo.
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Etapa 22 – Criação do subsistema (Subsystem)
Uma vez concluído o projeto da suspensão (Template), se faz necessária a 

criação do subsistema da suspensão (Subsystem) para que possam ser realizadas 
simulações no modelo criado.

•	 Ainda na tela principal do Template, salve-o e pressione a tecla F9 do 
teclado. Essa ação resulta na transferência para o ambiente standard 
do ADAMS/Car (destacado na Figura 4.110). A Figura 4.110 ilustra a 
interface resultante.

A notar: Para alternar do modo Template para o Standard ou vice versa,clique no menu 
Tools e em seguida em ADAMS/Car Template Builder (caso necessite ir paro o Template) 
ou selecione Adams Standard Car Interface (caso necessite ir paro o Standard). Uma 
forma mais rápida (atalho) é utilizar a tecla “F9” para alternar entre as interfaces.

Figura 4.109 – �Ativando para visualização os 
detalhes construtivos do modelo.
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•	 Para criar o subsystem, acesse o menu File → New → Subsystem (Figura 
4.111).

Figura 4.111 – Criando o Subsystem.

•	 Preencher os campos da janela New Subsystem, conforme ilustrado na 
Figura 4.112. Note que, como o projeto se trata de uma suspensão dian-
teira o campo Minor Role,  deverá estar selecionado com a opção front. 
O nome de subsystem pode ser o mesmo já designado no template.

Figura 4.110 – Interface do modo Standard.
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A Figura 4.114 ilustra o Subsystem criado.

Figura 4.112 – Criação do subsistema.

Figura 4.113 – Confirmação de uti-
lização do Template em execução.

Caso o Template esteja aberto, a janela ilustrada na Figura 4.113 será aberta. 
Para confirmar, clique em Yes.

Figura 4.114 – Subsistema da suspensão.
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Salve o subsistema, conforme ilustrado na Figura 4.115.

Figura 4.115 – �Salvando o subsistema 
suspensão.

Figura 4.116 – Criando um Assembly.

Etapa 23 – Criação do Assembly
Nesta etapa, será criado o Assembly, o qual é uma hierarquia definida após 

o subsistema. O Assembly representa uma montagem entre subsistemas e, no 
ADAMS/Car, pode ser escolhido entre as seguintes opções: Suspension Assembly 
ou Full-Vehicle Assembly. Como, neste caso, a simulação será realizada apenas 
com o subsistema suspensão e uma plataforma de testes, a primeira opção será 
escolhida. 

•	 Ainda na tela onde foi criado o subsistema da suspensão, acesse o menu 
File → New → Suspension Assembly (Figura 4.116). 

•	 A Figura 4.117 ilustra o preenchimento da janela New Suspension As-
sembly. Atribua um nome ao Assembly, no primeiro campo, este deve ser 
diferente do nome atribuído ao Subsystem. Selecione o subsistema de in-
teresse (segundo campo). No campo Suspension Test Rig, a opção _MDI_
SUSPENSION_TESTRIG  deve estar selecionada, a qual corresponde 
à plataforma de teste a ser utilizada nas simulações. Caso deseje incluir 
outros subsistemas na simulação, selecione o item Other Subsystems.
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•	 Clique em OK.

Figura 4.117 – Criação do Assembly.

Figura 4.118 – �Confirmação de criação do Assembly.

•	 A janela ilustrada na Figura 4.118 será aberta, confirmando a criação 
do Assembly. Essa mesma janela poderá fornecer informação de algum 
erro durante a criação deste para possíveis correções no modelo.

A Figura 4.119 ilustra o Assembly construído.
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Etapa 24 – Simulação
Nesta etapa, será realizada a simulação do Assembly. 
•	 Primeiramente, defina o diretório para armazenar os resultados gerados 

na simulação. Acesse o menu File → Select directory (Figura 4.120).

Figura 4.120 – Selecionando diretório para simulações.

Figura 4.119 – Assembly construído.

•	 Selecione o diretório de interesse (Figura 4.121).
•	 Clique em OK.
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•	 A simulação aqui proposta corresponde a uma solicitação vertical e pa-
ralela na suspensão (left e rigth). Ela permite analisar as características 
da suspensão durante todo seu curso vertical. Para isso, acesse o menu 
Simulate → Suspension Analysis → Parallel Wheel Travel (Figura 4.122).

Figura 4.121 – �Diretório selecionado 
para as simulações.

Figura 4.122 – �Selecionando o tipo 
de simulação.

•	 Os parâmetros de simulação devem ser definidos na janela Suspension 
Analysis: Parallel Travel, conforme ilustrado na Figura 4.123. Note que, 
na simulação proposta, o percurso total corresponde a 100 mm (50 mm 
no sentido positivo, ou Bump e 50 mm no sentido negativo, Rebound).

•	 Clique em OK.
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A Figura 4.124 ilustra que a simulação foi executada.
•	 Clique em Close.

Figura 4.123 – �Definindo os parâmetros 
de simulação.

Figura 4.124 – �Caixa de diálogo in-
formando que a simu-
lação foi executada.V

Figura 4.125 – Animando o modelo da suspensão.

Etapa 25 – Animação dos resultados
Nesta etapa, o modelo da suspensão será animado, conforme a simulação 

proposta. 
•	 Acesse o menu Review → Animation Controls (Figura 4.125).
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•	 Na janela Animation Controls, preencha os campos, conforme ilustrado 
na Figura 4.126. O usuário pode definir os parâmetros de animação de 
acordo com sua preferência, ou seja, permitindo uma animação lenta ou 
rápida. Segue, como sugestão, os parâmetros descritos na Figura 4.126.

•	 Para inicializar a animação clique em .

Figura 4.126 – Definição dos parâmetros de animação.

Para melhor visualização do modelo da suspensão durante a animação, o 
usuário pode optar pelo modo Shaded. Para isto, ao terminar a animação, clique 
com o botão direito do mouse na área de trabalho principal e selecione Shaded 
<S> (Figura 4.127).
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A Figura 4.128 ilustra como o modelo será apresentado na tela principal. A 
animação pode ser recomeçada selecionando-se o item .

Figura 4.127 – Modo de visualização Shaded.

Figura 4.128 – Animação sendo executada.

MSC_ADAMS_prova-4.indb   303 17/10/14   16:09



304 MSC ADAMS: Guia Prático de Utilização

Etapa 26 – Definindo sensores virtuais (Requests) 
Nesta etapa, será possível definir a nível de exemplo sensores virtuais de me-

dições no modelo proposto. Estes podem ser definidos na posição de interesse do 
usuário. No entanto, para criar esses Requests é necessário que o usuário retorne 
para o modo Expert.

Fica a critério do usuário explorar a ferramenta Requests e analisar os resul-
tados gerados. A proposta desta etapa é apenas auxiliá-lo na utilização da ferra-
menta e mostrar suas potencialidades.

•	 Selecione a tecla F9. Isso o fará retornar à interface Expert.
•	 Acesse o menu Build → Request → New (Figura 4.129). 

A notar: Note que, para definir os Requests, é necessário ter, no modelo, os Markers 
já definidos, os quais são pontos criados estrategicamente para definir o Request. Para 
definir um Marker o usuário de acessar o menu Build → Marker → New. Ex.: Cria-se 
dois Markers em pontos específicos da suspensão. Ao criar o Request que fornecerá 
deslocamento, o software solicitará a informação entre quais Markers o software 
calculará este deslocamento, e isto será delimitado pelos Markers existentes. 

Figura 4.129 – Criando um novo Request.
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•	 A janela Create Request será aberta, conforme ilustra a Figura 4.130. O 
nome do Request deve ser definido no primeiro campo. Para especificar 
o tipo de sensor (deslocamento, velocidade e aceleração, entre outros), 
clique no ícone , no campo disponível em branco. No caso da Figura 
4.130 esse campo corresponde ao indicado por F2.

Figura 4.130 – �Definindo propriedades 
do Request.

•	 A janela Function Builder será aberta, conforme ilustrado na Figura 
4.131. 

•	  Selecione o tipo de parâmetro a ser medido, selecionando o item dese-
jado no campo 1, como destacado na Figura 4.131.

•	 Selecione o item de interesse como ilustrado no campo 2 (Figura 4.131). 
A seleção do item Distance Magnitude no campo 2 resultará na abertu-
ra da caixa de diálogo Distance Magnitude, na qual se define os Markers 
(Figura 4.131).

•	 Para inserir detalhes do Request especificado clique no campo 3 (Figura 
4.131).

Clique em OK.
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Figura 4.131 – �Especificando 
o Request.

Figura 4.132 – Criação do Request.

•	 Ao retornar à janela Create Request, informações complementares de-
vem ser preenchidas nos campo Component Attributes, conforme des-
tacado na Figura 4.132.

•	 Clique em OK.
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Na próxima etapa a suspensão modelada será acoplada ao subsistema dire-
ção para que possam ser realizadas simulações.

Etapa 27 – Construção do Assembly: Suspensão Macpherson/Sistema de 
Direção
Esta etapa parte da premissa que o usuário possui o Template da suspensão 

(desenvolvido anteriormente) armazenado em seu banco de dados e este já se en-
contra aberto no software ADAMS/Car.

A partir do Template da suspensão criada anteriormente define-se o subsis-
tema (Subsystem) “suspensão”. O Assembly será criado acoplando este último ao 
subsistema “sistema de direção” (disponível na própria biblioteca do ADAMS/
Car). A Figura 4.133 ilustra a Assembly a ser criado a partir desta etapa.

Figura 4.133 – Assembly Suspensão–Sistema de Direção.

•	 Para criar o Subsystem da suspensão verifique se o ADAMS/Car encon-
tra-se na interface Standard.

•	 Acesse o menu File → New → Subsystem.
•	 A Figura 4.134 ilustra o preenchimento dos campos da caixa de diálogo 

que será aberta. No campo Minor Role, selecione front, caracterizando, 
portanto, uma suspensão dianteira. No campo Template Name, selecio-
ne o arquivo (extensão .tpl) correspondente à suspensão Macpherson, 
criada nos passos anteriores (finalizado na Etapa 21). Certifique-se que 
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a opção Translate from default position está selecionada. No campo Up 
translation, informe que será necessário uma translação de 50 mm para 
que esse Subsystem acople corretamente no sistema de direção.

Figura 4.134 – Criando o Subsystem da suspensão.

Figura 4.135 – Inserindo comentário no subsistema da suspensão.

•	 Para adicionar comentários sobre o subsistema a ser criado, selecione 
o ícone . A caixa de diálogo Modify Comment será aberta, confor-
me ilustrado na Figura 4.135, e o texto deverá ser inserido no campo 
Comment Text.
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Figura 4.136 – Subsystem criado utilizando o Template da suspensão MacPherson.

•	 Selecione a opção OK para confirmar as informações em ambas as ja-
nelas.

A Figura 4.136 mostra o subsistema referente à suspensão Macpherson.

•	 Salve o subsystem criado em File → Save.
•	 Para construção do Assembly, acesse o menu  File → New → Suspension 

Assembly.
•	 Preencha os campos da caixa de diálogo New Suspension Assembly 

conforme ilustrado na Figura 4.137. No campo Suspension Subsystem, 
selecione o susbsistema correspondente à suspensão Macpherson defi-
nido nos passos anteriores. Selecione o item Steering Subsystem, e en-
tão defina o arquivo .tbl (extensão utilizada paro o subsystem) de in-
teresse. Como será utilizado um subsystem da biblioteca da ADAMS/
Car, para selecioná-lo, clique com o botão direito do mouse no campo 
em amarelo, selecione a opção Search e então selecione <acar_shared>/
subsystems.tbl. Selecione o susbsistema denominado MDI_FRONT_
STEERING.sub.
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A Figura 4.138 ilustra a aparência final da caixa de diálogo New Suspension 
Assembly para criação do Assembly.

Figura 4.137 – �Definindo o 
Assembly.

Figura 4.138 – Definição do Assembly.

•	 Clique em OK. 
A Figura 4.139 ilustra a construção do Assembly.
•	 Clique em Close após verificar que o Assembly foi gerado com sucesso.
Salve o Assembly criado.
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Etapa 28 – Simulação do Assembly: suspensão Macpherson/sistema de direção
Nesta etapa será realizada uma análise do tipo Parallel Wheel Travel (curso 

paralelo das rodas) no Assembly gerado na Etapa 27. Para gerar a simulação são 
necessárias informações sobre o veículo no qual serão utilizados os subsistemas 
suspensão e sistema de direção.

•	 Para definir os parâmetros do veículo, os quais são necessários para a 
simulação, acesse o menu Simulate → Suspension Analyses → Set Suspen-
sion Parameters. A janela Suspension Analysis: Setup Parameters será 
aberta e deverá ter seus campos preenchidos conforme ilustrado na Fi-
gura 4.140.

Figura 4.139 – Geração do Assembly na interface principal do software.
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Observa-se na Figura 4.140 que o campo Drive Ratio possui valor igual a 
100, ou seja, toda a força motriz está aplicada nas rodas dianteiras. Já o campo 
Brake Ratio indica a força de frenagem aplicada nos freios dianteiros.

•	 Clique em OK.
•	 Para definir os parâmetros da simulação, acesse o menu Simulate → Sus-

pension Analyses → Parallel Wheel Travel (Figura 4.141). Nessa simula-
ção, o centro das rodas se irão se movimentar de – 100 mm a +100 mm 
em relação à sua posição inicial, mantendo, portanto, o volante fixo.

Figura 4.140 – Definindo os parâmetros da suspensão para simulação.
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•	 Selecione o ícone  para adicionar comentários.
•	 No campo Comment Text, insira o texto: Baseline Parallel Wheel Travel 

Analysis, o qual indica que o teste está sendo realizada com a suspensão 
padrão (Baseline), conforme ilustra a Figura 4.142.

Figura 4.141 – �Definindo os parâmetros 
da simulação.

Figura 4.142 – �Adicionando comen-
tário à simulação. 
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•	 Clique em OK em ambas as janelas.
A Figura 4.143 ilustra a condição da simulação realizada.

Figura 4.143 – Simulação realizada.

Caso a simulação tenha sido executada sem erros, clique na opção Close.

Etapa 29 – Animação dos resultados – Assembly suspensão Macpherson/
sistema de direção
Nesta etapa, os resultados obtidos na etapa 28 serão animados, facilitando 

sua compreensão. 
•	 Acesse o menu Review → Animations Controls.
•	 Preencha os campos da janela Animation Controls, conforme ilustrado 

na Figura 4.144.
•	 Selecione o ícone Play .
•	 Após a animação completa, feche a caixa de diálogo.
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Etapa 30 – Verificando os resultados (Plotting) 	
Nesta etapa, os resultados serão gerados em forma de gráficos, facilitando 

assim sua análise.
•	 Menu Review → Postprocessing Window. Caso deseje, o usuário poderá 

utilizar o atalho correpondente à tecla F8 do teclado. A Figura 4.145 
ilustra a interface PostProcessing.

Figura 4.144 – Painel de controle das animações. 
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Para criar os gráficos, acesse o menu Plot → Create Plot (Figura 4.146). 

Figura 4.145 – Interface PostProcessing.

Figura 4.146 – Gerando gráficos.

A janela File Import será aberta. 
•	 Selecione o tipo de arquivo: Plot Configuration (*.plt).
•	 O arquivo com a configuração desejada dos resultados deve ser selecio-

nado no campo Plot Configuration File. Para isto, clique com o botão 
direito do mouse sobre esse campo, e selecione a opção mostrada na 
Figura 4.147.
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•	 Na biblioteca do ADAMS/Car já existem diversas opções disponíveis de 
configurações de gráficos. Nesse caso, como estamos interessados nos 
resultados do Assembly suspensão/sistema de direção, ou seja, de uma 
suspensão com esterçamento, selecione a opção mdi_suspension_short.
plt (Figura 4.148).

Figura 4.147 – Importando arquivos de configuração dos gráficos.

Figura 4.148 – Definindo o arquivo de configuração dos gráficos.

O arquivo mdi_suspension_short.plt gera, automaticamente, nove gráficos, 
sendo eles: anti dive, camber angle, caster moment arm, roll camber coefficient, 
roll center height, roll steer, scrub radius, toe angle e wheel rate.

A Figura 4.149 ilustra a janela File Import, após preenchimento dos campos 
necessários.
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•	 Clique em OK.
•	 Para alternar entre os gráficos obtidos, selecione os ícones .
Como exemplo, o sétimo gráfico gerado corresponde ao parâmetro Scrub 

Radius (eixo vertical) em função do curso da roda (eixo horizontal), como pode 
ser observado na Figura 4.150.

Figura 4.149 – Configuração dos gráficos definidos.

Figura 4.150 – Gráfico Scrub Radius x Wheel Travel.

A notar: O raio de deslizamento do pneu, ou Scrub Radius (R0), é a distância, medida 
no plano frontal do veículo, entre o eixo king pin e a linha de contato do pneu com 
o solo. 
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Nas suspensões mais antigas, era usado o raio positivo, pois os sistemas de direção 
não eram assistidos hidraulicamente e o esforço em manobras com o veículo parado 
era menor com essa configuração, pois exigia que o pneu, ao ser esterçado, rodasse 
em seu próprio eixo. Assim, a roda de fora da curva se movimenta para frente e a 
de dentro, se movimenta para trás. Nessa configuração, as rodas podem apresentar 
shymming com maior frequência. Se o raio for pequeno, o esforço nas manobras com 
veículo parado será maior. Por outro lado, o motorista sentirá menos as reações das 
frenagens em linha reta. A utilização desse raio nulo tende a deixar o veículo instável 
com o veículo em movimento executando curvas. Na prática, costumam-se utilizar 
valores negativos para veículos de tração na dianteira ou nos dois eixos e valores 
positivos quando a tração do veículo é traseira.

Caso deseje apagar algum gráfico(s), selecione-o na árvore de diretórios – 
treeview (à esquerda da tela), conforme ilustrado na Figura 4.151. Recomenda-se 
apagar individualmente cada gráfico. O atalho Ctrl+X também pode ser usado 
para executar a ação de excluir o gráfico.

Scrub Radius.
Fonte: BEISSBARTH. Disponível 
em: <http://www.beissbarth.com/
tryit/index.php?ID=6&SUB1=13&
SUB2=29&LG=E&CS=3>. Acesso 
em:22/04/2013
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•	 Acesse o menu Edit → Delete (Figura 4.152).

Figura 4.151 – Selecionando gráficos para serem apagados.

Figura 4.152 – Excluindo gráficos.

•	 Para sair da interface PostProcessing, pressione a tecla F8 ou acesse o 
menu File → Close Plot Window.
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Etapa 31 – Executando uma Análise do tipo Pull
	 A simulação do tipo Pull possibilita analisar o comportamento da suspen-

são quando se gira o volante (steering wheel) do sistema em estudo.
Da análise realizada na etapa anterior, tem-se informação suficiente para 

calcular o torque aproximado no eixo de direção, utilizando-se, portanto, a dife-
rença das forças de frenagem (direita e esquerda) e o raio de deslizamento (Scrub 
Radius).

Utilizando esses resultados e ainda tendo disponível a geometria do sistema 
de direção, pode-se calcular o torque necessário aplicado ao volante para que as 
rodas se mantenham alinhadas (sigam um percurso reto).

Esses cálculos serão realizados a partir desta etapa. Para isso se utilizará uma 
análise do tipo Pull e, para tanto, é necessário primeiramente definir um Loadcase 
File no qual serão definidos os parâmetros da simulação.

•	 Acesse o menu Simulate → Suspension Analysis → Create Loadcase (Fi-
gura 4.153).

Figura 4.153 – �Criando o arquivo 
Loadcase.

A Figura 4.154 ilustra o preenchimento dos campos da janela Generate Lo-
adcase File. Primeiramente, defina o tipo de Loadcase, nesse caso, Static Load.

Note que os campos preenchidos nesse arquivo correspondem a informações 
de frenagem (Braking Force) e o ângulo de esterçamento do volante (Steer Lower 
Limit).

A força de frenagem será considerada desigual para ambas as rodas, simu-
lando, portanto, superfícies de rodagem com diferentes coeficientes de atrito.
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A notar: Esse tipo de superfície de rodagem recebe a denominação split-µ.

Para calcular as forças de frenagem assume-se que o veículo está freando a 
uma taxa de 0,5 g’s de desaceleração, considerando uma razão de frenagem de 
64% na dianteira e 36% na traseira. Considere a massa do veículo igual a 1400 
kg. A força de frenagem dianteira se divide em 55% para o lado esquerdo e 45% 
para o lado direito. Dessa maneira a força total de frenagem dianteira (Fbr) é 
calculada da seguinte forma:

Superfície split-µ.
Fonte: dSPACE. Disponível em: 
<http://www.dspaceinc.com/en/inc/
home/products/sw/expsoft/modesk.
cfm>. Acesso em:22/04/2013

= ⋅ ⋅ ⋅ =F kg g m s N1400 0,5 9,81 0,64 4395br
2

Ainda para a força de frenagem dianteira, tem-se:

Força de frenagem dianteira esquerda: 0.55 × 4395 N = 2417 N 
Força de frenagem dianteira direita: 4395 N –  2417 N = 1978 N

Observe que o ângulo de esterçamento do volante varia entre – 180º e 180º 
(Figura 4.154). Define-se o número de steps igual a 15 e o nome do arquivo como 
brake_pull (Figura 4.154).

Dessa maneira, o ADAMS/Car irá gerar os parâmetros de simulação no in-
tervalo de – 180º a + 180º (em 15 intervalos igualmente espaçados) e mantendo a 
força de frenagem constante (Tabela 4.3).

Tabela 4.3 – Arquivo Loadcase da análise do tipo Pull

Ângulo de esterçamento do volante Força de frenagem esquerda Força de frenagem direita
-180 2417 1978
-156 2417 1978
-132 2417 1978
-108 2417 1978
-84 2417 1978
-60 2417 1978
-36 2417 1978
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Ângulo de esterçamento do volante Força de frenagem esquerda Força de frenagem direita
-12 2417 1978
12 2417 1978
36 2417 1978
60 2417 1978
84 2417 1978
108 2417 1978
132 2417 1978
156 2417 1978
180 2417 1978

Figura 4.154 – Definição dos parâmetros do Loadcase File.

•	 Clique em OK.
Uma vez definido o Loadcase File, o próximo passo corresponde a executar 

a simulação.
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Figura 4.155 – Definindo a análise.

•	 Acesse o menu Simulate → Suspension Analysis → External Files (Figura 
4.155). 

Figura 4.156 – �Definindo os parâmetros 
da análise.

No diretório <acar_shared> selecione o arquivo brake_pull (Figura 4.157).

•	 A Figura 4.156 ilustra o preenchimento dos campos da janela Suspen-
sion Analysis: External Files. Para selecionar o arquivo Loadcase criado 
anteriormente, clique com o botão direito do mouse no campo em bran-
co (conforme indicado na Figura 4.156).
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Figura 4.157 – Selecionando o Loadcase File. 

Após selecionar o Loadcase File atente-se para selecionar os campos indica-
dos na Figura 4.158.

Figura 4.158 – � Finalizando definição dos 
parâmetros da simulação.

•	 Clique em OK.
A caixa de diálogo mostrada na Figura 4.159 será exibida caso a simulação 

tenha sido executada corretamente.
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•	 Clique em Close.

Etapa 32 – Animando os resultados da Análise tipo Pull 
Nesta etapa os resultados obtidos na análise tipo Pull serão animados.
•	 Acesse o menu Review → Animations Controls (Figura 4.160).

•	 Na janela Animation Controls (Figura 4.161), selecione o ícone Play  
para iniciar a animação.

Figura 4.160 – Animando os resultados.

Figura 4.161 – �Tela principal 
da animação.

Figura 4.159 – �Simulação 
executada 
corretamente.
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Observe, na animação, que as rodas se movem de acordo com a movimenta-
ção (giro) do volante.  Perceba que não há movimento na direção vertical.

Etapa 33 – Gerando os resultados da Análise tipo Pull 
Nesta etapa serão gerados os gráficos para análise dos resultados.
Para este tipo de análise as configurações gráficas não estão predefinidas con-

forme análise da etapa 30. Portanto, essas configurações precisarão ser definidas 
manualmente.

O primeiro gráfico a ser construído é: Steering Wheel Torque x Steering 
Wheel Angle.

•	 Primeiramente, alterne para a interface do ADAMS/PostProcessor. Para 
isso, acesse o menu Review → Postprocessing Window, ou pelo atalho, 
utilizando a tecla F8. 

•	 Com o mouse, dê um duplo clique em Page_1 (lado esquerdo da tela, 
conforme indicado na Figura 4.162). 

•	 Selecione o item plot_1.
•	 Certifique-se de que as opções Auto Title e Auto Subtitle estão desmar-

cadas. (conforme indicado na Figura 4.162).
•	 No campo Title, preencha com: Brake Pull Analysis.
•	 No campo Subtitle, preencha com: Steering Wheel Torque vs Steering 

Wheel Angle.

Figura 4.162 – Definindo a área gráfica.
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•	 Clique com o botão direito do mouse, na área denominada Treeview. 
Selecione Type Filter → Plotting → Axes (Figura 4.163).

•	 Na área Treeview, selecione o item plot_1 com um duplo clique do 
mouse. Selecione o item haxis, conforme indicado na Figura 4.164.

•	 Para configurar o eixo horizontal do gráfico, selecione a aba Labels, 
conforme ilustra a Figura 4.165. No campo denominado Label, insira o 
texto: Steering Wheel Angle [degrees].

Figura 4.163 – �Definindo os 
eixos do gráfico.

Figura 4.164 –  Selecionando o eixo haxis.

Figura 4.165 – Personalizando o eixo vertical.
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•	 Retornando à área Treeview, selecione o item vaxis para configurar o 
eixo vertical do gráfico (Figura 4.166).

Figura 4.166 – Selecionando o eixo vaxis.

Figura 4.167 – Personalizando o eixo vertical.

•	 Selecione a aba Labels, e insira o texto “Steering Wheel Torque [Nmm]”  
no campo Label (Figura 4.167).

•	 Após editar os eixos do gráfico, verifique se a opção Requests no campo 
Source está selecionada (Figura 4.168). O ADAMS/Car automaticamen-
te disponibiliza os dados disponíveis no campo Request.
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•	 Selecione a simulação de interesse no campo Simulation (neste caso, 
brake_pull), conforme ilustra a Figura 4.169.

•	 No campo Independent Axis, selecione a opção Data (Figura 4.169).

Figura 4.168 – Dados disponíveis para construção do gráfico.

Figura 4.169 – Selecionando a simulação e definindo o eixo horizontal.

•	 Uma caixa de diálogos será aberta. O seguinte procedimento deverá 
ser seguido: no campo Filter, selecione a opção user defined; no campo 
Request, selecione steering_displacements (selecione a barra de rolagem 
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à direita para ver essa opção); no campo Component, selecione angle_
front. Clique em OK. A Figura 4.170 ilustra o procedimento descrito.

Figura 4.170 – Caixa de diálogo do eixo vertical.

•	 Uma vez definido o parâmetro (variável) do eixo horizontal (ou eixo 
independente), também será necessário atribuir uma variável ao eixo 
vertical. Para isso, no campo Filter, selecione a opção user defined; no 
campo Request, selecione a opção steering_wheel_input; no campo 
Component, selecione a opção steering_wheel_input_torque (Figura 
4.171).

•	 Selecione a opção Add Curves (Figura 4.171).
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A Figura 4.172 mostra o gráfico construído. Este gráfico ilustra o torque 
aplicado ao volante para manter as rodas na posição retilínea. O torque negativo 
indica que este é aplicado no sentido horário, de modo a contrabalancear com a 
força de frenagem desigual, a qual puxa as rodas no sentido anti-horário como se 
o carro estivesse fazendo uma curva à esquerda.

Figura 4.171 – Caixa de diálogo do eixo vertical.
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O segundo gráfico a ser construído é: Scrub Radius x Steering Wheel Angle.
•	 Na barra de ferramenta principal, selecione New Page (conforme ilus-

trado na Figura 4.173).

Figura 4.172 – Caixa de diálogo do eixo vertical.

Figura 4.173 – Novo gráfico.

•	 No campo treeview, dê um duplo clique em Page_2.
•	 Selecione plot_2.
•	 Certifique-se que a opção Auto Title e Auto Subtitle não estão selecio-

nados (Figura 4.174).
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•	 Na caixa de texto Title, digite “Brake Pull Analysis” (Figura 4.175).
•	 Na caixa de texto Subtitle, digite “Scrub Radius vs Steering Angle” (Fi-

gura 4.175).

Figura 4.174 – Criando um novo gráfico.

Figura 4.175 – Título e Subtítulo do novo gráfico.

Figura 4.176 – �Selecionando os 
eixos do gráfico.

Clique, com o botão direito do mouse, no campo treeview, selecione Typer Filter 
e, em seguida, clique na opção Plotting e, posteriormente, selecione o item Axes.
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•	 Clique duas vezes em plot_2 para que as opções disponíveis se tornem 
visíveis. Selecione o item haxis (Figura 4.177).

Figura 4.177 – Selecionando eixo haxis.

Figura 4.178 – Editando o eixo haxis.

Figura 4.179 – Editando rótulo do eixo haxis.

•	 No editor de propriedades, selecione o campo Labels (Figura 4.178).

•	 Na caixa de texto Label insira o texto “Steering Wheel Angle [degrees]” 
(Figura 4.179).
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•	 Novamente, no campo treeview, selecione vaxis (Figura 4.180).

Figura 4.180 – Selecionando eixo vaxis.

Figura 4.181 – Editando rótulo do eixo vaxis.

Figura 4.182 – �Selecionando os 
parâmetros do gráfico.

•	 Na caixa de texto Label, insira o texto “Scrub Radius [mm]” (Figura 4.181).

•	 No campo Source, verifique se está selecionada a opção Requests (Fi-
gura 4.182).
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•	 No campo Simulation, selecione baseline_brake_pull; no campo Filter, 
selecione user defined; no campo Request, selecione scrub_radius; no 
campo Component, selecione left; e, por último, selecione Add curves.

Figura 4.183 – Definindo parâmetro do eixo vertical.

Figura 4.184 – Gráfico Scrub Radius vs Steering Angle.

A Figura 4.184 ilustra o gráfico obtido.

Observe, na Figura 4.184, que o Scrub Radius parece variar muito em re-
lação ao ângulo de esterçamento do volante. No entanto, essa variação no eixo 
vertical é de apenas 0,08 mm. Para verificar visualmente essa pequena variação, o 
eixo vertical pode ser alterado, como mostrado a seguir.

•	 Selecione o eixo vertical vaxis, na área treeview (Figura 4.185).
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•	 No editor de propriedades do eixo vaxis, selecione a guia Format. Des-
marque a opção Auto Scale (Figura 4.186).

Figura 4.185 – Selecionando o eixo vaxis.

Figura 4.186 – Editor de propriedades do eixo vaxis.

Figura 4.187 – Limites do eixo vaxis,

•	 Na caixa de texto Limits, estabeleça os limites entre 0 e 100 (Figura 4.187).
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Na Figura 4.188, observe que a variação do Scrub Radius em relação ao 
Steering Wheel Angle agora parece ser bem menor.

Figura 4.188 – Limite do eixo vertical definido entre 0 e 100 mm.

Etapa 34 – Salvando as configurações gráficas
Para salvar as modificações nos gráficos gerados anteriormente o usuário 

deve seguir os passos descritos nesta etapa.
•	 No menu File, selecione Export e, em seguida, selecione Plot Configura-

tion File (Figura 4.189).

Figura 4.189 – Exportando arquivos gráficos. 
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•	 A janela Save Plot Configuration File será aberta. No campo Configuration 
File Name, digite brake_pull. Selecione a opção All Plots (Figura 4.189).

Figura 4.190 – �Definindo o arquivo 
de exportação.

•	 Clique em OK.
•	 No menu File, selecione Close Plot Window ou pressione F8 para que o 

ADAMS/Car retorne para a janela principal.

Etapa 35 – Modificando a localização de Hardpoints da suspensão
Nesta etapa, dois Hardpoints da suspensão serão modificados de modo a 

alterar o parâmetro Scrub Radius da suspensão modelada. O objetivo é diminuir 
o raio de deslizamento (Scrub Radius) e comparar os resultados com os obtidos 
na Etapa 33.

Os Hardpoints que terão suas localizações alteradas serão:
- hpl_LBJ
- hpl_struct_upper
Ambos Hardpoints definem o eixo Kingpin da suspensão. Uma vez que este 

eixo seja deslocado para fora da suspensão, visto que o restante do subsistema se 
manterá inalterado, o parâmetro Scrub Radius será modificado.

Para realizar essas alterações, siga os passos a seguir.
•	 Na área de trabalho Standard do ADAMS/Car selecione o menu View → 

Subsystem (Figura 4.191).
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•	 A caixa de diálogo Display Subsystem será aberta. Selecione o susbsis-
tema de interesse (Figura 4.192). 

Figura 4.191 – �Visualizando o susb-
sistema suspensão.

Figura 4.193 – �Selecionando a tabela 
de Hardpoints .

Figura 4.192 – �Selecionando o subsistema 
de interesse.

•	 Acesse o menu Adjust → Hardpoint → Table (Figura 4.193).

•	 Na tabela de Hardpoints (Figura 4.194), clique na célula corresponden-
te à coordenada y (loc_y) do Hardpoint hpl_LBJ. Altere o valor para – 
725, ou seja, este Hardpoint será deslocado de 25mm.
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Figura 4.195 – Confirmando alteração 
da coordenada do Hardpoint hpl_LBJ.

•	 Clique em Apply (Figura 4.195).

Figura 4.194 – Modificação da coordenada y do Hardpoint hpl_LBJ.

A notar: A partir da tabela mostrada na Figura 4.194 é possível alterar as 
coordenadas de todos os Hardpoints do subsistema. Os Hardpoints com simetria 
esquerda–direita (left-rigth) se diferem apenas na coordenada y, ou seja, eles são 
simétricos em relação ao plano X-Z. Para alterar as coordenadas de Hardpoints com 
simetria, basta modificar a coordenada de interesse de apenas um deles (left ou rigth), 
que o programa se encarrega de alterar a coordenada do Hardpoint correspondente 
simetricamente. No entanto, caso o usuário deseje, essa simetria poderá ser removida, 
modificando apenas um dos Hardpoints do par simétrico. 

•	 Ainda na tabela mostrada na Figura 4.194, selecione a célula correspon-
dente à coordenada y (loc_y) do Hardpoint hpl_struct_upper. Altere o 
valor para – 625, ou seja, este Hardpoint também será deslocado de 25 
mm (Figura 4.196).

•	 Clique em OK.
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Etapa 36 – Salvando as modificações na suspensão 
•	 Após ter modificado os Hardpoints, salve o susbsistema alterado. Aces-

se o menu File → Save. Nesse momento, uma caixa de diálogo Warning 
será aberta. O programa perguntará se deseja criar uma cópia de ba-
ckup do arquivo em questão. Caso contrário, o arquivo original será 
substituído pelo arquivo modificado. Essa escolha fica a seu critério.

•	 Nesse caso, selecione No na caixa de diálogo (Figura 4.197). O arquivo 
do susbsistema será substituído pelo arquivo modificado no diretório 
padrão (default writable database).

Figura 4.196 – Alteração da coordenada y do Hardpoint hpl_struct_upper.

Figura 4.197 – �Alteração da 
coordenada.

Figura 4.198 – Selecionando a simulação.

Etapa 37 – Simulação da suspensão modificada 
Nesta etapa, será realizada a mesma simulação descrita na etapa 31, utilizan-

do-se, portanto, o mesmo arquivo Loadcase.
Acesse o menu Simulate → Suspension Analysis → External Files (Figura 4.198). 
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•	 A janela Suspension Analysis: External Files será aberta. No campo Ou-
put Prefix escreva Modified (Figura 4.199).

Figura 4.200 – Alternando para o ambiente de trabalho Postprocessing..

Figura 4.199 – Alterando o nome do arquivo de saída da simulação.

•	 Selecione o ícone  e, na caixa de comentários, escreva: Steering 
axis moved 25mm outboard.

•	 Selecione OK em ambas as caixas de diálogo.
O ADAMS/Car fará a simulação do assembly suspensão/sistema de direção.

Etapa 38 –  Comparando os resultados 
Nesta etapa serão gerados os resultados gráficos do assembly suspensão/sis-

tema de direção, tanto do sistema original quanto do sistema modificado para fins 
de comparação. Serão os mesmo gráficos gerados na etapa 33.

•	 Inicie o ADAMS/PostProcessor. Acesse o menu Review → Postproces-
sing Window, ou pela tecla F8 (Figura 4.200).
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•	 No menu Plot, selecione Create Plots.

Figura 4.201 – Gerando gráficos.

Figura 4.202 – �Selecionando o arquivo 
de simulação.

Figura 4.203 – Plotando mais de uma curva no mesmo gráfico. 

•	 A janela File Import será aberta. No campo Plot Configuration File, 
digite: mdids://private/plot_configs.tbl/brake_pull.plt (Figura 4.201), ou 
clique com o botão direito do mouse nesse campo e o selecione no dire-
tório de destino.

•	 Na caixa de texto Plot title digite: Brake Pull Analysis –  UAN_FRT_
SUSP (Figura 4.202).

•	 Para que os programa disponibilize as duas curvas no mesmo gráfico, 
selecione o ícone Cross Plotting (Figura 4.203).
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•	 Clique em OK.
As ferramentas da área de trabalho PostProcessor, , poderão ser utiliza-

das acessar todos os gráficos gerados.
A Figura 4.204 ilustra as curvas obtidas. A curva com linha contínua se refe-

re ao resultado do assembly original, já a linha pontilhada se refere ao resultado 
do assembly modificado. Como já era esperado, observe que o torque é menor 
para o assembly modificado quando comparado com o assembly original em toda 
a faixa de análise. 

Figura 4.204 – Curvas obtidas com o assembly orginal e o modificado.

•	 Utilize a ferramenta  para visualizar o gráfico Scrub Radius vs 
Steering Wheel Angle. 

Observe na Figura 4.205 que o Scrub Radius diminuiu de 34 mm para 8 mm 
em virtude das modificações realizadas nos Hardpoints da suspensão.

Figura 4.205 – Gráfico comparativo Scrub Radius vs Steering Wheel Angle.
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Etapa 39 – Finalizando 
Esta etapa finalizará as tarefas executadas neste capítulo. Os gráficos e as 

simulações geradas serão excluídos, e os subsistemas criados e modificados serão 
encerrados. 

•	 Para excluir os gráficos gerados, no ambiente de trabalho Postproces-
sing, clique com o botão direito do mouse na área treeview. Selecione 
Type Filter → Modeling →  Analyses (Figura 4.206).

Figura 4.206 – �Selecionando as 
análise corrente.

Figura 4.207 – �Selecionando as simulações 
a serem excluídas.

•	 Clique duplo em my_assembly para atualizar os resultados gerados pe-
las simulações.

•	 Selecione as simulações a serem excluídas (Figura 4.207).
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Figura 4.208 – Excluindo gráficos.

•	 No menu Edit, selecione a opção Delete (Figura 4.208).

•	 No menu File, selecione a opção Close Plot Window (ou a tecla F8).
O ADAMS/Car retornará para o ambiente de trabalho Standard.
Para encerrar o Assembly siga os próximos passos.
•	 Acesse o menu File → Close → Assembly (Figura 4.209).

•	 A caixa de diálogo Close Assembly será aberta. Selecione o Assembly a 
ser encerrado e clique em OK (Figura 4.210).

Figura 4.209 – Encerrando o Assembly.

Figura 4.210 – �Selecionando o Assembly 
a ser encerrado.
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•	 Clique em OK.
Dessa maneira, todas as simulações foram excluídas, bem como encerrados 

os Assemblies em execução. O software, agora, pode ser utilizado para novas 
modelagens de sistemas multicorpos.
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Desenvolvimento de uma 
Suspensão Automotiva do 
tipo Duplo A: Aplicação do 
módulo ADAMS/Car

A notar: Esta suspensão é comumente conhecida como “Double Wishbone”, 
“Double A” ou ainda Duplo A. Ela é constituída por duas bandejas triangulares, as 
quais constituem elos entre o chassi do veículo e suas rodas. Classifica‑se como uma 
suspensão independente e é reconhecida por ser mais robusta que outras suspensões 
como, por exemplo, a Macpherson. Isso pelo fato de possuir mais elementos mecânicos 
em sua formação.
Esse modelo apresenta uma fácil e precisa regulagem de seus parâmetros de geometria, 
como a variação da cambagem e a máxima variação de bitola. Devido a estes fatores 
este modelo de suspensão é mais comumente utilizado em eixos dianteiros de veículos 
de alto desempenho, por necessitarem de um ajuste mais fino dos parâmetros de 
geometria de suspensão.

5
C
A
PÍTU

LO
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Neste capítulo, será apresentado ao leitor o tutorial de construção de uma 
suspensão Duplo A, denominado _tutorial_duploa. A metodologia adotada para 
o desenvolvimento desse subsistema está dividida em 30 etapas, identificadas de 
acordo com as tarefas a serem executadas.

Até a Etapa 24, o leitor desenvolverá o modelo virtual, utilizando‑se da in‑
terface Template Builder, conforme tratado no Capítulo 1. Nessas etapas, o leitor 
fará a parametrização do modelo, ou seja, criação de Hardpoint e Construction 
Frame, construção de partes (Parts), geometrias (Geometry), inserção de juntas e 
buchas (Attachments), criação de Communicators, entre outras ações pertinentes 
ao projetista nessa interface.

Nas etapas restantes, o leitor construirá um subsistema (Subsystem) associado 
ao Template da suspensão Duplo A e, em seguida, criará um Assembly entre o sub‑
sistema suspensão e um sistema de teste virtual do ADAMS/Car chamado Test Rig.

Ao final, após execução das etapas propostas, o leitor deverá obter o seguinte 
modelo virtual.

Obtenha o arquivo da suspensão 
Duplo “A” no seguinte link: http://www.blucher.
com.br/materiaisdeapoio/mscadams/tutorial_
duploa.cdb.zip

Ilustração de uma suspensão Duplo A.
Fonte: Valdeck, 2007.

Fonte: REIMPELL, J.; STOLL, H.; BETZLER, J. W. The automotive chassi: 
engineering principles, Butterworth‑Heinemann, 2001.
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Etapa 1 – Inicializando o Módulo ADAMS/Car
Ao inicializar o módulo ADAMS/Car, as seguintes opções estarão disponí‑

veis na janela de abertura: Standard Interface e Template Builder (item 1.2.1), 
conforme mostra a Figura 5.1. O usuário deverá marcar a opção Template Buil‑
der, uma vez que um novo projeto será criado, depois clicar na opção OK.

Figura 5.1 – �Tela de inicialização do 
Módulo ADAMS/Car.

Etapa 2 – Criando o Template
•	 Abra o menu File e clique na opção New.
•	 Na caixa de diálogo aberta, digite o nome do projeto na caixa Template 

Name.
•	 Especifique o tipo de subsistema (Subsystem) a ser construído na opção 

Major Role, conforme ilustrado na Figura 5.2.
•	 Clique na opção Ok.

 Figura 5.2 – �Definição do New Template.

Etapa 3 – Definição do diretório de trabalho
•	 Abra o menu Tools e clique na opção Database Management → Create 

Database.
A Figura 5.3 ilustra a janela correspondente a essas ações.   
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Figura 5.3 – �Ilustração da janela referente à defini‑
ção do diretório de trabalho.

•	 Na caixa de diálogo Create New Database preencha o campo Database 
Alias com o nome do diretório de trabalho e, no campo Database Path, 
informe seu caminho (Figura 5.4).

Figura 5.4 – �Preenchimento sugerido da janela 
Create New Database.

•	 Clique em OK.
Uma nova janela será aberta para que o usuário aceite a criação do diretório 

de trabalho definido nas etapas anteriores, conforme ilustra a Figura 5.5. 

 

Figura 5.5 – �Janela de confir‑
mação da criação 
do diretório de 
trabalho.

•	 Uma mensagem de confirmação da criação do diretório será aberta, 
apenas para verificação por parte do usuário (Figura 5.6). Caso a tarefa 
tenha sido executada com sucesso, clique em Close.
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Figura 5.6 – �Mensagem de 
alerta referen‑
te à criação do 
diretório de 
trabalho.

•	 Para obter informações sobre o diretório de trabalho criado, abra o 
menu Tools → Database Management → Database Info (Figura 5.7).

Figura 5.7 – �Janela para obtenção de informações 
sobre o diretório de trabalho.

Em seguida, será exibida uma janela com a aparência da mostrada na Figura 
5.8.
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Figura 5.8 – Resultado da definição do diretório de trabalho.

A próxima etapa é definir o diretório de trabalho criado como sendo o dire‑
tório padrão, no qual os arquivos referentes ao projeto executado serão salvos. 
Para isso:

•	 Abra o menu Tools → Database Management → Set Default Writable 
(Figura 5.9).

Figura 5.9 – �Ilustração da opção a ser selecio‑
nada para definição do diretório 
padrão.
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•	 Será aberta uma caixa de diálogo (Set Default Writable Database), con‑
forme ilustrado na Figura 5.10. No campo Database Name, selecione 
o diretório de trabalho criado anteriormente. Para tanto, clique sobre a 
seta à direita da aba.

Figura 5.10 – �Especificação do diretório 
de gravação de arquivos de 
projeto.

•	 Clique em OK.

Etapa 4 – Parametrização da Geometria da Suspensão

A notar: Para alterar/verificar unidades de medidas no ADAMS/Car, acesse o menu 
Settings → Units.

O primeiro passo para a construção de um subsistema suspensão é a criação 
dos Hardpoints. Dessa maneira, o modelo se torna parametrizado, facilitando, 
portanto, alterações geométricas, evitando, assim, o desenvolvimento de um novo 
projeto. Na Figura 5.11 é mostrado um esquema dos Hardpoints a serem defi‑
nidos e sua respectiva representação em uma suspensão Double A. A numeração 
representada é coincidente com a da Tabela 5.1.

Figura 5.11 – �Esquema dos Hardpoints a serem cons‑
truídos.

Para criação dos Hardpoints ilustrados na Figura 5.12:
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•	 Acesse o menu Build, clique em Hardpoint e, em seguida, clique em 
New (Figura 5.12).

Figura 5.12 – �Ativação da janela para criação de hardpoints.

Na caixa de diálogo Create Hardpoint defina o nome (Hardpoint Name) e 
selecione o tipo (Type). Se há simetria à esquerda – left –, à direita – right – ou 
caso não haja simetria defina como single.

A localização dos Hardpoints com relação às coordenadas globais (x, y e z) 
do sistema deverá ser inserida no campo Location (Figura 5.13). Caso haja algum 
erro nos campos preenchidos, esse erro será destacado na cor amarela, para aler‑
tar o usuário.

•	 Após preenchimento dos campos clique em Apply, para inserir os de‑
mais Hardpoints (Tabela 5.1) ou para finalizar, após inserção do último 
ponto clique em OK. A aba Type será selecionada para todos os Hard‑
points criados como sendo right.

A notar: A simetria à direita ou à esquerda se refere ao fato de que os hardpoints 
criados se repetirão (serão espelhados) ou à direita ou à esquerda, relativamente ao 
referencial global do projeto.
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Figura 5.13 – �Janela para criação de hardpoints.

A notar: Neste ponto, recomenda‑se que se salve o projeto. Para tanto selecione a aba 
File → Save. Esta operação se repetirá em determinados pontos ao longo da construção 
da suspensão Duplo A.
Caso o usuário utilize a opção Save As, a tela mostrada a seguir aparecerá e se 
recomenda que ela seja preenchida conforme indicado.

Figura ilustrativa da caixa de diálogo 
referente à gravação do Template.

Tabela 5.1: Nomes e coordenadas dos hardpoints 

Nome Coordenadas (x,y,z)

1 lca_front (‑97.5, 215.55, 60.56)
2 lca_outer (‑14.12, 646.89, – 106.22)
3 lca_rear (192.25, 235.56, 1.31)
4 lwr_strut_mount (8.43, 529.97, – 49.04)
5 tierod_inner (150, 290, 76)
6 tierod_outer (62.61, 626.65, – 43.76)
7 top_mount (97.96, 258.91, 274.94)
8 uca_front (‑175.08, 214.19, 230.24)
9 uca_outer (28.39, 609.09, 42)
10 uca_rear (224.13, 247.43, 139.76)
11 wheel_center (7.135, 627.99, – 32.11)
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A notar: Repare que os Hardpoints com sigla de identificação “lca” (Lower Control 
Arm) se referem à bandeja inferior, já os com “uca” (Upper Control Arm) se referem 
à bandeja superior. Os Hardpoints identificados por “tierod” correspondem à união 
do sistema de direção ao subsistema suspensão. “lwr_strut_mount” e o “top_mount” 
são relativos à fixação do amortecedor na bandeja inferior e no chassi. Por fim, 
“wheel_center” localiza o centro da roda (Figura 5.11)

Após criar os onze Hardpoints, poderão ser feitas alterações em suas coorde‑
nadas, acessando‑se o menu Build, clicando em Hardpoint e em seguida em Table. 
Uma tabela com o nome do Hardpoint e as respectivas localizações x, y e z abrirá 
na tela principal, possibilitando editá‑la (Figura 5.14).

Figura 5.14 – Tabela de modificação da coordenada do hardpoint.

A notar: Perceba que na parte inferior desta janela há a opção Display. Nela ao 
selecionar as opções Left ou Right, haverá um ajuste automático dos sinais das 
coordenadas, de acordo com o sistema de coordenadas global. O termo hpl ou hpr é 
inserido automaticamente no nome do Hardpoint pelo próprio software, de modo a 
indicar a que lado ele pertence, segundo o sistema de coordenadas global.

A Figura 5.15 ilustra a tela do software após criação dos Hardpoints.
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Figura 5.15 – Tela exibindo os hardpoints definidos.

Etapa 5 – Criação da bandeja inferior da suspensão (Lower Control Arm).
A bandeja inferior da suspensão é definida por três Hardpoints: lca_front; 

lca_rear e lca_outer, o que lhe confere uma forma triangular (Figura 5.11).
Para criação da bandeja, será necessário criar um General Part (item 

1.2.5.2.1), o qual no ADAMS/Car é indicado pela abreviação gel (general part 
left) ou ger (general part right).

Para criação do General Part, é possível utilizar‑se de dois tipos de construto‑
res: New (criação do corpo rígido com características de geometria de massa e de 
material) ou Wizard (criação do corpo rígido baseado em duas geometrias possí‑
veis Link/Arm, podendo‑se definir a densidade do material, a partir da escolha do 
tipo ou como um input por parte do usuário).

•	 Para criação do General Part, acesse o menu Build → Parts → General 
Part → New (Figura 5.16).
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Figura 5.16 – �Janela ilustrativa da opção selecio‑
nada para criação do General Part.

•	 Preencha a janela que se obtém ao acionar a opção, conforme mostrado 
na Figura 5.17.

O preenchimento dos campos: General Part, Coordinate Reference #1, #2, 
#3 (Location Dependance), Coordinate Reference #1 e #2 (Orientation Depen‑
dance) pode ser realizado manualmente, ou se pode clicar com o botão direito do 
mouse no referido campo e optar por umas das opções disponíveis, sendo essa se‑
gunda forma de preenchimento, um atalho. Os campos que possuem a seta lateral 
se acionadas com um clique fornecem as opções disponíveis. A Figura 5.18 (a) e 
(b) ilustram o dito aqui, respectivamente.

Os dados relativos à geometria desse General Part, como massa, e momentos 
de inércia, inclusive o centro de massa, foram definidos, a priori, por um valor 
aleatório (como pode ser observado na Figura 5.17). Após inclusão da geometria 
(próxima etapa), esses dados serão recalculados. Caso o usuário já possua os 
valores corretos, estes podem ser inseridos sem a necessidade de recalculá‑los 
posteriormente.
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Figura 5.17 – �Definição dos parâmetros de construção 
do General Part “Lower Control Arm”.

t
Figura 5.18 – �Telas ilustrativas  

(a) atalho para seleção de coordenadas, por exemplo, Coordinate Reference #1;  
(b) acionamento de seta lateral para definição de opção (Orientation Dependency).
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A notar: Verifique que no campo Orientation Dependency foi selecionada a opção 
Orient to zpoint‑xpoint. Ao selecioná‑la juntamente com a opção ZX no campo Axes 
(Figura 5.18 (a), o usuário define que o eixo “Z” do General Part criado (Lower_
control_arm) será paralelo ao vetor formado entre a entidade (General Part) e a 
coordenada #1 (Coordinate Reference #1). Veja que a origem do vetor está no General 
Part e sua extremidade no Hardpoint hpl_lca_outer.

•	 Após preenchimento dos campos da Figura 5.17, clique em OK.
A Figura 5.19 ilustra a tela principal do software, destacando a criação do 

General Part.

Figura 5.19 – General Part “Lower Control Arm” construído e sua orientação.

Etapa 6 – �Criação da geometria relacionada ao General Part 
“Lower Control Arm”

A bandeja inferior da suspensão Lower Control Arm, a qual está relacionada 
ao General Part criado na etapa anterior, é composta por duas geometrias cilín‑
dricas do tipo Link e três esféricas, que serão criadas pela ferramenta Ellipsoid, 
localizadas nas extremidades dos Links.

A notar: Para definir a geometria do tipo Link são necessários dois Hardpoints 
localizados em ambas as extremidades do Link, além da definição de um raio.
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•	 Para construção da primeira geometria Link, o qual será formado pelos 
Hardpoints hpl_lca_front e hpl_lca_outer, acesse o menu Build → Geo‑
metry → Link → New, como mostrado na Figura 5.20.

Figura 5.20 – �Janela referente à construção da 
geometria Link.

•	 A janela Create Link Geometry será aberta e deverá ser preenchida con‑
forme ilustrado na Figura 5.21. Observe que a opção para calcular as 
propriedades de massa do General Part (Calculate Mass properties of 
General Part) deve ser assinalada. Isso no caso de se desejar atualizar os 
dados de propriedades de massa inseridos na Etapa 5.

•	 Ao finalizar, clique na opção OK.
Repare que o preenchimento das abas General Part, Coordinate Reference 

#1 e Coordinate Reference #2 pode ser manual ou pelo acionamento do botão 
direito do mouse sob a aba, conforme ilustrado na Figura 5.18 (a). Nesse caso, 
recomenda‑se escolher Coordinate Reference → Guesses, onde se abre uma janela 
elencando todos os Hardpoints, hpl e hpr disponíveis no projeto.
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Figura 5.21 – �Criação do Link associado 
ao General Part criado na 
Etapa 5.

O Link construído está ilustrado na Figura 5.22.

Figura 5.22 – Link 1 construído.

•	 Repita o mesmo procedimento descrito anteriormente para construção 
do Link 2, o qual terá em suas extremidades os Hardpoints hpl_lca_rear 
e hpl_lca_outer. A Figura 5.23 ilustra como os campos da caixa de diá‑
logo devem ser preenchidos.

•	 Clique em OK.
•	 Salve seu projeto.
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A notar: Dependendo da disponibilidade do usuário, o presente projeto pode ser 
realizado de uma só vez, ou interrompido para que depois se dê continuidade a ele. No 
entanto, quando o Template é aberto a partir de um arquivo salvo, este pode aparecer 
na tela principal sem todos os detalhes construtivos, normalmente vistos pelo usuário, 
tais como juntas, especificação de Hardpoints, Construction Frame, General Part etc.
Para que todas essas entidades passem a ser visíveis novamente no modelo, posicione 
o cursor em qualquer ponto da tela de construção (menos em pontos do modelo) 
e clique com o botão direito do mouse. Na janela que se abrirá, selecione a opção 
Toogle Icon Visibility <v>.

Figura 5.23 – �Criação do Link 2 associado 
ao General Part criado na 
Etapa 5.

Nas extremidades dos Links 1 e 2 serão construídos volumes esféricos, a 
partir da ferramenta Ellipsoid. Para tanto, acesse o menu Build → Geometry → 
Ellipsoid → New (Figura 5.24).

A notar: A geometria Ellipsoid pode ser utilizada para gerar geometrias esféricas, 
desde que os raios definidos em cada coordenada (x, y e z) sejam iguais. 
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Figura 5.24 – �Janela para criação da geometria 
esférica nas extremidades do Link.

•	 A janela Create Ellipsoid Geometry será aberta. Os campos deverão ser 
preenchidos conforme ilustrado na Figura 5.25. Observe que essa primei‑
ra esfera terá como referência o Hardpoint hpl_lca_front, e pertencerá ao 
General Part gel_Lower_control_arm. Lembre‑se que o campo Calculate 
Mass Properties of General Part deverá estar selecionado para atuali‑
zação das propriedades de massa do General Part Lower_control_arm.

•	 Clique em OK.

Figura 5.25 – �Preenchimento da caixa de 
diálogo para criação da primei‑
ra esfera.
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•	 O procedimento do item anterior deverá ser repetido para construção 
do segundo volume esférico. A segunda esfera será localizada no Hard‑
point hpl_lca_rear. O preenchimento da janela Create Ellipsoid Geome‑
try para essa geometria está ilustrado na Figura 5.26.

Figura 5.26 – �Preenchimento da caixa de 
diálogo para criação da segun‑
da esfera.

•	 A terceira esfera será construída na intersecção dos Links 1 e 2. A Figura 
5.27 ilustra o preenchimento da janela Create Ellipsoid Geometry para 
construção dessa geometria.

•	 Clique em OK.

Figura 5.27 – �Preenchimento da caixa de 
diálogo para criação da terceira 
esfera.
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Após construção das geometrias que compõem a bandeja da suspensão, o 
General Part Lower_control_arm será atualizado em relação às suas propriedades 
de massa.

•	 Aproxime a imagem de um dos lados da suspensão, pressionando o 
botão direito do mouse em qualquer ponto da tela, menos em pontos da 
geometria do modelo virtual, selecione a opção Zoom In/Out e mova o 
cursor para o efeito desejado.

•	 Em seguida, na tela principal do software, clique com o botão direito 
do mouse sobre o General: Part gel_Lower_control_arm. Em seguida, 
clique em Modify (Figura 5.28).

Figura 5.28 – �Opção para atualização das propriedades do General Part Lower_control_arm 
a partir da opção Modify.

•	 A janela Modify General Part será aberta. Para atualização das proprie‑
dades, clique no ícone referente à calculadora (canto inferior direito), 
como destacado na Figura 5.29. Após essa ação, os dados serão auto‑
maticamente recalculados.

•	 Clique em OK.
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Figura 5.29 – �Atualização das 
propriedades do General Part 
“gel_Lower_control_arm”.

•	 Salve seu projeto.

Eatapa 7 – �Construção da fixação inferior do amortecedor 
na bandeja Inferior

Nesta etapa, será construída a geometria para ancoragem à bandeja.
Para tanto, é necessário que sejam criados Construction Frames para orien‑

tação dos Links. Para isto:
•	 Acesse o menu Build Construction Frame → New (Figura 5.30).
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Figura 5.30 – �Janela para criação do Construction 
Frame para fixação do amortecedor.

A notar: Trata‑se de um elemento do ADAMS/Car, que é utilizado sempre que 
uma determinada entidade necessita para sua criação, não apenas da definição de 
coordenadas para localização como o Hardpoint, mas também de uma orientação 
(Orientation Dependancy). Como ele é um elemento parametrizável, ele acompanha 
as alterações realizadas nos Hardpoints relacionados a ele.
Além disto, perceba que na construção de determinados elementos do modelo, onde 
houver a necessidade de se definir coordenadas (Coordinate Reference #1, #2, #3 ou 
#4 ou ainda, I ou J Coordinate Reference) essas abas serão sempre preenchidas ou por 
Hardpoint ou Construction Frame.

•	 A janela Create Construction Frame será aberta e os campos deverão 
ser preenchidos conforme ilustrado na Figura 5.31. Note que este Cons‑
truction Frame será construído entre os seguintes Hardpoints: hpl_lca_
front e hpl_lca_outer.

•	 Clique em OK.
Repare que a janela Location Dependency (assinalada na Figura 5.31), se 

acionada na seta lateral direita, fornece seis opções de localização. Selecione Lo‑
cated on a line, o que solicita ao usuário a entrada de duas coordenadas de refe‑
rência (Coordinate Reference #1 e Coordinate Reference #2).
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A notar: A opção Relative Location (%) fornece ao usuário a possibilidade de definir 
a localização do Construction Frame, com base na distância entre as coordenadas (x, 
y, z) de #1 e #2.
No caso, considerando‑se as coordenadas dos Hardpoint hpl_lca_front e hpl_lca_
outer; a distância entre eles é dada pela diferença de coordenadas entre hpl_lca_outer 
e hpl_lca_front, que multiplicada por 72% e somada aos valores de coordenadas de 
hpl_lca_front, fornece o posionamento do Construction Frame.

Figura 5.31 – �Janela de construção do 
Construction Frame  
lca_front_middle.

•	 A Figura 5.32 destaca o Construction Frame criado, indicado pela seta 
branca.
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Figura 5.32 – Detalhe do primeiro Construction Frame criado na bandeja inferior da suspensão.

•	 Em seguida, será criado um novo Construction Frame, no qual as in‑
formações a serem fornecidas devem seguir o que mostra a Figura 5.33.

Após a construção, repare que esses Construction Frame possuem seus eixos 
paralelos.

Figura 5.33 – �Janela de construção 
do Construction Frame 
lca_rear_middle.
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A Figura 5.34 destaca o Construction Frame criado, indicado pela seta branca.

Figura 5.34 – Detalhe do segundo Construction Frame criado na bandeja inferior da suspensão.

Com a construção dos Construction Frame, é possível criar, a partir dessas 
entidades, um Link que ligue os dois braços da bandeja, onde será fixado o amor‑
tecedor.

•	 Para a criação deste Link, acesse o menu Build → Geometry → New 
(Figura 5.35).
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Figura 5.35 – �Criação do Link para fixação 
do amortecedor na bandeja 
inferior da suspensão.

A criação do Link três deve atender às especificações mostradas na Figura 
5.36.

Figura 5.36 – �Construção do Link de união 
entre os braços de suspensão 
da bandeja inferior – Link 3.

•	 Clique em Apply e preencha as especificações para o Link 4, como mos‑
trado na Figura 5.37.
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Figura 5.37 – �Construção do Link de união 
entre os braços de suspensão da 
bandeja inferior – Link 4.

•	 Em seguida, clique em OK, e verifique se os Links foram criados corre‑
tamente, conforme ilustrado na Figura 5.38.

Figura 5.38 – Links 3 e 4, construídos para fixação do amortecedor.

•	 Salve seu projeto.

Etapa 8 – Criação da bandeja superior da suspensão (Upper Control Arm)
A bandeja superior da suspensão é definida por três Hardpoints: uca_front; 

uca_rear e uca_outer, sendo, portanto, triangular.
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Para criação da bandeja superior, da mesma forma que para a bandeja infe‑
rior, será necessário criar um General Part.

A construção do General Part é realizada acessando‑se o menu Parts → 
General Part New (Figura 5.39)

Figura 5.39 – Criação do General Part referente à bandeja superior.

O preenchimento da janela de criação do General Part deve ser como ilustra 
a Figura 5.40.
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Figura 5.40 – �Janela de criação do General Part 
Upper_control_arm.

•	 Ao finalizar o preenchimento, clique em OK.
A Figura 5.41 destaca o General Part criado, indicado pela seta branca.

Figura 5.41 – General Part referente à criação do Upper_Control_Arm.
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Etapa 9 – �Criação da geometria relacionada ao 
General Part “Upper Control Arm”

Após criação do General Part, parte‑se para a definição da geometria da 
bandeja inferior, a partir da criação de geometrias denominadas Link. Para tanto:

•	 Acesse o menu Build → Geometry → Link → New (Figura 5.42).

Figura 5.42 – �Janela ilustrando a opção a ser ativada 
para criação de Links na bandeja supe‑
rior (Upper Control Arm).

•	 Preencha a janela Create Link Geometry, de acordo com o especificado 
na Figura 5.43.

•	 Clique em Apply.

Figura 5.43 – �Criação do Link 5, associa‑
do ao General Part criado 
na Etapa 8.
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•	 Repita o procedimento para o Link 6, preencha a janela Create Link 
Geometry de acordo com o especificado na Figura 5.44.

•	 Clique em OK.

Figura 5.44 – �Criação do Link 6, associa‑
do ao General Part criado 
na Etapa 8.

A Figura 5.45 destaca as geometrias Links criadas e associadas ao General 
Part “gel_Upper_control_arm”.

Figura 5.45 – Ilustração dos Links 5 e 6 (em verde) configurando o gel_Upper Control Arm.

•	 Salve seu projeto.
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Nas extremidades dos Links 5 e 6, serão construídos volumes esféricos, a 
partir da ferramenta Ellipsoid. Para tanto:

•	 Acesse o menu Build Geometry → Ellipsoid → New (Figura 5.46).

Figura 5.46 – �Janela destacando as opções para 
criação da geometria esférica nas 
extremidades dos links da bandeja 
superior.

•	 Preencha a janela Create Ellipsoid Geometry, de acordo com a Figura 
5.47.

•	 Clique em Apply.

Figura 5.47 – �Preenchimento da caixa de diálogo 
para criação da quarta esfera.
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•	 Preencha a janela Create Ellipsoid Geometry, de acordo com a Figura 
5.48.

•	 Clique em Apply.

Figura 5.48 – �Preenchimento da caixa de diálogo 
para criação da quinta esfera.

•	 Para a última esfera, preencha a janela Create Ellipsoid Geometry, de 
acordo com a Figura 5.49.

•	 Clique em OK.

Figura 5.49 – �Preenchimento da caixa de 
diálogo para criação da sexta 
esfera.

A Figura 5.50 mostra, em verde, as três esferas criadas.
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Figura 5.50 – Ilustração das esferas nas extremidades do Upper Control Arm.

•	 Salve seu projeto.
•	 Aproxime a imagem de um dos lados da suspensão, pressionando o bo‑

tão direito do mouse em qualquer ponto da tela e selecionando a opção 
Zoom In/Out.

•	 Na tela principal do software clique com o botão direito do mouse so‑
bre o General Part “gel_Upper_Control_Arm”.

•	 Clique em Modify, Figura5.51 e com a caixa de diálogo resultante da 
Figura 5.52 clique sobre o ícone calculadora.

Figura 5.51 – �Opção para atuali‑
zação das proprieda‑
des do General Part 
Lower_control_arm 
a partir da opção 
Modify.
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Figura 5.52 – �Atualização das propriedades do General Part 
“gel_Upper_control_arm”.

Etapa 10 – Criação da manga de eixo (Upright)
Inicialmente, será criado o General Part associado à manga de eixo. Cabe 

salientar que, de acordo com a Figura5.10, haverá quatro Hardpoints associados 
a essa parte (Part): hpl_lca_outer, hpl_uca_outer, hpl_wheel_center e hpl_tierod_
outer e, ainda, três geometrias do tipo Link. Dando continuidade à etapa, tem‑se:

•	 Acesse o menu Build → Parts → General Part → New, conforme ilustra a 
Figura 5.53.

Figura 5.53 – �Janela correspondente á constru‑
ção do General Part “Uprigth”.
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A janela Create General Part será aberta e deverá ser preenchida, conforme 
ilustra a Figura 5.54.

Figura 5.54 – �Janela correspondente à criação do 
General Part “Uprigth”.

•	 Clique em OK.

A notar: A opção Orientation Dependency, Figura 5.54, selecionada como Orient 
axis along line solicita a especificação de duas coordenadas. Perceba que entre os dois 
Hardpoints especificados pode‑se imaginar um eixo de ligação, que na aba Axis, foi 
especificado como sendo o eixo “Z”. A direção, neste caso, é da coordenada 1 até a 
coordenada 2.

O resultado é mostrado na Figura 5.55.
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Figura 5.55 – Tela ilustrativa da criação do General Part “Upright”.

Em seguida, serão construídos dois Links, que complementam a manga de 
eixo. Para a criação destes Links siga as instruções a seguir:

•	 Acesse o menu Build → Geometry → Link → New, conforme ilustrado 
na Figura 5.56.

Figura 5.56 – �Janela correspondente à criação 
da geometria Link que constitui‑
rá a manga de eixo.
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A janela Create Link Geometry será aberta e a Figura 5.57 ilustra seu pre‑
enchimento.

Figura 5.57 – �Janela relativa à criação do 
primeiro Link correspondente 
ao General Part “Upright”.

•	 Clique em Apply.
O mesmo procedimento deve ser seguido para a construção do segundo Link. 

A Figura 5.58 ilustra o preenchimento da janela correspondente a sua criação.

Figura 5.58 – �Janela relativa à criação do se‑
gundo Link correspondente ao 
General Part “Upright”.

•	 Clique em OK.
•	 Salve seu projeto.
Considerando que a manga de eixo da suspensão Duplo A, geralmente, vem 

acompanhada por um suporte de fixação da direção, o próximo passo será a 
construção de um terceiro Link, conforme ilustrado na Figura 5.59.
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Figura 5.59 – �Janela relativa à criação do 
segundo Link correspondente 
ao General Part “Upright”.

•	 Clique em OK.
A Figura 5.60 destaca a parte General Part “Uprigth” com os três Links cria‑

dos, nas Figuras 5.57, 5.58, e 5.59, em azul.

Figura 5.60 – Ilustração do General Part “Upright” associado às geometrias Links

•	 Salve seu projeto.

Etapa 11 – Criação do elemento de ancoragem do amortecedor ao chassi
Nesta etapa, será construído o elemento (corpo rígido) de fixação do conjun‑

to mola/amortecedor ao chassi do veículo.
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Antes de criar o General Part e as geometrias relacionadas, serão criados três 
Construction Frames para definir a orientação da estrutura a ser criada. Para isso:

•	 Acesse o menu Build Construction Frame → New (Figura 5.61).

Figura 5.61 – �Criação do Construction Frame.

•	 A janela Create Construction Frame será aberta e os campos deverão ser 
preenchidos, conforme a Figura 5.62.

Note que esse Construction Frame será criado, utilizando‑se, como coorde‑
nada de referência, o Hardpoint “hpl_lwr_strut_mount”.

•	 Clique em Apply.
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Figura 5.62 – �Janela relativa à cria‑
ção do Construction Frame 
“Lwr_strut_ext”.

A Figura 5.63 ilustra o Construction Frame construído.

Figura 5.63 – Tela ilustrativa do Construction Frame “Lwr_strut_ext”.

As janelas devem ser preenchidas, conforme mostram as Figuras 5.64 e 5.66.
•	 Clique novamente em Apply após a criação do segundo Construction 

Frame “Top_mount_ext” e em OK, após concluir o terceiro Lwr_
spring_seat.
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As telas ilustrativas de cada uma das operações são mostradas nas Figuras 
5.65 e 5.67.

Figura 5.64 – �Janela relativa à construção 
do Construction Frame “Top_
mount_ext”.

Figura 5.65 – Tela ilustrativa do Construction Frame “Top_mount_ext”.
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Figura 5.66 – �Janela relativa à constru‑
ção do Construction Frame 
“Lwr_spring_seat”.

Figura 5.67 – Tela ilustrativa do Construction Frame “Lwr_spring_seat”.

Note que a construção dos três Construction Frames definiram as coordena‑
das por onde a linha de construção do conjunto mola/amortecedor irá passar. Os 
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dois primeiros fixaram as extremidades, enquanto o último, posicionado no meio 
do segmento de reta (Relative Location igual a 50%), complementou a orientação.

•	 Salve seu projeto.
Após a construção dos Construction Frames, a próxima etapa consiste na 

criação do General Part “Upper Strut”. Neste serão definidos os parâmetros da 
mola e do amortecedor da suspensão. Para tanto:

•	 Acesse o menu Build → Parts → General Part → New, conforme a Figura 
5.68.

Figura 5.68 – �Tela correspondente 
à opção de construção 
do General Part 
“Upper‑strut”.

A janela Create General Part será aberta e seus campos deverão ser preenchi‑
dos, conforme a Figura 5.69.

•	 Ao finalizar o preenchimento, clique em OK.
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Figura 5.69 – �Janela relativa à construção do 
General Part “Upper_strut”.

A notar: A escolha da aba Location Dependency como Located on a Line, Figura 
5.69, permite que o General Part “Upper_strut” se situe a 66% da distância entre os 
dois Hardpoints especificados como coordenadas #1 e #2, medido relativamente à 
coordenada #1.

A Figura 5.70 ilustra a criação do referido General Part.
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Figura 5.70 – Tela ilustrativa do General Part “Upper_strut”.

•	 Crie outro General Part que, juntamente com o General Part “Upper_
strut”, representará o comportamento do amortecedor e da mola. Para 
criá‑lo acesse o menu Build → Parts → General Part → New (Figura 5.71).

Figura 5.71 – �Tela correspondente à opção 
de construção do General 
Part.
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•	 A janela Create General Part será aberta e seus campos deverão ser pre‑
enchidos conforme a Figura 5.72.

Figura 5.72 – �Janela relativa à construção do 
General Part “Lower_strut”.

A notar: A escolha da aba Location Dependency como “Located on a Line”, Figura 
5.72, permite que o General Part “Lower_strut” se situe a 33% da distância entre os 
dois Hardpoints especificados como coordenadas #1 e #2, medido relativamente à 
coordenada #1.

•	 Clique em OK.
A Figura 5.73 ilustra o General Part “Lower_strut”.
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Figura 5.73 – Tela ilustrativa do General Part “Lower_Strut”.

Etapa 12 – Definindo parâmetros da suspensão
Nesta etapa, serão definidos os parâmetros de Camber, Toe (convergência) e 

Cáster da suspensão. Para isso:
•	 Acesse o menu Build → Suspension Parameters → Toe/Camber Values → 

Set (Figura 5.74).

Figura 5.74 – �Definição de parâmetros de 
Toe e Camber da suspensão.
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A janela Set Toe & Camber Values será aberta e os valores destes parâmetros 
deverão ser inseridos nos campos disponíveis, de acordo com o projeto. Note 
que os valores requeridos se referem a ambos os lados: esquerdo (Left) e direito 
(Right) (Figura 5.75).

•	 Após preenchimento, clique em OK.

Figura 5.75 – �Janela de inserção dos valores de Toe e 
Camber da suspensão Duplo A.

A notar: O preenchimento da caixa de diálogo mostrada na Figura 5.75 dá origem a 
dois parâmetros da geometria da suspensão que serão denominados: pvl_Toe_Angle e 
pvl_Camber_Angle. Esses parâmetros pertencem a uma classe denominada Parameter 
Variables (pv) e serão utilizados na construção do Construction Frame “upright_
spindle_inr”, Figura 5.79 – Etapa 13.

A definição do valor de Caster da suspensão se dá a partir do preenchimento 
das informações da Figura 5.77. Para isso:

•	 Acesse o menu Build → Suspension Parameter → Characteristics Array → 
Set (Figura 5.76).

Figura 5.76 – �Opção de definição do 
Caster da suspensão Duplo A.
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•	 Preencha a janela Suspension Parameters Array, conforme ilustrado na 
Figura 5.77.

•	 Ao final, clique em OK.
Perceba que a suspensão foi definida como independente na aba Suspension 

Type, selecionando‑se a opção a partir da seta à direita da aba. O eixo de direção 
(Steer axis) é definido pelos Hardpoints inseridos nas abas I Coordinate Refe‑
rence, J Coordinate Reference. I Part e J Part são preenchidos com informações a 
partir de General Part.

Figura 5.77 – �Definição do Caster da 
suspensão.

Etapa 13 – Construção da geometria relacionada ao cubo de roda
Para construção da geometria (Geometry), referente ao cubo de roda, é ne‑

cessário, primeiramente, criar um novo Construction Frame, o qual irá fornecer a 
orientação das variáveis Toe e Camber. O preenchimento do campo Orientation 
Dependancy, assinalado na Figura 5.79, garante que as características estabeleci‑
das na Etapa 12 sejam atendidas. Assim:

•	 Acesse o menu Build → Construction Frame → New (Figura 5.78).
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Figura 5.78 – �Construção do Construction Frame 
relacionado ao cubo da roda.

A janela Create Construction Frame será aberta e os campos deverão ser 
preenchidos, conforme mostrado na Figura 5.79. Observe que o Construction 
Frame estará localizado no hpl_Wheel_Center e terá sua orientação definida pelas 
variáveis Toe e Camber declaradas anteriormente.

•	 Finalizado o preenchimento, clique em OK.

Figura 5.79 – �Definindo a posição da Construction 
Frame.
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A Figura 5.80 ilustra o Construction Frame “Upright_spindle_inr”.

Figura 5.80 – Tela ilustrativa do Construction Frame “upright_spindle_inr”.

Após esta ação, parte‑se para a construção da geometria. Para isso:
•	 Acesse o menu Build → Geometry → Cylinder → New, associado ao 

Construcrion Frame (Figura 5.81).

Figura 5.81 – �Criação de uma geometria do tipo 
Cylinder.
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A notar: A diferença entre as geometrias Link e Cylinder são sutis visualmente, 
diferenciando‑se apenas no modo de suas construções. Enquanto o Link necessita 
da definição de dois hardpoints e do raio, o Cylinder requer a definição de um 
Construction Frame. O eixo z do Construction Frame define o eixo longitudinal do 
cylinder, e seu comprimento é fornecido tanto no sentido positivo quanto negativo do 
eixo z. O raio do cylinder também é um parâmetro requisitado.

A janela Create Cylinder Geometry será aberta e os campos a serem preen‑
chidos estão ilustrados na Figura 5.82. Note que para construção de uma geome‑
tria cilíndrica é necessário definir um Construction Frame (3º campo) o qual já foi 
criado anteriormente nesta mesma etapa.

•	 Clique em OK.

Figura 5.82 – �Janela relativa à construção da 
geometria Cylinder referente ao 
cubo da roda.

A Figura 5.83 ilustra o cilindro representativo do cubo da roda.
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Figura 5.83 – Tela ilustrativa do cilindro Gracyl_Cylinder.

Etapa 14 – Construção do amortecedor (Damper)
•	 Para a criação do amortecedor, acesse o menu Build → Forces → Damper 

→ New (Figura 5.84).
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Figura 5.84 – �Definição do amortecedor da 
suspensão.

O preenchimento dos campos da janela Create Damper se dá conforme mos‑
trado na Figura 5.85. O amortecedor é definido entre os corpos rígidos (partes) 
“Upper_strut” e “Lower_strut” e sua curva característica pode ser inserida do 
próprio software ou editada manualmente pelo usuário e utilizada no modelo. 
Como se pode observar na Figura 5.85, no campo Property File, as propriedades 
do amortecedor são definidas no arquivo especificado na biblioteca do software.

•	 Clique em OK.

Figura 5.85 – �Definição do amortece‑
dor da suspensão.

A Figura 5.86 ilustra o amortecedor construído.
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Figura 5.86 – �Tela ilustrativa do amortecedor 
construído.

•	 Salve seu projeto.

Etapa 15 – Construção da mola (Spring)
Nesta etapa, será definida a mola da suspensão. Ressalta‑se que a mola não 

é considerada um corpo rígido, portanto sua criação não será por meio da cria‑
ção de um General Part. No ADAMS/Car, a mola é definida por meio da criação 
de uma força (Forces). Entretanto, o processo de construção da mola necessita, 
antes, da criação de um Mount, que pode ser criado acessando‑se o menu Build → 
Parts → Mount → New (Figura 5.87).
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Figura 5.87 – �Criação do Mount para construção 
da mola.

A janela Create Mount Part será aberta, e os campos a serem preenchidos 
estão ilustrados na Figura 5.88.

•	 Clique em OK.

Figura 5.88 – �Janela de criação do Mount 
para construção da mola.

A Figura 5.89 ilustra o Mount criado.
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Figura 5.89 – �Tela ilustrativa do 
Mount para a constru‑
ção da mola

•	 Com o Mount construído, é possível, então, criar a mola. Para isso, aces‑
se o menu Build → Forces → Spring → New (Figura 5.90).

Figura 5.90 – �Janela de opção para criação de 
uma mola.

•	 Preencha os campos da janela Create Spring conforme mostrado na Fi‑
gura 5.91. Note que a mola é definida entre o corpo rígido Lower_con‑
trol_arm e mount que se criou nessa etapa mtl_strut_to_body. A curva 
característica da mola pode ser editada manualmente pelo usuário e salva 
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em arquivo externo ou podem ser utilizadas informações da própria bi‑
blioteca do software (campo Property File) como é o caso deste modelo.

•	 Clique em OK.

Figura 5.91 – �Janela correspondente à definição da 
mola da suspensão.

A Figura 5.92 ilustra a mola construída.

Figura 5.92 – Mola construída.
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A notar: BumpStop ou batente de suspensão tem a função de limitar o funcionamento 
do conjunto mola e amortecedor, evitando deslocamentos que possam prejudicar o 
funcionamento do conjunto.

•	 É necessário criar o Bumpstop da suspensão para limitar o seu deslo‑
camento. Para isso, acesse o menu Build → Forces → Bumpstop → New 
(Figura 5.93). 

Figura 5.93 – �Criando Bumpstop.

•	 Preencha os campos da janela Create Bumpstop conforme mostrado na 
Figura 5.94. A curva característica do Bumpstop pode ser editada ma‑
nualmente pelo usuário e salvo em arquivo externo ou podem ser utili‑
zadas informações da própria biblioteca do software (campo Property 
File) como é o caso deste modelo.

•	 Clique em OK.
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Figura 5.94 – �Janela de definição das carac‑
terísticas do Bumpstop.

A Figura 5.95 ilustra o Bumpstop construído.

Figura 5.95 – �Tela ilustrativa do Bumpstop criado 
nas extremidades da mola.

•	 Salve seu projeto.
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Etapa 16 – Construção da barra de direção (Tierod)
Nesta etapa, será construída a barra de direção, a qual será um General Part 

denominado por Tierod.
•	 Acesse o menu Build → Parts → General Part → New (Figura 5.96).

Figura 5.96 – �Janela correspondente à 
criação do General Part 
“Tierod”.

•	 Preencha os campos da janela Create General Part, conforme ilustrado 
na Figura 5.97.

Note que a geometria (Geometry) associada a este General Part será do 
tipo Link, sendo este último definido pelos Hardpoint “hpl_tierod_inner” e 
“hpl_tierod_outer”.

•	 Clique em OK.
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Figura 5.97 – �Preenchimento da caixa de diálogo para 
construção do General Part “Tierod”.

A Figura 5.98 ilustra como a suspensão deve estar até o presente momento.

Figura 5.98 – �Ilustração do General Part 
“Tierod” construído.
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•	 Para criação do Link referente ao braço de direção, acesse o menu Build 
→ Geometry → Link → New (Figura 5.99).

Figura 5.99 – �Janela correspondente à criação da 
geometria referente General Part 
“Tierod”.

•	 Preencha os campos da janela Create Link Geometry, conforme mostra‑
do na Figura 5.100.

Figura 5.100 – �Janela de criação do link 
referente ao braço de 
direção.

•	 Clique em OK.
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A Figura 5.101 ilustra o braço de direção criado a partir das informações da 
Figura 5.100.

Figura 5.101 – �Ilustração do Link 
representando a barra 
de direção (em branco).

•	 Em seguida, crie esferas nas extremidades do Link10 (Figura 5.100). 
Para a criação dessas esferas, acesse o menu Build → Geometry → Ellip‑
soid → New (Figura 5.102).
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Figura 5.102 – �Janela correspondente à criação de 
esferas utilizando a opção Ellipsoid.

•	 A janela Create Ellipsoid Geometry será aberta. Os campos deverão ser 
preenchidos conforme Figura 5.103. Lembre‑se que o campo Calculate 
Mass Properties of General Part deverá estar selecionado para atualiza‑
ção das propriedades de massa do General Part “Tierod”.

•	 Clique em Apply.

Figura 5.103 – �Janela relativa à criação da esfera do 
Link10.

•	 Repita o procedimento descrito acima para a construção de outra esfera 
a se situar no Hardpoint hpl_tierod_outer. O preenchimento da janela 
Create Ellipsoid Geometry para essa geometria está ilustrado na Figura 
5.104.
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Figura 5.104 – �Preenchimento da janela de cria‑
ção da esfera Esf8.

•	 Clique em OK.
A Figura 5.105 ilustra as esferas criadas nas extremidades da barra de dire‑

ção, segundo as Figuras 5.103 e 5.104.
•	 Salve seu projeto.

Figura 5.105 – �Ilustração das esferas criadas nas 
extremidades da barra de direção 
(em branco).

MSC_ADAMS_prova-4.indb   417 17/10/14   16:12



418 MSC ADAMS: Guia Prático de Utilização

Etapa 17 – Criação dos Mounts de conexão da suspensão
Nesta etapa, serão criados três Mounts denominados uca_to_body, 

subframe_to_body e tierod_to_steering, os quais são classificados como Parts, de 
acordo com o ADAMS/Car.

Esses Mounts possuem a função de estabelecer a conexão (compatibilidade 
de informação) de um subsistema com outro, no caso a suspensão com o chassi 
(body) e o sistema de direção. Durante a simulação, a transferência de dados de 
um subsistema para o outro é feita por meio desta comunicação (Mount). Para 
criar um Mount:

•	 Acesse o menu Build → Parts → Mount → New (Figura 5.106).

Figura 5.106 – �Ilustração do menu/opções cor‑
respondente à criação do Mount 
“uca_to_body”.

•	 A janela Create Mount Part deverá ter seus campos preenchidos, confor‑
me mostrado na Figura 5.107.

Note que o nome do Mount deve ser exatamente o mesmo definido no ou‑
tro susbsistema, nesse caso, o chassi, ou seja, no chassi deve haver um Mount de 
mesma denominação.

Ainda com relação a Figura 5.107, a coordenada de referência utilizada é o 
Hardpoint “hpl_uca_front”.

•	 Ao finalizar a operação clique em Apply.
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Figura 5.107 – �Janela correspondente à 
criação do Mount “uca_to_
body”.

Na Figura 5.108 o Mount “uca_to_body” está destacado com uma seta 
branca.

Figura 5.108 – Ilustração do Mount “uca_to_body” criado.

•	 Repita o procedimento anterior para criação dos dois outros Mounts, 
“subframte_to_body” e “tierod_to_steering”. Para isso:

•	 Utilize o preenchimento apresentado na Figura 5.109 para o Mount 
“subframe_to_body” e o preenchimento dado na Figura 5.110 para o 
Mount “tierod_to_steering”.

Figura 5.109 – �Preenchimento da caixa de 
diálogo relativa à criação do 
Mount “subframe_to_body”.
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•	 Ao finalizar o preenchimento da caixa de diálogo, ilustrada na Figura 
5.109, clique em Apply.

Figura 5.110 – �Preenchimento da caixa de 
diálogo relativa à criação do 
Mount “tierod_to_steering”.

•	 Ao finalizar o preenchimento da caixa de diálogo, ilustrada na Figura 
5.110, clique em OK.

Na Figura 5.111 é mostrado como os Mounts devem estar localizados no 
subsistema de suspensão.

Figura 5.111 – �Ilustração dos Mounts 
“subframe_to_body” 
e “tierod_to_steering” 
criados.

•	 Salve seu projeto.

Etapa 18 – Criação das juntas de conexão da suspensão
Nesta etapa, serão inseridas quatro juntas no modelo virtual da suspensão. 

Essas juntas definem o tipo de movimento (graus de liberdade e restrições) entre 
os General Part. A Tabela 5.2 relaciona as juntas a serem criadas.
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Tabela 5.2 – Juntas do modelo multicorpos da suspensão 

Junta Tipo General Parts

1 Esférica Uprigth e Lower_control_arm
2 Esférica Uprigth e Upper_control_arm
3 Esférica Upright e Tierod
4 Revoluta Spindle e Upright

Para inserção das juntas da suspensão:
•	 Acesse o menu Build → Attachments → Joints → New (Figura 5.112).

Figura 5.112 – �Janela correspondente à cria‑
ção de uma Junta, utilizando a 
opção Joint.

Os campos da janela Create Joint Attachment deverão ser preenchidos, con‑
forme ilustrado na Figura 5.113 e de acordo com a Tabela 5.2.

•	 Após finalizar o preenchimento sugerido na Figura 5.113, clique em 
Apply.
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•	 Em seguida, defina a junta 2 (Tabela 5.2), preenchendo a janela Create 
Joint Attachment, mostrada na Figura 5.115.

Figura 5.113 – �Preenchimento da caixa de diálogo para 
criação da Junta 1.

A Figura 5.114 ilustra a junta 1 construída.

Figura 5.114 – Ilustração da junta 1 construída.
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A notar: Perceba que a nomenclatura de juntas no ADAMS/Car segue a seguinte 
denominação; jol para especificação que o tipo de Attachment utilizado é uma junta 
à esquerda seguida da especificação do tipo, no caso da Junta_1 trata‑se de uma junta 
esférica (spherical).

Figura 5.115 – �Preenchimento da caixa de diálogo para 
criação da Junta 2.

A Figura 5.116 ilustra a junta 2 construída.

Figura 5.116 – Ilustração da junta 2 construída.
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Para construção da junta 3, proceda como sugerido a seguir:
•	 Preencha os campos da janela Create Joint Attachment, conforme a Fi‑

gura 5.117.
•	 Clique em OK.

Figura 5.117 – �Preenchimento da caixa de 
diálogo para criação da Junta 3.

A Figura 5.118 ilustra a junta 3 construída.
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Figura 5.118 – Ilustração da junta 3 construída.

Neste ponto, antes da construção da próxima junta (Joint_4), que será uma 
junta revoluta (Tabela 5.2), deve‑se proceder a construção de um General Part 
denominado Spindle. Perceba que, tanto sua localização (Location Dependancy), 
quanto sua orientação (Orientation Dependancy) são dependentes do Construc‑
tion Frame (cfl) “Upright_spindle_inr”, Figura 5.79 e Figura5.80. As informações 
para construção do General Part deve seguir o especificado na Figura 5.119 (a).

•	 Acesse Build → Parts → General Part → New.
•	 Após preenchimento, clique em OK.
A Figura 5.119 (b) ilustra a criação do General Part “Spindle”.
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Figura 5.119 (a) – �Preenchimento da caixa de 
diálogo para criação do General 
Part “Spindle”.

Figura 5.119 (b) – General Part “Spindle” construído.
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Em seguida, parte‑se para a construção da quarta junta, que é revoluta (Ta‑
bela 5.2). Para tanto, siga as instruções abaixo:

•	 Acesse a opção Build → Attachments → Joints → New.
•	 Preencha os campos da janela Create Joint Attachment, conforme a Fi‑

gura 5.120.
•	 Clique em OK.
•	 Salve seu projeto.
A Figura 5.121 traz a tela resultante, referente a este passo.

Figura 5.120 – �Preenchimento da caixa de diálogo 
para criação da Junta 4.
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Figura 5.121 – Tela ilustrativa da criação da Junta 4 construída.

Etapa 19 – Junta de ligação entre os braços da suspensão e o chassi
Nesta etapa, será criado o par de juntas responsáveis pela restrição dos graus 

de liberdade entre o chassi e os braços de suspensão. Para inserção das juntas da 
suspensão, siga:

•	 Acesse o menu Build → Attachments → Joints → New (Figura 5.122).
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Figura 5.122 – �Janela correspondente 
ao menu para criação de 
juntas.

•	 Na janela Create Joint Attachment, preencha os campos, conforme mos‑
trado na Figura 5.123. Note que esta junta é do tipo revoluta (Revo‑
lute) e é construída entre o General Part “gel_Lower_control_arm” e o 
Mount “mtl_subframe_to_body”.

•	 Após preenchimento sugerido, clique em OK.
A Figura 5.124 destaca a junta criada.
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Figura 5.123 – �Preenchimento de caixa de 
diálogo para criação da Junta 5.

Figura 5.124 – Tela ilustrativa da Junta 5 construída.
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O procedimento descrito aqui deve, então, ser repetido para a bandeja supe‑
rior da suspensão. Sendo assim, prossiga:

•	 Na janela Create Joint Attachment, preencha os campos, conforme 
mostrado na Figura 5.125. Note que essa junta é do tipo revoluta e é 
construída entre o General Part “gel_Upper_control_arm” e o Mount 
“mtl_uca_to_body”.

•	 Clique em OK.
•	 Salve seu projeto.
A Figura 5.126 destaca a junta criada, segundo a sugestão de preenchimento 

apresentada na Figura 5.125.

Figura 5.125 – �Preenchimento de caixa de 
diálogo para criação da Junta 6.
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Figura 5.126 – Tela ilustrativa da Junta 6 criada.

Etapa 20 – Criação da junta Hooke
Nesta etapa, serão construídas duas juntas Hooke, as quais têm como co‑

ordenadas de referência (Coordinate Reference) os Hardpoint “hpl_lwr_strut_
mount” para a Junta 7 e “top_mount” para a junta 8. Ambas possuem a função 
de, respectivamente, restringir graus de liberdade entre o braço e o amortecedor e 
entre o amortecedor e o chassi. Para cumprir esta Etapa:

•	 Acesse o menu Build → Attachments → Joint → New (Figura 5.127).
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Figura 5.127 – �Janela correspondente ao menu 
para criação da Junta 7.

•	 Preencha os campos da janela Create Joint Attachment, de acordo com 
o mostrado na Figura 5.128.

Note que essa junta está sendo criada entre o General Part “gel_Lower_
strut” e o General Part “Lower_control_arm”.

•	 Clique em OK, ao finalizar.
A Figura 5.129 ilustra a junta Hooke construída, a partir do preenchimento 

da caixa de diálogo mostrada na Figura 5.128.
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Figura 5.128 – �Preenchimento da caixa de 
diálogo para criação da junta 7, 
do tipo Hooke.

Figura 5.129 – �Ilustração em destaque da 
junta Hooke construída.
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Para criação da junta que restringirá graus de liberdade entre o amortecedor 
e o chassi é necessário que o preenchimento dos campos da janela Create Joint 
Attachment esteja de acordo com a Figura 5.130. Está será entre o General Part 
“gel_Upper_strut” e o Mount “mtr_strut_to_body”.

•	 Clique em OK.
•	 Salve seu projeto
A Figura 5.131 ilustra a junta Hooke construída.

Figura 5.130 – �Preenchimento da caixa de 
diálogo para criação da junta 
8 tipo Hooke.
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Figura 5.131 – Ilustração em destaque da junta Hooke construída.

Etapa 21 – Criação da junta no eixo de direção (Convel Joint)
Nesta etapa, será criada uma junta do tipo Convel, no eixo de direção (Tie 

rod). Essa junta restringirá os movimentos desse eixo no subsistema Sistema de 
Direção.

Para criar a referida junta no eixo de direção, proceda assim:
•	 Acesse o menu Build → Attachments → Joint → New (Figura 5.132).
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Figura 5.132 – �Janela correspondente ao 
menu para criação da junta 
Convel.

•	 Crie a junta do tipo Convel, conforme ilustrado na Figura 5.133.
•	 Note que essa junta é definida pelo General Part “gel_tierod” e o Mount 

“mtl_tierod_to_steering”. Atente‑se para o Hardpoint destacado na Fi‑
gura 5.133, perceba que J – Part Axis é um Hardpoint situado à direita.

•	 Após preenchimento, clique em OK.
•	 Salve seu projeto.
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Figura 5.133 – �Preenchimento da caixa de 
diálogo para criação da junta 
Convel.

A Figura 5.134 ilustra a junta do eixo de direção construída.

Figura 5.134 – Ilustração em destaque da junta Convel do eixo de direção construída.
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Etapa 22 – Construção das junções por buchas (Bushing Attachments)
Nesta etapa, serão criadas as buchas da suspensão em um total de quatro 

buchas entre o chassi e os braços da suspensão, ou seja, uma em cada extremidade 
do braço de suspensão e duas buchas nas extremidades do amortecedor, que se 
fixam ao chassi.

•	 Para criar a primeira bucha, a qual estará localizada na mesma coorde‑
nada que o Hardpoint “hpl_lca_front”, acesse o menu Build → Attach‑
ments → Bushing → New (Figura 5.135).

Figura 5.135 – �Janela correspondente ao 
menu de criação da bucha 
“bkl_Bushing1”.

Os campos da janela Create Bushing Attachment deverão ser preenchidos, 
conforme a Figura 5.136.

Note que essa bucha é criada entre o General Part “gel_Lower_control_arm” 
e o Mount “mtl_subframe_to_body”. Um arquivo com as propriedades da bucha 
deve ser selecionado (no campo Property File), podendo este ser da biblioteca do 
software ou editado pelo usuário.

•	 Clique em OK.
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Figura 5.136 – �Preenchimento da caixa de diálogo para 
criação da bucha“bkl_Bushing1”.

A Figura 5.137 ilustra a bucha criada no passo anterior.

Figura 5.137 – Ilustração da bucha “bkl_Bushing1” inserida no modelo virtual.
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Para construção da segunda bucha, a qual estará localizada no Hardpoint 
hpl_lca_rear:

•	 Acesse o menu Build → Attachments → Bushing → New (Figura 5.138).

Figura 5.138 – �Janela correspondente ao 
menu de criação da bucha 
“bkl_Bushing2”.

•	 Preencha os campos da janela Create Bushing Attachment, como ilus‑
trado na Figura 5.139.

•	 Clique em OK.
Note que essa bucha também é construída entre o General Part 

“gel_Lower_control_arm” e o Mount “mtl_subframe_to_body”.
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Figura 5.139 – �Preenchimento da caixa de diálogo relati‑
va à criação da bucha “bkl_Bushing2”.

A Figura 5.140 ilustra a segunda bucha “bkl_Bushing2” construída.

Figura 5.140 – Ilustração da segunda bucha “bkl_Bushing2” inserida no modelo.
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•	 Para construção da terceira bucha, a qual estará localizada no hardpoint 
hpl_uca_front repita os procedimentos anteriores e preencha os campos 
da janela Create Bushing Attachment como ilustrado na Figura 5.141.

•	 Terminado preenchimento, clique em OK.

Figura 5.141 – �Preenchimento da caixa de diálogo 
relativa à criação da bucha “bkl_
Bushing3”.

A Figura 5.142 ilustra a bucha “bkl_Bushing3” construída.
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Figura 5.142 – Ilustração da terceira bucha “bkl_Bushing3” inserida no modelo.

A construção da quarta bucha seguirá o mesmo procedimento das três an‑
teriores.

•	 Repita os procedimentos e preencha os campos da janela Create Bushing 
Attachment, como ilustrado na Figura 5.143.

•	 Em seguida, clique em OK.
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Figura 5.143 – �Preenchimento da caixa de diálogo 
relativa à criação da bucha “bkl_
Bushing4”.

A Figura 5.144 ilustra a quarta bucha construída “bkl_Bushing4”.
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Figura 5.144 – Ilustração da quarta bucha “bkl_Bushing4” inserida no modelo.

Para a construção da quinta bucha:
•	 Preencha os campos da janela Create Bushing Attachment, como ilus‑

trado na Figura 5.145.
•	 Finalizada a operação, clique em OK.
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Figura 5.145 – �Preenchimento da caixa de 
diálogo relativa à criação da 
bucha “bkl_Bushing5”.

A Figura 5.146 ilustra a quinta bucha construída “bkl_Bushing5”.
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Figura 5.146 – Ilustração da quinta bucha “bkl_Bushing5” inserida no modelo.

•	 Para finalizar, a construção da sexta bucha se dá da mesma forma que a 
das cinco anteriores.

•	 Preencha os campos da janela Create Bushing Attachment, como ilus‑
trado na Figura 5.147.

•	 Clique em OK.
•	 Salve seu projeto.
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Figura 5.147 – �Preenchimento da caixa de 
diálogo relativa à criação da 
bucha “bkl_Bushing6”.

A Figura 5.148 ilustra a sexta bucha construída “bkl_Bushing6”.

MSC_ADAMS_prova-4.indb   449 17/10/14   16:12



450 MSC ADAMS: Guia Prático de Utilização

Figura 5.148 – Ilustração da sexta bucha “bkl_Bushing6” inserida no modelo.

Etapa 23 – Criação de Communicators
Nesta etapa, serão criados os Communicators do tipo Output, os quais esta‑

belecerão a comunicação do subsistema suspensão com os diversos subsistemas 
que se acoplarão a este (Roda, Sistema de Direção, entre outros). Resalta‑se, no‑
vamente, que os nomes designados aos Communicators devem ser iguais aos dos 
Communicators dos susbsistemas de interesse. Outro aspecto a considerar é que 
um Communicator output se relacionará com um Communicator input de outro 
subsistema.

Para criação do primeiro Communicator do tipo Output, proceda conforme 
especificado abaixo:

•	 Acesse o menu Build → Communicator → Output New (Figura 5.149). 
Este Communicator fará a comunicação entre o General Part “Uprig‑
tht” (cubo de roda) e o subsistema roda.
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Figura 5.149 – �Criando um Communicator do tipo 
Output.

A janela Create Output Communicator deverá ser preenchida conforme ilus‑
trado na Figura 5.150.

•	 Clique em Apply.

Figura 5.150 – �Criação do Communicator 
“suspension_suprigth”.

Para criação do Communicator “suspension_mount”:
•	 Preencha os campos da janela Create Output Communicator, conforme 

ilustrado na Figura 5.151.
•	 Clique em Apply.
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Figura 5.151 – �Criação do Communicator 
“suspension_mount”.

A Figura 5.152 ilustra a criação do Communicator “wheel_center”.
•	 Clique em OK.
•	 Salve seu projeto.

Figura 5.152 – �Criação do Communicator 
“wheel_center”.

Etapa 24 – Realizando teste de compatibilidade entre Communicators
Nesta etapa, serão obtidas informações sobre os Communicators criados, e 

ainda será feito um teste de compatibilidade entre estes e os Communicators do 
subsistema de interesse. Nesse caso, o subsistema de interesse é o MDI_ Suspen‑
sion_ Testrig, o qual corresponde ao subsistema de teste da suspensão.

•	 Para se obter informações sobre os Communicators criados, acesse o 
menu Build → Communicator → Info (Figura 5.153).
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Figura 5.153 – �Obtendo informações sobre os Communi‑
cators criados na Etapa 23.

A janela Communicators Info será aberta e se encontra ilustrada na Figura 
5.154.

No campo Model names aparece automaticamente o nome do Template que 
se está trabalhando, no caso, _tutorial_duploa.

•	 No campo Type, selecione o item All.
•	 No campo Entity selecione o item All.
•	 Clique em OK.

Figura 5.154 – �Selecionando os tipos de Communicators.
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A janela Information será aberta, e nela constam as informações requeridas, 
conforme a Figura 5.155.

Figura 5.155 – Informações sobre os Communicators.

•	 Após análise das informações, clique em Close nesta mesma janela, op‑
ção que se encontra no canto superior direito da caixa de diálogo da 
Figura 5.155.

•	 Para teste de compatibilidade dos Communicators com o susbsistema 
MDI_ Suspension_ Testrig, acesse o menu Build → Communicator → 
Test (Figura 5.156).
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Figura 5.156 – �Realizando teste de compatibilidade dos 
Communicators com o dispositivo de 
teste MDI_Suspension_Testrig.

Na janela, Test Communicators, verifique os subsistemas a serem testados. O 
campo Model Names deve ser preenchido pelo usuário. Para tanto, sobre o campo, 
clique com o botão direito do mouse. Nesse momento, aparecerá uma caixa de 
diálogo solicitando o modelo (Model). Passe o cursor por cima e selecione a opção 
Guesses. Os nomes dos modelos disponíveis aparecerão, e o usuário deverá selecio‑
nar primeiramente o tutorial_duploa e, em seguida, o MDI_ Suspension_ Testrig.

Nesse caso, observa‑se na Figura 5.157 que o teste será feito entre o subsis‑
tema da suspensão (_tutorial_duploa) em construção e do subsistema correspon‑
dente a uma plataforma de teste, denominado MDI_ Suspension_ Testrig.

Os parâmetros contidos no campo Minor Roles “front” e “any” devem ser 
digitados pelo usuário.

•	 Clique em OK.

Figura 5.157 – Subsistemas a serem submetidos a 
teste de compatibilidade de Communicators.
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A janela mostrada na Figura 5.158, denominada Information, será aberta e, 
nela, é possível verificar se há algum erro de comunicação entre Communicators 
para que possam ser realizadas as correções necessárias.

Figura 5.158 – Informação de compatibilidade dos communicators.

Note que a lista de Unmatched input communicators e Unmatched output 
communicators não significa propriamente erro de projeto. Mostra apenas, como 
é o caso, que há Communicators que não encontraram seu correspondente. De 
fato, isto acontece por não se estar testando todo o veículo, mas apenas a suspen‑
são dianteira com o dispositivo de teste virtual Testrig.

O Template da suspensão está, agora, finalizado.
•	 Feche a janela, selecionando a opção Close, em seu canto superior direito.
•	 Salve seu projeto.
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Etapa 24 – Verificação das juntas: aplicando o Kinematic Mode
Um importante passo para a correta simulação da suspensão Duplo A será 

apresentada nesta Etapa. De fato, durante a construção do projeto, juntas e bu‑
chas foram inseridas e precisam de ajustes em sua função.

Nesse sentido, serão feitas modificações nas juntas Joint_5 e Joint_6. Lem‑
brando que essas juntas são as revolutas e foram iseridas entre as partes gel_Lo‑
wer_control_arm e o mtl_subframe_to_body; gel_Upper_control_arm e o mtl_
uca_to‑body, respectivamente.

A notar: Durante a construção do projeto de uma suspensão, há duas maneiras possíveis 
de se estabelecer como as partes (Parts), que o compõe, irão reagir umas em relação às 
outras. Essas relações podem ser por meio do uso de Buchas (Bushings) ou pelo uso de 
Juntas (Joints).
Buchas: permitem seis graus de liberdade entre as partes (três translações e três rotações). 
No entanto, em sua construção, é possível especificar a rigidez, pré‑carga (Preload) e ser 
offset.
Juntas: estabelecem uma relação cinemática entre as partes, fornecendo graus de 
liberdade e restringindo movimentos. As juntas, normalmente, são especificadas de 
acordo com a ideia de grau de liberdade e restrição de movimento que se deseja no 
modelo.
Na janela de criação das buchas (Bushing) Build → Attachments → Bushing → New há um 
campo denominado Inactive, enquanto na criação de juntas (Joints) Build → Attachments 
→ Joint → New há outro campo denominado Active. No caso de se criar buchas e juntas 
no mesmo local de conexão de uma parte (Part) em um dado modelo, o usuário pode 
alternar a função entre as duas categorias de Attachments, da seguinte forma: ao tornar 
o Kinematic Mode ativo na junta (basta selecionar esta opção), selecione no campo 
Inactive da bucha a opção Kinematic Mode. Desta forma, apenas a junta atuará em 
simulações cinemáticas.
Geralmente, a junta se torna inativa em análises dinâmicas, se existe uma bucha. Isso 
porque a bucha é capaz de modelar tanto o movimento, quanto inserir características 
de rigidez e amortecimento entre as Parts. A junta tem papel definido no que tange a 
análise cinemática apenas.

•	 Desta forma, clique com o botão direito sobre a Joint_5 (Figura 5.124) e 
altere o campo denominado Active para a opção kinematic mode como 
é mostrado a seguir, Figura 5.159

•	 Em seguida, faça o mesmo com a Joint_6 (Figura 5.126), alterando o 
campo denominado Active para a opção kinematic mode.
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Figura 5.159 – �Alterando para kinematic 
mode a opção Active em am‑
bas as juntas jolrev_Joint_5 e 
jolrev_Joint_6.

•	 Salve seu projeto.

Etapa 25 – �Criação do subsistema associado ao 
Template _tutorial_duploa (Subsystem)

Uma vez concluído o projeto da suspensão (Template), se faz necessária a 
criação do subsistema da suspensão (Subsystem) para que se possa realizar as 
devidas simulações no modelo criado. Neste sentido:

•	 Ainda na tela principal do Template, salve o mesmo e aperte a tecla F9 
do teclado. Esta ação resulta na transferência para o ambiente Standard 
do ADAMS/Car destacado na Figura 5.160. Repare no canto inferior es‑
querdo da tela mostrada na referida figura, onde se lê Switching modes 
to: Standard ADAMS/Car….
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Figura 5.160 – Interface do modo Standard.

•	 Para criar o Subsystem, acesse o menu File → New → Subsystem (Figura 
5.161).

Figura 5.161 – �Janela correspondente à criação de um 
Subsystem.

•	 Preencha os campos da janela New Subsystem, conforme ilustrado na 
Figura 5.162. Note que, como o projeto é de uma suspensão dianteira o 
campo Minor Role, deve estar selecionado com a opção front. O nome 
de Subsystem pode ser o mesmo já designado no Template.

•	 Clique em OK.

MSC_ADAMS_prova-4.indb   459 17/10/14   16:13



460 MSC ADAMS: Guia Prático de Utilização

Figura 5.162 – �Preenchimento da caixa de 
diálogo para criação de um 
Subsystem.

•	 Caso o Template esteja aberto, a janela ilustrada na Figura 5.163 será 
aberta. Para confirmar, clique em Yes.

Figura 5.163 – Confirmação de utilização do Template em execução.

A Figura 5.164 ilustra o Subsystem criado.

Figura 5.164 – Ilustração do subsistema gerado a partir do Template _tutorial_duploa.
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•	 Salve o subsistema Para tanto acesse o menu principal do ambiente 
Standard selecione a opção File → Save.

Etapa 26 – �Criação do Assembly associado ao 
Template _tutorial_duploa (Subsystem)

Nesta etapa, será criado o Assembly, que configura o próximo passo após a 
criação do Subsystem, para que se possam realizar simulações cinemáticas e dinâ‑
micas com o modelo criado.

O Assembly configura uma montagem entre subsistemas e no ADAMS/Car 
pode ser escolhido entre as seguintes opções: Suspension Assembly ou Full‑Vehicle 
Assembly. Como, nesse caso, a simulação será realizada apenas com o subsistema 
suspensão e uma plataforma de testes, a primeira opção será escolhida.

•	 Ainda na tela onde foi criado o subsistema da suspensão, acesse o menu 
File → New → Suspension Assembly (Figura 5.165).

Figura 5.165 – �Janela correspondente à criação de um 
Assembly.

A Figura 5.166 ilustra o preenchimento da janela New Suspension Assembly.
•	 Atribua um nome ao Assembly no primeiro campo; este já deve ser di‑

ferente do nome atribuído ao Subsystem.
•	 Selecione o subsistema de interesse (segundo campo). No campo Sus‑

pension Test Rig a opção _MDI_SUSPENSION_TESTRIG deve estar 
selecionada, a qual corresponde à plataforma de teste a ser utilizada nas 
simulações. Caso deseje incluir outros subsistemas na simulação, sele‑
cione o item Other Subsystems.

•	 Clique em OK.
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Figura 5.166 – �Criação do Assembly.

Caso o Template do projeto esteja aberto, aparecerá a mensagem mostrada 
na Figura 5.167. Nesse caso, clique sobre a opção Yes.

Figura 5.167 – Confirmação de utilização do Template em execução.

A Figura 5.168 ilustra a tela de confirmação de criação do Assembly “Mes‑
sage Window”. Esta mesma janela poderá fornecer a informação de algum erro 
ocorrido durante a criação do Assembly.

•	 Após verificação de mensagens, clique em Close.
•	 Salve seu projeto.

Figura 5.168 – Tela de confirmação de criação do Assembly.
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A Figura 5.169 ilustra o Assembly construído.

Figura 5.169 – Ilustração do Assembly construído.

Etapa 27 – �Simulação do Assembly _tutorial_suspensao_duploa e _MDI_
SUSPENSION_TESTRIG

Nesta etapa, será realizada a simulação do Assembly, criado na Etapa 26.
Primeiramente, defina o diretório para armazenar os resultados gerados na 

simulação. Para tanto:
•	 Acesse o menu File → Select directory (Figura 5.170).

Figura 5.170 – �Janela correspondente à seleção do diretório para 
simulações.
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•	 Selecione o diretório de interesse (Figura 5.171).
•	 Clique em OK.

Figura 5.171 – �Janela correspondente à seleção de 
diretório para gravação de simulações

A simulação proposta aqui corresponde a uma solicitação vertical e paralela 
na suspensão (left e right). Essa simulação permite analisar as características geo‑
métricas do subsistema, durante todo seu curso vertical. Para isto:

•	 Acesse o menu Simulate → Suspension Analysis → Parallel Wheel Travel 
(Figura 5.172).

Figura 5.172 – �Selecionando o tipo de 
simulação.

Os parâmetros de simulação devem ser definidos na janela Suspension Analy‑
sis: Parallel Travel, conforme a Figura 5.173. Note que, na simulação proposta, o 
percurso total corresponde a 100 mm (50 mm no sentido positivo, ou Bump e 50 
mm no sentido negativo, Rebound).

•	 Ao finalizar o preenchimento, clique em OK.
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Figura 5.173 – �Janela correspondente à definição 
dos parâmetros de simulação.

A Figura 5.174 ilustra que a simulação foi executada.
•	 Clique em Close.
•	 Salve seu projeto.

Figura 5.174 – Caixa de diálogo informando que a simulação foi executada.

Etapa 28 – �Visualização da simulação do Assembly: animação do modelo 
virtual para obtenção de resultados

Nesta etapa, o modelo da suspensão criado será visualizado, mediante ani‑
mação do carregamento vertical aplicado, conforme ensaio virtual estabelecido 
pela opção Paralell Wheel Travel.

Para melhor visualização do modelo da suspensão durante a animação, o 
usuário pode optar pelo modo Shaded. Para isto:
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•	 Clique com o botão direito do mouse na área de trabalho principal (em 
qualquer ponto que não seja sobre o modelo).

•	 Selecione a opção Shaded <S> (Figura 5.175).

Figura 5.175 – �Janela correspondente à seleção do modo de 
visualização Shaded.

Em seguida:
•	 Acesse o menu Review → Animation Controls (Figura 5.176).

Figura 5.176 – �Janela correspondente à animação do 
modelo da suspensão.

•	 Na janela Animation Controls preencha os campos, conforme a Figura 
5.177. O usuário pode definir os parâmetros de animação, de acordo 
com sua preferência. Segue como sugestão os valores especificados na 
Figura 5.177.
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Logo abaixo das teclas de controle de animação, a barra que oscila entre – 
Inc e +Inc, permite ao usuário, dentro de um ciclo de simulação (Cycles), avançar 
ou recuar, a fim de escolher um ponto de análise (Frame). O campo Time Range 
dá ao usuário a possibilidade de definir um intervalo de tempo para realização da 
simulação. A aba Cycles permite escolher quantas vezes a simulação irá se repetir, 
no caso, cinco vezes. O campo Frame Increment permite ao usuário definir de 
quantos em quantos Frames ele deseja saltar, no caso, o incremento será de um 
em um.

•	 Para inicializar a animação, clique em .

Figura 5.177 – �Definição dos parâmetros de animação.

A Figura 5.178 ilustra como o modelo será apresentado na tela principal. A 
animação pode ser recomeçada selecionando o item .
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Figura 5.178 – Ilustração da tela referente à animação do Assembly.

Etapa 29 – Obtenção de resultados: ADAMS/Car Postprocessing
Nesta etapa, os resultados serão gerados em forma de gráficos, facilitando, 

assim, sua análise. Para realizar essa análise, proceda como sugerido a seguir:
•	 Acesse o menu Review → Postprocessing Window. Caso deseje, o usuá‑

rio poderá utilizar o atalho correpondente à tecla F8 do teclado. A Figu‑
ra 5.179 ilustra a interface PostProcessing.
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Figura 5.179 – Interface PostProcessing.

•	 Para criar os gráficos, acesse o menu Plot → Create Plot (Figura 5.180).

Figura 5.180 – �Janela correspondente à criação de 
gráficos.

A janela File Import será aberta.
•	 Selecione o tipo de arquivo: Plot Configuration (*.plt).
•	 O arquivo com a configuração desejada dos resultados deve ser selecio‑

nado no campo Plot Configuration File. Para isto, clique com o botão 
direito do mouse sobre esse campo, e selecione a opção mostrada na 
Figura 5.181.
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Figura 5.181 – Janela correspondente à importação de arquivos da 
biblioteca de configuração de gráficos do ADAMS/Car.

•	 Na biblioteca do ADAMS/Car, já existem diversas opções disponíveis 
de configurações de gráficos. Nesse caso, como se está interessado nos 
resultados do Assembly relacionados à Suspensão, selecione a opção 
mdi_suspension_short.plt (Figura 5.182).

Figura 5.182 – Janela correspondente à definição de arquivo de configuração de gráficos.

O arquivo mdi_suspension_short.plt gera automaticamente nove gráficos, 
sendo eles: anti dive, camber angle, caster moment arm, roll camber coefficient, 
roll center height, roll steer, scrub radius, toe angle e wheel rate.
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A Figura 5.183 ilustra a janela File Import, após preenchimento dos campos 
necessários.

Figura 5.183 – �Janela correspondente à impor‑
tação de arquivos para obtenção 
de gráficos no Postprocessor.

•	 Clique em OK.
•	 Para alternar entre os gráficos obtidos, selecione os ícones .
Como exemplo, o sétimo gráfico gerado corresponde ao parâmetro Caster 

Moment Arm (eixo vertical) em função do curso da roda (Wheel Travel), como 
pode ser observado na Figura 5.184.

Figura 5.184 – Gráfico Caster Moment Arm x Wheel Travel.
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A notar: O termo Wheel Travel define o movimento das rodas do veículo, no caso, 
as rodas do eixo dianteiro, provocado pelo trabalho vertical da suspensão (ride) e, 
também, o movimento destas, ocasionado pelo uso do sistema de direção.
O Caster representa uma das medidas de geometria da suspensão, podendo ser 
definido em vista lateral do veículo, como o ângulo que o eixo de direção faz com uma 
linha vertical. Essa linha vertical representa um referencial, que passa pelo centro da 
roda. O eixo da direção, por sua vez, no presente modelo virtual, passará pelas juntas 
situadas nos Hardpoints hpl_uca_outer e hpl_lca_outer. Perceba, pela construção do 
modelo, aqui proposto que essa reta conterá o hpl_tierod_outer.

(a) (b)
Figura representativa do Caster: (a) Caster positivo; (b) Caster negativo.

Fonte: HALDERMAN J. D. Automotive technology: principles, diagnosis and service, New 
Jersey, Pearson, 2012.

Seu valor é positivo quando o pivô superior, junta superior, está atrás do pivô inferior. 
No caso negativo observa‑se o contrário.
Considerando o caso de um Caster positivo, o Caster Moment Arm representa um 
braço de alavanca que é medido a partir do centro da roda até o ponto em que o eixo 
de direção toca a linha horizontal que passa por esse centro. De acordo com a figura 
a seguir EG representaria o eixo de direção, – nτ Caster Moment Arm e τ o ângulo 
de Caster.

Figura representativa do Caster Moment Arm.

Fonte: REIMPELL, J.; STOLL, H.; BETZLER, J. W. The automotive chassi: engineering 
principles, Butterworth‑Heinemann, 2001.
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•	 Caso deseje apagar algum gráfico(s), selecione‑o na árvore de diretó‑
rios – Treeview (à esquerda da tela), conforme ilustrado na Figura 5.185. 
Recomenda‑se apagar individualmente cada gráfico. O atalho Ctrl+X 
também pode ser usado para executar a ação de excluir o gráfico.

Figura 5.185 – Selecionando gráficos para serem apagados.

•	 Acesse o menu Edit → Delete (Figura 5.186).

Figura 5.186 – �Excluindo gráficos.

•	 Para sair da interface PostProcessing, pressione a tecla F8 ou acesse o 
menu File   Close Plot Window.
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Etapa 30 – Salvando as configurações gráficas
Para salvar as modificações nos gráficos gerados anteriormente o usuário deve 

seguir os passos descritos nesta etapa.
•	 No menu File, selecione Export e, em seguida, selecione Plot Configura‑

tion File (Figura 5.187).

Figura 5.187 – �Janela correspondente à exportação de 
arquivos gráficos. 

A janela Save Plot Configuration File será aberta. No campo Configuration File 
Name, digite Parameters_duploa. Selecione a opção All Plots (Figura 5.188).

Figura 5.188 – �Janela correspondente à de‑
finição do arquivo de expor‑
tação.

•	 Clique em OK.
•	 No menu File, selecione Close Plot Window ou pressione F8 para que o 

ADAMS/Car retorne para a janela principal.
Assim, considera‑se que o presente tutorial atende o que o usuário espera em 

termos de construção do subsistema, no entanto, a análise dos gráficos gerados da 
construção fogem ao escopo da presente obra.
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LO

Importação de Geometrias 
CAD no Módulo ADAMS/Car

Neste capítulo, será abordado o procedimento de importação de geometrias 
CAD – Computer-Aided Design (Desenho Assistido por Computador) para com-
por a visualização dos sistemas modelados no ADAMS/Car.

As geometrias importadas de um software CAD funcionam como uma “ma-
quiagem” para o sistema multicorpo, de modo a compor sua imagem, facilitando 
o entendimento em relação ao funcionamento, e tornando a visualização mais 
agradável.

O projeto de geometrias no software CAD possibilita também a extração de 
propriedades geométricas importantes, tais como, centro de massa, massa, mo-
mento de inércia, entre outros, as quais serão necessárias para compor o modelo 
multicorpos.

Este capítulo tem como objetivo auxiliar o usuário no procedimento de im-
portação dessas geometrias CAD, abordando um pequeno exemplo, onde apenas 
um componente do subsistema será importado. Os passos aqui descritos podem 
ser normalmente utilizados para importação de outras geometrias, bem como 
utilizados em outros módulos do software ADAMS.
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Neste capítulo, o subsistema multicorpo abordado é uma suspensão do tipo 
Double A-arm (ou Double Wishbone), também conhecida como Duplo A. O de-
senho CAD aqui utilizado é parte integrante de um projeto Mini-Baja, o qual foi 
gentilmente cedido pela Equipe “Piratas do Cerrado” da Universidade de Brasília.

Visto que o procedimento de construção de uma suspensão automotiva foi 
abordado nos capítulos anteriores, neste capítulo, parte-se do modelo multicorpo 
da suspensão concluído bem como o desenho CAD já pronto. 

O procedimento demonstrado neste capítulo corresponde especificamente à 
importação da geometria CAD da roda do susbsistema suspensão. A figura a se-
guir ilustra o modelo a ser obtido ao fim deste capítulo.

Para facilitar o processo de importação de geometrias CAD para o ADAMS/
Car é aconselhável que ambos os modelos (CAD e multicorpos) possuam o mes-
mo sistema de coordenadas global (mesma localização e orientação dos eixos), 
evitando, portanto, ajustes adicionais para posicionamento da peça importada. 
No entanto, afim de demonstração ao leitor, esta premissa não foi adotada neste 
capítulo visando mostrar as etapas necessárias para contornar esse fato.

Primeiramente, a importação da peça será realizada sem considerar corre-
ções no posicionamento da geometria importada. O resultado será apresentado 
mostrando a não conformidade da metodologia. Posteriormente, uma nova im-
portação desta mesma peça será realizada, considerando, portanto a correção do 
posicionamento da peça importada em razão da diferença de localização e orien-
tação nos sistemas de referência.
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A notar: Logo após a II Guerra Mundial a suspensão Double A (Duplo Triângulo) 
era o tipo mais utilizado no sistema dianteiro dos carros produzidos nessa época. 
Essa suspensão é composta basicamente de um mecanismo de quatro barras, o qual 
permite um maior controle dos ângulos do pneu (câmber e cáster). Ela é constituída 
de dois braços, um superior e outro inferior, que servem como meio de ligação entre a 
estrutura do veículo e suas rodas. A suspensão Duplo Triângulo também é conhecida 
internacionalmente como Double Wishbone.
Na atualidade, a suspensão Double A é encontrada principalmente em carros de 
alto desempenho, por possibilitar um ajuste fino de características importantes, 
como variação de cambagem e bitola. Além disso, ela se mostra um sistema robusto, 
apresentando mais elementos emsua constituição em relação a outros sistemas mais 
enxutos, acrescentando, portanto, massa global ao veículo.

A suspensão Double A é encontrada em várias configurações, dependendo da 
necessidade de projeto. A configuração de braços paralelos e iguais tem a vantagem 
do centro de rolagem estar posicionado no solo, mas tem a grande desvantagem do 
ângulo de inclinação da roda acompanhar a inclinação do chassi, o que resulta e uma 
cambagem positiva durante uma curva, com isso o veículo perde apoio na curva pois o 
ponto de contato do pneu fica mais próximo ao centro de gravidade do veículo. Outra 
vantagem dessa configuração é a grande estabilidade ao enfrentar ondulações na pista.
Já a suspensão com os braços iguais e não paralelos pode ser projetada para atingir um 
baixo centro de rolagem, o que auxilia na transferência de peso durante uma curva. 
Há também a vantagem do fácil posicionamento dos pontos de apoio no chassi. Essa 
configuração começou a ser usada na Fórmula 1, quando os carros passaram a ter sua 
frente mais estreita e mais alta. 	
A suspensão com os braços diferentes e não paralelos é efetivamente o desenho de 
suspensão mais versátil, pois o projetista pode determinar que a roda esteja na posição 
ideal em quase todas as situações, mas, como em todo projeto mecânico, há algumas 
limitações, tais como a posição dos apoios, que torna sua construção um pouco mais 
complexa.

Suspensão Double Wishbone. 
Fonte: GTCarz. Disponível em: 
http://www.gtcars.ca/online/
car-care-detailing-paint-visual-
-mods/42407-suspension-faq-
-all-you-need-know.html. Acesso 
em: 17/12/2012
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Etapa 1 - Escolhendo o tipo de arquivo a ser importado
São três os principais (e mais comum) tipos de arquivos utilizados para im-

portação de geometrias CAD no ADAMS/Car. São eles: STEP (.stp), IGES (.igs) 
e Parasolid (.x_t). O termo entre parênteses corresponde à extensão do arquivo. 

Na Figura 6.1 está ilustrada a opção de importação de arquivos no ADAMS/
Car onde se destacam as três extensões de arquivos mencionadas. Para tanto, o 
desenho em software CAD deve ser salvo em uma dessas três extensões.

Figura 6.1 – �Extensões dos arquivos para 
importação no ADAMS/Car.

Figura 6.2 – �Caixa de diálogo 
de importação.

No exemplo a seguir, o arquivo CAD foi salvo com extensão .igs.

Etapa 2 – Importando a geometria CAD
Para executar esta etapa, é necessário que a geometria CAD esteja concluída 

no software CAD e o modelo multicorpo esteja disponível no modo Template do 
ADAMS/Car.

•	 No ADAMS/Car, com o modelo multicorpo na tela do computador, 
acesse o menu File → Import...

A caixa de diálogos mostrada na Figura 6.2 será aberta.
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•	 Na caixa de diálogo da Figura 6.2, altere o tipo de arquivo a ser im-
portado para o ADAMS/Car. No campo File Type, selecione arquivo do 
tipo IGES (.igs), como ilustrado na Figura 6.3.

•	 No campo File To Read da Figura 6.2, indique o arquivo que se dese-
ja importar. O arquivo pode ser selecionado clicando-se com o botão 
direito do mouse sobre o campo citado. Dentre as opções disponíveis, 
selecione Search ou Browse. O arquivo poderá ser selecionado no dire-
tório de destino.

Figura 6.3 – Seleção do arquivo a ser importado.

O próximo passo consiste em especificar o General Part (no campo Part 
Name) que estará relacionado com a peça a ser importada. Para isso, uma análise 
do sistema deverá ser feita pelo usuário a fim de identificar o corpo rígido a ser 
associado à geometria CAD. 

Para este caso, como a geometria a ser importada corresponde à roda do 
subsistema, tem-se que o Hardpoint diretamente relacionado a ela é o denomi-
nado wheel_center, conforme ilustrado na tabela de Hardpoints do modelo (Fi-
gura 6.4). Os valores contidos na Figura 6.4 relacionados à localização de cada 
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Hardpoint não são exibidos por motivos de confidencialidade, visto que estes são 
oriundos de um projeto real. 

Figura 6.4 – Hardpoint associado à geometria CAD.

Figura 6.5 – �General Part associado 
à geometria CAD.

A partir do Hardpoint wheel_center tem-se que o General Part associado a 
este é o Uprigth (indicado pela seta na Figura 6.5, correspondendo à geometria 
em cor azul claro).
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A Figura 6.6 ilustra a identificação do General Part associado à geometria 
CAD a ser importada. Clicando-se com o botão direito do mouse sobre o cilindro 
em azul claro as informações são exibidas (Figura 6.6).

Figura 6.6 – Informações do General Part denominado Uprigth.

Figura 6.7 – Selecionando o General Part.
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Uma vez definido qual será o General Part, clique com o botão direito do 

Figura 6.8 – General Part selecionado.

mouse no campo Part Name, selecione a opção Browse e, em seguida, selecione o 
General Part gel_Uprigth, conforme ilustra a Figura 6.7.

A caixa de diálogo File Import resultante está mostrada na Figura 6.8.
•	 Ainda com relação à Figura 6.8, mantenha o campo Tolerance com o 

valor 0.01 e Scale com o valor 1.0. Estes são valores padrões (default) 
do programa.

•	 No campo Location, insira as coordenadas 0,0,0 (Figura 6.9). Nesse 
caso, estamos informando que as coordenadas 0,0,0 da geometria CAD 
será posicionada nas coordenadas globais (0,0,0) do modelo multicor-
pos da suspensão.

•	 No campo Relative To, insira o nome do modelo multicorpos em ques-
tão. Nesse caso, denominado como Susp_Baja (Figura 6.9).

A notar: Os campos Location e Orientation da Figura 6.8 são complementados 
com a informação contida no campo Relative To. Dessa maneira, a geometria a ser 
importada terá sua localização e orientação definidas por seu referencial em relação 
ao referencial global utilizado no modelo multicorpos. Sendo assim, se a localização é 
definida como 0,0,0, então o referencial da geometria, quando importada, coincidirá 
com o referencial global do modelo multicorpos da suspensão.
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•	 Clique em OK.
A Figura 6.10 ilustra o processo de importação sendo processado.

Figura 6.9 – �Finalização da caixa de diálogo referente à importação de geometria CAD.

Figura 6.11 – Mensagem indicando a conclusão da importação da geometria.

Figura 6.10 – �Progresso de importa-
ção sendo processado.

A Figura 6.11 mostra a mensagem exibida pelo ADAMS/Car após conclusão 
da importação da geometria.
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•	 Na Figura 6.11, clique em Close, após verificar que não houve erros 
relativos ao processo de importação.

A Figura 6.12 mostra a peça importada, neste caso, a roda.

Figura 6.12 – Geometria relativa à roda importada para o ADAMS/Car.

Observa-se na Figura 6.12 que a geometria não se encontra no local deseja-
do, uma vez que esta deveria estar localizada no General Part Uprigth (cilindro 
azul claro), localizado na extremidade lateral da suspensão. Este procedimento 
foi realizado a título de exemplo ao usuário, mostrando o quanto é importante 
analisar as coordenadas de referência de ambos os modelos (CAD e multicorpos) 
a fim de se obter uma importação na posição correta.

Um novo procedimento será necessário para que a peça seja posicionada no 
local correto do modelo multicorpos. Para isto, uma análise deverá ser feita a fim 
de verificar o quanto a geometria da roda deverá sofrer translação para que ocupe 
a posição correta. 

Para dar prosseguimento à proxima etapa, considere que a geometria im-
portada foi apagada (excluída) do modelo (clique com o botão direito do mouse 
sobre a geometria e clique em Delete). Um novo procedimento de importação será 
realizado, levando em conta este posicionamento, em virtude da difenrença no 
referencial de ambos os modelos.

Etapa 3 – Importação e posicionamento da geometria CAD
Nesta etapa, o processo de importação da geometria CAD para o ADAMS/

Car será realizado já com a translação desta, de modo a localizá-la no local de-
sejado no modelo multicorpos, ou seja, posicionando a geometria importada no 
local de interesse do modelo multicorpos.
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Após uma análise entre as coordenadas de referência do modelo no software 
CAD e no ADAMS/Car, identificou-se que o eixo Y do modelo no ADAMS/Car 
correponde ao eixo –Y do modelo construído no software CAD.

A Figura 6.13 mostra a geometria CAD no seu programa de origem, ilustran-
do o sistema de coordenadas deste. 

Figura 6.13 – Geometria CAD da roda.

Figura 6.14 – �Coordenadas do centro 
do aro esquerdo da roda 
no SolidWorks.

Uma análise de simetria da peça com relação à origem das coordenadas será 
realizada, tanto na direção longitudinal quanto na radial. 

Primeiramente, obtêm-se os valores das coordenadas do aro esquerdo da 
roda, conforme ilustrado na Figura 6.14 (destacado em azul). Pelas informações 
fornecidas pelo software CAD o centro deste aro encontra-se a -114,02 mm da 
origem das coordenadas na direção Y. Já a simetria radial foi também conferida, 
e sua existência foi verificada.
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As mesmas informações apresentadas aqui (localização do centro do aro) são 
obtidas para o aro da direita, conforme Figura 6.15. 

Figura 6.15 – �Coordenadas do centro 
do aro esquerdo da 
roda no SolidWorks.

Pelos resultados obtidos nas Figuras 6.14 e 6.15 nota-se que a origem das 
coordenadas da roda não se encontra localizada no meio do comprimento longi-
tudinal da peça. Como se pode observar, as distâncias no eixo Y entre a origem 
e o centro de cada aro são diferentes (-114,02 mm na primeira medição e 65,97 
mm na segunda medição). 

Para que essa origem de coordenadas esteja localizada exatamente no centro 
da peça, tanto radial quanto longitudinal, o seguintes cálculos devem ser feitos:

•	 Comprimento total longitudinal da roda: 114,02 mm + 65,97 mm = 

180 mm
•	 Centro do comprimento longitudinal: 180 mm / 2 = 90 mm
•	 Distância a ser percorrida pelo sistema de referência na direção Y para 

que esta fique localizada exatamente no centro do comprimento longi-
tudinal da roda: 114,02 mm - 90 mm = 24 mm.	

Desta maneira, o sistema de coordenadas do software CAD precisaria ser 
deslocado em 24 mm na direção do eixo Y, porém em seu sentido negativo, para 
que o sistema de referência ficasse localizado no centro da peça (radial e longitu-
dinal).

Enquanto é necessário deslocar-se -24 mm em Y no software CAD, no ADA-
MS/Car será necessária uma translação de +24 mm em Y (como ressaltado ante-
riormente ambos os eixos estão em sentidos opostos). 

Para que esse centro (radial e longitudinal) da geometria importada ocupe 
a posição correta no modelo mutlicorpos, ou seja, na localização do Hardpoint 
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de interesse, é necessário analisar o quanto a peça deverá ser deslocada nos res-
pectivos eixos cartesianos X, Y e Z. O centro da roda deverá ser posicionado no 
Hardpoint wheel_center cujas coordenadas (7,135; 627,99; -32,11) no ADAMS/
Car estão mostradas na Figura 6.4.

Para realizar a importação considerando o posicionamento da peça, conside-
re o campo Location da caixa de diálogo File Import, o qual deve ser preenchido 
conforme a Figura 6.16. Note que a coordenada Y corresponde à soma dos va-
lores 627,99 mm e 24 mm, resultando em 652 mm. Os demais valores (X e Z) 
correspondem à posição do Hardpoint wheel_center.

Figura 6.16 – Importação da geometria CAD com translação no ambiente ADAMS/Car.

Figura 6.17 – Progresso de importação da geometria.

•	 Clique em OK.
A Figura 6.17 ilustra o processo de importação da peça.
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A Figura 6.18 mostra a geometria importada na posição correta no modelo 
multicorpos no ADAMS/Car.

Figura 6.18 – �Geometria CAD importada 
na posição desejada.

Figura 6.19 – �Propriedades da geometria 
importada.

Etapa 4 – Modificando a aparência da geometria importada
O processo de importação do ADAMS/Car não importa características grá-

ficas definidas no software CAD, tais como a cor, dificultando, no entanto, sua 
identificação.

Entretanto, o ADAMS/Car possui ferramentas que alteram a cor da geo-
metria e ainda seu nome. Nesta etapa, estas ações referentes às modificações de 
características gráficas e nomes serão executadas. 

•	 Para alterar o nome da geometria importada, clique com o botão direto 
nela, aponte o mouse para a geometria de interesse (o ADAMS automa-
ticamente denomina a geometria importada com uma sigla SHL, prove-
niente da palavra Shell, seguida de um número) e, em seguida, selecione 
Rename (Figura 6.19). 
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Figura 6.20 – Renomeando a geometria importada.

Figura 6.21 – Alterando a aparência da geometria importada.

•	 Uma caixa de diálogo será aberta. Preencha o campo New Name com o 
novo nome da mesma (Figura 6.20). 

•	 Para alterar a aparência (cor) da peça importada clique novamente com 
o botão direito do mouse sobre a geometria de interesse. Posicione o 
cursor do mouse sobre o nome dessa geometria e selecione o item Appe-
arence (Figura 6.21).

Uma caixa de diálogo (Edit Appearance) será aberta. Os campos de interesse 
nessa janela serão Color e Transparency as quais dizem respeito à cor e o nível de 
transparência (Figura 6.22).
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•	 No campo Color, clique com o botão direito do mouse, aponte o cursor 
para Color → Guesses e, então, selecione a cor desejada (Figura 6.23).

Figura 6.22 – Caixa de diálogo Edit Appearance.

Figura 6.23 – �Selecionando 
a cor da peça.

•	 Clique em OK.
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Figura 6.24 – Aparência final da peça importada.

A Figura 6.24 ilustra a geometria importada (roda dianteira) com a cor alte-
rada de cinza para vermelho.

As demais peças desse subsistema poderão ser importadas do software CAD 
seguindo a mesma metodologia descrita neste capítulo.
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Como copiar e executar 
tarefas com um arquivo  
.cdb (ADAMS/Car)  
em seu computador

ATENÇÃO: o leitor tem acesso a duas pastas .cdb das suspensões indepen-
dentes: Macpherson e Duplo “A”. Cada uma dessas pastas deve ser aberta indivi-
dualmente, conforme indicado nos passos especificados abaixo.

Primeiro passo 

Faça o download da pasta compactada referente aos tutoriais das Suspensões 
Macpherson e Duplo “A” no local desejado em seu computador. Por exemplo, no 
diretório C:\, crie uma pasta de nome “Suspensão_Macpherson” e outra “Suspen-
são_duploA”. Copie para dentro dessas pastas o respectivo arquivo compactado.

Segundo passo 

Descompacte os arquivos nas referidas pastas tendo o cuidado de manter os 
mesmos nomes, quais sejam:

A
PÊN

D
IC
E
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– Tutorial_macpherson.cdb (caso vá trabalhar com a suspensão Macpherson)
ou
– Tutorial_duploa.cdb (caso vá trabalhar com a suspensão Duplo “A”)

Obs.: o botão direito do mouse permite que clicando sobre o arquivo com-
pactado e selecionando a opção: “Extrair para Tutorial_macpherson.cdb” ou 
“Extrair para Tutorial_duploa.cdb”, os arquivos sejam copiados nas pastas cria-
das anteriormente.

Terceiro passo

Inicie o ADAMS/Car clicando no ícone referente a ele e, em seguida, escolha, 
conforme tela abaixo a opção “Standard Interface”.

Quarto passo

Em seguida, selecione a opção File → Select Directory e navegue de forma a 
indicar o local onde a pasta .cdb foi armazenada em seu computador (selecione o 
último nível desta pasta). Por exemplo:

C:\Suspensao_Macpherson\Tutorial_macpherson.cdb\Tutorial_macpherson.cdb
ou
C:\Suspensao_duploa\Tutorial_duploa.cdb\Tutorial_duploa.cdb
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Quinto passo 

Por fim, vá ao menu principal e selecione a opção Tools → Database 
Management → Add to Session para carregar a pasta .cdb na sessão aberta do 
ADAMS/Car.

Neste caso, deve–se informar o Database Alias, que é o próprio nome da pasta 
.cdb (Tutorial_duploa ou Tutorial_macpherson) e o Database Path, que indica o lo-
cal onde a mesma se encontra (C:\Suspensao_Macpherson\Tutorial_macpherson.
cdb\Tutorial_macpherson.cdb) ou (C:\Suspensao_duploa\Tutorial_duploa.cdb\
Tutorial_duploa.cdb).

Sexto passo

O subsistema existente na pasta descompactada já pode ser aberto. Para 
isto vá em File → Open → Subsystem . Na caixa de diálogo Open Subsystem, 
clique com o botão direito do mouse na caixa de texto e em seguida clique em 
Browse. Duplo clique na pasta subsystems.tbl e em sequência selecione o arquivo 
tutorial_macpherson.sub ou tutorial_duploa.sub. Clique em OK em ambas as ja-
nelas. Clique em Close para fechar a janela que se abrirá sobre a área de trabalho. 
Pronto, seu modelo já está pronto para ser trabalhado.
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